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1 About this Guide  
This guide provides an overview of SiPass integrated Configuration Client. The 

document also provides technical information required for the System 

Administrator, Operator and the User to configure SiPass integrated for initial setup 

and on a day-to-day basis. 

Objective 

The objective of this document is to teach the implementer the various processes 

involved in configuring the SiPass integrated system using the Configuration Client.
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2 Document Updates after Previous Release 
The following updates have been done to this document as below: 

SiPass integrated MP 2.80 
 

Section Details 

Managing the Database [➙ 132] Updated with information about backing up data to a 
password-protected encrypted file and restoring 
from the same. 

Access Point General Configuration 

[➙ 66] 
Added information on the Disable Card Event 
checkbox, the new option for ensuring Access Point 
Privacy to comply with General Data Protection 
Regulations, if applicable in the region where 
SiPass integrated is installed. 

Added information on Door forced/tamper buzzer 
checkbox, the new option to sound the buzzer on 
any “Door Forced” or “Door Tamper” event. 

Searching for Components [➙ 44] New section describing the new Component Search 
functionality to search a specific component on the 
Components dialog. 

Multi Function Interface (MFI) [➙ 54] New section that provides information on the newly 
added Multi Function Interface (MFI) device. 

Adding Devices [➙ 58] Updated to include the MFI related options while 
adding devices. 

Door Frame Held Only mode New section that describes the new "Door Frame 
Held Only" mode, available while configuring Input 
Points through the Components dialog. 

Sending OSDP Site Key to the Reader 

for Encrypted Communication [➙ 85] 
New section that describes the new process to set 
the OSDP key for the reader for encrypted 
communication with the ACC. 

Creating an Operator Group [➙ 114] Section updated to include settings for the backup 
file encryption by the Operator Group. 

New section 
Door Frame Input as Intrusion Input 

[➙ 74] 

Updated section  
Configuring an Intrusion Area [➙ 107] 

Information on the new capability of assigning Door 
Frame Input Points (Door Contact point) to the 
Intrusion Areas. 

Creating an Operator Group [➙ 114] Section updated to include information about the 
configurable file setting to enable an operator see 
audit trail entries for all the cardholders, irrespective 
of the cardholder’s workgroup permissions. 
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SiPass integrated MP 2.76 SP2 
 

Section Details 

Aperio Doorframe Sensor Input [➙ 76] New section that describes the Aperio Doorframe 
Sensor Input introduced in SiPass integrated 
MP2.76 SP2 onwards. 

 

 

SiPass integrated MP 2.76 SP1 
 

Section Details 

System Components [➙ 41] The section has been updated at different places to 
include information about Wiegand Reader Interface 
support on ACC-AP and multiple Aperio Wireless 
Hub support. 

New sub-sections: 

● Wiegand Reader on ACC-AP [➙ 52] 

Updated sub-sections: 

● Aperio Wireless Lock Technology [➙ 52] 

● Adding an FLN Connection [➙ 49] 

● Adding Aperio Wireless Hub [➙ 54] 

● Adding Devices [➙ 58] 

● Discovering Devices [➙ 63] 

● Linking/Unlinking to an OSDP Reader Device [➙ 62] 

● Points [➙ 65] 

Step 2 - Configuring Cardholder Details 

[➙ 105] 
Section updated to include the new Manager Email 
Address field for forwarding messages to email 
address of the Cardholder’s manager. 

Device Firmware Download and 

Configuration [➙ 78] 
Added description for the Tamper Ignore checkbox 
on the Reader Firmware & Config tab. 

See table Configuration Tab Fieldsin this document. 
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SiPass integrated MP 2.76 
 

Section Details 

FARGO HDP8500 Printer [➙ 30] New section that explains the setup and 
configuration settings for Fargo HDP8500 5121 card 
printer 

System Components [➙ 41] The entire section has been updated at many 
places to include information about OSDP on FLN 
Bus and Aperio Wireless Hub capabilities. 

New sub-sections: 

● OSDP Reader Devices [➙ 51] 

● Aperio Wireless Lock Technology [➙ 52] 

● Adding Aperio Wireless Hub [➙ 54] 

● Linking/Unlinking to an OSDP Reader Device [➙ 62] 

Updated sub-sections: 

● Adding an FLN Connection [➙ 49] 

● Adding Devices [➙ 58] 

● Discovering Devices [➙ 63] 

● Points [➙ 65] 

DC Input Delay [➙ 75] New section that provides changes done to DC 
Input Delay settings for ACC firmware version 
2.50.23 and higher (in combination with DRI/SRI 
firmware version 3.06 or higher). 

CCTV Removed from document 

Personnel Management [➙ 114] Added restrictions about not creating Operator and 
Operator groups with some specific names. 

 

 

SiPass integrated MP 2.75 
 

Section Details 

ACC-AP [➙ 48] New section that describes the new IP-based ACC-
AP Controller. 

● Adding an ACC [➙ 45] 

● FLN Connections [➙ 49] 

● Devices [➙ 51] 

Sections updated to include instructions on the 
ACC-AP Controller and the onboard Dual Reader 
Interface (DRIe), 
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SiPass integrated MP 2.70 Service Pack 1 
 

Section Details 

Certificate Expiry and Renewal New section that explains how SiPass integrated 
monitors the certificate for validity and informs the 
user before its expiry date. The process to renew 
the certificate is also explained in this section. 

Client / Server Monitoring [➙ 131] New section that describes the Client/Server 
Monitoring feature that lists information about the 
Client Computer, Server, Windows Login and 
Certificate in use.. 

Profile Configuration [➙ 145] The Profile Configuration is now done separately for 
Mifare DESFire cards. 

● The DESFire encoding now supports thirteen keys 

per application. 

● From one application, you can now assign a key to a 

file as READ, a key to a file as WRITE, a key to a file 

as READ/WRITE, and a key to a file as CHANGE. 

The section is updated to include: 

● Separate Profile Configuration dialog for Mifare 

DESFire Cards 

● Configuring the Application / File Contents for Mifare 

DESFire Cards 

● Configuring the Sector Keys for Mifare DESFire Cards 

Configuring OSDP Readers [➙ 84] Descriptions added for the Encryption Mode while 
configuring OSDP readers. 
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3 Introduction and Starting Up 
Congratulations on choosing SiPass integrated to be your access control software 

solution. SiPass integrated is the leading access control software on the market. 

SiPass integrated is an access control and security management system that 

monitors and controls access to your site, using a personal computer running the 

latest Windows operating system. 

The graphical user interface of SiPass integrated is designed to support the 

complex and demanding needs of security staff and operators. You can quickly 

and easily navigate the system and use the many functions provided. SiPass 

integrated is a complete system that packages all your access control needs into 

an easy-to-use application. 

The SiPass integrated system allows you to effectively and efficiently monitor your 

building site and the people who access it. The system also allows dial-up 

communication via modems, meaning that fewer resources are required to monitor 

a large number of sites. 

3.1 Online Help and SiPass integrated  

License Information 

SiPass integrated provides an interactive Online Help reference manual under the 

Help menu. The menu also provides an About option that opens the SiPass 

integrated dialog which gives information like Site Name, Serial Number and 

Computer System Details. 

Clicking the License Details button opens up another dialog which displays detailed 

information about Site, Workstations, Clients, Card Limit and available modules as 

per the respective SiPass integrated license. 

Note: Creating a new Configuration Client Login does not utilize any SiPass 

integrated workstation license. 

You can also have more information about SiPass integrated on the internet 

through the hyperlink given on the dialog. 
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3.2 Password Management 

SiPass integrated is installed and configured by the Siemens Commissioning 

Engineer with the default password provided by Siemens. For ensuring maximum 

security, you will be asked to change the default password to a secure password of 

your choice while logging in to SiPass integrated Configuration Client for the first 

time. 

Note: If you logged in to the SiPass integrated Operation Client first and have 

already changed the password, you will not be asked to change the password 

during the first login on the Configuration Client. If you cancel the Change 
Password dialog three times, it will be closed and displayed again during your next 

login attempt. 

A secure password can be created with the following properties: 

● At least three characters long 

● At least three of uppercase characters / lowercase characters / numbers / non-

alphabet characters 

You can change the password at any time later following the steps below: 

1. Run the SiPass integrated Configuration Client through the Windows Start 

Menu. 

2. On the Welcome dialog, click the Change Password button. 

 The Change Password dialog is displayed. Enter the required information: 

3. Type the username in the User Name field. 

4. Type the existing password in the Old Password field. 

5. Type an appropriate password in the New Password field. Memorize it so there 

are no login issues in future. 

6. Type the new password again in the Confirm Password field. 

7. Click OK. 

8. The Welcome dialog is displayed again. 

9. Login with the new password. 
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3.3 System Preferences 

System Preferences allow you to customize the SiPass integrated user interface 

and system operation to your own preferences. The tabs for defining System 

Preferences help you configure different areas according to your need. 

 

 

The system preferences are operator specific and changes made to the default 

preferences and will only affect the operator who made those changes. 

In addition to the customizable system settings, SiPass integrated will remember 

the size and position of the Audit Trail window from each operator’s last session. 

 

3.3.1 Customizing System Preferences 

Customizing System Preferences will provide you with an enhanced and 

personalized Audit Trail view. 

1. Select Preferences from the Options menu to display the General tab. 

2. Complete the General tab system preferences. The section General Tab 

details the various the fields / options displayed on this tab. 

3. To alter the Audit Trail preferences, choose the Audit Trail  tab and complete 

the preferences displayed on this tab. 

4. To select a location for archiving, choose the Archive Folder Location button. 

5. To alter the Audit Trail Columns that are displayed, choose the Audit Trail 
Columns tab. 

6. Select the columns to appear in the Active Audit Trail. Options selected in this 

dialog do not change the columns that are printed as part of Audit Trail 

Reports. 

– Select top or bottom section and press the ‘Ctrl’, ‘Shift’ and ‘+’ keys to fit all 

Audit Trail Columns on the screen 

– The Audit Trail information appears in a window on the main screen of 

SiPass integrated and, due to the limitations of screen size, only a limited 

amount of information can be viewed at any one time. It may be necessary 

to scroll across to view events that do not completely fit within the window. 

7. To alter Imaging details, select the Imaging tab and choose the preferences 

that are suitable for the viewing of images on screen. These preferences will 

depend largely on the video capture card installed in your PC. 

8. Click Save. 
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3.3.1.1 General Tab 

The following table explains the settings available on the General Tab. 
 

Setting Context Description 

Background Image File User Specifies the path and file name of the image to appear in the 
background of the SiPass integrated main screen. 

Default Operator Expiry Date System(Local) Specifies the date that will appear by default in the Operator definition 
screens. To disable the expiry date so that the operator privileges will 
never expire, de-select the checkbox. 

Operator Lockout Timeout 
(minutes) 

Operator Specifies the time in minutes before workstation lockout is activated. 
You must re-enter your password to re-activate SiPass integrated, 
once your workstation has become locked. A value of 0 doesn’t lock 
out the workstation. 

Confirm on Save Operator When checked, the Save Confirmation dialog will appear when 
saving a modified Database record. 

Confirm on Delete Operator When checked, the Delete Confirmation dialog will appear when 
deleting a Database record. 

Show Equipment Description System When checked, displays the description of the component in the 
Components tree, if a description has been added in the Description 
field on the individual Component dialogs. 

Show on Start-up Operator When checked the System Status screen will be displayed upon 
start-up. 

Refresh Rate (sec) Operator Specifies how often the data displayed in the Status monitor is 
updated to reflect the latest changes in status and alarm conditions. 
Default is 10 seconds. The current refresh rate is shown on the 
System Status screen. 

 

3.3.1.2 Audit Trail Tab 

The following table explains the settings available on the Audit Trail tab. 
 

Setting Description 

Additionally Write to TAB 
Files 

Tick this checkbox if you want to write the audit trail transactions to a TAB File, in addition to 
the SQL database. 

 

  



 

 

Introduction and Starting Up 

System Preferences 
3 

22 | 313  A6V101068156 

 

3.3.1.3 Imaging Tab 

The following table explains the settings available on the Imaging Tab. 
 

Setting Context Description 

Video Source User User to configure the Video capture settings according to your 
preferences. 

The Video Capture settings will normally deal with video capture 
source, picture quality (resolution, brightness) and the physical 
settings of the camera, like tilt. 

Video Format System(Local) Used to select video format depending upon the camera, video 
capture card installed and the driver being used. 

Video Overlay Operator Video Overlay has been added to the GUI in anticipation of future 
SiPass integrated development. This feature may or may not be 
supported, and will depend upon your installed video capture card. 
Currently, the recommended card (Videum VO) does not support 
Video Overlay. The button will be disabled, indicating that your 
installed hardware is incompatible with this feature. 

IP Camera Operator When checked, lets you choose an available IP Camera from the 
drop down list. 

Live Video Operator Enables live video feed from the selected IP Camera. 

 

3.3.1.4 Notify Email Tab 

The Options drop down of this tab displays the types of email notifications that can 

be configured in SiPass integrated. These options and the configuration 

instructions are as follows: 

● Disabled: Select this option to disable the email notification feature. 

● Exchange Server: Select this option to send email notifications to cardholders 

using the Exchange Server. 

● SMTP: Select this option to send email notifications to cardholders using the 

SMTP protocol. 
 

Configuration Fields Description 

Exchange URL Enter the URL of your Exchange Server web service. 

e.g., http://192.168.0.10/EWS/ExchangeServer 

It is recommended that you contact your system administrator for this information. 

User Name Enter the username of the main user. 

Password Enter the password of the main user. 

Domain Enter the domain name. 
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Recommendations: 

1. Use any computer within the same domain with the Outlook 2007 or 2010 Auto 

Discovery feature. 

2. Hold the Ctrl button and right click on the Outlook Icon in the system tray. 

3. Select Test E-mail Auto Configuration from the menu. 

4. Type in any email address located on the Exchange server. 

5. Ensure that only the "Use Auto Discover" checkbox is enabled. 

6. Click Test. 

7. Search the results for the line starting with Availability Service URL. This 

contains the Exchange Web Services (EWS) URL. 

The User Name and Password (provided by system administrator) specifies the 

account to be used as the Organizer of all the meetings created by SiPass. This 

account should have privileges to create/update/delete meetings in the Exchange 

server. 

Note: This feature is supported by Exchange 2007 SP1, Exchange 2010 and 

Exchange 2013. 

SMTP 

Select this option to send email notifications to cardholders using the SMTP 

protocol. 
 

Option Description 

Organizer Email Enter the organizer’s email address that will remain the standard email address 
displayed in the From: field of all emails sent from SiPass. 

Host Enter the SMTP Server host IP address. 

Port Enter the port number of the server 

User Name Enter the username of the main user. 

Password Enter the password of the main user. 

Enable SSL checkbox Tick this checkbox if you want to enable the SSL security protocol. 

Note: It is recommended that you contact your system administrator for this 
information. 
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3.3.2 Customizing Views and Toolbars 

SiPass integrated allows you to customize the position of the toolbars, as well as 

move the icons across toolbars with a single drag and drop motion. 

1. From the View menu, select the Customize option to display Customize dialog 

2. Tick on the box next to the toolbar you would like to display. 

3. You can also add the toolbars to your SiPass integrated display by selecting 

the icons. For example, selecting the Alarm icon will automatically display the 

Alarm toolbar. 

4. Select the Commands tab. 

5. Select a toolbar from the Categories dialog box, all the commands available will 

display in the Commands dialog box. 

6. Select the icon you would like to add and drag it to you the toolbar. 

7. To further customize the menu’s and toolbars select the Options tab. To reset 

the menu and toolbar to the original settings, select Reset Menu and toolbar 

usage data. 

8. Select Close. 

3.3.3 User Definable Menu Items 

SiPass integrated allows operators to create and customize their own menu bars 

and buttons. This functionality is client specific, and is not governed by Operator 

partitioning. 

There are 2 simple stages required to apply this feature: 

● Stage 1: Adding a new button to a tool bar 

● Stage 2: Attaching and running an executable command to the new button 

These stages have been discussed in the sections that follow. 

3.3.3.1 Adding a New Button to a Toolbar 

1. From the View menu, select Customize… 

2. On the Customize dialog, select the Commands tab. 

3. Scroll down the list of the Categories box, and select All Commands. 

4. Scroll down list of the Commands box, and select External Command. 

 

 

There are 24 External Commands buttons that an operator can use. 

5. Click and drag this external command to a selected toolbar on the SiPass 

integrated user interface. 

 The new button will now be displayed on the toolbar. 
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3.3.3.2 Attaching and Running an Executable Command 

1. From the Options menu, select Custom Command Configuration. 

2. Click Add. 

 An external command will appear on the adjacent box. 

3. In the Name field, enter a name for this External Command button. 

4. In the Path field, enter a path for the External Command. 

5. In the Icon File field, enter a file for an icon for the External Command button. 

6. Click Apply. 

7. Click the new menu button on the toolbar. This action runs the executable 

command attached to the button. 

Consider that an executable command to open a Notepad application was 

attached to the new button. Clicking on the new button on the toolbar will execute 

this command, and so open the specified Notebook application. 

Audit Trails will be generated for actions corresponding to the creation and edit of 

these User Definable Menu items. 

 

 

Before backing up the SiPass integrated database, the operator will need to 

manually copy the XML file corresponding to the defined menu items to the other 

PC. 

 



 

 

Introduction and Starting Up 

Setting up Printers for SiPass integrated 
3 

26 | 313  A6V101068156 

 

3.4 Setting up Printers for SiPass integrated 

SiPass integrated provides the functionality to configure four unique, task-oriented 

printing operations. Individual printers can be set up to automatically carry out 

specific printing tasks according to operator requirements. 

The four printing operations are: 

● Audit Trail Printing 

● Card Printing 

● Plan Printing 

● Report Printing 

Each of the above tasks can be configured from the standard Windows Print Setup 

dialog, which is opened by selecting the New Printer button under the tabs in the 

Setup Global Printers dialog. The New Printer button will only appear if there are 

no printers installed in Windows. 

Printers may be shared across the application, although some limitations are 

imposed upon the use of each of the printer types. Each task requires a dedicated 

printer, but there is some allowance for multiple uses. 

All printer output is dependent upon the access privileges assigned to the operator. 

Actual printers cited in the following section are for the purposes of example only. 

Consult your local System Administrator and SiPass integrated distributor for 

details concerning recommended printers and their compatibility with your site. 

3.4.1 Audit Trail Printing 

Audit Trail printing can be carried out using either standard page or line printers. 

The SiPass integrated application identifies a line printer through the Tractor Feed 

setting, which is enabled during the configuration process. If this is not set, the 

system assumes that the printer is a page printer and buffers the page until the 

printable area is filled. The buffer is then dumped to the printer output file for 

normal printing. 

To avoid potential conflicts, spooling should be selected in all circumstances. Refer 

to the appropriate Printer Properties dialogs when installing your printers. These 

are located in the Start menu of your computer under Settings > Printers and 

Faxes, and display the advanced settings and page setup options available for the 

selected printer. 

3.4.1.1 Privilege Control for Printer Access 

Operator Group privileges control access to the Printer Setup dialog. If an operator 

does not have the necessary access privileges, the Printer Setup options located 

under the File menu will be disabled, preventing the current settings from being 

altered. This stops the operator from enabling or disabling the Print Audit Trail 

option from within SiPass integrated. 
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3.4.1.2 System Behavior 

These important issues are related to system behavior and Audit Trail printing: 

● It is recommended that a separate default printer be installed and configured 

for Audit Trail printing from the printer configured for Report printing. 

● Where the use of the same line printer for both Audit Trail and Report printing 

is unavoidable, ensure that the Enable Audit Trail Printing checkbox under the 

Audit Trail tab of the Setup Global Printers dialog is disabled before you print a 

Report. This will prevent live audit trail messages conflicting with the current 

printing job. 

To help keep Audit Trail and Report printing separate: 

● You can send the Audit Trail to a page printer that does not have a default 

printer requirement. 

● In the case where a line printer is used, you must ensure that Audit Trail and 

Report printing are not run concurrently. This will require manual intervention. 

● A Print Preview of an Audit Trail screen will display a blank page unless the 

Enable Audit Trail Printing checkbox is ticked during setup. In addition, without 

the necessary access privileges, an operator cannot alter the current settings in 

order to display the Audit Trail report prior to printing. 

3.4.1.3 Filtering of Audit Trail Columns 

It is important to understand the distinction between Audit Trail printing and Audit 

Trail Reports. Audit Trail printing produces a “hard copy” of the events recorded in 

the Audit Trail and takes place dynamically as the events occur. The columns that 

are displayed in Audit Trail printing are not configurable. However, Audit Trail 

reports are the result of retrieving and formatting records from the Audit Trail 

database. The columns displayed in Audit Trail reports are configurable. 

This functionality is totally independent of the display settings used in the Audit 
Trail tab of the System Preferences dialog. 

Checking the Print Alarm Messages Only checkbox in the Setup Global Printers 

dialog initiates the filtering of Audit Trail messages, so that only Alarm messages 

are printed. 

Printer settings are retained for all operators, so that when operators are changed, 

the printer enabled or print filtering options will not be altered. However, the Print 
Setup dialog will appear disabled for operators lacking the necessary access 

privileges to alter these settings. 

3.4.2 Configuring an Audit Trail Printer 

An audit trail printer can be either a standard laser or a line printer. While a line 

printer will print a line at a time, a laser printer will buffer the messages until the 

page buffer is full and then print the contents a single page at a time. Both printer 

types are configured in a similar way. 

Follow the procedure below to configure the audit trail printer. 

 If you are connecting the printer directly to a SiPass client PC, ensure that you 

have installed the appropriate printer driver for that printer. Otherwise, the 

printer cannot be selected from the drop-down list during the configuration 

process. 
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1. From the File menu, select the Print Setup option to display the Setup Global 
Printers dialog. 

2. Choose the Audit Trail Printer tab. This is the default tab and it displays the 

current printer, if connected. 

3. Check the Enable Audit Trail Printing checkbox. This activates the Audit Trail 

Options section of the dialog. If this check box is not ticked, Audit Trail events 

will not be printed. 

4. From the Audit Trail Print Options section, select the type of messages to be 

displayed by highlighting the appropriate radio button. 

– Print Alarm Messages Only: This option enables the printing of Alarm 

messages only from the Audit Trail. 

– Print All Messages: This option enables the printing of all messages from 

the Audit Trail. 

5. Tick the 132 Column checkbox, if required. By default, the font used by the 

printer will be a standard width font, such as Courier. 

– Select this option if your audit trail printer can print 132 or more characters 

per line. The fields A/N, DATE, TIME, LOCATION, F_NAME, L_NAME, 

CARDNO, and MESSAGE will be printed with format "%s %-12.12s %-12s 

%-22.22s %-12.12s %-12.12s %-12.12s %-43.43s". (133 characters). 

– Do not select this option if your audit trail printer can only print 80 

characters per line. The fields A/N, DATE, TIME, LOCATION and 

MESSAGE will be printed with format "%s %-12.12s %-12.12s %-20.20s 

%-32.32s" (81 chars). 

6. Choose the Select Printer button to open the Print Setup dialog. 

7. Select a suitable printer type from the list displayed in the Name drop down 

box. 

8. From the (Paper) Source drop down box, select the paper source. 

9. Select the paper orientation. 

– Portrait: Select this option if you are using an 80 column printer. 

– Landscape: Select this option if you are using a 132 column printer, and 

have ticked the 132 Column check box in the Setup Global Printers dialog, 

or if you are using a laser printer and want a wide audit trail printout. 

10. Choose the OK button to return to the Setup Global Printers dialog. 

11. Choose the Apply button. 

 The columns that will appear in the Audit Trail printout may not be altered. 

They are as outlined in the section that follows. 

 Once the setup for Audit Trail printing has been completed, the system 

immediately begins to pass the Audit Trail events to the line printer as they 

occur. 
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3.4.2.1 Audit Trail Printing Columns 

The following table lists the columns available for Audit Trail printing. These 

columns cannot be modified. 
 

Column Description 

Type (of 
Message) 

Indicates whether the displayed message is a Normal or Alarm 
message. 

Date Occurred Displays the date of the Audit Trail event 

Time Occurred Displays the time of the Audit Trail event 

Location Displays the location where the Audit Trail event took place. 

Message Displays the contents of the Audit Trail message. 

 

3.4.2.2 Viewing the Contents of the Printer Buffer 

You can view the contents of the buffer by using the Print Preview option. 

◈ From the File menu, choose Print Preview. 

 The contents of the buffer will now be displayed. 

The printed version provides you with an alternative “hard-copy” backup of the 

Audit Trail. 

3.4.3 Plan Printing 

Plan Printing is unique in that SiPass integrated supports many different drawing 

formats, both in physical size and file type, as well as different printer technologies. 

Sending plans and drawings to the appropriate printer / plotter will produce outputs 

at the correct size and scale, making them more manageable and their 

interpretation easier. Sizes range from A4 up to A0. 

The supported technologies for plan printers and plotters include the following 

Windows-compatible technologies: 

● Pen Plotters, 

● Inkjet Printers 

● Bubble jet Printers 

● Laser Printers 

● Electrostatic Printers 

3.4.3.1 Configuring a Site Plan Printer 

A site plan printer allows you to generate paper copies of your site plans. These 

are very useful for introducing new staff to the site, as well as organizing and 

coordinating Guard Tours. 

1. From the File menu, select Print Setup to display the Setup Global Printers 

dialog. 

2. Choose the Site Plan Printer tab. If you wish to nominate another Plan printer 

as the default, choose the Select Printer button to open the Print Setup dialog. 

3. Make the necessary changes to the printer settings. For further information 

concerning the setup options, refer to the printer manuals. 

4. Choose the OK button to return to the Setup Global Printers dialog. 
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3.4.4 Report Printing 

Report printing is a vital aspect of the SiPass integrated access control system. It 

can assume one of three general types: 

● Audit Trail Reports 

● Database Reports 

● Log Book Reports 

Although their content is different, these reports essentially are created and 

configured the same way. Therefore, a single printer can be used for all three types 

of reports, subject to site-specific considerations such as network traffic, and the 

volume and frequency of reports that are required. Virtually all reports are printed 

as standard A4 size documents. This means that the installation of printers and the 

printer drivers are generally straightforward tasks, since most A4 printers now 

install under the “Plug and Play” scenario. 

3.4.4.1 Configuring a Report Printer 

 If you are connecting directly to a SiPass client, ensure that you have installed 

the appropriate printer driver. 

1. From the File menu, select Print Setup to show the Setup Global Printers 

dialog. 

2. Select the Reports Printer tab. 

3. If you wish to nominate another Reports printer as the default, choose Select 

Printer button to open the Print Setup dialog. 

4. Make the necessary changes to the printer settings. For further information, 

refer to the documentation that came with your printer. 

5. Choose the OK button to return to the Setup Global Printers dialog. 
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3.4.5 FARGO HDP8500 Printer 

SiPass integrated supports the FARGO® HDP8500 Industrial Card Printer/Encoder 

to provide you a robust, heavy duty performance in demanding environments. The 

printer is available for selection in the Printer Type dropdown list on the Setup 
Global Printers dialog in SiPass integrated Configuration client. 

The printer has two modes of operation: 

1. Local Connection (USB) 

2. Network Connection (Ethernet) 

Depending on the selected operation mode, different set of drivers and different 

configuration settings are required. If the printer was initially setup for Local 

Connection (USB) mode and afterwards, is desired to be used in Network 

Connection (Ethernet) mode, the same settings will not work. There will be re-

configuration required or in some cases, re-installation of all the drivers. 

Note: The required drivers are provided in the SiPass integrated software bundle in 

the Drivers\FARGO HDP 8500 Printer Driver folder. 

3.4.5.1 Supported Features 

● Printing and encoding of DESFire EV1 Smart Cards. 

● Network based printing for FARGO HDP8500 Printer. 

● Network based encoding using HID OMNIKEY 5121 Embedded Encoder 
installed in FARGO HDP8500 Printer. 

● Batch card encoding and printing. 

● Performance improvement in batch card encoding and printing (only when 

FARGO HDP8500 Printer is in use). 

● Printing and Encoding of Mifare Classic Cards (1K and 2K). 

3.4.5.2 Pre-requisites for Encoding Over Network 

For Network Connection (Ethernet) connection type, the embedded encoder within 

the printer and the driver for the encoder should have Ethernet capability (network 

communication). 

 

 

Currently, the only available OMNIKEY embedded encoder that supports Ethernet 

capability is OMNIKEY 5121 Embedded Encoder. 

 

3.4.5.3 FARGO HDP8500 Printer and Encoder Drivers 

FARGO HDP8500 Printer Driver 
 

Name HID Fargo HDP8500 Windows Driver 

File Name hdp8500_windows_driver_v1.4.0.4.7_setup.zip 
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HID OMNIKEY 5121 Embedded Encoder Drivers 

USB Mode 
 

Name HIDOMNIKEY 5121 and 5125 Driver 

File Name (32-bit) hid_omnikey5x2x_x86_w7_r1_2_18_0.exe 

File Name (64-bit) hid_omnikey5x2x_x64_w7_r1_2_18_0.exe 

 

 

Network Mode 
 

Name OMNIKEY 5121 Ethernet Encoder Driver 

File Name omnikey_5121_ethernet_encoder_driver_2.0.0.1.zip 

 

 

The printer must have the latest firmware version (1.6.2 or later). 

3.4.5.4 Local Connection (USB) Setup 

In this configuration, the printer is connected to the workstation through the USB 

cable. To install and configure the drivers for printer and embedded encoder, follow 

the steps below: 

Driver Installation & Configuration for Printer 

For FARGO HDP8500 printer to work with SiPass integrated, the latest printer 

driver must be installed. Currently, the latest available driver is: 
 

Name HID Fargo HDP8500 Windows Driver 

File Name hdp8500_windows_driver_v1.4.0.4.7_setup.zip 

 

 

● Run the setup file located in the archive file 

● During installation, select the Local Connection (USB) for type of connection for 

the printer. 

Driver Installation & Configuration for OMNIKEY 5121 

Embedded Encoder 

For the embedded encoder to work with SiPass integrated, the latest encoder 

driver must be installed. Currently, the latest available driver is: 
 

Name HIDOMNIKEY X-Chip Windows BU & RU Driver 

V.1.2.29.156 (X64 And X86) 

File Name hid_global_xchip_driver_1.2.29.156.zip 
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3.4.5.5 Network Connection (Ethernet mode) Setup 

Driver Installation & Configuration for Printer 

For FARGO HDP8500 printer to work with SiPass integrated in Network 
Connection (Ethernet) mode, the latest printer must be installed. Currently, the 

latest available driver is: 
 

Name HID Fargo HDP8500 Windows Driver 

File Name hdp8500_windows_driver_v1.4.0.4.7_setup.zip 

 

 

During driver installation, select Network Connection (Ethernet) for the type of 

connection for the printer. 

Note: The following outbound ports shall not be blocked by anti-virus or firewall: 

● 5400 (for transmitting printer data) 

● 5402 (for transmitting printer's commands) 

 

 

If the printer driver was previously installed for Local Connection (USB) 
connection type, it will not work for Network Connection (Ethernet) type. To setup 

the Network Connection (Ethernet) type, see section Switching between Local 

Connection (USB mode) Type and Network Connection (Ethernet mode) Type 

[➙ 33] 

Driver Installation & Configuration for OMNIKEY 5121 

Embedded Encoder 

For the OMNIKEY 5121 embedded encoder to work on a network, a specific driver 

must be installed that enables the network communication capability for OMNIKEY 

5121 Embedded Encoder: 
 

Name OMNIKEY 5121 Ethernet Encoder Driver - 2.0.0.1 

 

The driver package is available in the SiPass integrated Software bundle and 

includes the OMNIKEY 5121 Ethernet Encoder User Guide document which 

describes the process of installation and configuration of the OMNIKEY 5121 

Ethernet Encoder driver. 

 

 

The OMNIKEY 5121 Ethernet Encoder driver establishes connection on port 

22222. This outbound port should not be blocked by anti-virus software or firewall. 
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3.4.5.6 Switching between Local Connection (USB mode) Type 

and Network Connection (Ethernet mode) Type 

The FARGO HDP8500 printer does not support mix mode configuration. This 

means that: 

● The Local Connection (USB mode) type and Network Connection (Ethernet 
mode) type cannot be configured simultaneously on a single workstation. 

● Only one configuration will work on a given workstation at a time. 

Switching from Local Connection (USB mode) type to 

Network Connection (Ethernet mode) type 

To switch configuration from Local Connection (USB mode) type to Network 
Connection (Ethernet mode) type on a workstation, the steps below must be 

followed: 

Printer Driver Installation 

● Uninstall the previously installed printer driver (HID Fargo HDP8500 Windows 

Driver) configured for Local Connection (USB mode) 

● Re-install the driver using the instructions in section Driver Installation & 

Configuration for Printer [➙ 33] 

Encoder Driver Installation 

Install and configure the OMNIKEY 5121 Ethernet Encoder Driver as explained in 

section Driver Installation & Configuration for OMNIKEY 5121 Embedded Encoder 

[➙ 33]. 

 

 

The Ethernet encoder supports only one session at a time. If multiple 

workstations are configured in Network Connection (Ethernet mode) to 

communicate with the same printer, only one workstation will have a live session 

at a given time. Some synchronization will be required between workstations to 

use the encoder without any interruption. 

 

3.4.5.7 Switching from Network Connection (Ethernet mode) Type 

to Local Connection (USB mode) Type 

Printer Driver Installation 

● Uninstall the previously installed printer driver configured for Network 
Connection (Ethernet mode) 

● Re-install the driver using the instructions in section Driver Installation & 

Configuration for Printer [➙ 32]. 

_Ref673A564C73E316CEFF8D98F2D37A7BA0
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Encoder Driver Installation 

1. Ensure that the driver mentioned in section Driver Installation & Configuration 

for OMNIKEY 5121 Embedded Encoder [➙ 32] is installed. 

2. Restart the printer manually, or from Web-browser interface (the Web-browser 

interface can be accessed by entering the IP address of the printer in the 

browser URL field). 

3. After the printer restarts, connect it to the workstation through USB (if not 

already connected). 

 The Windows Device Manager console will display OMNIKEY 5x21 under 

the Smart Card Readers section. 

Points to Note: 

● Ensure that any remote workstation configured for Network Connection 
(Ethernet mode) does not attempt to establish connection with the printer. If 

this happens, it will disrupt the encoder settings for that workstation on which 

Local Connection (USB mode) is configured. 

– To fix such disrupted encoder settings, ensure that no remote workstation 

configured for Network Connection (Ethernet mode) is communicating with 

the printer. 

– Restart the printer. 

 The Windows Device Manager console will display the OMNIKEY 5x21 

under the Smart Card Readers section. 

● If local workstation is configured for Local Connection (USB mode) and a 

remote workstation is configured for Network Connection (Ethernet mode) for 

the same printer, the embedded encoder will work only for the remote 

workstation (as the LAN based encoder takes precedence). 

 The embedded encoder on local workstation with Local Connection (USB 
mode) will no longer function and no such encoder will be shown in the 

Windows Device Manager console under Smart Card Readers section. 

3.4.5.8 Limitations  

Limited support for Windows 10 

The Windows 10 platform is not certified by HID Global for the OMNIKEY Ethernet 

encoder driver. Presently, only Windows 10 Enterprise has had some success in 

working with the printer (however, this can not be fully assured). 

All Microsoft Windows versions before Windows 10 are supported (till Windows 

XP) by OMNIKEY for their Ethernet encoder driver. 

Windows Remote Desktop Does Not Allow Encoder 

Access 

Using Windows Remote Desktop session to access the embedded encoder does 

not work. This is true for both configurations - the target workstation configured for 

Local Connection (USB mode) type or Network Connection (Ethernet mode) type. 

3.4.5.9 Troubleshooting 

For troubleshooting Fargo HDP8500 Printer/Encoder issues, see section 

Troubleshooting Fargo HDP 8500 Printer & Embedded Encoder in SiPass 

integrated Installation Guide (version MP 2.76 onwards). 

_RefCA5D15342FDBF2847EC40C0CFC7A4E5C
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3.5 Client Configuration 

A client provides the GUI (Graphical User Interface) that is used by the SiPass 

integrated operator to administer and monitor your access control and security 

system. Only one client of each type can be installed on any single computer in 

your system. 

After the SiPass server is installed, the SiPass integrated Configuration Client on 

the Server computer is used to generate a self-signed certificate that will be 

provided to the client computer during installation. Since this certificate is 

generated (and hence, signed) by the Certification Authority (CA) of the server 

computer, installing this self-signed certificate on the remote client computer 

authenticates it as the genuine client of the respective server computer. 

This section gives you information about configuring the remote client through 

SiPass integrated Configuration Client. See the SiPass integrated Installation 
Manual gives you complete instructions for installing SiPass integrated clients. 

3.5.1 Steps 
 Prerequisite: To generate Client certificates through the SiPass integrated 

Configuration Client, the client must be run locally (on server site) with the 
SiPass integrated server. 

 For this operation the Configuration Client must be run in Administrator mode. 

1. Right-click on the SiPass integrated Configuration Client icon on the computer 
where SiPass server is installed and select Run as Administrator. 

2. From the System menu, click Client Configuration … 

 The Client Configuration - New dialog is displayed. 

3. Type the name of the computer (where SiPass integrated client will be 
installed) in the Full computer name field. 

 Note: If the Remote Client computer is connected to SiPass server 
computer through a VPN connection, tick the Only check thumbprint for 
authentication checkbox. 

4. Click the Generate Self-Signed Certificate… button (which is enabled when the 
Self-signed certificate has been generated for SiPass integrated during server 
installation). 

5. When the Windows browsing dialog is displayed, select an empty folder or 
create a new one on the local hard drive to store the self-signed certificate 
generated for the client. These files will be required during the SiPass 
integrated installation on the client computer. 

 Note: This folder must be accessible from the remote client computer. You 
can manually copy this folder to the client computer or save it to a shared 
network drive or remotely access the server computer from the client 
computer. After using the certificate, remember to delete this folder 
permanently to ensure security of information. 

 Once you specify the location to store the certificate, a message is 
displayed confirming that the certificate has been generated successfully. 

6. Click OK to close the message. 

 The Certificate Thumbprint field on the Client Configuration - New dialog is 
now populated. 

 Note: If a client’s certificate is generated, the server thumbprint is also 
included. In case you wish to save only the server thumbprint without 
generating the self-signed certificate, click the Save Server thumbprint… 
button and specify an empty folder to save the thumbprint file. 

7. Click Save. 

 The Client Computer is listed on left hand side of the Client Configuration - 
New dialog. To delete an existing Client Configuration, select it from the left 
pane of the dialog and click Delete. 

8. Click Close to close the Client Configuration - New dialog. 

 



 

 

Introduction and Starting Up 

Certificate Expiry and Renewal 
3 

A6V101068156  37 | 313 

 

3.6 Certificate Expiry and Renewal 

Every certificate has a validity period after which, it expires and must be renewed. 

This is to ensure that existing certificate information gets replaced with new one 

after regular intervals and security is maintained at all times. 

Using the SiPass Authentication Management tool, you can renew a certificate on 

SiPass Server and Local Clients installed on a single computer, or on any SiPass 

integrated Remote Clients installed on separate computers. 

 

 

SiPass integrated Server / Client starts giving you warning messages 30 days 

prior to the certificate’s expiry date. You can close the message and log on to the 

system but you will keep getting reminders about renewing the certificate. 

If you do not renew the certificate in 30 days, you will not be able to log on to 

SiPass integrated after the certificate has expired. You MUST renew the 

certificate in this case. 

If the certificate of the Server for a Remote Client has expired, starting up the 

client will give you an error message about Server not being available. In this 

case, the Server Certificate must be renewed to work with this remote Client. 

 

3.6.1 Renewing the Certificate on SiPass Server 

1. Go to the SiPass integrated installation folder on the computer. 

2. Right-click the SiPass.CertificatePicker.exe file and select the Run as 

Administrator option from the menu. 

 The Authentication Management dialog is displayed. 

3. Click Next. 

 A message is displayed informing you that the SiPass integrated service 

will be stopped before making any changes. 

4. Click OK and wait for the service to close. 

5. To generate and install a self-signed certificate, tick the Generate Self-Signed 

Certificate checkbox. 

 OR 

6. Select your own certificate from the available certificate list on the screen. 

 Note: If you select a certificate having expiry date in the next seven days, a 

warning message is displayed. Click OK to close the message and select 

another certificate. 

7. Click Finish. 

 A message is displayed asking if you wish to copy Windows Account 

Permissions from the previous certificate to the new certificate. 

8. Click Yes if you want to import the permissions else click No and set the 

permissions yourself later. 

 Now a message asks you if you wish to remove the existing (expired) 

certificate from the system. 

9. Click Yes to remove it or No to keep it on the system. 

 The new certificate is generated and applied to the SiPass server and any 

local clients. A message is displayed confirming that the certificate has 

been successfully applied. 
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If you have performed this operation on a computer that has SiPass Server 

installed, the message will also mention that the certificate configuration on 

Remote Clients should also be updated. 

Follow the steps given in the next section to update the Remote Client certificate 

information. 

10. Click OK to close the message. 

 Another message will ask you if you wish to restart the SiPass Service on 

this computer. 

11. Click OK to restart the SiPass service or No to close the message without 

restarting the service. 

3.6.1.1 Generating New Certificates for Remote Client 

Each Remote Client has its unique thumbprint. After renewing the certificate of the 

SiPass server, the thumbprint must also be updated in each Remote Client to 

authenticate the server again. 

Follow the steps below to generate new certificates for the SiPass Remote Clients. 

1. Right-click on the SiPass integrated Configuration Client icon on the computer 

where SiPass server is installed and select Run as Administrator. 

2. From the System menu, click Client Configuration … 

 The Client Configuration - New dialog is displayed. The existing Remote 

Clients for this SiPass server will be listed on the left pane on the dialog. 

3. Click the Generate All Self-Signed Certificates… button. 

 A message appears informing you that this step will generate self-signed 

certificates for all client records in the system, and update the thumbprint 

entries. It also asks if you wish to proceed with this step. 

4. Make a choice as desired: 

 If you click Yes, no further steps are required. 

– Proceed to Step 5. 

 If you do not want to generate certificates for all clients at once and click 

No. In this case: 

– Select the Remote Client name from the left pane on the dialog. The Full 

computer name and Certificate Thumbprint fields will be populated with the 

information for that computer. 

– Click the Generate Self-Signed Certificate button. 

– Proceed to step 5. 

5. When prompted, select a destination folder for saving the new client 

certificates. Sub-folders will be created inside this folder based on the client 

computer name. The functionality makes it easier to generate all client 

certificates in one go after expiry when server certificate is renewed. 

 A message informs you that the certificate generation process has 

completed. 

6. Click OK. 

 The new client certificates will be available in the respective sub-folders 

inside the main folder you specified earlier. Now you can copy these 

certificates to individual client computers and authenticate. See section 

Renewing the Certificate on SiPass Remote Client [➙ 39]. 

7. Click Close to close the Client Configuration – New dialog. 
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3.6.2 Renewing the Certificate on SiPass Remote Client 

Each Remote Client has its unique thumbprint. After updating the Certificate 

information for SiPass Server, you must now update this in the existing remote 

Client Computer also to ensure both remain mutually-authenticated. 

1. Go to the SiPass integrated installation folder on the Remote Client computer. 

2. Right-click the SiPass.CertificatePicker.exe file select the Run as Administrator 

option from the menu. 

 The Authentication Management dialog is displayed. 

3. Click Next. 

4. Click the folder icon next to the Import Client & Server Certificate From field. 

5. Locate the folder created for saving the new certificates in the Generating New 

Certificates for Remote Client [➙ 38] section. Select the sub-folder inside this 

that has the name of the Remote Client computer for which, you are currently 

renewing the certificate. 

6. The Import Client & Server Certificate From field will be populated with the 

location of this folder. 

7. Click Finish. 

 A message is displayed asking if you wish to copy Windows Account 

Permissions from the previous certificate to the new certificate. 

8. Click Yes if you want to import the permissions else click No and set the 

permissions yourself later. 

 Now a message asks you if you wish to remove the existing (expired) 

certificate from the system. 

9. Click Yes to remove it or No to keep it on the system. 

 The new certificate is generated and applied to the remote client. A 

message is displayed confirming that the certificate has been successfully 

applied. 

 It also informs that this Remote Client must be authenticated again in the 

SiPass system by updating the certificate configuration on SiPass 

integrated server computer through the Configuration client. The thumbprint 

of the new certificate of the Remote Client computer is also given in the 

message box which can be copied for authenticating in the server 

depending on the scenarios as below: 

 Scenario 1: If you updated the certificate configuration in SiPass Server 

first and then authenticated the client, you do not need to perform any 

additional step. 

– Click OK to close the message. 

 Scenario 2:If you updated the certificate configuration in the Remote Client 

computer first, the thumbprint for this client must also be updated in the 

server to authenticate the client again as genuine client for that server. Go 

to section Updating Remote Client Certificate Thumbprint in SiPass Server 

[➙ 39] for the next steps. 

– Copy the Certificate Thumbprint for the Remote Client and save it locally. 

– Click OK to close the message. 

  

_Ref87987B3D185B344A572FF9D1880D745B
_RefBD86E36BFE281F80FA6DA227F3C0907B


 

 

Introduction and Starting Up 

Certificate Expiry and Renewal 
3 

40 | 313  A6V101068156 

 

3.6.2.1 Updating Remote Client Certificate Thumbprint in  

SiPass Server 

On the SiPass server computer: 

1. Run the SiPass integrated Configuration Client. 

2. From the System menu, click Client Configuration … 

3. The Client Configuration - New dialog is displayed. 

4. Select the name of the computer (where SiPass integrated client is installed 

and for which, you are currently updating the certificate configuration) from the 

list of Remote Clients in the left hand pane of the dialog. 

5. The Full Computer Name field is populated. 

 Note: If the Remote Client computer is connected to SiPass server 

computer through a VPN connection, tick the Only check thumbprint for 

authentication checkbox. 

6. Paste the thumbprint of the remote client computer (saved locally in the 

previous section) in the Certificate Thumbprint field. 

7. Click Save. 

 The Remote Client certificate information is updated. 

 You can also delete an existing Client Configuration and add the Remote 

Client with the new certificate information as a new client.
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4 System Components 
The SiPass integrated system monitors and reports vital information regarding 

events that occur at your site. Before SiPass integrated can do this, the system 

must be programmed with details about the layout and the hardware structure of 

the site. 

The components that you will create when commissioning your site will depend on 

the type of installation you have. 

A brief overview of the SiPass ACC Series components is in the following table: 
 

Component Description 

Server The Server is the foundation to which all other components connect. 

Ethernet Comms This is the communications channel that the Server uses to communicate with an ACC 
Controller. Communication by Ethernet eliminates the need to install an access bus at 
installation time. 

ACC Controller The SiPass Central Controller sends and receives messages to and from the Server and the 
hardware devices that monitor your system. 

FLN Connection Each hardware device in the SiPass integrated system communicates with an ACC by a Field 
Level Network connection. 

Devices A device is a hardware component that controls the physical operation of the SiPass 
integrated system. It may, for example, control access to lifts, elevators, and fire exits, or it 
may be a component for controlling intrusion detection devices. 

Points Points belong to devices. They make up the basic hardware components of the system and 
can be anything from locks and infra-red sensors to card readers and floors. 

Groups Groups are collections of points. They allow the control of many points that share some 
commonality, as if they were a single entity. The points in a group do not necessarily need to 
be in the same part of a building. Groups are especially useful for controlling cardholder 
access. 

 

4.1 The Behavior of Components Offline 

When communications between ACC units and the SiPass Server are disabled, 

several factors have to be taken into account. It is important that database changes 

be stored while offline and downloaded quickly to controllers when communications 

are restored, but it is equally important that commands to components like doors 

and input points are NOT executed at online time. 

For example, in a high-security facility, a set of commands to open doors is sent 

while ACCs are offline. Two hours later when communications are restored, the 

delayed open door command is executed, probably at a time that is extremely 

inappropriate. To prevent this, any manual command, Event Task Effect or site 

plan command sent to an offline ACC unit will result in a “Command Failed” 

message immediately being sent to the Audit Trail. This message will be received 

for each point involved; for example, if a disable command is sent to an offline 

point group, a Command Failed message will be received for each point in the 

group. 

If a command is sent to both offline and online ACCs, devices or points, the 

commands to the online components will be executed and a Fail message will be 

received for each offline point. For example, a point group may contain points 

connected to different ACC units. 

This scenario applies to Host-based commands only. Controller Event Task 

messages between ACCs are not buffered, so peer-to-peer commands, sent when 

inter-ACC communications are disabled, will simply fail when no reply is received. 



 

 

System Components 

Server Properties 
4 

42 | 313  A6V101068156 

 

4.2 Server Properties 

The Server is the main component in your system. All the components used in the 

SiPass integrated system are ultimately connected to the Server. Each SiPass 

integrated system can only have one Server, but may have many Clients 

(depending upon the license agreement). 

 

 

By default, the Server name will be the same as the name of the computer on 

which the Server software has been installed. 

To change the Server Name: 

1. Choose Components from the System toolbar or menu. 

2. Select the Server. 

3. Change the name of the Server, by typing a new name into the Server Name 

field. 

4. For SiPass integrated to operate correctly, the Server name must match the 

name of the PC on which the server has been installed. 

5. Click Save. 

4.3 Ethernet Communications 

The Ethernet Communications channel connects the Server to the advanced 

Central Controller (ACC), and allows communication between the Server and 

defined devices and points. 

Communication by Ethernet means that a dedicated Bus does not have to be 

installed, because both Windows and the ACC understand TCP/IP. TCP/IP is a 

protocol used to send and receive messages over Ethernet networks. 

The number of ACCs that can be connected to a single Ethernet Comms channel 

is limited only by: 

● The number of IP addresses available on the local network on which the ACCs 

are located 

● The connection speed. 

In the SiPass integrated component hierarchy, the Ethernet Comms is a “child” 

item of the Server, and is automatically assigned the name “ACC Controllers”. This 

name cannot be changed. 
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4.3.1 Setting the Ethernet Communications 

Setting the Ethernet communications channel involves allocating a maximum 

number of cards per ACC and deciding whether a PIN code is required at access 

points connected to this channel. 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Underneath the Server you will see the Ethernet communications channel, 

called “ACC Controllers”. Select this. 

4. Set the default port number. The default Port No. is 4343. This value may be 

changed if required; for example, if the port number is already being used by 

another application. 

 

 

If the Port No. is changed, you will need to update the Port No. for every ACC 

connected to this Ethernet Comms, using the ACC configuration software. 

A TCP port number is a part of a TCP/IP connection and should only be assigned 

or addressed by an experienced IT administrator. Two additional read-only fields 

also appear and supply information selected during the SiPass integrated 

installation 

Facility Code: The default facility code for access cards at this site 

Card Technology: The default type of card used for access 

5. The PIN Code Required and PIN Code digits fields are read only fields. 

6. Specify the ACC Alive Poll Time (s) that the server will wait between 

successively polling the ACC to check it is online. Default is 10s. 

7. Specify the ACC Response Time (s) that the server will wait to receive a 

response from the ACC before triggering a ‘No Response’ event, declaring the 

ACC to be offline. The default time is 30 seconds. 

8. Specify the Bus Delay to send Time (ms) that can be used to control the rate at 

which SiPass and the ACC communicate – in low bandwidth or high traffic 

networks it may be useful to increase this value to reduce the network 

utilization of the ACC controllers. Sefault is 20 ms. 

9. Configure the Disable Daylight Saving on all units checkbox, as required. The 

operator can change the state of the box to either the ticked, or unticked state 

only. A highlighted / filled checkbox is only a display state of the ACC units 

under that particular controller. 

– A ticked checkbox implies that all ACC units under this controller have 

disabled Daylight Savings. 

– An unchecked box implies that all the ACC units under this controller have 

enabled Daylight Savings. 

– The Disable Daylight Saving checkbox is a convenience function to change 

ALL the controllers. Note that it is still possible to change the Daylight 

Saving setting for individual ACCs on their respective dialogs. 

10. Click Save. 
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4.4 Searching for Components 

With SiPass integrated MP2.80 onward, you can search for system components 

that have already been added to the system. Depending on the Search keyword, 

the results can list one or all the components with the keyword in their name, or 

type. 

The search can be performed from the Components dialog and lets you directly 

look up for specific components or devices. It is especially helpful when a fresh 

system is being set-up and requires frequent access to different components to 

modify their configuration, or add more sub-devices. It is also easier to navigate to 

a specific component in existing systems set-up earlier. 

4.4.1 Steps 

1. Click System > Components… from the top menu. 

 The Components dialog is displayed. 

2. In the Component Definition field, type an applicable keyword to uniquely 

identify the component. 

3. Click the Search button. 

 All the components matching the Search keyword are listed in the 

Components tab in the left-hand pane of the dialog. 

 To see the Points for those listed components, click the Points tab. 

4. Click on the component or point that you wish to access directly. 

 The configuration details are displayed on the right-hand side of the 

Components dialog. 

5. If required, make any changes to the configuration as per the normal process. 

6. When done, click the Save button. 

7. Click Close. 

 The Components dialog is closed. 

 

 

Note: The Component Definition field retains the search keyword till the Clear 

button is clicked, or the Components dialog is closed. 
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4.5 Adding an ACC 

The Advanced Central Controller manages communication between devices and 

points in your system and the Server. Adding an ACC involves assigning it a name 

and Time Zone and entering the unit Serial Number. 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Select the ACC Controllers communications channel. 

4. Click the New Unit button. 

 A new controller will appear connected to the comms channel and a new 

tab will be available. 

5. Enter the name of the ACC unit into the Unit Name field. This name must 

exactly match the name used when configuring your ACC. 

6. Select the correct time zone for your ACC’s region from the Time Zone drop-

down box. 

7. Select the alarm definition that will apply to this ACC from the Alarm Definition 

drop-down box. 

8. Select the type of unit being connected from the Unit Type drop-down box. The 

types of units listed in this drop down box are as follows: 

– ACC 

– ACC-Lite 

– ACC-4 

– ACC-8 

– ACC-16 

– ACC-32 

– ACC G2 

– ACC-GRANTA 

– ACC-AP 

9. Select a Backup mode for ACC database. 

– None: No backup mode applied. To ensure database Integrity after power 

loss, an event task must be configured to auto initialize the ACC for 

operation. 

– On-Board Flash: The ACC database will be backed up locally using the on-

board flash. 

10. Enter the serial number of the ACC into the Serial Number field. 

 The serial number will have been issued with the ACC unit (should be 

printed on the sticker on the ACC). The Unit No. will be automatically 

assigned. 

11. Enter a desired description for the ACC into the Description field. 
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An operator can enter an alternate name or number for the device, to the internal 

name that is already provided for the device. i.e., while the internal name of this 

device is an ACC, an operator can enter a number or name that helps operators 

or maintenance personnel identify the device in their site. 

This description will be preserved during backup and restore of the system. 

Further, this description field can be used as a filter field while generating reports 

in SiPass integrated. This assists operators search for reports using this field as a 

filter. 

Once configured and saved, this field can be still be modified. Audit Trails and 

Reports will reflect changes to Device Descriptions appropriately. 

12. Choose the appropriate operation checkbox options, as described in the 

section ACC Configuration Options [➙ 46]. 

13. Click Save. 

The new ACC is listed on the left side under ACC Controllers. 
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4.5.1 ACC configuration Options 

The options available are explained in the table below. 
 

Option Description 

Disable Communications Tick this checkbox to disable all communications between the ACC and the Server. The ACC 
will effectively be offline. 

Disable Telnet Tick this checkbox to disable the ability to connect a telnet session with the ACC. If you have 
already done this via the ACC, the checkbox must still be ticked to ensure that the ACC 
continues to ignore telnet requests. 

Disable Power Monitoring Tick this checkbox to disable reporting of power failures at the ACC. 

Disable Tamper Tick this checkbox to disable reporting of any wire tampering detected on supervised wires. 
This tab also contains read-only fields in the Statistics section: 

Disable Daylight Saving 
Time 

Tick this checkbox to disable the Daylight Saving Time feature for this ACC unit only. 

Disable SSH Tick this checkbox to disable the SSH protocol. 

Peer Network Mode Depends on the speed of the network. If there is a dedicated network for SiPass integrated, it 
can be set to Fast. If there is a lot of network traffic, it must be set to Medium or Slow. 

Three Wrong Pins When 3-wrong PIN feature is enabled on the given readers, the settings below determine the 
result on entering wrong PIN three times: 

● Global: Any 3-wrong PINs in a row on any controller in the system will cause cardholder to be void on 

all controllers in the system. 

● Local: Any 3-wrong PIN’s on a single controller will cause the cardholder to be void on that controller 

only. 

● Void Card Only: Any 3-wrong PIN’s on a single controller will cause the cardholder to be void on all 

controllers in the system. 

IP Address The IP address of the ACC Controller. 

FW Version The current version of the firmware loaded onto the ACC. 

Status Status of the comms channel between the ACC and the Server. 

Unit Model Indicates the type of ACC used. 

OS Version Indicates the firmware platform version. 

Persistent memory Usage Database memory usage. 

RAM Usage Runtime memory usage 

Refresh This button will update the data in the Statistics section. 
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4.5.2 ACC-Granta  

ACC-Granta is the new hardware that is being used along with SiPass integrated. 

The following rules apply if the user wants to change the hardware from ACC-

Granta to any other type of units: 

1. ACC-Granta can be converted to ACC-Unit only if FLN 4 is not configured. 

2. ACC-Granta can be converted to ACC-lite only if FLN 1 is configured with the 

type Access or Entro and FLN count is 1. 

3. ACC-Granta can be converted to ACC-4/8/16/32 only if FLN-1 is configured 

with the type Entro and FLN count is 1. 

 

 

Other unit types cannot be converted to ACC Granta. 

Modem Port Configuration 

A modem can be configured on an ACC-Granta unit by selecting the Enable 

Communication Redundancy in the Dialup/PPP tab of the Components dialog box. 

 

A modem can be configured only on FLN 1 on an ACC-Granta unit. If FLN1 is in 

use then a modem cannot be configured on the ACC-Granta unit. Also if the 

modem is configured on FLN1 then, FLN1 cannot be used for any other purpose. 

 

4.5.3 ACC-AP 

With SiPass integrated MP 2.75 onwards, you get the support for IP-based AP 

door controller that offers the latest technology, better cost-effectiveness, and easy 

installation. 

It supports: 

● 2 OSDP Readers: Controller for one or 2 doors (depending on configuration) 

● 4 Monitored or Unmonitored Inputs 

● 2 Relay Outputs 

● 4 Open-collector Outputs 

● 1 general-purpose FLN bus to connect to IPM, OPM, 8IO devices and Aperio® 

AH30 

● Capacity for 500,000 cards 

● Maximum 5 cards per user 

● Large offline event buffer with up to 200,000 events 

● Anti-passback 

● Linux O/S 

Note: Only Input/Output devices and IAT are supported on the FLN Bus. No RIM 

device support available. 

The onboard Dual Reader Interface (DRIe) on the ACC-AP can be programmed to 

function as any one of the door sets (Dual Reader, Two Single Readers, Dual 

Reader Turnstile Contact, Single Reader Turnstile Contact) at one time. 

The controller can be configured like an ACC through the Components dialog in 

SiPass integrated Configuration Client. Once the ACC-AP is created, it is listed on 

the left side of the Components dialog under the ACC Controllers Communication 

Channel. 
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4.6 FLN Connections 

Devices are connected to an ACC by a Field Level Network connection, or FLN. 

The type of ACC device used determines the number of supported FLNs. 

4.6.1 Adding an FLN Connection 

Adding an FLN connection involves assigning it a name and number, and setting 

the baud rate. 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Select the ACC Controllers communications channel. 

4. Select the ACC to which you want to configure an FLN connection. 

5. Click the New FLN button. 

6. Enter a name for the FLN into the Name field. 

7. Select the number of the FLN Connection from the Number drop-down box. 

– If ACC-AP is the type of ACC used, FLN1-2 are available for selection. FLN 

1 is reserved for the onboard Dual Reader Interface (DRIe), and FLN 2 is 

used for other devices. 

– If ACC G1 or ACC G2 is the type of ACC used, then FLN 1 to 6 are 

available for selection. 

– If ACC-Granta is the type of ACC used, then FLN 1 to 4 are available for 

selection. 
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8. Select the kind of FLN you wish to add from the Type drop down box: 
 

If ACC-G1 or ACC-G2 is the selected ACC Type 

ACC FLN Bus Select this to connect to Input/Output (I/O) Point devices and 
RIM Devices. 

Entro FLN Bus Select this bus to add SiPass Entro device. 

OSDP FLN Bus Select this bus to add an OSDP on FLN Device. 

If ACC Granta is the selected ACC Type 

ACC FLN Bus Select this to connect to Input/Output (I/O) Point devices and 
RIM Devices. 

Entro FLN Bus Select this bus to add SiPass Entro device. 

Granta FLN Bus Select this bus to add an ACC Granta device. A Granta FLN 
bus can be used only with FLN 4. 

If ACC-AP is the selected ACC Type 

ACC FLN Bus Select this to connect to Input/Output (I/O) Point devices (RIM 
Devices cannot be connected in case of ACC-AP). 

AP Onboard FLN Bus Used for the onboard Dual Reader Interface (DRIe), that can 
be programmed to connect to any one of the door sets (Dual 
Reader, Two Single Readers, Dual Reader Turnstile Contact, 
Single Reader Turnstile Contact) at one time. 

Aperio FLN Bus Select this option to create an Aperio Hub on the FLN. The 
hub can be created as a new device after saving this FLN bus. 

If ACC-Lite/ACC-4/ACC-8/ACC-16/ACC-32 is the selected ACC Type 

ACC FLN Bus Select this to connect to Input/Output (I/O) Point devices and 
RIM Devices. 

Entro FLN Bus Select this bus to add SiPass Entro device. 

 

 

◈ Click Save. 
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4.7 Devices 

A device is a component that processes and transfers data between points and the 

SiPass integrated server. Each device is capable of storing information in its own 

memory. You can also set default settings for a device, so that when a new device 

is created it will automatically be configured to the default settings. 

4.7.1 OSDP Reader Devices 

With SiPass integrated MP2.76 onward, you get the support for connecting OSDP 

Reader Devices directly to controller FLN (for ACC-G1 and ACC-G2 only). An 

OSDP FLN Bus can be created through the Components dialog and programmed 

using the FLN Configuration tool in SiPass integrated Configuration Client. The 

communication between an OSDP Reader Devices and the controller can be 

encrypted for enhanced security. 

 

A mix of FLN devices like DRI / ERI / IPM / OPM and OSDP reader at one bus 

cannot be configured. 

4.7.1.1 Brief Overview 

Step by step instructions on setting up OSDP on FLN Bus are given in the coming 

sections at relevant places. However, a brief overview of the functionality is given 

below: 

● Select the OSDP FLN Bus type while creating FLN for ACC-G1 or ACC-G2. 

● Create an OSDP Device for the OSDP FLN Bus. 

 

The OSDP Reader can be logically linked/unlinked to any existing ERI, DRI or 

SRI (on the same ACC unit) to act as a Replacement Reader in case when 

encrypted reader communications are required.. 

See section Linking/Unlinking to an OSDP Reader Device [➙ 62] for more 

information. 

– An OSDP Access point is automatically created which can be linked to a 

Access Point of ERI, DRI or SRI (as Replacement Reader). If the OSDP 

Access Point is linked to an Access Point of ERI, DRI or SRI, the name of 

the linked access point is also displayed. 

– OSDP Reader Device cannot be deleted if the OSDP Reader point is 

assigned to an intrusion area, elevator or another Access Point. 

● Discover the OSDP Reader Device through the FLN Configuration dialog in the 

same way as other FLN devices are searched. 

Notes: 

● All Configuration options are available for OSDP Reader Device (including 

Reader Technology selection, Reader LED configuration, Reader Tamper 

Reset and Smart Card Configuration). A Soft Reset can also be performed on 

the device. 

● Reader configuration upload and download can also be performed on the 

OSDP Reader Device through the Reader Firmware & Config dialog. 

● Any FLN Group Partition also apply to the OSDP FLN Bus. 

● The Access Point Alarm Class can be assigned to the OSDP Access Point. 
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4.7.2 Wiegand Reader on ACC-AP 

With SiPass integrated MP2.76 SP1 onwards, the ACC-AP can be used to 

configure Wiegand Readers. While creating the onboard DRIe device, you can 

select the Wiegand Door Set option and configure further through the FLN 
Configuration dialog. 

4.7.2.1 Brief Overview 

Step by step instructions on creating a DRIe in Wiegand Reader mode are given in 

the coming sections at relevant places. However, a brief overview of the 

functionality is given below: 

● After saving the DRIe, the Reader Type and Door Set controls are disabled and 

no further changes can be made 

● The card technologies for DRIe in Wiegand Mode are listed in the Reader 

dropdown list in the Configuration tab of the FLN Configuration dialog. 

● On clicking the Wiegand checkbox on the Devices tab of the Components 

dialog, the Door Set dropdown list gives you the available options to configure 

the Wiegand door set. 

For more information on Onboard Door Interfaces under different door 

configurations, Extension Interfaces and the Card Technologies used, see the 

Controller and Device Installation Guide in the Hardware and Firmware 

documentation folder in SiPass integrated Software bundle. 
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4.7.3 Aperio Wireless Lock Technology 

With the enhancements made to SiPass integrated MP2.76 SP1, the Aperio® 

Wireless Lock technology is expanded to support multiple Aperio Hubs connected 

to one ACC-AP through the Aperio FLN Bus (RS485 communication channel). You 

can select the Card Technology for selected locks and also assign a custom card 

format. 

4.7.3.1 Brief Overview 

Aperio Programming Application 

The software tool is supplied with the Aperio package and is used to program 

Aperio devices and pair the Aperio locks and hub with each other. The user must 

plug in the USB radio dongle (supplied with the lock) to the computer in order to 

communicate directly to the Aperio locks and the Aperio Wireless Hub to configure 

them. 

SiPass integrated 

● Since FLN 1 (reader 1) on an ACC-AP is reserved for onboard DRIe, only 

FLN2 (the Comms 1 port) can be used for creating an Aperio FLN Bus (and 

Aperio Hub under this FLN). 

● If an ACC FLN Bus has been added on an ACC-AP, then the Aperio FLN Bus 

cannot be created (for adding the Aperio Wireless Hub). If an Aperio FLN Bus 

has been created on an ACC-AP, a new ACC FLN Bus cannot be added (for 

adding other RIM devices). The AP Onboard FLN Bus can always be created 

for adding a DRIe in any of the above scenarios as it is created on a separate 

FLN channel. 

● Depending on the number of Aperio Hubs and the number of Wireless Locks, 

the configuration must be done as per the allowed numbers below: 

– Up to 15 Aperio Hubs can be connected to one ACC-AP through the Aperio 

FLN Bus. 

– Up to 8 Locks can be created under each Hub. 

– Up to 32 wireless Aperio Lock devices can be paired across all the Aperio 

Hubs connected to one ACC-AP FLN. 

 

 

The above points are true for SiPass integrated MP 2.76 SP1. In case of MP 

2.76, only one Aperio Hub can be created for one ACC-AP FLN. If the required 

number of wireless lock devices is more than 8, another Aperio Wireless Hub 

must be configured on another ACC-AP. 
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● The Aperio Hub and locks can be configured with the help of the Aperio 

Software utility and then discovered directly through the FLN Configuration 

dialog by performing a search. The search will identify the Aperio devices and 

fetch the device information which will be visible in SiPass integrated. 

– The Device Details tab on FLN Configuration dialog displays information 

like Name, Device Number, Aperio External ID, Hardware and Application 

specific information. 

– The Configuration tab allows you to select the Card Technology for each 

reader and create a custom card format. 

 

 

The Aperio Hub must be restarted (power OFF and then back ON) after any 

major configuration changes are done. 

● The “Aperio Wireless Access Point” cannot be selected as In / Out / Internal 

reader for the Anti-passback function. 

● The Hub Alarm Class is used to define the Aperio Hub related alarms. 

● The Hubs report is available in the Components Report group of the Predefined 
Reports section in SiPass integrated Operation client. 

● The SiPass integrated Management Station API has been updated to support 

the RS485 Hub type, new Output Points and Access Point Device, new Hub 

Alarm and new Device Alarm States. 

4.7.3.2 Adding Aperio Wireless Hub 

When the FLN Type is selected as Aperio FLN Bus (for ACC-AP), clicking the New 

Device button on the Components dialog displays the HUB option. On selecting 

this option, the Aperio Hub tab is displayed on right hand side of the dialog. 

1. Enter a name for the Aperio Hub into the Name field. 

 

 

The Number drop-down box displays the unique identity of the Hub in the Aperio 

setup. This is populated after performing a FLN Search for the Aperio devices 

through the FLN Configurator dialog and should not be selected by the user at 

this stage. 

2. Type an appropriate description for the Hub in the Description field. 

3. Select the applicable alarm for the Hub from the Alarm Definition dropdown 

box. 

 The Hub Alarm Class is used to define the Aperio Hub related alarms and 

supports trigger states like Communication Back, Communication Lost, 

Communication Unknown and Battery low. 

4. Click Save. 

 The Aperio Hub is created and listed under the Aperio FLN bus for the 

respective ACC-AP in the list on left hand side of the Components dialog. 

Repeat the above steps to add more Aperio Hubs to the ACC-AP. 
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4.7.4 Multi Function Interface (MFI) 

With release MP2.80 onward, SiPass integrated offers you the Multi-Function 

Interface (MFI) that adds-on to the powerful functionality of the ACC-AP door 

controller. 

In Configuration Client, it can be added under ACC-AP (FLN 2 with ACC FLN Bus 

type) and then, door readers can be connected in different combinations, as 

required. Alternatively, you can use the FLN Configurator and FLN Field Service 
Tool located in the Tools folder in SiPass integrated software bundle. 

Features: 

● Up to 4 MFI devices per ACC-AP can be connected, with up to 4 doors per MFI 

(total of up to 16 doors per ACC-AP) 

● MFI I/O Only Mode: I/O device with 8 inputs and 8 outputs. Can be used for 

general I/O, intrusion and low level-elevator control. 

● MFI Door Controller Mode: Secure OSDP V2 (encrypted) communication 

between Door Reader and MFI 

– 2 Door mode using up to 4 OSDP readers 

– 4 Door mode using up to 8 OSDP readers 

● Support for global reader manufacturers 

● Support for mixed configuration with IPM, OPM, 8IO and IAT in the same FLN 

bus 

4.7.4.1 Brief Overview 

Step by step instructions on creating an MFI device are given in the coming 

sections at relevant places. However, a brief overview of the functionality (in 

relation to SiPass integrated) is given below: 

SiPass integrated Components: 

● The MFI device 

– Can only be created under ACC AP (under FLN 2 with ACC FLN Bus type) 

– Supports the Component system function for operator privilege 

– Supports the Point Group and Device Group for point and device 

partitioning 

– Logs Audit Trail entry when creating devices and points 

– Does not support Link Reader and Unlink functionalities 

● The following door set can be selected while creating an MFI device: 

– 4 Dual Reader Doors 

– 4 Single Reader Doors 

– 2 Turnstiles, Dual DC 

– 2 Turnstiles, Single DC 

– 2 Dual Reader Doors 

– 2 Single Reader Doors 

– I/O Only Mode 
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● MFI can be mixed with other devices like IPM, OPM, 8IO and IAT in the same 

FLN bus 

● Like other FLN devices, MFI also supports saving the default setting under 

ACC AP 

● An Alarm Class can be assigned to the tamper input point with Alarm/Normal 
and Input Disabled modes available during configuration 

● The MS-API and RESTful MS-API support the MFI with a new device type MFI, 
a new door set and new input point type Tamper Input 

  

SiPass integrated FLN Configurator: 

● The MFI device: 

– Can be searched under FLN 2 of ACC AP 

– Can be saved from the FLN Configurator 

● OSDP encryption mode can be configured for all the MFI readers per device 

● Allows selecting one door set from the list: 

– 4 Dual Reader Doors 

– 4 Single Reader Doors 

– 2 Turnstiles, Dual DC 

– 2 Turnstiles, Single DC 

– 2 Dual Reader Doors 

– 2 Single Reader Doors 

– I/O Only Mode 

 

Input / Output / Intrusion Point Selection 

● Support for 8 Inputs in No Door mode 

● Support for 8 Relay + 3 Open collector Outputs in all modes 

● For Intrusion Input Point: 

– The Input Point can be selected if the selected door set is No Door 

– The Auxiliary Input Point can be selected if the selected door set is 2 Dual 
Reader Doors or 2 Single Reader Doors or 2 Turnstiles, Single DC 

– The DC point can be selected 

– The Tamper Input CAN NOT be selected. 

 

Low Level Elevator 

● A Low-level Elevator can be created in ACC AP 

● The MFI I/O points can be selected as elevator points if the door set is set as 

No Door 

● The Tamper Input Point CAN NOT be selected as Elevator Input Point 
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4.7.4.2 Benefits 

● RS485 Connectivity for reliable communications for up to 4 MFI units per ACC-

AP 

● Can be configured for virtually all access and security needs 

● Economical solution for door expansion 

● Can easily be added to an existing SiPass integrated system to extend your 

access and security solution 

● No extra training required due to components being in the same place as the 

existing entities 

● Bi-directional communication 

● 2 wire + power 

● 8 readers per FLN bus 

● Fully supervised communication 

● Authenticated 

● Encrypted (AES-128) 

● Point-to-point & Multi-drop (daisy chain) 

● RS485 up to 1200m 

● Addressable 

● Text messages capability (LCD enabled readers) 

● Up-to 1024 bytes 

● Remote servicing: firmware & smartcard key updates 

● SIA industry standard 

4.7.5 Help and Documentation 

The hardware for Aperio Wireless Technology and Multi Function Interface (MFI) is 

not supplied by Siemens. However, to help you quickly setup everything, SiPass 

integrated documentation gives you the required support information sourced from 

the device manufacturer. The standard SiPass firmware documentation also helps 

you at places during the whole process. 

While setting up the Aperio Wireless Hub and Locks and / or MFI, it is 

recommended that the following documents (from SiPass integrated Software 

bundle) are read in conjunction: 

● SiPass integrated Controller and Device Installation Guide 

● ACC-AP Technical Manual 

● Multi Function Interface (MFI) Technical Manual 

● SiPass integrated Configuration Client User Guide 

Aperio Wireless Lock Support Guide 

 

Siemens does not take responsibility for the correctness of the content with 

regards to the Aperio or MFI devices you may use. In case of any issues or 

requirement of more information, the device manufacturer should be contacted 

directly. 
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4.7.6 Adding Devices 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Select the ACC Controllers communications channel. 

4. Select the ACC to which you want to add a new device. 

5. Select the FLN to which the Device will be connected. 

6. Click the New Device button. A menu will appear showing a list of device types. 

7. Depending on the type of ACC and FLN combination, the list of devices will 

appear as below: 
 

ACC Type and FLN Bus 
Combination 

Available Devices 

ACC-G1/G2 and ACC FLN API5100: Input Point Module (IPM) 

AFO5100: Output Point Module (OPM) 

AFO5200: 8 Input /Output (8IO) 

AFO5200: 8 Input /Output (8IO) 

ADD5100: Dual Reader Interface (DRI) 

ADE5300: Eight Reader Interface (ERI) 

ATI5100: Intrusion Arming Terminal (IAT) 

ACC-G1/G2 and Entro FLN DC12: Single Door Dual Reader 

DC22: Single Door Dual Reader 

DC800: Single Door Dual Reader 

PD30/PD40: Single Door controller with built in reader 

IOR6: 4 Input / 6 Output Module 

ACC-G1/G2 and Granta FLN 4322–COTAG: 2 Readers/4 Input and 2 Output Module 

4422-SWIPE: 2 Reader/ 4 Input and 2 Output Module 

4253-IO: 16 Input / 8 Output Module 

BACKBOARD: Zero input/zero Output/Zero reader 
points 

ACC-G1/G2 and OSDP FLN OSDP: OSDP Reader Device 

ACC-AP and ACC FLN API5100: Input Point Module (IPM) 

AFO5100: Output Point Module (OPM) 

AFO5200: 8 Input /Output (8IO) 

ATI5100: Intrusion Arming Terminal (IAT) 

Multi Function Interface (MFI) 
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ACC-AP and AP Onboard FLN DRIe: For connecting to other RIM devices (including 
OSDP and Wiegand readers) 

ACC-AP and Aperio FLN Bus Hub: Aperio Wireless Hub and Wireless Locks 

 

Select the device type you want to add. A series of tabs will become available 

according to the device selected. 

1. Enter a meaningful name for the device into the Name field. 

2. Select the alarm definition that will apply to this device from the Alarm 

Definition drop-down box. 

3. A default device number will automatically be assigned in the Device Number 

field. For some devices, you can change this by entering a new number into the 

field. 

● The valid device numbers for Granta FLN are: 

– For 4322-Cotag, 4422-Swipe, 4253-IO – 1/3/5/7/9 are valid 

– For Backboard – 11 is valid 

● The valid device numbers for Aperio Lock are determined by Aperio Hub ID 

and a selection of valid addresses will be presented.. For example, below is la 

list of valid device numbers for Aperio Hub with ID ‘1’: 

– 1 - (Aperio External Id 1) 

– 2 - (Aperio External Id 17) 

– 3 - (Aperio External Id 33) 

– 4 - (Aperio External Id 49) 

– 5 - (Aperio External Id 65) 

– 6 - (Aperio External Id 81) 

– 7 - (Aperio External Id 97) 

– 8 - (Aperio External Id 113) 

 

 

Up to 8 Aperio Locks can be added to one Aperio Hub (and up to 15 Hubs can be 

added to one ACC-AP). Up to 32 Aperio Locks can be connected across all 

Aperio Hubs on the Aperio FLN Bus per ACC-AP. 

Note: The above numbers are different for SiPass integrated MP 2.76. See the 

documentation for the MP 2.76 version, if required. 

The Device Number field for the Aperio Hub should not be changed manually as 

this will get populated after performing the device search through the FLN 
Configurator dialog. Changing the EAC address of the Aperio Hub (through 

Aperio Setup Utility) will also change the device numbers. In this case, SiPass 

integrated configuration must be updated to match new device numbers. 
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In case of a DRI device, tick the Second Reader checkbox if you want to enable 

both card readers. 

 

 

To enable the second reader, the appropriate configuration must also be made on 

the FLN Configuration dialog. The operator needs to verify that the Enable 

Second Reader checkbox has been ticked on the Configuration tab of the FLN 
Configuration dialog. 

Further, configure the required Reader Technology for the second reader on the 

same dialog. 

1. Select the Door Set configuration for the reader- This will vary according to the 

reader selected. The table below specifies the different options available for 

each reader. 

2. Add a meaningful description for the device in the Description field. 

3. Click Save. 
 

8IO No selection available: the configuration for this device is pre-
determined. 

IPM No selection available: the configuration for this device is pre-
determined. 

OPM No selection available: the configuration for this device is pre-
determined. 

DRI Dual Reader Door ; 2 Single Reader Doors, Turnstile single door 
contact, Turnstile dual door contact. 

DRIe You can select the following door sets for both OSDP and Wiegand 
reader types: 

Dual Reader Door; 2 Single Reader Doors; Turnstile, Single Door 
Contact; Turnstile, Dual Door Contact. 

In case of Wiegand Reader type, the output points will be saved in the 
manner described in the Brief Overview section of the chapter Wiegand 

Reader on ACC-AP [➙ 52]. 

SRI Single Reader Door ACC installation only. 

ERI 8 single reader doors; 6 single reader doors and 1 dual reader door; 4 
single reader doors and 2 dual reader doors; 2 single reader doors and 
3 dual reader doors; 4 dual reader doors. 

MFI 4 Dual Reader Doors, 4 Single Reader Doors, 2 Turnstiles, Dual DC, 2 
Turnstiles, Single DC, 2 Dual Reader Doors, 2 Single Reader Doors, I/O 

DC12 No selection available: the configuration for this device is pre-
determined. 

DC22 No selection available: the configuration for this device is pre-
determined. 

DC800 No selection available: the configuration for this device is pre-
determined. 

PD30/40 No selection available: the configuration for this device is pre-
determined. 

IOR6 No selection available: the configuration for this device is pre-
determined. 

_Ref89A36168DAE8D4B659922E9855029E38
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4322-Cotag 2 Readers/4 Input and 2 Output Module 

4422-Swipe 2 Reader/ 4 Input and 2 Output Module 

4253-IO 16 Input / 8 Output Module 

Backboard Zero input/ Zero Output/ Zero reader points 

 

4.7.6.1 Configuring a DRI Reader as a Turnstile 

1. Repeat steps 1-10 as above (‘To Configure a device’) 

2. Select Turnstile Single door contact or Turnstile dual door contact. 

3. When configuring operational modes under the Door Reader tab, the 

Double/Single Arming mode will not be supported. 

4. Click Save. 

 The device details will be saved in the system. 

 

 
NOTICE 

IMPORTANT 

The turnstile will only operate under the ‘access control’ (i.e. Card badging) mode. 

If an operator or cardholder uses manual commands or event task effects on the 

turnstile, then these commands will override both access points in the turnstile, 

and they will act as two separate doors. 

The offline mode is also not supported in the turnstile. 
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4.7.7 Default Settings for Devices 

SiPass integrated allows you to nominate particular settings as the default settings 

for a new device. You can save one set of default settings for each type of device 

available. 

Setting default device settings from the Components dialog 

1. Select Components from the System menu or toolbar. 

2. Open an existing device record or create a new device record in the 

Components dialog. 

3. The Set Default button will only be enabled after you have saved at least one 

device in the system 

4. The Default Device settings only apply to devices created in the Component 
screen. 

5. Change the settings according to your preferences. You cannot set defaults for 

device, reader, and point names. 

6. Click the Set Default button. 

 A confirmation dialog will appear asking if you want your current settings for 

this device to be the default settings. 

7. Click OK. 

 Any new devices of this type that are created will automatically be assigned the 

default settings. 

SiPass integrated also allows you to nominate particular settings as the default 

settings for a device before you create the device. You can save one set of default 

settings for each type of device available. 

Setting default device settings before creating a device 

1. Select Configure Device Defaults from the Options menu. 

2. Select a Controller and Device from the drop-down lists. 

3. Change the settings according to your preferences. You cannot set defaults for 

device, access, and point names. 

4. Click Save. 

 Any new devices of this type will automatically be assigned the default settings. 
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4.7.8 Linking/Unlinking to an OSDP Reader Device 

The link/unlink between a RIM Device and an OSDP Reader Device can be done 

from the Door Reader tab of the device, as well as from the Door Reader tab of the 

OSDP Reader Device (both displayed in the left hand pane of the Components 

dialog). 

 

 

The Link / Unlink function is not supported by the Multi Function Interface (MFI). 

 

1. Click the RIM device listed in the left hand pane of the Components dialog. You 

can also click the OSDP Reader Device. 

2. Click the Door Reader tab on the right hand side of the dialog. 

3. Click the Link Reader button. 

4. Select the device from the list given on the Select dialog. 

– If you clicked the RIM device in step 1, the OSDP Reader Device list will be 

available for selection. 

– If you clicked the OSDP Reader Device in step 1, the RIM device list will be 

available for selection. 

5. Click OK. 

6. Click Save. 

 The RIM device is now connected to the OSDP Reader Device. The name 

of this device is displayed in the Referring to field. 

 To unlink an OSDP Reader Device from the RIM Device, click the Unlink 

button and click Save. 

7. Follow rest of the steps as described in section Defining Access Points [➙ 65]. 
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4.7.9 Discovering Devices 

When the system components and FLN devices have been added, these must now 

be discovered by SiPass integrated for further configuration and Firmware 

download. This can be done using the FLN Configuration Tool. 

1. Select FLN Configuration from the System menu. 

2. Right click Global settings and go to the Search Protocol (Default) option. 

 The right-click menu displays the FLN Buses across which, you can 

search: 

– Default 

– ACC FLN Bus 

– ENTRO 

– GRANTA FLN Bus 

– AP Onboard FLN Bus 

– OSDP 

– Aperio FLN Bus 

 You can select a specific option, Search Range or Search Exhaustive. 

3. Click Yes to begin the search. The navigation tree will automatically expand 

and all new devices discovered will be displayed in blue. 

4. Select a device to add to SiPass integrated. 

5. Enter a meaningful name in the Name field. 

6. Click Save New Device. 

 If you clicked the Refresh Display button to view the latest device 

information, wait for the operation to complete (till the information is 

displayed in the respective fields) before clicking the Save New Device 

button. 

7. Click Yes to confirm. 

8. Repeat steps 5-8 for each device you wish to add. 

9. Click Close when you are finished to exit the FLN Configuration tool. 
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4.8 Points 

When you create a device, any points associated with that device are automatically 

created and stored in the device’s record in the Components dialog. 

Or, if you create an Input Point Module (IPM) Device, the Input tab will contain a 

table of default inputs and the Output tab will contain a list of default outputs. 

You then modify the settings for the input and output points that are actually 

connected to the device, by modifying values in the displayed table. 

4.8.1 Defining Access Points 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Select the ACC Controllers communications channel. 

4. Select the ACC and then the FLN connected to the device for which you want 

to define an access point. 

5. Select the device containing the access point. 

6. Select each of the Reader tabs in turn. These tabs will only be available for 

reader interface devices.  

– To disable Reader 2 of a DRI de-select the Second Reader checkbox on 

the Devices tab. 

– The reader will be given a default name in the Name field, which consists of 

the Device name appended with the access label (e.g. “Door 1 Reader 1”). 

You can change this by entering a new name into the field. 

7. If you wish to link the ERI, DRI or SRI reader to an OSDP Reader Device, see 

section Linking/Unlinking to an OSDP Reader Device [➙ 62], else go to the 

next step. 

8. Select the alarm definition that will apply to this point from the Alarm Definition 

drop-down box. 

9. Select how the reader should operate from the Operation Mode drop-down 

box. 

– See SiPass integrated Reference Manual for details of the different 

operation modes. 

10. Enter the Facility Codes, separated by commas that this reader will accept into 

the Multiple Facility Codes field. 

 This field will only be enabled for facilities that have purchased the Card 

Technology “HID Prox 26-bit Multi-Facility” as part of their license. Tenants 

at your facility, if any, will also be permitted access at readers if they have a 

valid card and their card’s Facility Code is permitted at that reader. There is 

a maximum of 20 different Facility Codes permitted per reader. Also note 

that multiple Facility Codes are reader-specific; each reader may allow 

access to different Facility Codes. 

11. Complete the following reader specific parameters as given in section Access 

Point General Configuration [➙ 66]. 

12. The Reset Reader Tamper button will allow for a reader device to be manually 

reset after it has gone into tamper mode (Siemens RS485 readers only). 

 Depending on the type of device selected, all or a few of the parameters 

given below will be available for you to complete: 

_Ref51C44E79DB28EA039B3E606050DB59FD
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13. Click Host Verification to configure host verification for this reader. See section 

Access point Host Verification Configuration [➙ 67] for more information. 

14. Click Additional Access Method Options to set up either a ‘Daily Code’ or ‘PIN 

as Card’ access. See section Access point Additional Access Configuration 

[➙ 67] for more information. 

15. Click Dual Custody to configure Dual Custody for this reader. See section 

Access Point Dual Custody [➙ 67] for more information. 

16. Click Intrusion Control to configure intrusion controls for this reader. See 

section Access point Intrusion Control Configuration [➙ 72] for more 

information. 

17. Click Save. 

 

 

A checkbox in the Cardholder dialog will record the “3 Wrong PIN” status of a 

card. A SiPass operator must disable this checkbox and save the record to re-

enable to the card for use. 

It is also important to note that the incorrect PIN entries do not have to be made 

at the same reader; three consecutive incorrect entries made at any readers 

defined for this SiPass Server will void the card. 

 

4.8.1.1 Access Point General Configuration 

The following configuration options are available. 
 

Option Description 

PIN Timeout (sec) The time in seconds that a cardholder has to enter a PIN on the keypad. The timeout begins 
once the first digit is entered, or a card is badged and the reader is set to Card and PIN 
operation mode. This function can also be used in an intrusion area under Double/Single 
arming mode. 

Under this mode, the PIN timeout field will specify the length of time in seconds between the 
double card badge that is necessary to arm an intrusion area. If double badging does not 
occur within the specified time, then the area will be disarmed. 

Buzzer Period (sec) The time in seconds that can be specified to the pre-alarm or door held state so that the 
buzzer will sound for a door held open at this allocated time. If a value of 0 is entered, the door 
state will be ‘alarm’ and it will buzz until the door is closed. 

Void card after 3 wrong 
PIN entries 

Tick this checkbox, if you want any card that enters a wrong PIN number three times at this 
reader to be temporarily voided. Each incorrect PIN entry is recorded in the Audit Trail, along 
with a “3 Wrong PIN – Card Voided” message. All subsequent attempts at entry with that card 
will result in a “3 Wrong PIN Void Card – Entry denied” message. 

Disable Card Event When checked, the card event is not sent to SiPass server (which means no Audit Trail log), 
allowing data privacy for that Access Point. This option can be used for ensuring Cardholder 
data privacy to comply with any Data Protection regulations in your region. 

Door forced/tamper buzzer When checked, enables the Reader Buzzer to sound on any “Door Forced” or “Door Tamper” 
event. The “Door Closed” will stop the buzzer. This applies to all of the Doorframe Sensor 
modes. 

Remote Arming Terminal Tick this checkbox if you want a point to be used as a Remote Arming Terminal. This 
checkbox will only be enabled for CX23 and Siemens RS 485 readers, and only when 
Double/Single arming is not selected under the Operational Mode drop down box. If 
Double/Single arming has been selected, then this checkbox will not be displayed. 
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4.8.1.2 Access point Host Verification Configuration 

The following configuration options are available. 
 

Option Description 

*Time out (sec) The time in seconds that the Image Verification dialog will wait for a response from an 
operator, before closing and allowing access to be re-tried. 

Alarm Class Select the alarm class that will apply to this point from the Alarm Class drop down box. 

Unit Select the DVR unit from the Unit dropdown box. 

Camera Select a camera for the unit from the Camera dropdown box. 

Preset (PTZ only) Select the preset numbers for the camera. 

Save Image Snapshot Determines whether a snapshot is saved of the host verification image. 

**Snapshot Delay The delay in seconds after the host verification event occurs and when the snapshot is taken. 

 

4.8.1.3 Access point Additional Access Configuration 

The following configuration options are available. 
 

Option Description 

Time Schedule Select the time during which the additional access, like a Daily Code is valid. 

Additional Access Method 
during Time Schedule 

Determines which type of additional access you wish to configure. It will be in effect during the 
Time Schedule that was configured above. 

Additional Access Method 
outside Time Schedule 

Determines what additional access will be available outside the configured Time Schedule. 

Current Additional Access 
Method 

The additional access method currently in use on this reader. Click the refresh button to 
update this display. 

*Daily Code The daily code for this reader. This may or may not be the same daily code used at other 
access points. 

*Code No. of Digits The exact number of digits in the daily code. When specifying the number of digits to be used 
at the keypad, and you wish to create Controller Base Event Tasks on PIN entry, ensure that 
the number of digits specified is the same as ‘Base PIN digits” under System Preferences. 

 

*Please note that in order for the configuration to be saved successfully, settings in 

the Additional Access Method Options tab have to be saved with a clearly specified 

Daily Code, and Code No. of Digits. Such configurations cannot be saved with a 

blank Daily Code, while defining a reader interface module. 
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4.8.1.4 Access Point Dual Custody 

Dual Custody is a way of securing resources so that two people are required 

before access is granted. This means that two cardholders, who have been 

configured for the Dual Custody, will need to badge their card at a specific reader 

for access to be granted. 

There are three kinds of Dual Custody modes that can be configured for a door 

reader: 

● Standard:  

If set to the Standard mode, any two cardholders with appropriate access will 

be allowed entry. 

● Supervisory:  

If set to the Supervisory mode, one of two cardholders must be flagged as a 

Supervisor. Cardholders are marked as Supervisors by checking the 

Supervisor checkbox on the Definition tab of the Cardholder dialog. 

● None:  

If the mode is set to None, it implies that Dual Custody has not been configured 

for that particular reader. 

Using Self-Authorization at a Dual Custody Reader 

A single cardholder who has Self-Authorization privileges will be able to gain 

access to doors configured for Dual Custody. In such a case, a second authorized 

cardholder is not required, and all dual custody rules are waived. 

To configure a cardholder with Self-Authorization privileges, tick the Self-Authorize 

checkbox on the Definition tab of the Cardholder dialog, and save the cardholder. 

The Self-Authorization feature works independent of the Supervisory mode, and 

can be enabled at any time. Further, both the Supervisory and Self-Authorize 

privileges can be applied to a card. 

Dual Custody Rules for Single Readers 

The table below explains the Dual Custody access rules that apply at a Single 

Reader. It details situations when access is allowed or denied, depending on the 

Dual Custody privilege assigned to cardholders, and the Door Reader’s configured 

Dual Custody mode. 

With reference to the table, 

Cardholder 1 => Refers to the first card to be badged at the Access Point 

Cardholder 2 => Refers to the second card to be badged at the Access Point 

Employee => Refers to a cardholder with Standard Dual Custody Access 

Privileges 

Self-Authorized Employee => Refers to a cardholder with Standard Dual Custody 

Access Privileges + Self-Authorize privileges 

Supervisor => Refers to a cardholder with Supervisory Dual Custody Privileges 

Self-Authorized Supervisor => Refers to a cardholder with Supervisory Dual 

Custody Privileges + Self-Authorize privileges 
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Dual Custody 

Privilege of Cardholder 1 

Dual Custody Privilege of 

Cardholder 2 

Access Point Access Status 

Employee Employee Standard Dual Custody Granted 

Employee Supervisor Standard Dual Custody Granted 

Supervisor Employee Standard Dual Custody Granted 

Supervisor Supervisor Standard Dual Custody Granted 

Self-Authorized Employee - Standard Dual Custody Granted 

Self-Authorized Supervisor - Standard Dual Custody Granted 

Employee Self-Authorized Employee Standard Dual Custody Granted 

Employee Self-Authorized Supervisor Standard Dual Custody Granted 

Supervisor Self-Authorized Employee Standard Dual Custody Granted 

Supervisor Self-Authorized Supervisor Standard Dual Custody Granted 

Employee Employee Supervisory Dual Custody Denied 

Employee Supervisor Supervisory Dual Custody Granted 

Supervisor Employee Supervisory Dual Custody Granted 

Supervisor Supervisor Supervisory Dual Custody Granted 

Self-Authorized Employee - Supervisory Dual Custody Denied 

Self-Authorized Employee Supervisor Supervisory Dual Custody Granted 

Self-Authorized Supervisor - Supervisory Dual Custody Granted 

Employee Self-Authorized Employee Supervisory Dual Custody Denied 

Employee Self-Authorized Supervisor Supervisory Dual Custody Granted 

Supervisor Self-Authorized Employee Supervisory Dual Custody Granted 

Supervisor Self-Authorized Supervisor Supervisory Dual Custody Granted 

 

Rules for Single Reader Dual Custody with Anti-Passback 

An Access Point that has Dual Custody enabled, can be assigned as an IN / OUT / 

Internal Reader to an Anti-Passback area. 

The cardholders will be logged into the Anti-Passback area once the 2nd Card 

badge has occurred at the Dual Custody Access Point. 

The Dual Custody reader for the Anti-Passback area will increment (or decrement) 

the area count by 2 after a successful Dual Custody access. 

 

 

If an Anti-Passback area has a capacity limit enforced and cannot accept 2 more 

cardholders, the Dual Custody access may be denied. 
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Configuring a Door Reader for Dual Custody 

1. Select System > Components on the menu bar. 

2. Navigate to a specific Device on the Server tree hierarchy that you wish to 

configure for Dual Custody. 

3. Select a specific Door Reader tab of this device. 

4. Select the Dual Custody tab. 

5. Configure a required Time Schedule used for Dual Custody configuration. 

6. From the Dual Custody when Time Schedule On drop down list, select the Dual 

Custody mode in effect when the Time Schedule is active. 

7. From the Dual Custody when Time Schedule Off drop down list, select the Dual 

Custody mode in effect when the Time Schedule is not active. 

8. In the Dual Custody Timeout (sec) field, configure the maximum time allowed 

(in seconds) between the first and second cardholder’s card badge. If the 

second card is presented after this timeout expires, it is treated as a separate 

card badge. By default, the Dual Custody Timeout is set to 20 seconds. 

 The Current Status field will display as Standard, Supervisory or None, 

depending on the Dual Custody status of the door reader. 

9. Click the Refresh button to refresh the present status of the reader. 

 

 

In order to enable a reader for the Dual Custody mode, the door has to be set to 

the DOOR CLOSED state. If the door contact is in an Alarm condition, or if the 

door is open, the reader will be disabled. Further, Dual Custody will not work on a 

reader that has already been configured for Elevator Control, or an Intrusion 

Arming Terminal. 

10. When the Always Self-Authorize checkbox is left un-ticked, the general Dual 

Custody rules (as explained in previous sections) are applicable. However, 

when this checkbox is ticked, the following set of rules are applicable: 

● For Access with a Single Card Badge, the Cardholder must have Self-

Authorize Enabled 

User Scenario: An employee that has Self-Authorize enabled, but Supervisor 

disabled, will be granted access at a reader that is configured for Supervisory Dual 

Custody. 
 

1st Card Badge 2nd Card Badge Access Point 
Configuration 

Access 
Granted/Denied 

Always Self-
Authorize 

Employee* X Supervisory 
Dual Custody 

YES Enabled 

Supervisor* X Supervisory 
Dual Custody 

YES Enabled 
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With reference to the table above; 

Employee*refers to a cardholder with Standard Access Privileges with Self-

Authorization 

Supervisor* refers to a cardholder with Supervisory Dual Custody Privileges with 

Self-Authorization 

X implies that no card has been badged 

● For Supervisory Dual Custody Access, the first card badged must have ‘Self-

Authorize’ disabled 
 

1st Card Badge 2nd Card Badge Access Point 
Configuration 

Access 
Granted/Denied 

Always Self-
Authorize 

Employee Supervisor Supervisory 
Dual Custody 

YES Enabled 

Employee Employee* Supervisory 
Dual Custody 

NO Enabled 

Supervisor Employee Supervisory 
Dual Custody 

YES Enabled 

 

With reference to the table above; 

Employee refers to a cardholder with Standard Access Privileges 

Employee* refers to a cardholder with Standard Access Privileges with Self-

Authorization 

Supervisor refers to a cardholder with Supervisory Dual Custody Privileges 

● Turnstiles that have Supervisory Dual Custody enabled require that the 2nd 

card badged MUST be a Supervisor 

This rule applies regardless of whether the card badged first was a Supervisor or a 

Non-supervisor. 
 

1st Card Badge 2nd Card Badge Access Point 
Configuration 

Access 
Granted/Denied 

Always Self-
Authorize 

Employee Supervisor Supervisory 
Dual Custody 

YES Enabled 

Employee Employee* Supervisory 
Dual Custody 

NO Enabled 

Supervisor Employee Supervisory 
Dual Custody 

NO Enabled 

 

With reference to the table above; 

Employee refers to a cardholder with Standard Access Privileges 

Employee* refers to a cardholder with Standard Access Privileges with Self-

Authorization 

Supervisor refers to a cardholder with Supervisory Dual Custody Privileges 
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Dual Custody Rules at a Turnstile 

Turnstiles that have the Supervisory Dual Custody feature enabled, require that the 

2nd card badged at the reader MUST be a Supervisor. This is regardless of 

whether the card badged first was a Supervisor or a Non-Supervisor. 

As a result, the following rules apply: 

● If a Supervisor badges first, and a Non-Supervisor badges next, access will be 

denied. 

● If a Non-Supervisor badges first, and a Supervisor badges next, access will be 

granted. 

● If a Supervisor badges first, and another Supervisor badges next, access will 

be granted. 

 

 

Only ONE person will be allowed to enter at a turnstile when access is granted. 

● If access is granted (as per the rules explained below), only the first cardholder 

will be allowed to enter. This action will be reported as a Valid Card entry in the 

audit trail. The second cardholder will be reported as Cardholder did not enter. 

Manual Override Commands for Dual Custody 

Manual commands enable various Dual Custody modes for specific access points. 

When the Dual Custody manual command is submitted, it overrides the current 

operating mode. 

The following are some of the Manual Override commands available for Dual 

Custody: 

● Restore Dual Custody Configuration Mode 

● Set mode ‘No Dual Custody’ 

● Set mode ‘Standard Dual Custody’ 

● Set mode ‘Supervisory Dual Custody’ 

These manual commands to enable various Dual Custody modes for a specific 

point are also available as Access Point ‘Effects’ for both Controller and Host Event 

Tasks. 

4.8.1.5 Access point Intrusion Control Configuration 

The following configuration options are available. 
 

Option Description 

Terminal Device The terminal device used for Intrusion Control 

Time Schedule The Time Schedule controlling when the Intrusion Control is active 

Current State The current state of the Intrusion Control 
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4.8.1.6 Access point Programmable Authorization 

The following configuration options are available. 
 

Option Description 

Timeout (ms) This field specifies the time-out period set for authorization. The field 
becomes enabled when the Programmable Authorization operation 
modes are selected for the reader device. 

If a card is badged, and authorization takes longer than the timeout 
period set in this field; the card will be denied access and an appropriate 
audit trail message will be displayed. 

The default value of this field is 0. 

 

4.8.2 Defining Input and Output Points 

1. Choose Components from the System toolbar or menu. 

2. Select the Server in the left hand pane. 

3. Select the ACC Controllers communications channel. 

4. Select the ACC and then the FLN connected to the device for which you want 

to define an input or output point. 

5. Select the device containing the point. 

6. Select the Input/Output tab if you are modifying a card reader device, or either 

the Input tab or the Output tab if you are modifying an Input Point Module 

(IPM). 

 Input points and Output points for devices are listed in the table below. You 

can change the properties of a point by clicking in a cell and either entering 

a new value or selecting from a drop-down list. 

 Latch allows you to configure the length of time that the door lock will 

remain unsecured after the door has shut. 

7. Choose the Save button when you have defined all the necessary points. 
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4.8.2.1 Input Points 
 

Property Description 

Point Name The name of the point. This is the name that will be assigned to alarms. 

Alarm Definition The alarm class of the input point. 

Time Schedule The Time Schedule during which the input point is enabled or disabled. 

Operation Mode This specifies how the point should operate as part of the security 
system (depends on the type of input point associated with the selected 
device). 

In case of REX input , the Operation Mode options are: 

● Passback 

● Passback No Message 

● Passback No Report - Lock Not Activated 

● Passback Report - Lock Not Activated 

● Input Disabled 

Note: When the Passback No Message input mode is set, the behavior 
changes with the associated Time Schedule as described below: 

● Time Schedule is ON and Passback input takes place: The latch is unlocked 

for the defined access time without any message reported in the audit trail. 

● Time Schedule is OFF and Passback input takes place: The latch is 

unlocked for the defined access time and a Passback Triggered message is 

reported in the audit trail. 

If you do not wish to have any message at all times, set the Time 
Schedule to Always (point unsecure). 

Note: To know about more options available for the Operation Mode, 
see the Reference Guide in SiPass integrated software bundle. 

Input Delay This specifies the length of time before an alarm will be reported (exact 
operation dependant upon mode set). 

See DC Input Delay [➙ 75] for more information. 

Shunt Delay This specifies the length of time that a door monitor will remain disabled 
after a door has been opened, before a “Door Held” alarm is registered 
(exact operation dependant upon mode set). 

Pre-Alarm Delay This is an initial delay after an alarm event has occurred, which can 
trigger a low priority warning instead of a high priority alarm. 

Invert Input This option reverses the input of the point. Alarm events become restore 
events and so on. 

 

Door Frame Input as Intrusion Input 

With SiPass integrated MP 2.80 onward, the Door Frame Input Points (Door 

Contact point) can be assigned to the Intrusion Areas. 

Once the Door Frame points have been defined as Input Points while setting up 

devices through the Components dialog, the Intrusion Area Members tab on the 

Intrusion area Configuration dialog displays these “Door Frame” points available for 

inclusion in an Intrusion Area. 

For example, you can include a door contact point in an Intrusion Area in case 

where the building main entry is a SiPass Access Point, and a forced entry will 

trigger the intrusion area alarm. 
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DC Input Delay 

ACC firmware versions before 2.50.23 treated the Input Delay as a debounce timer 

which was active only when the door was closed. 

The ACC firmware 2.50.23 and higher (in combination with DRI/SRI firmware 

version 3.06 or higher) supports the following: 

1. The DC Timer Delay field is specified in tenths of seconds. This means 10 

second entered is = 1 second input delay time. 

2. Values up to 2.5 seconds (a count of 25) are handled in the DRI/SRI device; 

larger values are handled in the ACC. 

3. The DC Delay Timer is not active when the door is closed, so a Door Forced is 

generated without first applying the Delay Timer value. 

4. The DC Delay Timer is active when the door is first opened and closed when a 

valid door access is in progress (valid card or REX event). 

5. REX events (while the door is open) extend the door open time for the latch 

Delay1 time. Previously, the door latch open time would NOT be extended. 

Note: The above information about “Input Delay” is only related to the DC (Door 

Feedback contact input). All other inputs like REX or AUX IN keep working as in 

ACC firmware versions before 2.50.23. 

Here are 3 use cases that demonstrate handling of the door contact feedback. In 

all cases, the Input Delay set to 10 => 1 second Input Delay. 

Use case 1: Door bounces briefly on opening 

● A valid card is presented and the door is opened for a moment 

● The cardholder closes the door for less then a second (e.g. different air 

pressure) 

● The cardholder then pushes the door open and passes through. 

● If the door is closed for more the 1 second then the door will be internally 

reported as closed 

● If the door is now forced an event will be reported without an input delay. Here 

only the 50 ms debouncing time is active. 

Use case 2: Door bounces on closing 

● A valid card is presented, the door is opened and the cardholder passes. 

● A second cardholder who is following pushes the door open after the door 

feedback contact has reported a close door (but less than 1 second), the 2nd 

cardholder will be able to pass without a Door Forced being reported. 

● After the door is closed for more the 1 second the door will be internally 

reported as closed 

● If the door is now forced, door forced event will be reported without an input 

delay. Here only the 50 ms debouncing time is active. 
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Use case 3: Cardholder is slow to open the door 

Output delay set to 4 seconds 

● A valid card is presented. 

● The cardholder opens the door shortly after the output delay time has expired, 

but before the 1 second delay has expired, and passes through. 

● If the door is closed for more the 1 second the door will internally reported as 

closed. 

● If the door is now forced, the door forced event will be reported without the 

input delay. Here only the 50 ms debouncing time is active. 

At all use cases the Input Delay time is active, after the Input Delay Time has 

expired a door open will be reported after 50 ms debounce time as door forced. 

The valid card can be replaced by a REX event with the same behavior. 

Each of these use cases would have reported a door forced in the past with or 

without Input Delay value set. 

Important things to consider: 

The Delay Time setting on a door should be greater than: 

● Door bounce time for an Open event 

● Time the door takes to lock properly after the door frame reports closed. This 

one is important, as a person could force the door at this point and the System 

will just ignore it if the door eventually closes, or report door held if it stays 

open. 

 

Both the DRI/SRI and also the ACC are backwards compatible. 

This means that an ACC Firmware version 2.50.23 or higher works well with 

DRI/SRI having a Firmware lower then 3.06. 

Door Frame Held Only Mode 

With SiPass integrated MP2.80 onward, the "Door Frame Held Only" mode is 

available while configuring Input Points through the Components dialog. The new 

mode is listed as a dropdown list option in the Input/Output tab > Operation Mode 

column during device configuration. 

In case when the door has a reader on the outside but no reader (and no 

passback) on the inside, this mode can be selected, and the user can set a time in 

the Input Delay column. The open door is then held virtually for the set time 

duration and is not reported as a “door-force” event. However, when the door is 

opened from outside, it is considered as normal access. 
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Aperio Doorframe Sensor Input 

With SiPass integrated MP2.76 SP2 onward, the Components dialog in 

Configuration Client includes the Aperio Doorframe Sensor input which is available 

for all the components where a doorframe input is configurable. 

● The Aperio Basic Lock component configuration always includes this input 

(Input Number 2). 

● The existing “Doorframe Sensor” and “Input Disabled” modes are available for 

this input. 

Based on the state of this input, the ACC can perform standard processing and 

report standard door open, closed, forced and held events to SiPass integrated. 

4.8.2.2 Output Points 
 

Property Description 

Point Name The name of the point. This is the name that will be assigned to alarms 
and events and appear in the Audit Trail. 

Time Schedule The Time Schedule during which the output point will be able to be 
activated. 

Alarm Definition The alarm class of the output point. 

Delay 1 If the Delay 1 field is set to zero, the output point will operate in Pulse 
mode. 

Delay 2 This delay is used for special accessibility. 
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4.9 Device Firmware Download and Configuration 

When a new firmware device is added to the system, the initial configuration of the 

device is essential to ensure that it will work correctly with the SiPass integrated 

software. 

 

 

After upgrading the firmware of ACCs, all FLN devices MUST be upgraded to the 

latest firmware. 

1. Select FLN configuration from the System menu. 

2. Select the Smart Card Configuration tab. 

 Under the Smart Card Configurations panel, the smart cards that have 

been added will be displayed. 

3. To configure a new smart card, select Add. 

4. Fill out the following fields: 

– Configuration Name: Enter a unique name for the new smart card 

configuration. 

– Sector (1-15): Enter the sector on the smart card in which access data is 

stored. 

– Block (0-2): Enter the block containing the sector into which access data is 

stored. 

– Encryption Key: Enter an encryption key for the smart card. It must be 12 

characters in length and in Hexadecimal. Hexadecimal numbers use the 

digits 0-9 and letters A-F. 

– Confirm Key: You will need to re-enter the Encryption key to confirm it. 

5. When you have entered all the details, select OK. 

 A confirmation dialog will appear asking you if you want to add the 

configuration to the database. 

 The Smart Card configuration details will now appear on the Mifare Smart 

Card Configurations panel. 

6. Click to expand the Global Settings option on the left hand side panel of the 

dialog. A list of all the ACC Controllers will appear. Click on it to expand the 

tree and view the units connected to each controller. 

7. By clicking and highlighting each unit, an ACC Details tab will appear 

displaying the following fields: 

– Name: This will display the name of the selected unit. 

– IP Address: This will display the IP address of the selected unit. 

– Serial No.: This will display the Serial number of the selected unit. 

8. Expand the plus symbol on the tree view for the desired unit to display the FLN 

Channels connected to that unit. 

9. Select the FLN channel from the list that you wish to configure. 
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10. The following details will be displayed on the right hand side panel, under the 

tab FLN Details. 

 Set Device Number: 

– Device S/N: This will display the device’s serial number 

– New Device Number: This box will allow you to set a new device number 

for the selected FLN Channel. Click on the up and down buttons to select 

the new number you wish to allocate. 

 Clear Device Number: 

– Device number of the device to be cleared 

– Clear Device Number button 

11. Once you have entered the new details, click on the Set Device Number button 

which will save your changes. 

 

 

In case of ACC-AP with an Aperio Wireless Hub, the Hub Details tab will be 

displayed with the following information: 

- Name: The name of the Aperio Wireless Hub as defined while adding it to the 

ACC-AP. 

- Hub Number: The number of the hub as selected while adding to the ACC-AP. 

- Model: The model number of the Aperio Wireless hub. 

 

1. Click on the + symbol next to the selected FLN Channel to expand the tree. 

 The current devices you have installed will be displayed. 

2. Select the device you wish to configure. 

 The tabs Device Details and Configuration will be displayed on the right 

hand side panel. The fields of the tabs are explained in the tables below. 

3. To check that the information was stored on the device, select Refresh Display. 

4. Click Save. 

 If you clicked the Refresh Display button, wait for the operation to complete 

(till the information is displayed in the respective fields) before saving. 
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Device Details Fields 
 

Fields Description 

Name This will display the name of the device. 

Device Number This will display the device number. Use the up and down arrows to 
select a number and click on Set to save. 

Door Set The selected door set combination for the configured device. In case of 
a DRIe configured in the Wiegand Mode, there will also be a Wiegand 
checkbox on the right hand side. 

Model This will display the model type of the device. 

Revision This displays the Hardware revision given to the device. 

Serial Number This will display the device Serial number. 

Hard Reset Select this option to perform a complete hardware reset, all values on 
the device will be reset. 

Soft Reset Select this option to report all input states only, no outputs will be reset. 

Drop to 
BootRom 

Use this function to reset the hardware to its original operating system 
before it begins loading the specified firmware application. 

Run Application Use this function to reverse the drop to BootRom. This will call upon the 
hardware to run on the current application in the firmware. 

 

 

The buttons Hard Reset, Drop to Bootrom, Run Application and Download 

Firmware are applicable only to Backboard device and are not enabled for the 

4322-Cotag, 4422-Swipe and 4253-IO devices. 

The DC12, DC22, IOR6 and DC800 devices are not supported for selection at 

input points. These are available only for Alarm/Normal operation modes. 
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Configuration Tab Fields 
 

Fields Description 

Reader 
Technology 

From the Reader dropdown box, select the reader type that has been 
installed and select the desired card technology from the Technology 
dropdown box. 

Repeat this step if there’s more than one reader, up to 8 readers can be 
selected. 

Inputs Select from Monitored and Unmonitored inputs for the device. 

Local Output 
follows Local 
Input 

Select this output if you want the output on the device to follow the local 
input. 

Reader LED’s Select from ZAP for Asia Pacific, or ZAM for North America. 

Reader Tamper 
Auto Reset 

Select Yes or No whether you would like the device to reset itself after 
the reader has been tampered (Siemens RS485 readers only). 

Note: For any specific configuration scenario, if it is required to ignore 
the Tamper Setting for a reader, check the Tamper Ignore checkbox on 
the Reader Firmware & Config tab (unchecked by default). This setting 
will be applied on all the readers of the device. 

Mifare Smart 
Card 
Configuration 

Select the Configuration from the drop down box. This corresponds to 
the smart card configuration settings. 

The Sector and Block will display the matching values to the 
configuration that has been chosen above. 

 

 

Granta Specific Configuration Tab Fields 
 

Fields Description 

Inputs Select from Monitored and Unmonitored inputs for the device. This 
configuration is available on Granta I/O modules. 

Enhanced Read Tick to enable Enhanced read check on Cotag cards. This configuration 
is available on Granta Baseboard devices. 

Parity Check Tick to enable Parity check on Cotag cards. This configuration is 
available on Granta Baseboard devices. 

Cotag Reader 
holdoff time 

Enter value between 0-255 to set the holdoff time (in tenths of a second) 
for all Cotag readers. This configuration is available on Granta 
Baseboard devices. 

Repeat 
transaction 
delay 

Enter a value between 0-255 to set a repeat transaction delay (in 
seconds) for all Cotag readers. This configuration is available on Granta 
Baseboard devices. 
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4.9.1 Creating a Custom Card Format 

The following instruction explains how to create a custom card format from the FLN 
Configuration dialog. 

1. Select FLN configuration from the System menu. 

2. Select the Custom Card format tab. 

3. Select Add. 

4. Complete the following fields: 

– Name: By default, the name will match the custom card format stored in the 

SiPass integrated database. This can be changed to any desired name. 

– Total Length: The total number of bits contained in the card. This can be 

increased by extending the end of the bar and moving it right or left, either 

to increase or decrease bit length. 

– Number: The range of bits that will be used to specify the card number 

within the card. It can be increased by extending the end of the bar and 

moving it right or left; the box can also be dragged along to change the 

range. To change the MSB (Most Important Bit), double-click on the box or 

right-click with your mouse. 

– Facility: This represents the facility that is currently selected by the tenant 

in SiPass integrated, and depicts how the bits of the card are interpreted. 

– Facility Additional: Check this box to add an additional facility to the card. 

– Revision: Check this box to incorporate the revision of the card. 

– Even Parity: Select this function to validate the card where the parity bits 

are checked for even number of bits. 

– Odd Parity: Select this function to validate the card where the parity bits are 

checked for an odd number of bits. 

5. To save the changes, select OK or to have the changes take effect straight 

away, select Apply. 

 The Custom Card dialog will close down, and the Custom Card Format tab 

will appear. 

6. If you have finished adding profiles, select Close. Alternatively, to update or 

change an existing card format, select it from the list and click on Update. 

4.9.2 Configuring Reader Interface Offline Modes 

Offline modes control how the reader interfaces behave when disconnected from 

the ACC. 

You can define Offline Access Groups by selecting Program > Offline Access 

Group. 

 

 

If the device firmware does not respond, or support the Offline mode, a message 

will be shown warning you that this is the case. You will need to upload the latest 

firmware. 
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Setting offline modes 

1. Select FLN configuration from the System menu. 

2. Click to expand the Global Settings option on the left hand side panel of the 

dialog. A list of all the ACC Controllers will appear. Click on it to expand the 

tree and view the units connected to each controller. 

3. Select the desired reader interface unit to be configured. 

4. Select the Offline Mode tab. 

5. Select a Door Set to use when in Offline Mode from the dropdown list. 

6. Select the Offline Mode for each available door from the dropdown list. You 

may need to scroll the Offline Door Configuration section to the right to see the 

dropdown list. 

7. Set the time delay in hours, minutes and seconds in Activation Delay. 

Activation Delay is the time after going offline before initiating Offline Mode. 

8. Configure your Offline Mode. 

– If one of the Card or PIN modes is selected, you can pick a specific Offline 

Access Group by clicking the … button. There is a default group that will be 

assigned if you do not select one. 

– If “Card and PIN” mode is selected you can set the PIN timeout to control 

how long a cardholder has to enter a PIN after badging their card. 

– If Facility Access is selected a list of facilities (up to 20) which will be 

granted access when presented to a door that is running ‘facility access’ 

mode is visible under Allowed facilities. To enter a facility code , click inside 

the Allowed facilities box and add the codes separated by a comma 

(Maximum twenty (20) codes allowed). For example: Adding the codes‘7,9’ 

will allow users whose cards have the facility numbers, 7, and 9 will be able 

to open the door. 

9. Click Save. 

 

 
NOTICE 

● Entro devices do NOT store audit trail when in Offline Mode. 

● The SRI / DRI / ERI can store events, so that when the device goes back 

online the messages will be displayed in the Audit Trail. 

● The number of doors configured to a device, do not make any difference to 

the storage requirements for events. 

● If the door is opened and closed, it will also store a DoorFrame opened and 

closed message. 

● The DRI/SRI has a relatively small storage size, and has a limit of 212 Card 

events + Door open/close events that it can store in the offline mode. 

● The ERI has a larger memory size, and has a limit of 1668 Card events + 

Door open/close events that it can store in the offline mode. 

● If the Passback button is pressed, it is considered a single input event, like a 

door open/close. In this mode, up to 710 input events (state changes) can be 

stored in a DRI/SRI; and up to 5630 input events (state changes) can be 

stored in an ERI. 
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Offline Mode Table 
 

Mode Description 

Disabled The device is disabled and there will be no change in state. 

Unlocked The door will unlock when device goes offline. 

Facility Access The door will grant access to any cardholder whose facility matches those specified in ‘Facility 
Access’. 

Locked The door will remain locked when device goes offline. 

Closed The door is locked and the reader is disabled. In this case, the REX button can be used to open 
the door. 

Card The door is locked but pre-programmed cards can still gain access. The Passback on the door 
also functions. 

PIN The door is locked and card badges are ignored. PIN entry from pre-programmed cardholders 
with “Card as PIN” enabled will gain access. The Passback on the door also functions. 

Card or PIN The door is locked and card badges or PIN entry from pre-programmed cardholders will gain 
access. For the PIN entry to work the cardholders must have “Card as PIN” enabled. The 
Passback on the door also functions. 

Card and PIN The door is locked and in “Card and PIN” mode. Only pre-programmed cardholders can gain 
access and they must badge their card and enter the correct PIN. The Passback on the door also 
functions. 

 

4.9.3 Configuring OSDP Readers 

Before configuring OSDP Readers in SiPass integrated, ensure that the required 

readers are displayed and configured correctly on the Reader Firmware & Config 

tab of the respective FLN on the FLN Configuration dialog. 

Note: The same process is followed to configure HID OSDP readers and devices 

paired with OSDP on FLN Bus. 

1. Select FLN Configuration from the System menu. 

2. Select the OSDP Reader Configuration tab. 

3. Click Add to create a secure OSDP Key. The OSDP Secure Key Configuration 

dialog is displayed. This is where a secure key is created to allow encrypted 

communication between the controller and the reader. This is supported only 

for the Dual Reader Interface (DRI), which supports the encrypted mode. 

4. In the Name field, enter a name for the secure key configuration. 

5. In the Encryption Key field; enter a unique encryption key for the configuration. 

6. In the Confirm Key field; re-enter the encryption key as in the previous step. 

7. Click OK. The secure key configuration will be saved, and you will be returned 

to the OSDP Reader Configuration tab. 

8. From the Reader Firmware box; select the reader for which firmware download 

is required. 

9. Click Add. 

 The Device Firmware Selection dialog is displayed. 

10. Navigate to the location where the firmware update files are stored. 
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11. Select a file and click Open. 

 The opened firmware is displayed in the Reader Firmware box. 

12. From the Global Settings tree on the left panel, select the specific reader 

device. 

13. Tick the checkboxes of the reader and firmware to be downloaded. 

14. Click the Download Firmware button of this dialog, and return to the Reader 
Firmware & Config tab. 

15. Tick the checkbox corresponding to the reader to be selected. 

16. Next, click the drop down list of the Flash Firmware button. Details of the 

options on this drop down list are as follow: 

– New firmware and restart: This option downloads the firmware, and restarts 

the OSDP reader immediately after download. 

– New firmware only: This option only downloads the firmware. The OSDP 

reader will not be restarted with this option. 

– Restart reader: This option only restarts the OSDP reader. Firmware will 

not be downloaded with this option. 

– Note: The three options listed above can be configured at the ACC, FLN, 

Device or Reader level. Depending on the level selected, all readers in the 

level can be chosen for firmware download/restart, or a specific reader/s 

can be chosen for the same. 

17. In the OSDP Secure Key Configuration section, select the desired Encryption 

Mode. Options are: 

– No Encryption: The Reader Interface Module (RIM) device will not use any 

encryption. 

– Encryption with fallback: The RIM device tries to establish a secure 

connection with the Site Key first. If that fails, it tries the default OSDP Key. 

– Encryption with site key only: The RIM device will not connect if the secure 

session with the Site Key fails. 

18. Select a site key from the Key Name dropdown list. 

19. If the connected reader supports encrypted communication with the ACC, the 

Overwrite Reader Site Key checkbox will be displayed. Checking this will allow 

you to securely send a custom site key to the OSDP reader. See the next 

section “Sending OSDP Site Key to the Reader for Encrypted Communication 

[➙ 85]“ for more details. 

20. Click the Tamper Ignore checkbox to read the card number even when the 

reader is in the Tamper state. 

21. Click the Card Badge Beep checkbox if you wish to SiPass integrated to sound 

a beep for readers that do not support beep on their own. 

22. From the Date/Time Format dropdown list, select the format to display the Date 

and Time on the OSDP reader. 

23. Click the Download Firmware button. 

 The firmware image download process will be initiated. When complete, the 

selected reader and its firmware will be configured in the SiPass integrated 

system. Audit trails will reflect the configuration that was just performed. 

  

_RefCF3C6A5285120A6AE5E51BE561A02C84
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4.9.3.1 Sending OSDP Site Key to the Reader for Encrypted 

Communication 

The ACC checks the connected reader for encrypted communication and if it is 

supported by the reader, the Overwrite Reader Site Key checkbox is enabled on 

the Reader Firmware and Config tab. When checked, this checkbox helps you to 

send an OSDP key to the reader. 

The devices that support this feature are 

● OSPD Readers connected to ACC-AP 

● OSPD Readers connected to OSDP FLN on ACC-G2 and ACC-AP 

● OSDP Readers connected to MFI 

● OSDP Readers connected to DRI running the DRI_Crypto firmware (firmware 

version 5.36 onwards) 

Note: This function is not supported for Vanderbilt VRxxx-MF and Siemens ARxxx-
MF readers. 

 

Steps 

For HID Readers, once the Overwrite Reader Site Key procedure has been 

performed, the Site Key is set in the reader and the default key is deleted. This 

means that Fallback will no longer work on these readers. 

Hence, the steps given below should be followed fully for the initial commissioning. 

Afterwards, steps 3, 4 and 5 can be performed without going back to the 

Encryption with Fallback mode. 

1. Select Encryption with Fallback from the Encryption Mode dropdown list. 

2. Wait for the reader to come online with encryption enabled with the default key. 

3. Select the new Site Key and check the Overwrite Reader Site Key checkbox. 

4. Click Save Configuration. 

5. Wait for the reader to come online with encryption enabled with the site key. 

6. Select Set Encryption with site key only from the Encryption Mode dropdown 

list. 

7. Click Save Configuration. 

 Note: This is not mandatory but is recommended as a good practice for 

HID Readers. 

8. Wait for the reader to come online with encryption enabled with the site key. 
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4.10 Initializing Units 

When a new ACC unit is added to the system, an initial data set needs to be 

downloaded to that unit. This is done through the process called initialization. 

Initialization may also be required when a configured unit is re-connected to the 

system. 

 

 

ACC components must be online and communicating before they can be 

initialized 

 Before you initialize a unit, you should define both the points that belong to the 

unit and the access control details for cardholders at those points. 

1. Select Initialize from the System toolbar or menu. The Initialize System dialog 

will appear with list of all the units defined in the system will appear in the 

Available list. 

2. Select the unit to be initialized by highlighting its name in the Available list. 

3. Choose Add to add the unit to the Selected list. 

4. Repeat Steps 2 and 3 until all the units to be initialized have been added to the 

Selected list. 

5. Tick the Initialization Options checkbox to unlock the data component options 

corresponding to those elements to be downloaded during initialization. 

6. Select each data element to be downloaded to the specified units by ticking the 

corresponding checkbox. 

7. Choose Full Initialize to perform a full initialization of the selected units. 

8. Choose Compact Backup to compact the data stored on an onboard flash 

backup card, if available, allowing more data to be backed up. 

9. Choose Image Download to download Firmware to selected units. 
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4.10.1 Initialization Options 

The following table lists the available options: 
 

Option Description 

Memory When ticked, the selected units will clear their memory on initialization. 

Holiday When ticked, all defined holidays will be downloaded on initialization. 

Time Schedule When ticked, all defined Time Schedules will be downloaded on initialization. 

Point When ticked, all information about the points that belong to the selected units will be 
downloaded on initialization. 

Employee Access When ticked, all cardholders’ access control information will be downloaded on initialization. 

Elevator When ticked, all elevator data will be downloaded on initialization. 

Event Task When ticked, all controller-based event task data will be downloaded on initialization. 

Intrusion Area When ticked, all intrusion area information is downloaded to the unit. 

Anti-Passback When selected, all Anti-Passback area information is downloaded to the unit. 

Download Expired Cards When selected expired cards are also downloaded to the ACC. 

Download all cards to all 
ACCs 

When selected all cards are downloaded to all ACCs regardless of access privileges. 

 

4.10.2 Creating an Initialization Event Task 

You can create an event task to automatically perform a full initialization on an 

Advanced Central Controller after a unit has been reset; for example, after a power 

loss. 

1. Select Program> Event Tasks > Controller toolbar. 

2. Enter a name for the Initialization Event Task into the Event Name field. 

3. Select the Time Schedule during which the event task will be able to occur. 

4. Select Unit from the Type drop-down menu. 

5. Select the ACC you want to be initialized after a unit reset from the Controller 

drop-down menu. 

6. Select Reset. 

7. Select Unit from the Target drop-down menu. 

8. Select Full Initialization from the Command drop-down menu. 

9. Select the ACC you want initialized from the Location drop-down menu. 

10. Enter the message that will appear in the Audit Trail when the event runs, into 

the Message field. 

11. Click Save. 
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4.10.3 Creating an Operation Mode Event Task 

Operation mode changes can be triggered by an event task. For example, you may 

want the operation mode at a certain door to be Card Only during normal business 

hours, Card & PIN until midnight, and then Host Verification & PIN until the start of 

the business hours the next day. 

1. Select Host Event Task from the System toolbar or menu. 

2. Enter an appropriate name for the Event Task into the Event Name field. 

3. Select the Time Schedule to trigger the mode change. 

4. Select Time Schedule from the Source1 drop-down box. 

5. Select Start from the State1 drop-down box. 

6. Select Access Point from the Target drop-down box. 

7. Select the mode that you want a reader to switch to, from the Command drop-

down box. 

8. Select the reader from the Location drop-down box. 

9. Enter a message to be displayed in the Audit Trail when the Event Task 

occurs, into the Message field. 

10. Click Save.
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5 Site Management 
After you have created all the components at your site using the Components 

dialog, you must then configure the parts of the system that define how and when 

components operate. 

5.1 Point Groups 

Point Groups are collections of points, floors, sub-groups, areas / sub-areas. Point 

Groups allow you to send a command to several points simultaneously, and ease 

the burden of assigning access control privileges to multiple points. A Point Group 

can only consist of points of the same type. A group cannot include a combination 

of input and output points. 

When altering the properties or members of a group, care should be exercised due 

to the potential impact on the operation of the access control system. 

If the changes are to take effect immediately, the system controllers must be re-

initialized. 

Usually, complex changes to point groups, such as the removal of individual points 

or changes to cardholder access control privileges are not immediately 

downloaded to system controllers. 

5.1.1 Creating a Point Group 

Creating a group involves assigning the group a unique number and specifying the 

group type, alarm class and members. 

 Ensure that you have defined all the points, floors, sub-units or areas you will 

need to include in a group. 

1. Select Component Group from the Program toolbar or menu. 

2. Ensure Point Group is selected from the list. 

3. Enter a unique name that identifies the group into the Group Name field. You 

can enter up to 40 characters, in any combination of upper and lower case 

letters, and numbers. 

4. Click Add Members. 

5. Select the group type by choosing the drop-down arrow on the Group Type 

field and selecting a type. 

6. Select the name of the points you want to include in the group. 

7. Click Add >. 

8. Click OK. 

9. Select the alarm class that best defines how the system should behave under 

certain (alarm) conditions. To change the alarm class, choose the drop down 

arrow and select a new alarm class from the list. To un-assign an alarm class, 

simply select the existing alarm class and press the Delete key on your 

keyboard. Do NOT click on the SiPass Delete button. 
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10. Configure the group alarm triggers. 

– Count:  

Specifies the number of group members that must be in alarm state, or 

have returned to normal but whose timers have not yet timed out, before 

the group goes into alarm. If 0 is entered, it prevents an alarm from 

occurring. 

– Timer:  

An internal timer starts counting (in seconds) for each member of the group 

that was in alarm after it returns to normal. The group goes into alarm if the 

number of points counting down or currently in alarm reaches the Group 

Count. If a point times out, the current count is decreased by one (which 

may cause the group to return to normal state). This means that if a certain 

number of group members have entered an alarm state simultaneously or 

within a configurable time interval, the group alarm will be generated. 

11. Set the group actions. 

– Isolate:  

When checked disables the group alarm and normal messages, however 

individual member messages will still appear in the Active Audit Trail 

window. 

– Clearance Required:  

When checked, the member(s) that caused the group to enter an alarm 

state must be restored before the group can return to normal. If this box is 

checked, a group timer will be started every time a member returns to a 

normal state after registering an alarm. If this box is not checked, a group 

timer will be started every time a member enters an alarm state. 

12. Choose Save. 

 

 
NOTICE 

● The Group Type and Group Alarm Status fields indicate the type of members 

and the group’s alarm status respectively. These fields do not appear until a 

group has been created. 

● When Point Groups are added to the system, it is essential that you update 

the Operator Group permissions to include them. Any time that changes are 

made to Groups, it is necessary to initialize the system after you have saved 

the changes for them to take effect 

● Deleting a group does NOT remove the individual points from the Database. 

Deleting a group may require other changes to the system. Because of this, 

removal of a group can make the Database inaccessible to other users for 

long periods and may impact on the performance of the system. 

● In relation to a Dial-up environment, because of the large number of 

commands generated by any changes to Groups, it is possible that an event 

task will be triggered to auto-download those changes to all the controllers in 

the system. This will depend upon the number of members in the group and 

the number of commands needed to trigger such an event. 
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5.2 Component Groups 

In addition to Point Groups, you can create other groups to Partition Devices, 

FLNs, Units and Components in the same way. View, Edit and Create privileges to 

these groups can be then added to operator groups to control how the items in the 

group can be viewed and modified by operators. However, unlike Point Groups, 

these groups are used only for Operator Partitioning and are not functional groups. 

By default whenever a new Unit, Device, FLN or Component it is assigned to the 

default group and the privileges assigned to the operator group that created it. 

However for greater control you can create your own groups to effectively manage 

your site. 

5.2.1 Creating a Component Group 

Creating a group involves assigning the group a unique name and specifying the 

members. 

 Ensure that you have defined all the Devices, FLNs Units or Components you 

will need to include in a group. 

1. Select Component Group from the Program toolbar or menu. 

2. Select Device Group, FLN Group, Unit Group or Component Group. 

3. Enter a unique name that identifies the group into the Group Name field. You 

can enter up to 40 characters, in any combination of upper and lower case 

letters, and numbers. 

4. Click Add Members. 

5. Select the name of the Devices, FLNs, Units or Components you want to 

include in the group. 

6. Click Add >. 

7. Click OK. 

8. Click Save. 
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5.3 Operational States and Control States 

The operational state of a point refers to its current location, or activity. For 

example, a door latch output point can be locked or unlocked. A PIR input point 

can be in an alarm or normal state 

Points change their operational state in response to a number of things in SiPass 

integrated: 

● Host Event Tasks 

● Controller Event Tasks 

● Manual Commands 

● The normal events that occur at a facility, such as a valid card badge. 

Each point in the security system is, at any given time, in a certain Control State 

i.e. it is under the control of one of the four command types above. For example, a 

door latch can be simply locked as dictated by the current Time Schedule and 

waiting for a valid card badge to unlock, or it could be locked by an operator 

sending a “Latch Lock” command via the Manual Command dialog. 

In addition, there are two types of Event Tasks and Manual Commands: 

Permanent and Interruptible. A Permanent command is used for situations where 

you want to completely over-ride the current operational state of a point for a 

duration of time (including indefinitely). The point will not change state (e.g. unlock) 

until over-ridden by particular commands, which are explained in the next section. 

An Interruptible command can be used for situations where you want to temporarily 

change the operational state of a point, but without interfering with normal access 

control. A point under Interruptible Command control will only change state in 

response to normal security and access events, or until another command 

(permanent or interruptible) is sent. 

Differentiating between Permanent and Interruptible commands this way provides 

greater flexibility to the operator in controlling points at a facility. 
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5.3.1 Control State Priorities 

In order to ensure consistency of operation within SiPass integrated, Control States 

must be given a priority. For example, it must be made clear that an Event Task 

with a Permanent Effect will not be overridden by a card-access attempt, but only 

by another Permanent Event Task. This avoids conflicts between simultaneous 

commands to points, as well as making access control even tighter. 

These Control States and their priority are listed below. “1” indicates the highest 

priority. 
 

Priority Control State Description 

1 Permanent Manual 
Command or Event 
Task 

A manual command or event task (Host or Controller) has been sent to a point and the 
Permanent option was selected. 

A point issued a Permanent Manual Command or Event Task will not change its 
operational state until: 

A new Permanent Event Task is sent to the point and the point is under Permanent 
Event Task control. 

A new Permanent Manual Command is sent to the point and the point is under 
Permanent Manual Command control. 

A “Cancel Permanent Action” command is sent to the point. 

A “Return to Time Schedule Control” command is sent to the point. 

The stated duration of the control state expires. 

2 Access/Internal Action A normal access or internal event that occurs at a point; for example, a card badge, or 
a PIR trigger. A point under Access/Internal Action Control Mode may remain in that 
mode for the defined period of time (e.g. a door is unlocked after a valid badge for the 
configurable delay period) or until one of the actions below: 

A Permanent Event Task or Command is sent to the point. 

A new internal or access event message is sent to the point; for example, a PIR input in 
alarm is restored by an operator. 

A “Cancel Permanent Action” command is sent to the point. 

A “Return to Time Schedule Control” command is sent to the point. 

3 Interruptible Manual 
Command or Event 
Task 

A manual command or event task (Host or Controller) has been sent to a point and the 
Permanent option was not selected. 

A point issued an Interruptible Manual Command or Event Task will not change its 
operational state until: 

A new Permanent Event Task or Command is sent to the point. 

A new Interruptible Event Task or Command is sent to the point. 

A new internal or access event message is sent to the point; for example, a PIR input in 
alarm is restored by an operator. 

The stated duration of the control state expires. 

A “Return to Time Schedule Control” command is sent to the point. 

4 Time Schedule Control The point remains in the operational state for the current Time Schedule as configured 
in the Components dialog. A point under Time Schedule Control will change its 
operational state in response to any of the above Control States. 
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5.3.2 Using Control States 

SiPass integrated stores a queue of Control State Commands for each point. This 

queue contains the last non-executed command of each Control State type. So, 

there will be four commands, at most, in the control state queue. 

When the current control state is terminated, the next control state in the queue will 

be executed as per the following rules: 

● Completion/termination of a Permanent command will restore the effect of: 

– The last Internal command, or 

– The last Interruptible command, or 

– Time Schedule Control 

● Completion/termination of an Internal/Access command will restore the effect of 

– The last Interruptible command, or 

– Time Schedule Control 

● Completion/termination of an Interruptible command will restore the effect of 

– Time Schedule Control 

Exceptions 

There are certain exceptions to the above rules. These are: 

● Change of Time Schedule State will terminate all current and non-current 

Interruptible commands. 

● Execution of a Permanent Manual command will terminate all current and non-

current Interruptible Manual commands. 

● Execution of a Permanent Event Task will terminate all current and non-current 

Interruptible Event Tasks. 

● Execution of the “Return to Time Schedule Control” command will terminate all 

current and non-current commands (Interruptible and Permanent) and return 

control to Time Schedule Control. 

Every unsuccessful change of Control State (for example, if the change is denied 

due to the above rules) is recorded in the Audit Trail. 
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5.4 Creating a Host Event Task 

A Host Event Task is a system related operation that is performed once certain 

conditions have been met. When you define a host event task, you define the 

conditions that must be met (Trigger) for the operation (Effect) to be executed. 

Host event tasks can be used to perform numerous system activities 

simultaneously. 

For example, a host event task can be used to control certain points in the system 

when other points change state. This might be useful to automatically secure an 

area when a security breach is detected at your site. In this case, a host event task 

could be defined in order to lock all the doors within a specified area when any 

sensor (intrusion detector) in that area enters an alarm state. 

An audit trail message appears when a host event task begins, and another audit 

trail message appears upon completion. 

 Ensure that you have configured all the components at your site that will trigger 

an event or execute a command when an event has been triggered. Also 

establish the Time Schedules to be used in the host event tasks. 

1. Choose Program > Event Tasks > Host. 

2. Enter a unique name for the host event task into the Event Name field. You 

may enter up to 40 characters, in any combination of upper and lower case 

letters, and numbers. There are two pre-defined host event tasks in the system. 

These are as follows: 

– Check Before Start Date Cards:  

Checks the Start Date in the cardholder record. The cardholder’s access 

control privileges are enabled if their Start Date is equal to or greater than 

the current date. 

– Check Expired Cards:  

Checks the Expiry Date in the cardholder record. If the Expiry Date has 

been reached, the cardholder will be voided. 

3. Select the Time Schedule in which the host event task is to occur. To select the 

Time Schedule, choose the drop down arrow and select a time zone from the 

list. 

– The effect a Time Schedule has on a host event task is detailed in the table 

at the end of this section. 

4. Specify the Trigger details. 

 The fields within the Trigger section of the dialog will depend upon the 

source type chosen. 

 Event Tasks based upon “Special Date” may take up to 15 minutes to 

trigger from the specified time. 

5. Complete the Effect details. 

6. Click Save. 
 

Time Schedule Description 

Never (point always 
secure) 

The host event task can never be triggered. 

Always (point 
unsecure) 

The host event task can be triggered at any time including holidays and weekends. 

System Function (non 
busy intervals) 

The host event task can only be triggered between 2 am and 3 am every day of the year including 
holidays. 
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5.4.1 Host Event Task Trigger fields 

The following fields are available when defining the trigger of Host Event Task. 
 

Field Description 

Source1 The item that will trigger the specified host event task. To change the first source, choose the 
drop down arrow and select a new source from the list. 

Location1 Specifies the location that will trigger the event. The available locations depend upon the 
source type selected. For example, if the source was an input event type, then only the input 
points defined in the system will be available. 

State1 The state into which the source must enter in order to trigger the event. The condition is also 
met when initialization occurs and the source is in the specified state. To change State1, 
choose the drop down arrow and select a new state from the list. 

Note: If you have entities of 3rd party systems that are integrated with SiPass integrated, the 
STATES of these entities can be uploaded and downloaded between the two systems. 

The STATE corresponding to the 3rd party system will contain the term ‘External System’ in 
the STATE 1 drop down list. 

For example, for the Access alarm type, 3rd party systems can have defined statues with the 
status Battery Low External System, Unlock External System, Door Held External System, 
Lock External System, etc. 

Additional Criteria When checked, additional criteria must be added and exist before an action takes place. 

Source2 Secondary source item required to trigger the specified host event task, only if the first 
condition has been met. The secondary source is Workgroup. 

Location2 Specifies the location that will trigger the event. This will be one of the work groups defined in 
the Database. 

 

5.4.2 Host Event Task Effect fields 

The following fields are available when defining the effect of a host event task. 
 

Field Description 

Target Specifies the type of item that the host event task will affect. To change the target, choose the 
drop down arrow and select a new target from the list. 

Location Specifies the name of the object that the event will affect. For example, if the specified event is 
unlocking a door, the target for such an event would be an output point and the actual door to 
be unlocked will be the location. To change the location, choose the drop down arrow and 
select a new location from the list. 

Command This is the command that will be performed on the target item when the host event task 
occurs. 

Data Specifies the data string for the command (if required). 

Message Message to appear on the Audit Trail when the host event task occurs. 
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5.5 Creating a Controller Event Task 

Controller Event Tasks are triggered by internal controller activities, and therefore 

can occur even when disconnected from the server. 

 Establish the Time Schedules to be used in the controller event task. 

 Ensure that your daily code is the same number of digits as the Base PIN 

length. 

1. Choose Program > Event Tasks > Controller. 

2. Enter a unique name for the Controller Event Task into the Event Name field. 

3. Select the Time Schedule during which the Controller Event Task will be able 

to activate, from the Time Schedule drop-down box. 

4. Specify the Trigger1 details. The fields within the Trigger section of the dialog 

will depend upon the Type chosen. 

– When selecting an Input point as the source for a controller based event 

task, the “Device” tasks will trigger from the actual activity at the point, 

regardless of the mode applied to that point. The “Logical” tasks will take 

into account the mode applied, for example if the point is disabled, and only 

operate based upon these modes, this means if the input point is disabled 

the event task will not run. 

5. Specify two triggers for a controller event task, by selecting from the Logical 

Operator drop-down box and completing the fields in the Trigger 2 section. The 

fields in the Trigger2 section are exactly the same as for Trigger1. 

– The Logical Operator options are detailed in the table at the end of this 

section. 

6. Complete the Effect details. The fields within the Effect section of the dialog will 

depend upon the source type chosen. 

7. Click Save. 

8. To create another controller event task with similar details, choose Copy. The 

event task details will be copied into a new controller event task. 

 

 

In most cases, by selecting zero, the data within the specified range of the event 

will allow a trigger on any card. 

 

 

Operator Effect 

None The fields in the Trigger 2 section will be disabled. 

AND Both Trigger 1 and Trigger 2 must occur before the Effect will be activated. Note that Trigger 1 
and Trigger 2 must occur within 2 seconds of each other if the AND operator is used. 

NOR Both Trigger 1 and Trigger 2 must occur, or both return to their original states, before the Effect 
will be activated. 

OR Either Trigger 1, or Trigger 2, or both must occur before the Effect will be activated. 

XOR Either Trigger 1, or Trigger 2, but not both must occur before the Effect will be activated. 
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5.5.1 Controller Event Tasks Trigger Fields 

The following fields are available when defining the trigger of a controller event 

task. 
 

Fields Description 

Type The type of event that must occur. 

Controller The controller connected to the source of the event. 

Source The controller or device that must undergo a change in state to trigger the effect. 

State The state into which the source must enter to trigger the effect. 

Data Any additional data that may need to be entered to identify the trigger. 

Credential Profile If the state being defined requires a Card Number, the Credential Profile field becomes enabled 
for the required profile to be selected from the field’s drop down list. 

Logical Operator This field specifies the state requirement for the effect to occur. The following options can be 
selected from the field: 

NONE: The configured Effect will occur if neither Trigger 1 or Trigger 2 states are true. 

AND: The configured Effect will occur if both Trigger 1 and Trigger 2 states are true. 

NOR: The configured Effect will occur if neither Trigger 1 or Trigger 2 states are true. 

OR: The configured Effect will occur if either the Trigger 1 or Trigger 2 state is true. 

XOR: The configured Effect will occur if either the Trigger 1 or Trigger 2 state is true, but NOT 
both. 

 

5.5.2 Controller Event Task Effect Fields 

The following fields are available when defining the effect of a Controller Event 

Task. 
 

Fields Description 

Type Specifies the type of component that the event task will affect. 

Controller Specifies the controller connected to the target of the effect. 

Target The component that will perform the Command if triggered. 

Command This is the command that will be performed when the event task occurs. 

Data Specifies a data string for the command (if required). 

Delay The delay time in seconds before the Command will be executed. 

Message This is the message displayed in the Audit Trail when the event task occurs. 
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5.5.3 Switching between Controller Event Tasks and  

Host Event Tasks 

Controller Event Tasks and Host Event Tasks generally correspond to different 

kinds of events. Controller Event Tasks are usually triggered by hardware related 

events, and Host Event Tasks are triggered by Global SiPass integrated 

conditions, like swiping a card or loss of communication to a controller. There is 

some overlap between the two types of event tasks. 

However, it is possible to create a flow-on effect, and cause a Host Event Task to 

be triggered by Controller Event Task conditions, and vice versa. This is done by 

creating a host event task and assigning it as a command (Effect) in a Controller 

Event Task. 

5.5.3.1 Triggering a Host Event Task from a Controller Event Task 

The various stages and steps required to trigger a Host Event Task from a 

Controller Event Task are detailed in this section. 

Stage 1: Creating the Host Event Task 

1. Choose Program > Event Tasks > Controller. 

2. Enter a unique name or select an existing host event task in the Event Name 

field. 

3. Select the Time Schedule during which the host event task will be able to 

occur, from the Time Schedule drop-down box. 

4. Select “ACC Control” from the Source1 drop-down box. 

5. Select “Activated” from the State1 drop-down box. 

6. Assign an ACC to this Host event task from the Location drop-down box. 

7. Complete the Effect section. 

8. Click Save. 

Stage 2: Creating the Controller Event Task 

1. Choose Program > Event Tasks > Controller. 

2. Enter a unique name or select an existing controller event task in the Event 

Name field. 

3. Select the Time Schedule during which the controller event task will be able to 

occur, from the Time Schedule drop-down box. 

4. Select “ACC Event Task” from the Type drop-down box. 

5. Complete the Trigger section. 

6. Select “Run Host Task” from the Type drop-down box in the Effect section. 

7. Select the Host Event Task, from the Target drop-down box. 

8. Complete the Delay and Message fields. 

9. Click Save. 

 When the specified Trigger occurs, the controller event task will execute the 

Host Event Task that you selected. 
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5.5.3.2 Triggering a Controller Event Task from a Host Event Task 

The stages and steps required to trigger a Controller Event Task from a Host Event 

Task are detailed in this section: 

Stage 1: Creating a Controller Event Task 

1. Choose Program > Event Tasks > Controller. 

2. Enter a new name or select an existing controller event task from the Event 

Name drop-down box. 

3. Select the Time Schedule during which the controller event task may be 

activated, from the Time Schedule drop-down box. 

4. Select “Host Control” from the Type drop-down box. 

5. Select the ACC Controller assigned to this controller event task from the 

Controller drop-down box. 

6. Select the state of the Host Event Task, which will trigger this controller event 

task, from the State drop-down box. There are two options: Cleared and Set. 

7. Complete the Effect section. 

8. Click Save. 

Stage 2: Creating the Host Event Task 

1. Select Program > Event Tasks > Controller. 

2. Enter a new name or select an existing controller event task from the Event 

Name drop-down box. 

3. Complete the Trigger section. 

4. Select “ACC Trigger” from the Target drop-down box in the Effect section. 

5. Choose either the “Set Trigger” state or the “Clear Trigger” state from the State 

drop-down box. 

6. Select the Controller Event task you defined in step 1, from the Location drop-

down box. 

7. Complete the Message field. 

8. Click Save. 

 When the specified Trigger occurs, the host event task will execute the 

Controller Event Task that you selected. 



 

 

Site Management 

Messaging 
5 

102 | 313  A6V101068156 

 

5.6 Messaging 

SiPass integrated can automatically send a message to a pager (or a similar 

paging system, like an intercom system), a GSM mobile phone or e-mail address 

when certain conditions have been met. This allows important events on the site to 

be registered, when no one is around to monitor them. 

The sections that follow explain the various steps required to configure and send 

messages to GSM mobiles, pagers and e-mail addresses. 

5.6.1 Messaging a GSM Mobile 

Configuring and sending a message to a GSM mobile allows selected personnel to 

be notified via SMS that a certain event / trigger has occurred. 

The first step required to configure this feature, is to add and configure Modem 

Hardware resources in SiPass integrated. 

Once the modem hardware is configured, operators can configure message 

forwarding to a GSM mobile in two ways: 

● Event Task Message Forwarding to a GSM Mobile 

● Alarm Class Message Forwarding to a GSM Mobile 

The sections that follow will take the user through all the steps required to 

configure SiPass integrated for this feature, and send messages. 

5.6.1.1 Configuring Modem Hardware Resources 

GSM Modems are mapped as hardware entities in SiPass integrated. These 

modems will first have to be added and configured to the system. 

1. Select System > Components. 

2. Click the New Bus button. 

3. Select Modems. 

4. Click the New Unit button. 

5. In the Modem Name field, add a name for the modem unit. 

6. From the Modem Type drop down list, select AT Command or Hayes 

Compatible Modem. 

7. From the Modem Port field, select a port. 

 This list displays all the modem ports that are available on the server. 

8. To view the Modem Status and Event History, click the View Modem Status 

button. To pause the scroll of Modem Event History messages, click the Pause 

History View button. 

 The Overall Modem Status will display one of the following statuses: 

Available, Malfunctioning or Busy. 

9. To return to view Modem Settings, click the View Modem Settings button. 

10. Click Save. 

 

 

If a GSM Modem is being used for Dialup Redundancy, it cannot be used for 

Short Messaging Services (SMS). 

A Modem unit cannot be deleted if it has an Alarm Class associated with it. 
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5.6.1.2 Event Task Message Forwarding to GSM Mobiles 

An operator can configure a Host Event Task to send messages to selected mobile 

numbers, when a certain trigger / event has occurred. 

 

 

The main pre-requisite to this feature is that the mobile number to which the 

message should be forwarded, must be specified on the Personal tab of the 

Cardholder dialog for the selected cardholders. 

Once the mobile number for the cardholder(s) has been specified, an event task 

can be configured in the Host Event Task dialog as described below. 

1. Select Program > Event Task > Host. 

2. Enter an Event Name. 

3. Select the appropriate Time Schedule. 

4. From the Source 1 drop-down list, select a required trigger source. 

5. From the State 1 drop-down list, specify a required state. 

6. From the Effect drop-down list, select Message Forwarding. 

7. From the Command field, select Forward to GSM Mobile(s). 

8. All the cardholders, whose mobile number have been entered in the 

Cardholder dialog, will be displayed in the Cardholder box field. 

9. Select a Cardholder(s). 

10. In the Message field, type a message that will be forwarded to the cardholder’s 

mobile on event trigger. 

11. Click Save. 

5.6.1.3 Alarm Class Message Forwarding to GSM Mobile(s) 

An operator who wishes to setup Alarm Class Message Forwarding will need to 

perform two main configuration activities: 

● Configure an Alarm Class to forward a message on State change 

● Assign a point to the Alarm Class 

These steps required for these two configurations will be discussed in this section. 

 

 

The main pre-requisite to this feature is that the mobile number, to which the 

message should be forwarded, must be specified on the Personal tab of the 

Cardholder dialog for the selected cardholders. 
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Configuring an Alarm Class to forward message on State change 

1. Select Program > Alarm Class. 

2. Specify an Alarm Definition Name. 

3. Specify an Alarm Type in the Type field. 

4. Tick the Forward to GSM Mobile(s) checkbox. 

5. In the box below this checkbox, specify the cardholders to whom the message 

should be forwarded. 

6. Specify the state change in the Current Defined States section. 

7. Click Save. 

Configuring an access point for the alarm class 

1. Select System > Components. 

2. In the tree hierarchy, navigate to the access point configured for the alarm 

class. 

3. In the Alarm Definitions field, select the Alarm Class that was configured for 

message forwarding. 

4. Click Save. 

Once these two configurations have been implemented, a state change will raise 

an alarm. This in turn, will forward a message to the selected GSM mobile(s). 

5.6.2 Configuring Message Forwarding to a Pager or Email 

Address 

Configuring and sending a message to a pager or mobile service is a three-stage 

process that includes Configuring the Service Provider, Configuring Cardholder 

information and Creating the Event Task to handle the paging scenario. 

Configuring and sending a message to an email address is a two-stage process 

that includes configuring cardholder information and creating the event task to 

handle the email forwarding. A connection between SiPass integrated and an 

Email Server must be present to allow messages to be forwarded to email 

addresses. 

5.6.2.1 Step 1 - Configuring Service Providers 

1. From the System menu, select Messaging and then select Service Providers. 

2. Enter the Service Provider Information. 

– You may need to contact your chosen service provider for the correct 

details to complete this section. 

3. Enter the Dial-Up Parameters. 

4. Enter the Local Parameters. 

 

 

If a modem on the SiPass server is deleted, you will need to re-configure your 

service provider details. 
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Service Provider Configuration Fields 

The fields used to configure Service Providers are given below: 
 

Field Description 

Service Provider Name Enter the name of the service provider. 

Service Provider 
Password 

Enter the password for access to the Service Provider. Note that not all Service Providers will 
require a password. If a password is not required, this field will be ignored. 

Maximum Messages per 
Session 

Select the maximum number of messages able to be sent per session using the up and down 
arrows. This will package multiple messages for the same service provider into a single phone 
call. That is, you can send the same message to multiple cardholders’ pagers with one call. 

Disable Service Provider Tick this checkbox if you wish to disable the Service Provider 

Use Dial-up Un-tick this checkbox if you want to send messages via a method other than dial-up modem. 
This could be via a paging or similar device that is compliant with the standard automatic TAP 
protocol. 

Port This field will be enabled only if the Use Dial-Up checkbox has been un-ticked. Select from the 
list the Com Port on the PC to which the TAP-compliant messaging device is connected 

Service Provider Phone 
No 

Enter the phone number for the Service Provider. 

Modem Select the modem to be used for sending the message from the drop-down list. You will need 
to install and configure an appropriate modem on the SiPass Server before you can select it 
for messaging. Please consult your System Administrator for more information regarding the 
installation and configuration of a modem. 

Port Select the port number on the workstation connected to the messaging or paging device. This 
field will only be enabled if the Use Dial-up checkbox in the Service Provider Information 
section has been un-ticked. The Service Provider details will be saved 

 

5.6.2.2 Step 2 - Configuring Cardholder Details 

To enable SiPass integrated to send a message to a cardholder, the cardholder’s 

pager number, mobile number or email address must be entered as part of their 

cardholder details. 

Do one of the following: 

● Ensure that the Mobile Number and Mobile Service Provider fields are 

completed if you wish to send messages to the cardholder’s mobile phone. 

● Ensure that the Pager Number and Pager Service Provider fields are 

completed if you wish to send messages to the cardholder’s pager. 

● Ensure that the Email Address and Use Email in Message Forwarding fields 

are completed if you wish to send messages to the cardholder’s email address. 

● Ensure that the Manager Email Address field is completed if you wish to send 

messages to the email address of the cardholder’s Manager. 
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5.6.2.3 Step 3 – Creating the Messaging Event Task 

The final step in configuring the SiPass integrated messaging component is to 

create an Event Task. This will allow you to configure the System Components that 

trigger a message, the recipient of the message and the message itself. 

1. Choose Program > Event Tasks > Host. 

2. Enter a unique name for the event task into the Event Name field. 

3. Select the Time Schedule during which messages can be sent. 

4. Specify the Trigger details. 

5. Select Message Forwarding from the Target drop-down list. 

6. Select Forward to Pager(s) from the Command drop-down list to send a 

message to a pager or a mobile phone. 

7. Select Forward to Email(s) from the Command drop-down list to send an email. 

8. Select the cardholder to whom the message will be forwarded from the 

Location drop-down list. 

– Only cardholders with a valid service provider (mobile or pager) configured 

in their database record will be selectable. 

9. Enter the text message to be sent to that cardholder’s mobile phone and/or 

pager into the Message field. 

10. Click Save. 

Each text message is formatted by SiPass integrated before being sent to the 

Service Provider for paging, including adding a date and time stamp, and UserID. 

Different Service Providers may process the entire message, text plus formatting, 

in a different manner. For example, characters or strings that have a particular 

meaning to the Service Provide, can be inserted into the Message field. For more 

information on using the Message string in such a way, consult the documentation 

for your Service Provider’s supported protocol. 

Note: Both SMTP and Microsoft Exchange protocols are supported. For Email 

Messaging setup, see section Notify Email Tab [➙ 22] in this document. 
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5.7 Intrusion Areas 

Intrusion areas allow cardholders to control whole groups of points (known as 

areas) through any device in SiPass integrated. Cardholders are able to secure 

and unsecure intrusion areas with the right access privileges. 

5.7.1 Configuring an Intrusion Area 

 Ensure that the input access points have been configured on the desired 

components. Please refer the Defining Access Points [➙ 65] section of this 

manual. 

 Ensure that arming and disarming of the selected areas has also been 

performed. 

1. Select Intrusion Area from the System toolbar or menu. 

2. When adding a second or subsequent Intrusion Area, you will need to select 

New on the bottom left hand side of the Intrusion Area dialog. 

3. Enter a unique name for the Intrusion Area into the Name field. 

4. Enter an abbreviated version of the name above under Short Name. This will 

be used for display on the reader’s LCD screen. This option has been included 

to allow for future development. 

5. Select the alarm class that will apply to this intrusion area from the Alarm Class 

drop down box. 

6. Select the Time Schedule that will be applied to the intrusion area. 

– Never (Point always Secure): The area is secured. 

– Always (Point always unsecure): The area is always unsecure 

– System Function (Non-busy intervals): The area will become unsecure 

between 2am and 3am everyday of the year including holidays 

7. Select the Arming Time Schedule Off/On state. 

– Arm/Disarm: Area will be armed when the Time Schedule is not active and 

disarmed when the Time Schedule is on. 

– Arm/Part Arm: Area will be armed when the Time Schedule is not active 

and only Part Armed when it’s on. 

– Part Arm/Disarm: Area will be Part disarmed when the Time Schedule is off 

and completely disarmed when it’s on. 

8. Enter the Entry Delay in seconds which will delay the alarm when the 

cardholder walks into the area. Also enter the Exit Delay to specify the time in 

exiting the area before the input points become enabled and an alarm can be 

reported. 

– This is only enabled when the Entry/Exit Delay operational mode is 

selected. 

 The ID field displays the intrusion area ID in read only mode. 

9. Click on the Intrusion Area Members Tab 

10. Select the Unit from the drop down box which displays all available ACC units. 
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11. Select the Type of member that can be assigned to an Intrusion Area. 

Selecting a type changes the Available List accordingly. The type of members 

that can be selected are the following: 

– Input Points: All available input points that had been set for intrusion 

operation through the components dialog or whose operation mode is set 

to Input Disabled. 

– Entry Lockout Points: All available access points 

– Dependent Intrusion Areas: All available intrusion areas 

 Note: With SiPass integrated MP 2.80 onward, the Door Frame Input 
Points (Door Contact point) can be assigned to the Intrusion Areas. Once 

the Door Frame points have been defined as Input Points while setting up 

devices through the Components dialog, these “Door Frame” points are 

available for inclusion in an Intrusion Area. For example, you can include a 

door contact point in an Intrusion Area in case where the building main 

entry is a SiPass Access Point, and a forced entry will trigger the intrusion 

area alarm. 

12. Select the unit and point from the list displayed in the top window by clicking 

once on that unit/point. 

13. Click on the Intrusion Area Link to display a drop down box for the intending 

arming action for that point 

– Arm: The area will be completely armed. 

– Partitial Arm: Any input points that have been assigned to an intrusion area 

as Partially armed points will enter an alarm state when Partial Alarm is 

selected. 

 

 

Part Arming can only be selected for input point types. 

14. The selected unit will appear on the window below. Once you have finished 

adding units, select Save. To remove any units, select the unit and select 

Remove. 

15. You will now need to configure cardholder’s permissions for the intrusion area. 

Please refer to the details regarding Isolation in the section Definition Tab in 

this manual. 

 Once an area is configured, it will be displayed on a tree on the left hand 

side panel of the dialog. 

 

 

The armed state of a native intrusion area is retained only if the area was armed 

by a Time Schedule. Otherwise the armed state of the native intrusion area is not 

retained. However this does not affect the armed state of external intrusion areas. 
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5.7.2 Viewing the details of an input point 

1. Once you have set up an Intrusion Area, select it from the tree on the vertical 

panel on the left hand side of the dialog. 

2. Expand the tree until the points are displayed. 

3. Select the point to view its details. On the right hand side panel, the Point 

Details are displayed: 

– Name: Displays the point’s name 

– Operation mode: Displays the point’s operation mode. 

 

 

Once you have configured the Intrusion Area, you will need to give cardholder 

privileges to the new areas by configuring the cardholder preferences. Refer to 

the section in this manual under Access level and Cardholder privileges. 
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5.8 Door Interlocking 

Door Interlocking is a mode of operation for multiple doors that lock together with a 

multiple set of rules. By combining a set of doors into a single interlocking set, you 

can ensure that only 1 door can unlock at any given point in time. Once this door is 

unlocked by a cardholder, all other doors configured in the same set will remain 

locked, even if a valid cardholder presents their access card. 

 

 

All doors in an interlocked set must be configured on a single ACC. 

 

5.8.1 Configuring a Door Interlocking Set 

 Ensure that the doors (devices) have been configured for the desired doors. 

1. Select Door Interlocking from the System toolbar or menu. 

2. Click the New button located at the bottom of the dialog. 

3. Enter a new Name for the Door Interlocking Set. 

4. Select the alarm class that will apply to this Door Interlocking Set from the 

Alarm Class drop down box. 

5. Select the Members tab to begin choosing the doors that will become part of 

the interlocking set. 

6. Select the ACC from which the doors will be selected using the Controller Unit 

drop down list. 

 All doors available for selection will appear in the Available list box. 

7. Select the doors to be added to the set by clicking on the appropriate names of 

the readers belonging to that door (holding the CTRL key down will allow you to 

select multiple doors at the one time. 

8. Click the Add button to add the doors to the Selected Doors list box. 

9. Click Save. 

 

 

A door can only be configured to any number of Door Interlocking Sets. 

 

5.8.2 Configuring the Delay Time for an Interlocked Door 

1. Select Door Interlocking from the System toolbar or menu. 

2. Click the + button to expand the Door Interlocking set your door belongs to. 

3. Select the door you wish to modify from the list. 

4. Enter the Delay Time by typing a value into the field or clicking the up and 

down buttons. 

5. Click Save. 
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5.9 External Alarm Monitoring 

The External Alarm Monitoring (EAM) function allows SiPass integrated to 

communicate with an external alarm monitoring company. To configure this, a set 

of external alarm monitoring points need to be set up to respond to state changes 

from input points, as well as intrusion zone points, and any groups of these points. 

5.9.1 Configuring an External Alarm Monitoring unit 

 Ensure that you have configured any necessary input points, and intrusion 

zone points. 

 Ensure that a set of external alarm monitoring points has also been configured. 

1. Select External Alarm Monitoring from the System toolbar or menu. 

 The Bus Details tab will appear and the Bus Name will be displayed. This is 

a read only field. 

2. Expand the tree under ACC Controllers until the ACC’s are displayed. The 

ACC Details tab will display: 

– Name: Displays the name of the ACC configured. Read Only field. 

– IP Address: Displays the IP address of the ACCC. Read Only field. 

– Serial Number: Displays the Serial number of the ACC. Read Only field. 

3. To set up a new External Alarm Monitoring unit, select New EAM Unit. 

4. Complete the following Unit Details: 

– Name: Enter a unique name to identify the External Alarm Monitoring unit. 

– Hard ID: Enter a unit ID used to initialize the External Alarm Monitoring unit. 

– FLN Port: Displays the FLN port that the external alarm monitoring unit can 

be connected to. Only an ISB port can be used. Read Only display. 

– Baud Rate: Select the baud rate at which the unit will transmit data. 

– Protocol: Select the list of protocols for the unit, only Securitel is available 

in this version. 

 The Auto Creation Wizard link launches a wizard for an automotive creation 

process. 

 

 

On Granta hardware, external alarm monitoring can be configured on only FLN 1, 

FLN 2 and FLN 3. Any of these three FLNs can be used to configure Securitel on 

the Granta unit. 

5. Click Save. 

 A new External Alarm Monitoring unit has been added. 
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5.9.2 Configuring an External Alarm Monitoring unit using the 

Auto Wizard 

1. Select External Alarm Monitoring from the System toolbar or menu. 

2. Expand the tree under ACC Controllers and select EAM. 

3. Select the Auto Creation Wizard link. 

4. Select Next to begin the wizard. 

– You can exit the Auto Creation Wizard at any time by selecting Cancel from 

this point onwards. 

5. Complete the following fields on the dialog: 

– Point Type: Select the point type for the unit from the dropdown list 

– Include Tamper Events (Input Points only) checkbox: This box is only 

enabled for input points. Ticking this checkbox will create 2 additional 

points for “Short” and “Open” event types which are two new alarm states 

that an input point can be in. 

– Point List: Select the points to be added to the unit from the list. More than 

one point can be selected. 

– Time Schedule: Select the Time Schedule that will be assigned to the 

External Alarm Monitoring point. 

– EAM Type: Read only. This field specifies the event type for the selected 

point. If an Input Point or Input Point group is selected only Alarm/Normal 

even types, will be displayed. If an Intrustion Point or Intrusion Point group 

is selected, only Secure/Unsecure event types will be displayed. 

– User ID: This field is only visible for Intrusion points. Specifies the User ID 

that triggered the Secure/Unsecure events. 

6. Select Next when all the necessary fields are complete. 

 This dialog allows you to configure the External Alarm Monitoring events. 

7. Complete the following Fields: 

– Point Number: Specify the point number that will be reported to the alarm 

monitoring company. This is an identifier for the alarm company and it 

doesn’t match the point number in configuration in SiPass integrated. 

– Allocated Point Number: Read Only. This number ranges from 1 to 255 and 

it is automatically assigned to an allocated number. 

– Point Description: Specifies the event name for each event type and point. 

Automatically generated but can be edited. 

– Sample Event Name: Read Only. Specifies the event name for each type 

and point 

– Sample Message: Read Only. Specifies the event message name that will 

appear in the active audit trail window when the event occurs in the system. 

– Reset to defaults button: This button resets all the fields to its default and 

automated entries. 

8. When finished, select Next, successively for each point, until they’re all 

complete. When you reach the last point, select Finish. 

9. The External Alarm Monitoring points have now been configured. 

10. To add subsequent units, you can use the New button located on the lower 

right hand side of the dialog. 
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5.9.3 Configuring External Alarm Point details 

1. Select External Alarm Monitoring from the System toolbar or menu. 

2. Expand the tree under ACC Controllers, until the EAM units are displayed. 

3. Select any of the EAM units. 

4. To add subsequent units, use the New button located on the lower right hand 

side of the dialog. 

5. Click Save. 
 

Field Description 

Event Name Displays the name of the event, automatically generated if point was created using the Auto 
Wizard. 

Time Schedule Select from the list of available time schedules that can be assigned to the event. 

Point Type (Trigger 1 
and Trigger 2) 

Select a member (input points, input point group, area point, area point group) that can be 
assigned to this event. 

Source (Trigger 1 and 
Trigger2) 

Displays the list of available points, depending on the Point Type selected above. 

Event Type (Trigger 1 
and Trigger 2) 

Displays the list of states that can be assigned to the External Alarm Monitoring point. Select from 
Alarm, Normal, Secure and Unsecure. 

Logical Operator: This specifies if the second trigger (Trigger 2) is enabled. It is only enabled if the Point Type is an 
Input or Intrusion point. The list of available operators is below. 

● NONE: When selected the second trigger (Trigger 2) is enabled. 

● AND: This enables the second trigger (Trigger 2). When selected, the event will only take effect if the first 

and second trigger event occur simultaneously. 

● OR: Enables the second trigger (Trigger 2). When selected, the event will only take effect if either the first 

or second trigger event occurs 

Message Specifies the message that appears in the active Audit Trail window when the event occurs in the 
system. This is automatically generated if the point was created using the Auto Wizard 

Point Number: This specifies the point number that will be reported to the alarm monitoring company. This is 
automatically generated if the point was created using the Auto Wizard. 

EAM type This is the notification that is sent to the alarm monitoring company. Select from four alarm types: 
Alarm, Normal, Secure and Unsecure. 
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6 Personnel Management 
SiPass integrated operators and cardholders make up the personnel at a SiPass 

integrated site. Operators are grouped by Operator Groups, and Cardholders are 

grouped according to Work Groups. This information is defined in the SiPass 

integrated system. 

The SiPass integrated system contains information about the personnel who use 

the site and about the site itself. The system uses this information to accurately 

monitor events, and to display detailed information about personnel to authorized 

operators. For these reasons, it is essential to keep the SiPass integrated system 

up-to-date. 

6.1 Operator Groups 

To limit the access an operator has to records contained in the SiPass integrated 

system, each operator must be assigned to an Operator group. Members of an 

Operator Group are conferred a required level of access / privileges to the system, 

to carry out their jobs. 

The concept of separating the privileges that Operator Groups have is called 

Operator Partitioning. 

 

 

When an operator is created, that operator must be assigned to an operator 

group. The operator will then be assigned the privileges defined for that group. An 

operator can only grant the same or a subset of the privileges belonging to their 

own operator group 

 

6.1.1 Creating an Operator Group 

Creating an Operator group includes assigning an operator group name, 

establishing the viewable Audit Trail events, System Functions, Access Controls, 

Password Complexity Rules and available Site Plans. 

When creating an operator group, the system administrator will only be able to see 

and grant access to those functions to which their own operator group has access. 

There are 3 key areas to fill out: 

● General: Determines password restrictions and audit trail viewing 

● Operator Functions: Determines which system functions and cardholder fields 

are available 

● Partition Functions: Determines which objects in the system are available 
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Important 

The SiPass Operator Groups should not be created as the following from the 

SiPass integrated system: 

● sipasszone_admin 

● um_admin 

● sipasszone.admin 

● sipasszone.user 

● um_resetPassword 

● UM.StartApp 

● UM.ViewUsersAndRoles 

● UM.AssignRoles 

● UM.ManageUsers 

● UM.ManageRoles 

● UM.AssignPermissons 

● UM.ViewPermissions 

● UM.ViewIdentityProviders 

● UM.ManageIdentityProviders 

● UM.PasswordReset 

● Access.UAM.DefaultSipassUaaPermissions 

Note: If the operator name and operator groups are created as above, the operator 

and operators groups cannot be synced with UAA. 

To create an Operator Group 

1. Select Operator Group from the Program toolbar to display the Operator Group 

dialog. 

2. Complete the fields in the General section. 

 

 

If some operator group options are changed, any operator who belongs to that 

group and is currently using a Client must log off and then log back on before the 

changes take effect. 

3. Select Cardholder Fields to assign some or all of the cardholder fields to this 

operator group. For example, you might not want one operator group to be able 

to view cardholder PINs. 

– Once a field is selected you can double click it to change the privilege from 

[v] (View) to [e] (Edit) 

 

 

Changing the privileges is not supported for the Imaging field. When selected, all 

the privileges (create, view and edit) are applicable for the field. 

4. Select System Functions to assign some or all of the system functions to this 

operator group. For example, you need to add the Cardholder System function 

if you want this operator group to modify cardholder records. 

5. Select a function and click Add to add just the one, or click Add All to add them 

all at the same time 
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6. Select the level of privilege, by double-clicking on the system function, to 

change the privilege level. 

– c (Create): Allows members of the group to create, delete and view 

database records. 

– v (View): Allows members of the operator group to view the records only. 

– e (Edit): Allows members of the group to view and modify existing 

Database records. 

7. Select Audit Trail Reports if your operator group has access to reporting 

functions. 

– Select the Audit Trail Reports over which the operator has control. 

8. Select Device Group, to assign device groups to your operator group. 

– These are like a point group but for devices. The operator group requires 

access to a device via a Device Group to view and modify the device. 

9. Select FLN Group to assign FLN groups to your operator group. These are like 

a point group, but for FLNs. The operator group requires access to an FLN via 

a FLN Group to view and modify it. 

10. Select Holiday to assign your system defined Holidays to an operator group. 

Operators can only view and modify holidays that they have privileges to. 

11. Select Site Plan to assign site plans to your operator group. This defines which 

site plans they can view and modify. 

12. Select Point Groups to assign point groups to your operator group. Please note 

this will affect the points an operator can see. 

 

 

To be able to view an Access Group, the operators should have view (v) 

privileges for all the Access Levels that belong to that Access Group. 

To be able to view an Access Level, the operators should have view (v) privileges 

for all the Point Groups, Points, etc. that belong to that Access Level. 

To be able to view/update a Point, the operators should have at least one Point 

Group containing that Point assigned to their Operator Group. 

13. Select SiPass Explorer Items to assign appropriate privileges for individual 

SiPass Explorer items to your operator group. 

14. Select Time Period to assign specific time periods to your operator group. 

15. Select Unit Group to assign Unit groups to your operator group. These are like 

a point group but for Units. The operator group requires access to a Unit via a 

Unit Group to view and modify it. 

16. Select Work Groups to assign Work Groups to your operator group. 

 

 

Only Partition Work Groups will be listed here for Operator Partitioning. 
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17. Select the work groups over which the operator has control. 

 Only those cardholders that belong to the assigned work groups can be 

administered by the Operator. If no workgroups are assigned to an operator 

group, that operator group will be unable to create cardholder records. 

 

 

When a card is badged, the operator group’s point permissions (of the reader) 

and workgroup permissions (of the cardholder) are considered when deciding if 

the audit trail entry is displayed or not. The option to consider workgroup 

permissions is based on the following entry in the SiPass configuration file: 

<!-- This defines Operator Group Privileges to workgroups 

addition --> 

<add key="AuditTrail.UseWorkgroupPartition" value="true"/> 

By default, the above setting is True. In this case, any audit trail entries (including 

reports) relating to cardholders that do not belong to these assigned work groups 

will not appear when the Operator is logged on. 

To see audit trail entries for all the cardholders, irrespective of the cardholder’s 

workgroup permissions, this setting must be set to False. Note that point 

permissions of the operator will still be considered when displaying audit trail 

entries for the cardholders. 

1. Select Component Group to assign Component Groups to your operator group. 

2. Click Save. 

6.1.1.1 General Details 

This table lists the general details that can be changed. These include the group 

name, lockout status, audit trail viewing and password complexity. 
 

Setting Description 

Operator Group Name This is a unique Name for the Operator group. You may enter up to 40 characters, in any 
combination of upper and lower case letters and numbers. 

Group Lock Out When checked, this denies access to the SiPass integrated system to all members of the 
specified operator group. This check box is only available to administrators and members of 
an operator group that have privileges within the group displayed. You cannot lock out your 
own operator group. 

Logon/Logoff When checked, logon and logoff activities will appear in the Audit Trail – All window for the 
Operator Group currently being configured. 

Comms actions When checked, communications activities will appear in the Audit Trail – All window. Included 
are comms related activities such as initialization, comms lost, comms restored, dial up activity 
and other general communications events. 

Alarm actions When checked, information regarding alarms that have been received, actioned or waiting to 
be actioned, etc. will appear in the Audit Trail – All window. Many of these messages are “free-
form” text. 

Database actions When checked, Database events such as Adding, Editing or Deleting records, and Backing up, 
Restoring or Purging activities will appear in the Audit Trail – All window. 

Event Task When checked, all types of event task related messages, many of which are “free-form” text, 
will appear in the Audit Trail – All window. 

Detailed Logging When checked, displays detailed Audit Trail information when records are updated. 
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Setting Description 

Min. Password Age (days) Specifies the minimum number of days after the operator has changed the password before it 
can be changed again. 

Min. Password Length Specifies the minimum number of characters allowed in the password 

Logon Retries Specifies the number of allowed logon attempts with the wrong password before the operator 
account is locked out. 

Max. Password Age (days) Specifies how old the password can be before the operator is forced to change it. 

Account Lockout Duration 
(mins) 

Specifies how long an operator account is locked out when the logon retries are exceeded. 

Password Complexity 
Check 

Turns the password complexity check on and off. When the complexity check is turned on the 
password must include three of the following character types: 

● Number (e.g. 1234) 

● Special character (e.g. !%$#) 

● Uppercase character (e.g. A) 

● Lowercase character (e.g. a) 

Enforce Backup 
Encryption 

When unchecked for the Operator Group, the encryption key for the backup file must be 
entered every time while taking a backup. 

When unchecked for the operator with Administrator rights, the encryption key can be entered 
on the Host Base Event Task dialog when creating a host base event task for backup. 

When unchecked, unencrypted backup cannot be taken. 

Note: Only the Operator with Admin rights can change this option. 

Min. Backup Password 
Length 

Specifies the minimum number of characters allowed in the backup file password. 

Backup Password 
Complexity Check 

Turns the backup password complexity check on and off. When the complexity check is turned 
on, the backup password must include three of the following character types: 

● Number (e.g. 1234) 

● Special character (e.g. !%$#) 

● Uppercase character (e.g. A) 

● Lowercase character (e.g. a) 
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6.1.2 Report Privileges 

The Report privileges are handled like a tree. You can assign privileges to a folder, 

a specific report or a folder plus reports. The following privileges apply: 
 

Privilege Folder Report 

View [v] Report folder will be visible to the operator in 
SiPass integrated. 

Report will be visible to the operator in SiPass 
integrated. 

Edit [e] Report folder can be modified by the operator in 
SiPass integrated. 

Report can be modified by the operator in 
SiPass integrated. 

Create [c] Reports can be created by the operator within 
this folder in SiPass integrated. The operator 
can also delete the folder. 

Report can be deleted by the operator in SiPass 
integrated. 

 

To give Reports privileges to an Operator Group: 

1. Ensure the Report section is opened in the Operator Group dialog and the 

correct Operator Group is selected. 

2. Select a report or folder from the Reports tree and click Add > or Add Hierarchy 

>>. 

– Add > just adds the selected folder or report. 

– Add Hierarchy >> adds the selected item and all its child elements in the 

tree. 

3. Right click the folder or report and select View, Edit or Create to modify the 

privilege assigned. 

4. Remove unwanted reports or folders by selecting the item and clicking Remove 

> or Remove Hierarchy >>. 

– Remove > only removes the selected folder or report. 

– Remove Hierarchy >> removes the select item and all its child elements in 

the tree. 

5. Click Save. 
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6.2 Operators 

Operators are responsible for maintaining the System Database, and monitoring 

the site. They must have access to system information, but there may be 

occasions where you wish to impose limits on what an operator can change. 

Operator Privileges determine whether an operator can view, edit or create a wide 

range of information on the Database. These privileges are assigned to Operator 

Groups. When you define an Operator Group, you define its privileges, which then 

apply to all operators in that group. 

6.2.1 Adding Operators 

Adding an operator to the system includes providing the operator with a user 

name, assigning them to an appropriate operator group and designating a Time 

Schedule during which they may log onto the system. 

 Ensure that all the operator groups have been established, along with the 

appropriate privileges. Each operator must be assigned to an operator group. 

1. Select Operator from the Program menu. 

2. Complete the operator’s identification details. 

3. (Optional) Complete the automatic logon details. Use the Windows logon to log 

into the SiPass workstation. Tick this checkbox to enable the operator to log 

straight into the SiPass client from Windows, without having to enter a new 

username and password. 

 A Select User dialog will appear, prompting you to select a domain and 

user. 

 

 

Note: The Operator name should not be created as ‘Admin’ from the SiPass 

integrated system. 

4. Complete the operator’s access details. 

– The Time Schedule table at the end of this section provides an example of 

the effect that a Time Schedule has on an operator. 

5. By right-clicking anywhere inside the Operator dialog, the General tab of the 

System Preferences dialog appears. This allows you to change the default 

operator expiry date. 

6. Click Save. 
 

Time Schedule Description 

Never The operator can never log on to the SiPass integrated system. 

Always The operator can always logon. 

System Function The operator can only log on between 2 am and 3 am every day of the 
year including holidays. 
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6.2.1.1 Operator Details 

The following table lists the operator details that can be set. 
 

Detail Description 

Last Name Operator’s last name. You may enter up to 30 characters, in any combination of upper and 
lower case letters and numbers. 

First Name Operator’s first name. You may enter up to 20 characters, in any combination of upper and 
lower case letters and numbers. 

User Name The operator’s user name is required when logging on to SiPass integrated. The user name 
must be unique to the system. You may enter up to 20 characters in any combination of upper 
and lower case letters and numbers. 

Password The operator’s password is required when logging on to SiPass integrated. The password is 
encrypted and appears as asterisks on screen. You may enter up to 128 characters in any 
combination of upper and lower case letters, numbers and symbols. The password is case 
sensitive and is required each time the operator logs on to the SiPass integrated system. 

Confirm Password Confirmation of the operator’s password. Unless the entry into the Confirm Password field 
matches the entry into the Password field, the operator’s record will not be saved in the 
system 

Use the Windows logon to 
log into the SiPass 
workstation 

When ticked, the user will be automatically logged-in as operator if already logged in as a 
Windows user on that same computer. 

Operator Group Specifies the operator group to which the operator will be assigned. The operator group 
determines the level of access and the privileges the operator has available when using 
SiPass integrated. To assign an operator group, choose the drop down arrow and select a 
group from the list. 

Time Schedule Specifies the Time Schedule during which the operator can log on to the SiPass integrated 
system. 

Expiry Date The date after which the operator’s log on access is denied. To change the date, choose the 
drop down arrow and select a new date from the displayed calendar. To disable the expiry 
date (the operator will always have log on privileges), simply de-select the checkbox. 

Change password next 
login 

The user wil be asked to provide a new password when logging-in next time. 

Operator Lock Out When checked, the operator is denied access when attempting to log on to the SiPass 
integrated system. If the operator has been locked out, a dialog will appear informing the 
operator that they have been denied access to the SiPass integrated system. If an operator is 
locked out, only an operator that belongs to the Administrator operator group or a group with 
higher privileges can change this setting. 

Technician This checkbox is read-only and will be checked only if the Technician Operator Group has 
been selected. This group is not available in a default installation. 

Password Never Expires When checked the operators password will never expire and will always work on this account. 

Can’t Change Password When checked means the operator can not change their password at logon by selecting the 
Change Password button. 
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6.2.2 Searching for an Operator 

SiPass integrated allows you to search the Database for a specific operator based 

on details you supply about that operator. The more details you supply, the 

narrower the search becomes and there is less chance of more than one matching 

record being found. The Search function will only reveal those operators who are 

present in an operator group to which you have privileges. 

Searching the Database for an operator’s record will be more efficient and quicker 

if you provide as much information about the operator as possible to narrow the 

search. 

1. Choose Operator from the Operator toolbar or the Program menu to display the 

Operator dialog 

2. Enter all or part of the details known about the operator into the respective 

fields displayed in the Operator dialog. Data may be entered into more than 

one field to narrow the search. 

3. Choose Search to begin the Database search. 

 The Operator Records dialog will appear if more than one operator’s record 

matches the search criteria. If only one record matches the search criteria, 

then that operator’s information will be displayed directly in the Operator 
dialog. 

 Only those operator records to which you have access will be displayed. 

The Search button is only visible when a record is not currently displayed. 

The Search button changes to a “Reset” button when an operator record is 

displayed. To clear the dialog fields and perform a search, choose either 

Reset or Clear. 

4. To select an operator from the Operator Records dialog, double-click anywhere 

on that operator’s row, or select the operator and choose OK. 

 The selected operator’s record will be retrieved from the Database and will 

appear in the Operator dialog.
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7 Site Monitoring 
SiPass integrated allows you to monitor and control your site using a number of 

powerful and easy-to-use tools. Primarily, you monitor activity at your site with 

Active Audit Trail or a Site Plan. (To view, edit and operate any of your sites using 

Site Plans, you must have the optional Graphics Module installed.) Your site is 

constantly monitored in the background using the SiPass integrated alarm system, 

which immediately informs you of alarm situations. 

7.1 SiPass integrated Alarm System 

The SiPass integrated alarm system monitors your site via points, groups and 

units. If one of these elements changes its state, you can configure an alarm to 

activate. You can also establish the method used to handle this alarm and it’s 

priority level. 

7.1.1 Creating an Alarm Class 

An Alarm Class allows you to be notified of a change in state at a particular point, 

or group of points. The Alarm Class allows you to determine how the operator is 

notified of the door violation, and the way in which they must handle the alarm. 

1. Choose Alarm Class from the Program toolbar or menu. 

2. Enter a unique name for the alarm class into the Alarm Definition Name field. 

You may enter up to 40 characters, in any combination of upper and lower 

case letters and numbers. 

3. Select the type of alarm class from the Type field. To change the alarm class 

type, choose the drop down arrow and select a new type from the list. 

4. Select the color you want the message text to be when displayed on the Alarm 

Queue screen. Choose the Alarm Display Color button, and select a color from 

the palette. 

5. Select the background color you want the message background to display on 

the Alarm Queue screen. Choose the Select Alarm Background Color button 

and select a color from the palette. 

6. Complete the Alarm Handling details. 

7. To change the alarm priority, choose the drop down arrow and select a new 

alarm priority from the list. 

8. Specify the Instruction File Name. Details the file name of the alarm 

instruction(s) that may be retrieved by the operator when the alarm is triggered. 

To change the file name, choose the drop down arrow and select a new file 

name from the list. 

9. Specify the Sound File Name. Details the file name of the sound file to be 

played when the alarm is triggered. To change the sound file, choose the drop 

down arrow and select a new sound file from the list. If no file is specified, the 

default alarm sound will be used. A sound file can only be specified if a sound 

card is installed in the computer. A sound file must be placed in the correct 

location before it can be incorporated into an alarm class definition typically, 

“C:\Program Files\SiPass\DataFolder\Drawing\Sound”. 

10. If the alarm requires acknowledging, tick the Requires Acknowledging 

checkbox. 
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11. If the Requires Acknowledging checkbox is ticked, the following fields can be 

configured: 

– Alarm Priority: Set the priority of the alarm 

– Instruction File Name: Select an Instruction File that will be displayed to 

operators when the alarm is raised. 

– Sound File Name: Select a Sound File to be configured for the alarm 

12. Complete the Alarm Options details. 

– Restorable Alarm: Tick this checkbox if the alarm is configured as a 

restorable alarm. 

– Forward via OPC: Tick this checkbox to forward the alarm via the OPC bus. 

– Forward to GSM Mobile(s) checkbox: Tick this checkbox to forward this 

alarm to a GSM Mobile(s). The cardholder’s mobile number must be saved 

in the cardholder dialog for this feature to work. 

– Once actioned, re-activate alarm every: Configure the time interval 

between re-activated alarms. 

– If not actioned, trigger a host event task after: Configure a time-period after 

which a host event task will be raised, if the alarm is still not actioned. 

13. Define the Current Defined States details. For details on the available states for 

various Alarm Types, please refer the section Alarm Class of the SiPass 

integrated Reference Manual. 

14. Click Save. 

7.1.1.1 Alarm Class Options 

The table below describes the configuration options for Alarm Classes. 
 

Option Description 

Requires Acknowledging If this checkbox is ticked, the operator must acknowledge an alarm once if it has been 
triggered. 

Edit Alarm Priority Choose this button if you want to create new alarm priorities, other than the standard SiPass 
integrated Lowest to Highest. Up to one thousand Alarm priorities in total can be defined. 

Alarm Priority Specifies the priority level for the alarm class. 

● Highest: Will display an Alarm dialog, and will appear at the head of the alarm queue. 

● Standard 1 to 5: Will display an Alarm dialog, and will appear above lowest priority alarms in the 

alarm queue. An alarm priority of standard 5 is of a higher priority than an alarm of priority of standard 

1. 

● Lowest: Will display an Alarm dialog, but will appear at the bottom of the alarm queue. 

● None: Will be sent to the Audit Trail, but will not appear on the Alarm Queue. 

Restorable Alarm Tick this checkbox to require that an alarm must return to a normal state, and be actioned by 
an operator, before the alarm will be completely deactivated. A non-restorable alarm is 
considered normal as soon as it is actioned. When you choose to make an alarm class 
restorable, you must define both an “alarm” and “restore” state for that alarm class. 

Once Actioned, re-activate 
alarm every 

Specifies the Time period before an actioned alarm is re-activated, if it has not already been 
restored to its normal state. 

If not actioned, trigger an 
event after 

Specifies the Time period after an alarm is triggered that a specified event should occur, if the 
alarm has not been actioned. 

Forward Via OPC If this checkbox is ticked, when this alarm occurs, the point name, alarm state and point status 
will be forwarded to every OPC point that you have defined in the Components dialog. 
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7.1.2 Creating a Defined State 

The Alarm Class can assume a number of different states. Each possible state 

must be defined. An alarm is triggered when a point enters into a state defined as 

an alarm. 

1. Choose Alarm Class from the Program toolbar or menu. 

2. From the Alarm Class Name field, select the name of the alarm class for which 

a state is to be defined. 

3. Choose Add. 

 A new line will appear in the Defined States grid. 

4. Select the item in the Status column. 

5. Specify the status to be defined. 

6. To change the status type, choose the drop down arrow and select a new 

status from the list. To expand the drop down list so that you can view the 

entire text, you can click on the right hand border of a column and drag to 

increase the column width. 

– Alarm State Status for 3rd Party Systems in SiPass integrated: If you have 

entities of 3rd party systems that are integrated with SiPass, the status of 

these entities can be uploaded and downloaded between the two systems. 

The status corresponding to the 3rd Party system will contain the term 

‘External System’ in the drop down list. For example, for the Access alarm 

type, 3rd Party systems can have defined states with the status Door Held 

External System, Lock External System, etc. 

7. Enter the status description (in the Status Description column) that will appear 

in the Audit Trail, alarm queue, and alarm query when this status is reported. 

8. Specify the status type. To change the status type, select a new state from the 

Alarm/Restore column. 

– Alarm:  

If the status is defined as Alarm, whenever it occurs, the corresponding 

point, area, group or unit will be considered to be in an alarm state. An 

audit trail event will be generated, and any other events you have defined 

for the alarm class will be triggered. 

– Restore:  

If the status is defined as Restore, whenever it occurs, the corresponding 

point, area, group or unit will be considered physically restored to its normal 

state. You cannot define a status as “Restore” if you have not ticked the 

Restorable Alarm check box. 

– Ignore:  

If the status is defined as Ignore, when it occurs, nothing will be reported in 

the alarm queue, no changes will be displayed on the site plans, and no 

event tasks will be triggered. 

9. Specify the symbol (in the Symbol Name column) to appear on the site plan to 

indicate the status of the alarm. To change the symbol, choose the drop down 

arrow and select a new symbol from the list. 

10. Select Yes in the Dial Back column, if you want a remote component (assigned 

this alarm class) to initiate a dial back to the SiPass server if an alarm occurs. 

11. Click Save. 
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7.1.3 Creating Custom Alarm Responses 

SiPass integrated allows you to create pre-defined alarm responses that can be 

selected from a menu in the Alarm dialog. This means that alarm responses can be 

consistent for similar alarm events. New alarm responses can be added “on the fly” 

from the Alarm dialog. 

1. Select Alarm Responses from the Program menu. 

2. Enter your pre-defined response into the Alarm Response field. 

 This message will appear in the Audit Trail when the alarm is actioned by 

an operator. 

3. Choose Add to add your response to the Current Alarm Responses list. Each 

item in the list will appear on the Pre-defined Alarm Response menu in the 

Alarm Dialog when an alarm is triggered. 

4. Repeat steps 2 – 3 for every alarm response you want to be available to 

operators. Choose Close when you have finished. 
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7.2 Audit Trail Logs 

To provide operators with a greater level of flexibility of Audit Trail views, SiPass 

integrated is equipped with the innovative feature of Audit Trail Logs. 

Operators can choose to fully utilize this feature by: 

● Customizing audit trails by applying filters for the information displayed, and 

share these views with other operators. For example, in one log, the operator 

can choose to view only Card Transactions, or only Anti-Passback Area related 

Audit Trails. 

● Opening multiple Audit Trail Logs 

● Applying operator privileges at various levels for each Audit Trail Log 

● Print and take Snapshots of Audit Trail Logs 

These features can be utilized through the SiPass integrated Operation Client. 

However, the assignment of operator privileges for Audit Trail Logs is done through 

the SiPass integrated Configuration Client. 

7.2.1 Saving and Sharing Audit Trail Logs 

When a Level 1 Operator creates or edits an Audit Trail Log, he can assign View, 

Create or Edit privileges for it to all the Level 2 Operators under him. 

 

 

Note: For the purpose of understanding, the term Level 1 Operator refers to a 

person at the highest level of hierarchy. 

Level 2 Operators refer to operators under the Level 1 Operator. 

Level 3 Operators refer to operators under Level 2 Operators. 

The level of permission a Level 2 Operator can assign to a Level 3 Operator 

depends on the kind of privileges assigned to him. 

For example, a Level 2 Operator with Edit privileges can assign only Edit or View 

privileges to a Level 3 Operator. He cannot assign Create privileges. 

Further, a Level 2 operator can configure privileges for Custom Transaction Logs 

to a Level 3 operator under him. But, he cannot assign privileges for Audit Trail 

Logs to another Level 2 operator. This can only be done by a Level 1 Operator. 

  



 

 

Site Monitoring 

Audit Trail Logs 
7 

128 | 313  A6V101068156 

 

7.2.2 Assigning Operator Privileges for Audit Trail Logs 

Operator Privileges for Audit Trail Logs can be assigned through the Operator 

Group dialog. 

This is done at two levels: 

Assigning Operator Privileges to access the Audit Trail Log feature in 
SiPass integrated 

To allow an operator to access the Audit Trail Logs feature of SiPass integrated, 

the Audit Trail System Function should be added to his set of selected functions. 

Privilege [c] allows the operator to create and delete Audit Trails 

Privilege [e] allows the operator to edit, rename or change the configuration of 

Audit Trails. 

Privilege [v] only allows the operator to view the Audit Trails. 

An operator without any of these privileges assigned will not be able to access any 

of the Audit Trail Logs in SiPass integrated. 

Assigning Operator Privileges to view individual Audit Trail Logs in 
SiPass integrated 

1. Select Program > Operator Group. 

2. From the Partition Functions section, select SiPass Explorer Items. 

3. From the Available section, select and expand Audit Trail Log. This action will 

display all the Audit Trail Logs configured in SiPass integrated. 

4. Select the individual Audit Trail Log that you wish to assign to the operator and 

click Add. 

These individual Audit Trail Logs can be configured to the operator with [c], [e] or 

[v] privileges. 
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7.3 Scheduled Reporting 

Reports within SiPass Reporting can be automatically generated and exported with 

an event task. This allows you to perform regular reporting without the ongoing 

manual effort. 

To schedule reporting 

 Email functionality requires you to configure cardholders for email, and the 

server for sending mail. 

1. Click Program > Event Tasks > Host. 

2. Enter a name for the event task. 

3. Select a valid Time Schedule to control when the event will occur. 

4. Select a Source and State for when the event task will trigger 

– If you want to schedule the report for a specific time, set the Source to 

Time Schedule and set the State to Start. This will trigger the event when 

the Time Schedule selected above begins. 

5. Set Target to Reporting and select a Report to use from the list 

6. Select Print, SaveAs or Email Forwarding. 

– If selecting Print, click the … button to configure the print settings. 

– If selecting SaveAs, select the Type of file to export to and click the ... 

button to select the file to save to. 

– If selecting Email Forwarding, click the + button to add a cardholder to the 

list of recipients. Only cardholders with email forwarding enabled will be 

shown in this list. 

7. Enter a message in the Message field, that will print in the audit trail when the 

event task is run. 

8. Click Save. 
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7.4 System Status 

The SiPass integrated status screen provides a summary of the status of the active 

components of the system and current alarm conditions. You can choose to 

automatically have the status screen visible when an operator logs into SiPass 

integrated. 

◈ Select System Status from the Operation menu. 

 The System Status window will appear. The following table describes the 

information displayed in each tab: 
 

Tab Description 

System Summary Displays status information on all connections, alarms and doors. 

Physical Points in 
alarm 

Displays the status of all physical point alarms in the system. 

Logical Points in alarm Displays information on the status of all logical point alarms in the system. 

Door Status Graphical display of all system doors. 

 

Automatically displaying the Status Screen on start-up 

1. Select Preferences from the Options menu. 

2. In the System Status Monitor section, tick the checkbox Show on Startup. 

The value in the Refresh Rate (sec) field determines how often the data displayed 

in the Status monitor is updated to reflect the latest changes in status and alarm 

conditions. 
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7.5 Client / Server Monitoring 

The Client/Server Monitoring feature of SiPass integrated lists information of the 

server and active clients on SiPass Configuration Client. 

◈ Click on the Operation Menu and select Client/Server Monitoring... 

 The Client/Server monitoring dialog is displayed listing the following 

information: 

● Client ID 

● Login Operator Name 

● Login Operator Group 

● Client Computer Name 

● Client Type 

– SiPass Operation Client 

– SiPass Web Client 

– SiPass Configuration Client 

– SiPass HR-API 

– SiPass Management Station API 

– SiPass Import/Export Tool 

– SiPass Data Synchronizer 

– SiPass Report Generator 

● Session Status 

● Client Certificate Name (if applicable) 

● Client Certificate Expiry Date (if applicable) 

● Client Version 

● Client up-time (displayed in days.hours:minutes:seconds. For example, 

01.03:12:34 means it has been running for 1 day 3 hours 12 minutes and 34 

seconds.) 

 

 

All information is refreshed automatically every 20 seconds (default). To modify 

this time as per your requirement, open the SiPassConfigurationClient.exe.config 

file from the SiPass installation directory of your computer and change the value 

by searching for the information as below: 

<add key="Poll.SystemInfo.Interval" value="20" /> 

The Refresh button can also be used to refresh all information manually. 
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8 Data Management 

 

 
NOTICE 

● It is recommended that you use the backup functionality provided by your 

SiPass integrated system to perform any archiving of database material. 

● In cases where you are using 3rd party applications to backup data within 

your SiPass integrated system / folders, it is important to test this operation 

before implementation. Some backup software may conflict with the SiPass 

operation depending on the way in which it generates its backup data. 

● It is not recommended that system backups be performed during peak / busy 

durations of system functioning. 

 

8.1 Managing the Database 

There are three main methods by which an operator can manage the SiPass 

integrated database: 

● Backing up the database 

● Restoring the database 

Both these methods have been discussed in the immediate sections that follow. 

8.1.1 Backing up the Database 

SiPass integrated allows you to back up information contained in the Database. All 

the information contained in the Database can be backed up as individual 

components (for example, image files) or can be backed up collectively. You may 

wish to backup the Database as a precaution against data corruption, or to move 

information contained in the Database to another location. You can restore any 

Database records that you have previously backed up. 

With SiPass integrated MP2.80 onward, you can also safeguard the backup file by 

performing a password protected encrypted backup which can be restored by 

using the same password. This prevents any misuse of the backup data file and 

provides you with enhanced security. 

To perform the backup, follow the steps below: 

1. Select Data > Backup > Database. 

2. Select the Database components that you want to back up by ticking or un-

ticking the appropriate checkbox. 

3. To perform a password protected encrypted backup, tick the Encrypt Backup 

File checkbox, if not ticked automatically. 

4. Provide a suitable password as recommended by Siemens guidelines in the 

Password field. 

5. Re-enter the same password in the Confirmation field to double-check the 

password. 

Note: If the Encrypt back up files checkbox is unticked, the Password and 

Confirmation fields will be disabled. 
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6. Specify the location and name for the backup file in the Backup To field. You 

can choose Browse to graphically select a location for the backup. 

7. Choose OK to begin the backup procedure. 

 The Backing Up Database dialog will appear displaying the current status 

of the backup. When the backup procedure has been completed, a further 

Backup dialog will appear to inform you of the successful operation. 

 When this operation is performed, the original PC Name and original 

SiPass integrated license details will be restored to the repository. 

8. Choose OK. 

8.1.1.1 Database Backup Components 

The table below explains the available database components when backing up the 

database. 
 

Component Description 

Database When ticked, backs up the entire Database including the Multi-site Access Management 
information, Custom Cardholder Pages, sounds, alarm instructions, look-up tables, operator 
preferences, and all the database files, themselves. 

Graphics Files When ticked, backs up the graphics information including, site plans, drawings, symbols, card 
templates, and cardholder images. 

Images When ticked, backs up all the images contained in the Database; for example, cardholder 
photos and signatures. The image files, themselves are backed up using this option. 

 

Note: The Audit Trail is not backed up automatically. You must perform a manual 

back up to save the Audit Trail data. 

8.1.1.2 Host Event Task-Triggered Database Backup 

An operator can configure a Database Backup to be triggered by a Host Event 

Task. 

1. Select Program > Event Task > Host. 

2. Configure the fields of the Trigger section, as required. For information on how 

to configure an Event Task, refer the Section Creating a Host Event Task. 

3. In the Effect Section, select Database in the Target field. 

4. Select the required type of Database Backup from the options of the Command 
drop down list. 

5. In the Path field, type the location where the backup file will be saved in the 

computer. 

6. To perform a password protected encrypted backup, tick the Encrypt backup 

files checkbox. 

7. Provide a suitable password as recommended by Siemens guidelines in the 

Password field. 

8. Re-enter the same password in the Confirmation field to double-check the 

password. 

Note: If the Encrypt back up files checkbox is unticked, the Password and 

Confirmation fields will be disabled. 

 

To perform a complete database backup, it is recommended that the Database 

Backup – Full command option be selected. 
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8.1.1.3 Cancelling an Event Task Triggered Backup 

This feature allows the operator to cancel a Backup triggered by an Event Task. 

To perform this function, select Data > Backup > Cancel Automatic Backup. 

 

 

Operators should be given privileges to Host Event Task Backup to be able to use 

the Cancel Automatic Backup feature. 

A status bar at the bottom of the screen will indicate the progress of the Host Event 

Task Backup. 

8.1.2 Restoring the Database 

SiPass integrated allows you to restore a previously backed up Database. 

 

 
NOTICE 

Performing a Database restoration will overwrite any records that currently exist in 

the Database. 

You cannot cancel the restoration process once it has begun. 

If possible, make backup copies of the current Database before restoring a 

previous version of the Database. 

1. Select Data > Restore > Database. 

2. Specify the path and file name of the Database to be restored, in the Restore 

From field. You must choose Browse to select the location of the record to be 

restored. The backed up Database file should include the extension “.bkp”. 

3. If you are restoring an encrypted backup file, type the password in the 

Password field. If you did not perform an encrypted backup, leave the 

Password field blank. 

– The OK button will remain disabled until you have made a valid choice of 

backup file via the Browse facility. Only those items that were saved in the 

back up are available to be restored. For example, if the backup file 

contained only image information, then the only active switch would 

correspond to Images. 

4. Select the components you wish to restore by ticking or un-ticking the 

appropriate checkboxes. Only those components that were originally backed 

up will be available to restore. 

– The Local and System settings must not be used when restoring a backed 

up database onto a new PC (a PC other than the original SiPass integrated 

installation) or when a new build of SiPass integrated has been installed. 

Restoring these settings under the described circumstances may corrupt 

your SiPass database. 

– Some minor settings, such as custom toolbars, will need to be re-

configured after this restore process. 
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5. Choose OK to begin the Database restoration process. 

 When the restoration procedure has completed, a Restore dialog will 

appear informing you that the process is complete. 

6. Remember to shut down both your SiPass Server and Client in order for the 

restored database to take effect. Remember to restart both your SiPass server 

and client. 

 The SiPass Audit Trail will display a status message that indicates the success 

of the database restoration. Each time a restoration process is attempted, 

SiPass integrated will perform an integrity check, to ensure that the database 

was restored correctly 

 If the restoration was not successful, it is recommended that you check the size 

of the SiPass SQL Transaction log (Asco4_log) and if necessary increase the 

size of this log. 

8.1.2.1 Database Restore Components 

The table below explains the available database components when restoring the 

database. 
 

Component Description 

Database Restores the entire Database 

Graphics Files Restores the graphics information; for example, site plans and symbols 

Images Restores all the images contained in the Database; for example, cardholder photos and 
signatures 

System Settings Restores the local machine settings; for example, the Server name, the locations of data 
directories, and so on. 

Local Settings Restores the local machine (operator) settings; for example, the operator’s system 
preferences 
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8.2 Managing the Audit Trail 

SiPass integrated allows its operators to manage their Audit Trails using three 

basic processes: 

● ARCHIVE 

Archiving is basically the action of moving Audit Trail entries/logs, kept in the SQL 

database table, to an external SQL archive files. These SQL archive files are in the 

SQL Compact format (with the .sqlarc file extension). This process allows the 

operator to maintain a collection of .sqlarc files at a destination referred to as the 

Archive Location. 

● BACKUP 

The Audit Trail Backup process involves creating copies of the SQL archive 

(.sqlarc) files, that are stored in the Archive Location, to another External / Backup 

location. This external location can be a backup server, or another other such 

backup media. Backups should be created before an upgrade installation of SiPass 

integrated. In the unexpected event of a hardware failure, operator error or any 

other such data loss, these copies or Backed up files can be used to update the 

original .sqlarc files. 

● RESTORE 

Generally performed after upgrading SiPass integrated, the Audit Trail Restore 

process involves copying all the backed up .sqlarc files from the External / Backup 

location back to the Archive Location. These files will then become available for 

Audit Trail Reporting purposes. 
 

Process Retrieve From Send To 

ARCHIVING SiPass integrated Audit Trail Archive Location 

BACKUP Archive Location External / Backup Location 

RESTORE External / Backup Location Archive Location 

 

SUMMARY OF BASIC AUDIT TRAIL MANAGEMENT PROCESSES 

SiPass integrated allows operators to manage Audit Trails using three basic 

processes: 

● Archiving Audit Trials to an Archive Location 

● Manual Backup of Audit Trails from Archive Location to an Backup/External 

Location 

● Restoring Audit Trail files from Backup/External Location to Archive Location 

8.2.1 Archiving the Audit Trail 

SiPass integrated allows you to make a record of the events that have occurred at 

your site and that have been logged to the Audit Trail. 

Archiving of Audit Trails can be done in two ways: 

● Automatic Audit Trail Archiving 

● Manual Audit Trail Archiving (Forced Operation) 
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8.2.1.1 Automatic Audit Trail Archiving 

The SiPass integrated audit trail is archived automatically daily. This means that 

the audit trail is stored in archive files at regular intervals without the need for 

manual intervention. 

As part of the Automatic Audit Trail Archiving process, SiPass Integrated will use a 

default location. However, the operator has the option of configuring a different 

archive location, outlined below. 

(Optional) Configuring the Audit Trail Archive location 

1. Select Preferences from the Options Menu. 

2. Select the Audit Trail tab. 

3. Click the Archive Folder Location button. 

4. Enter the path of the folder in which the backups will be stored in the Current 

Archive Folder Location field. Alternatively the … button may be clicked and a 

location can be chosen by browsing for an appropriate folder location. 

5. Select OK. 

6. Click Save. 

 

 

The specified folder must be accessible from the SiPass integrated Server PC 

with the Windows User Account that is logged on. It is recommended that this 

location is specified using a UNC path designation. 

 

8.2.1.2 Manual Audit Trail Archiving (Forced Operation) 

The operator can choose to perform a forced Audit Trail archive operation. This is 

particularly useful in instances where the operator may want backup the database 

in preparation for a SiPass integrated version upgrade. This operation will also 

archive the current days audit trail. 

1. Select Data > Archive > Audit Trail. 

2. Click Yes to start the Manual Audit Trail Archiving operation. 

 

 

It is recommended that this manual Audit Trail Archiving operation be performed 

before backing up a database. 
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8.2.2 Backing up the Audit Trail 

In this process, the audit trail files are manually copied to an Archive Location 

where it is stored. 

1. Select Data > Backup > Audit Trail. 

2. Select the radio button corresponding to the task to be performed – Backup 

Only, Backup and Purge or Purge only. 

3. Choose List Dates. 

 All the Audit Trail records that exist, between the specified start and end 

dates, will appear in the Available Dates list box. 

4. Select the specific date to be backed up, by clicking on it. 

5. Choose Add >. 

 The selected date will appear in the Selected Dates list box. 

6. Repeat Steps 4 and 5, until you have selected all the dates to be backed up. 

7. Specify the location for the back up file in the Backup To field. You may choose 

Browse to select a location for the backup. 

8. Choose Execute to begin the backup process. 

 The Status box, located at the bottom of the dialog, will display the status of the 

backup process 

8.2.2.1 Audit Trail Backup Operations 

The table below explains the various backup operations and configuration. 
 

Option Description 

Backup only Allows you to create a backup of Audit Trail records only. 

Backup and purge Allows you to make both a backup of the Audit Trail records in another location and delete 
them from their current location. 

Purge only Allows you to delete the Audit Trail records. Select the date-range over which the backup will 
be performed. 

From Specifies the start date for the backup date range. If no records exist for this date, the first 
archive displayed in the Available Archives list will automatically become the next subsequent 
file. To change the date, choose the drop down arrow and select a new date from the calendar 
displayed. 

To Specifies the last date for the backup date range. If no records exist for this date, the last 
archive displayed in the Available Archives list will automatically become the latest previous 
file. To change the date, choose the drop down arrow and select a new date from the calendar 
displayed. 
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8.2.3 Restoring the Audit Trail 

 

 

With the SQL Compact scheduled to be phased out by Microsoft, SiPass 

integrated now performs Audit Trail Archive in SQLite format. 

If you are restoring a previous Audit Trail Archive in SQLCE format, the archive 

file must first be converted to SQLite file to ensure that the Audit Trail Reporting is 

not affected. 

 

SiPass integrated allows you to restore previously backed up Audit Trail records, 

according to date. You can restore Audit Trail Archive files, or TAB files. 

The following instructions explain how to restore Audit Trail from the TAB files 

generated by older versions of SiPass integrated. 

 Ensure that your Archive Folder location has been set to where your archived 

Audit Trail files are kept. 

 Ensure that any previous Audit Trail Archive in SQLCE format has been 

converted to SQLite format. 

1. Select Data > Restore > Audit Trail. 

2. Specify the path of the file(s) to be restored, in the Restore From field. You can 

choose Browse to select the location where the TAB files/Archive files are kept. 

3. Select each file (in the Available Files list) from which the Audit Trail will be 

restored. 

4. Choose Restore to restore the Audit Trail records from the selected files. 

 

 

Please note that on restoring a TAB file, it will be converted to an Archive file 

automatically. 
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8.2.4 Purging the Audit Trail Archives 

SiPass integrated allows you to delete Audit Trail records that are no longer 

needed at your site across a range of dates. 

 

 

Before purging any Audit Trail records, it is highly recommended that you back up 

Audit Trail records to another location, (for example, a tape or disk), just in case 

they need to be retrieved at a later date. This can be achieved by selecting the 

Backup and Purge option from the Task section of the dialog. 

1. Select Data > Purge > Audit Trail. 

2. Select the date range over which the purge will be performed. 

– From: Specifies the start date, for the purge date range. If no records exist 

for this date, the first file displayed in the Available Archives list will 

automatically become the next subsequent file. To change the date, 

choose the drop down arrow and select a new date from the calendar 

displayed. 

– To: Specifies the last date, for the purge date range. If no records exist for 

this date, the last file displayed in the Available Archives list will 

automatically become the latest previous file. To change the date, choose 

the drop down arrow and select a new date from the calendar displayed. 

3. Choose List Archives. All the Audit Trail records that exist, between the 

specified start and end dates will appear in the Available Archives list box. Both 

the Start and End dates are included. 

4. Select the specific files to be purged by clicking on it. 

5. Choose Add >. The selected files will appear in the Selected Archives list box. 

6. Repeat steps 4 and 5, until you have selected all the files to be purged. 

7. Choose Execute to begin the purging process. 

 The Status box, located at the bottom of the dialog, will display the status of the 

purge process and a purge event will be recorded in the Audit Trail. 

8.2.5 Host Event Task Triggered Audit Trail Purge 

An operator can configure a purge of all audit trail archive files to be triggered by a 

host event task. 

1. Select Program > Event Task < Host. 

2. Configure the fields of the Trigger section as required. For information on how 

to configure an event task, refer the section Creating a Host Event Task. 

3. In the Effects section, select Database for the Target field. 

4. Select Purge Audit Trail in the Command drop down list. 
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8.3 Managing the Log Book 

The Log Book can be managed in three main ways: 

● Backing up the Log Book 

● Restoring the Log Book and 

● Purging the Log Book 

These three options have been discussed in the immediate sections that follow. 

8.3.1 Backing up the Log Book 

SiPass integrated allows you to make a record of events or conditions at your site 

that are significant enough to be reported separately in the Log Book. The 

operators record these events in the Log Book so that they may inform the relevant 

persons of the events or conditions independently of the Audit Trail. You may also 

purge the information simultaneously, creating an archive of Log Book records. 

 

 

You cannot backup the Log Book for today’s date. Only dates that have occurred 

before the current date can be backed up. 

1. Select Data > Backup > Logbook. 

 The Backup and/or Purge Log Book dialog will appear with the Backup 

Only radio button is highlighted by default. 

2. Select the radio button corresponding to the task to be performed. 

3. Select the date range over which the backup is to be performed. 

4. Choose List Dates. 

 All the Log Book records that exist, between the specified start and end 

dates, will appear in the Available Dates list box. 

5. Select the specific date to be backed up, by clicking on it. 

6. Choose Add >. 

 The selected date will appear in the Selected Dates list box. 

7. Repeat Steps 4 and 5, until you have selected all the dates to be backed up. 

8. Specify the location for the back up file in the Backup To field. You may choose 

Browse to graphically select a location for the backup. 

9. Choose Execute to begin the backup process. 

 The Status box, located at the bottom of the dialog, will display the status of the 

backup process. 
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8.3.1.1 Log Book Backup Operations  

The table below explains the various backup operations and configuration. 
 

Option Description 

Backup only Allows you to create a backup of the Log Book records only. 

Backup and purge Allows you to make both a backup of the Log Book records in another location and delete 
them from their current location. 

Purge only Allows you to delete the Log Book records. 

From Specifies the start date for the backup date range. If no records exist for this date, the first date 
displayed in the Available Dates list will automatically become the next subsequent date. To 
change the date, choose the drop down arrow and select a new date from the calendar 
displayed. 

To Specifies the last date for the backup date range. If no records exist for this date, the last date 
displayed in the Available Dates list will automatically become the latest previous date. To 
change the date, choose the drop down arrow and select a new date from the calendar 
displayed. 

 

8.3.2 Restoring the Log Book 

SiPass integrated allows you to restore a previously backed up Log Book record. 

You may wish to restore a previously backed up record for the purpose of 

generating a report. 

 Back up the current Log Book records before restoring a previous version. 

1. Select Data > Restore > Logbook. 

2. Specify the path and file name of the Log Book record to be restored, in the 

Restore From field. You must choose Browse to graphically select the location 

of the record to be restored. The backed up Log Book file should include the 

extension “.dlz”. 

3. Select the date or dates from the Available Dates. 

4. Choose the Select All button if you wish to restore all the dates listed in the 

Available list. 

5. Choose Restore to begin the Log Book restoration process. 

6. Choose Close. 

7. Create a Log Book Report, to ensure that the Log Book has been restored. 

8. Shut down and re-start both your SiPass Server and Client after the restoration 

is complete. 
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8.3.3 Purging the Log Book 

SiPass integrated allows you to delete Log Book records that are no longer needed 

at your site. 

 

 

Before purging any Log Book records, it is highly recommended that you backup 

the Log Book records to another location, (for example, a tape or disk), just in 

case they need to be retrieved at a later date. This can be achieved by selecting 

the Backup and Purge option in the Task section of the dialog. 

1. Select Data > Purge > Log book. 

 The Backup and/or Purge Log Book dialog will appear with the Purge Only 

radio button highlighted. 

2. Select the date range over which the purge will be performed. 

– From: Specifies the start date for the purge date range. If no records exist 

for this date, the first date displayed in the Available Dates list will 

automatically become the next subsequent date. To change the date, 

choose the drop down arrow and select a new date from the calendar 

displayed. 

– To: Specifies the last date for the purge date range. If no records exist for 

this date, the last date displayed in the Available Dates list will 

automatically become the latest previous date. To change the date, choose 

the drop down arrow and select a new date from the calendar displayed. 

3. Choose List Dates. All the Log Book records that exist, between the specified 

start and end dates will appear in the Available Dates list box. 

4. Select the specific date to be purged, by clicking on it. 

5. Choose Add >. The selected date will appear in the Selected Dates list box. 

6. Repeat steps 4 and 5, until you have selected all the dates to be purged. 

7. Choose Execute to begin the purging process. The Status box, located at the 

bottom of the dialog, will display the status of the purge process and a purge 

event will be recorded in the Audit Trail. 
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8.4 Time and Date (T&A) Data Export 

8.4.1 Overview 

SiPass integrated offers a utility for exporting cardholder “clock-on” and “clock-off” 

data. This kind of data can be used in Human Resources applications to collect 

hours worked, for example. When this functionality is enabled, every valid entry on 

an entry/exit reader is automatically exported to an external text file, and you can 

choose exactly which cardholder and card data to save to file. 

The T&A Calculation Interface exports all of the data you nominate for each valid 

card badge at entry and exit readers for the Clock-on and Clock-off areas you have 

selected. 

The Advanced Security Programming in SiPass integrated (Operation Client) 

allows operators to configure multiple T&A Calculation Interfaces. 

Before you begin: 

The T&A Calculation Interface relies on SiPass “Areas” to collect card badging 

data. An area is a location that can be entered and exited through one or more 

secure doors. Before you can configure the T&A Calculation Interface, you must 

first: 

● Ensure that all the areas, sub-areas and access points to which the cardholder 

will require access have been defined. 

● Establish the Time Schedules during which the cardholders will require access. 

8.4.2 Exporting T&A Data 

The operator can export the T&A data to a file in Tab Delimited or CSV format. 

1. Select T&A Data Export from the Data menu. 

 The T&A Data Export dialog is displayed. 

2. Tick the T&A File Export Enabled checkbox. 

3. Select The Clock-on field indicates the area for which cardholder details should 

be recorded for the first valid card badge of the day. 

4. The Clock-off field indicates the area for which cardholder details should be 

recorded for the last valid card badge of the day. A default area already exists, 

“Global Outside”, which means any location that is not inside your facility. 

5. Provide a location to save the Export File in the Export Path field. Use standard 

Windows browsing functionality. 

6. Type an appropriate name in the File name field. 

7. Select the desired format for the export file from the Format dropdown list. 

8. From the Available Fields list box, select the fields that must be included in the 

data to be exported and click the Add button. 

 The field appears in the Selected Fields list box. To remove a field from 

being included in the data export, select the field and click Remove button. 

9. You can also sort the fields in desired order so the information is listed in that 

order in the T&A export file. Select individual fields in the Selected Fields list 

box and click the Up or Down buttons to set the order. 

10. Click OK. 
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9 Profile Configuration 
Profile Configuration (or Smart Card Encoding) is an option of the SiPass 

Integrated access control software. It allows SiPass integrated to both encode and 

read Mifare and DESFire based smart cards. This option supports a wide range of 

possible smart card formats and shows the user how a smart card will be used in 

and around their facility. 

In addition, SiPass integrated allows individual smart card profiles to be pre-

configured within the system, allowing each tenant or even cardholder’s belonging 

to different divisions to have smart cards encoded with information that suits their 

exact needs. 

Finally SiPass integrated also supports the use of card printers with built in smart 

card encoding mechanisms that allow smart cards to be encoded as they are 

printed. Of course, a dedicated smart card reader/encoder can also be used for 

this purpose. 

The following diagram displays a rough flow chart for encoding smart cards from 

start to finish using SiPass integrated. 
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9.1 Creating a Smart Card Profile 

A smart card encoding profile includes the information required to configure each 

sector and block or application and file on a smart card with the appropriate 

information, including the appropriate read and write keys. 

9.1.1 Mifare Classic 
1. From the System menu, select Smartcard Profile Configuration and click Mifare 

Classic… 

 The Profile Configuration dialog is displayed. 

2. Enter a name for the Smartcard profile into the Profile Name field. 

3. Select the appropriate card type (1K or 4K). 

4. Left-click on the square “blue” node once to configure the sector/block 

contents. Refer the section Configuring a Sector / Block Detail [➙ 148] of this 

user manual for information on this function. 

5. Right-click on the Key corresponding to above node to configure the sectors 

read and write keys. Refer the section Configuring the Sector Keys of this user 

manual for further details. 

6. Repeat the above steps until all the contents of sector and block that you wish 

encoded and the appropriate read and write keys have been defined. 

7. Click Save. 

9.1.2 Mifare DESFire 
1. From the System menu, select Smartcard Profile Configuration and click Mifare 

DESFire… 

 The DESFire Profile Configuration dialog is displayed. 

2. Click the New Profile button on the dialog. 

 A new profile is created listed as New Profile0 under Desfire Profiles in the 

left pane of the dialog. 

3. Click on New Profile0 to select it. 

4. Enter a name for the Smartcard profile into the Profile Name field. 

5. Click Save. 

 The New Profile0 in the left pane is now replaced by the name given to the 

profile. 

Note: 

● Check the Format Before Encoding checkbox if you want the smart card to be 

formatted before you encode new data. If this is unchecked, then any one of 

the following conditions may occur: 

– If the current encoding is using the same profile used in the previous 

encoding, the data in the DESFire smart card will be updated. 

– If the current profile is different from the profile used in the previous card 

encoding, and there is no Application ID overlap, the new profile 

configuration will be added to the existing profile in the DESFire smart card. 

– If the current profile is different from the profile used in the previous card 

encoding, and there is an Application ID overlap, the new profile 

configuration will be updated where the Application ID overlaps. If the 

overlapping application has a different configuration than the previous one 

then the encoding may fail. 

● A Master Key can be set for DESFire cards, allowing operators to configure a 

higher level of security. A selection can then be made from the Card Master 

Key drop down field. 



 

 

Profile Configuration 

Configuring the Sector / Block Contents 
9 

148 | 313  A6V101068156 

 

9.2 Configuring the Sector / Block Contents 

9.2.1 Configuring the Sector / Block Contents for Mifare Classic 

Cards 

A 1k Mifare smart card incorporates 16 unique data sectors, and a 4k card 

supports up to 40. Each of these data sectors can then be split into three further 

data blocks. Depending upon the necessary requirements of a particular card, 

each block can potentially hold different data, such as an access card number, a 

cardholder’s name, address or even an electronic purse amount. Of course, 

depending upon the size of the information blocks within a sector, it can be 

combined to hold larger amounts of data. 

The following procedure explains how to configure the information to be encoded in 

a particular sector and block. 

1. In the left hand column, left-click on the square “blue” node once, 

corresponding to the sector for which the data contents are to be specified. 

2. Use the table on the right-hand side to specify the details for this sector as 

outlined in the following steps. 

3. Specify the Sector. This should match the number of the node that was 

selected previously. The available sector numbers will differ depending on 

which card type is selected. 

4. Select the Block where contents will begin to be written. 

– For Sectors 0-31 information can be written in blocks 0, 1, or 2. 

– For Sectors 32-39 information can be written in blocks 0-14 

5. Select the Offset used. 

6. Select the Length of the data to be written (in characters) 

7. Select the Output format: 

8. Select the Access Control format to be encoded on the card. 

9. Select the Data Type to be encoded to the card sector (only for custom format 

selections) 

10. Select or enter the Data to be encoded in the sector or block. The data entered 

will depend upon the format and data type selected in the previous two steps. 

11. Repeat the above process until all sectors and all blocks that require encoded 

information have been completed. 
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9.2.2 Configuring the Application / File Contents for  

Mifare DESFire Cards 

A DESFire 2k, 4k and 8k smart card incorporates 27 unique applications, each of 

which has a unique key and is locked by the key. Each of these applications can 

accommodate 32 files.(although the total length will be limited by the size of the 

smart card). Each file can have a length of maximum 4096 bytes and minimum of 

32 bytes. 

The following procedure explains how to configure the information to be encoded in 

each application: 

1. On the DESFire Profile Configuration dialog, select a profile from the list under 

DESFire Profiles in left pane. 

2. Click the New App button. 

 A new app is listed under the selected profile with a six-digit Application ID 

as name. 

3. Click the app name on left and enter a relevant two digit number in the 

Application Number field on the right. 

4. Specify an application ID in the AID field. 

– AID number is an hexadecimal number. It can be of six digits with either 

only alphabets from A-F, or numbers or a mix of both. AID appears by 

default only for imported Bioscrypt profiles; and for manually created 

Bioscrypt profiles AID has to be configured manually. (AID, File ID, File size 

has to be configured manually by the user based on the configuration in the 

L1 Reader for Bioscrypt system. AID for SALTO system is not editable by 

the user as it is not a configurable parameter in SALTO) 

 

 

Application ID cannot be empty and it cannot contain all zeros. The Application ID 

cannot be a duplicate within a profile. For an external system (SALTO system, 

Bioscrypt system) the Application ID cannot be configured from SiPass 

integrated. 

5. Select the encryption key for the application from the Application Master Key 

drop-down list. 

6. Tick the Encrypted Communication Mode checkbox if required. 

 

 

SiPass supports the configuration of the communication mode between the 

DESfire EV1 smartcards and the reader. This communication mode can be plain 

or fully encrypted communication mode. 

If the checkbox Encrypted Communication Mode is checked, it will configure this 

particular application/file to use full encryption when the communication between 

the smartcard and reader takes place. If it is not checked then plain mode will be 

used. 

Some third party systems do not support fully encrypted communication mode. 

7. In the Keys Section, you can specify up to 13 keys for the application. 

 Note: You can create a new key from this dialog by clicking the Keys button 

and filling-in the required details. See section Configuring the Keys for 

Mifare DESFire Cards [➙ 154] for more information. 

8. Click the New File button. 

_RefBEFAD8F97FCE65EB950E9D9ABCB0CC64
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9. Click the new entry listed under Files. 

 You can now specify the details for this application in the File Details 

section on the right side of the dialog as outlined in the following steps. 

10. Select the File number to where the contents will begin to be written. 

 

 

Changing the Application ID for the Application number 0 does not affect File 

number 0, but it affects other files the user may have configured within the 

Application number 0 

11. Select the Length of the data to be written. 

12. Select the Output format. 

13. Select the Access Control format to the encoded on the card. 

14. Select the Data Type to be encoded to the card application (only for custom 

format selections). 

15. Select the Data to be encoded in the application or file. The data entered will 

depend upon the format and data type selected in the previous two steps. 

 Note: See the next sections in this document for the options available for 

Output Format, Access Control Format and Data Type. 

16. In the File Key section, specify the user-defined key assigned to the application 

containing this file in to the Read, Write, Read/Write and Config Change 

Keydropdown list. All the keys assigned to the application are listed under 

these four lists. 

 

 

User defined Key number for an external system (SALTO system and Bioscrypt 

system) cannot be configured by the user in SiPass integrated. It is predefined by 

the SALTO system or Bioscrypt system 

17. Repeat the above process until all the applications and files that required 

encoded information have been completed. 

18. Click Save. 

 The Profile is now saved. The Profile name in the left pane will be 

condensed so you can start creating a new profile. 
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9.2.3 Output Formats 

The following table describes the various output formats. 
 

Format Description 

ASCII Standard for the code numbers used by computers to represent all the 
upper and lower-case Latin letters, numbers, punctuation, etc. 

BCD Binary Coded Decimal format 

Date/Time Date and time stamp format 

Byte Set of bits that represent a single character 

Word One complete word 

Double Word Two complete words 

Quad Word Four complete words 

BCD Boolean Binary Coded Decimal Boolean 

Binary Raw Binary data (e.g., data read from an external system). SiPass 
integrated will not apply any further formatting to the binary data. Will be 
encoded ‘as-is’. 

 

9.2.4 Access Control Formats 

The following table describes the various access control formats. 
 

Format Description 

None This sector/block may be used to hold custom information that does not 
relate to the access control system. For example, an electronic purse 
amount. 

Wiegand 26-bit Read Only field. This is enabled within a MIFARE sector and cannot be 
read with industry standard 26-bit format 

Wiegand 37-bit Read Only field. This is enabled within a MIFARE sector and cannot be 
read with industry standard 37-bit format 

Mifare Facility Siemens own 36-bit encoded facility format 

UID The Smartcard Uniqe ID 

Card Number Custom card number format 
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9.2.5 Data Types 

The following table describes the various data types. 
 

Format Description 

Boolean True or false statement 

Integer Whole number only 

String A linear sequence of symbols (characters or words or phrases) 

Database Field SiPass integrated predefined cardholder data field informaiton 

Custom 
Database Field 

SiPass integrated custom cardholder field information. 

External Field The data that is received from the external system. 

Custom Data 
Format 

User-defined data field 
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9.3 Configuring the Sector Keys 

9.3.1 Configuring the Sector Keys for Mifare Classic Cards 

To ensure that information within a smart card is always as secure as possible, the 

MIFARE Classic smart cards allow you to program protection or encryption keys for 

each sector. Without the knowledge of the 12-digit key, the information held within 

the sector cannot be interrogated or used. 

To configure the security keys for each sector of the smart card: 

 Ensure that you have the default factory keys handy before attempting to 

change a sector key on the smart card to a new value. 

1. In the left hand column, left click on the “yellow” key corresponding to the 

sector for which the read and write keys are to be specified. 

2. Click the Keys button at the bottom of the page. 

3. Enter a name for the key into the Key Name field. 

4. Enter the current existing or default key A into the Key A field. 

– You may need to consult your smart card dealer or manufacturer to 

determine what the sector default keys are when the smart cards are 

shipped. 

5. Confirm key A by re-entering it into the Confirm Key A field. 

6. Enter the current or existing default key B into the Key B field. 

– You may need to consult your smart card dealer or manufacturer to 

determine what the sector default keys are when the smart cards are 

shipped. 

7. Confirm key B by re-entering it into the Confirm Key B field. 

8. To overwrite the default sector key or existing sector key with a new one, check 

the Overwrite the Sector Key checkbox. 

9. Enter the current key A into the Key A field. The key must be 12 digits in length, 

made up of any combination of numbers 0 to 9, and upper case letters A to F. 

10. Confirm Key A by re-entering it into the Confirm Key A field. 

11. Enter the Key B into the Key B field. The key must be 12 digits in length, made 

up of any combination of numbers 0 to 9, lower case letters a to f, and upper 

case letters A to F. 

12. Confirm Key B by re-entering it into the Confirm Key B field. 

13. Select the access conditions that exist for each block within this sector: 

14. Click Save. 

 

 

Please note that once a key is created and saved, it can be configured to multiple 

sectors. 
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9.3.1.1 Access Conditions 

The table below explains the possible access conditions. 
 

Access Conditions Description 

All functions with KA 
and KB 

The sector and block can be written to, and read using both keys A and Key B. 

Read with KA, Write 
with KB 

Reading the contents of the sector and block will be done using key A only. Writing/Encoding 
information to the sector and block will be done using Key B only. 

Read only with KA and 
KB 

The sector cannot be written to, and can only be read using both keys A and Key B. 

Read / subtract with 
KA, Write / add with 
KB 

Reading information or subtracting value from the contents of the sector and block will be done 
using key A only. Writing information or adding electronic value to the sector and block will be 
done using Key B only. 

Read / subtract with 
KA or KB 

Read information or subtracting electronic value from the sector and block can be performed with 
Key A or Key B. 

Read / Write with KB Reading the contents or Writing new contents to the sector and block will be done using key B 
only. 

Read Only KB The sector cannot be written to, and can only be read using Key B. 

Blocked The sector and block cannot be read or overwritten. 
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9.3.2 Configuring the Keys for Mifare DESFire Cards 

The Mifare DESFire cards allow you to program security keys for each application 

of the card profile. The Mifare DESFire keys can use three types of encryption 

namely DES(16 digits), 3DES(32 digits), and AES(32 digits). Without the 

knowledge of the 32-digit key, the information held within the application cannot be 

interrogated or used. 

To configure the security keys for the card profile: 

 Ensure that you have the default factory keys handy before attempting to 

change the security key on the smart card to the new value. 

1. On the DESFire Profile Configuration dialog, click on the application for which 

the security key is to be specified. 

2. Click the Keys button at the bottom of the dialog. 

 The DESFire Key Configuration dialog is displayed. 

3. Enter a name for the key into the Key Name field. 

4. Select a type of Encryption from the drop-down. 

5. In the DESFire Security Key section, enter a unique key into the Key field. 

6. Re-enter the same unique key into the Confirm Key field. 

 Note: A 16 digit key is required for DES encryption and a 32 digit key for 

3DES/AES encryption. 

7. Click Save. 

To overwrite the default or existing security key: 

1. Select the Key Name that is to be overwritten. 

2. Check the Overwrite the Application Key checkbox. 

3. Enter the new key into the Key field. 

4. Re-enter this key into the Confirm Key field. 

5. Click Save. 
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9.4 Configuring a custom Access Control Format 

No two facilities should share exactly the same access details. Of course this 

opening statement is almost a logical statement. Because of this, many 

corporations derive their own custom formats to use at facilities in which they 

originally installed their equipment. SiPass integrated allows you take advantage of 

this situation and upgrade you base technology in unison, but still use the old 

custom format. 

 Ensure that you have the custom format details, before you attempt to replicate 

such a format using SiPass integrated, this will save a lot of time and effort. 

1. Click the Custom button (or click the small arrow on the Custom button and 

select the Access Type Format option) located at the bottom of the DESFire 
Profile Configuration dialog. 

2. Enter name for the format into the Data Format Name field. 

3. Enter the length of the format (number of characters) into the Wiegand length 

field. 

4. Enter the Start and End bits in the custom string that will hold the company 

(site) information. Use 0,0 if no company bits will be used in the format. 

5. Enter the Start and End bits in the custom string that will hold the facility 

information. Use 0,0 if no facility bits will be used in the format. 

6. Enter the Start and End bits in the custom string that will hold the card number. 

7. Enter the Start bit, End bit, and Position to be used for an even parity check. 

8. Enter the Start bit, End bit, and Position to be used for an odd parity check. 

9. Choose Save to save the custom card format. 

10. On saving the DESFire profile, a Test encode dialog opens. The Test encode 

dialog allows the user to check if the profile can be encoded within a card. Click 

Yes to test for encode. Click No to exit the dialog. 

The following provides an example of a custom format called Siemens 10-bit: 
 

Bit 1 2 3 4 5 6 7 8 9 10 

Info P S S F F C C C C P 

 

Where: 

P = Parity, S = Company, F = Facility, C = Card Number 

Therefore, the format configuration is: 

Data Format Name: Siemens 10-bit 

Wiegand Length: 10 

Company Start Bit: 2 

Company End Bit: 3 

Facility Start Bit: 4 

Facility End Bit: ` 5 

Card Number Start Bit: 6 

Card Number End Bit: 9 
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A DESFire card can have only one SALTO application per card for a given SALTO 

system. Hence every profile created by the SiPass can have only one SALTO 

binary data. The following points should be considered while configuring a DESFire 

card with SALTO. 

1. The keys used for the application that has SALTO binary data should be 

provided by the SALTO system. 

2. File ID should always be 1. 

3. Any application ID can be used for the SALTO binary data. It is recommended 

that SALTO binary data should be atleast 288 bytes in size. 

9.5 Configuring a Custom Card Number Format 

You can configure a custom Card Number format to meet your requirements. 

1. Click the Custom button (or click the small arrow on the Custom button and 

select the Card Number Format option) located at the bottom of the DESFire 
Profile Configuration dialog. 

 The Card Number Format dialog is displayed. 

2. Enter a character to be used for padding in the card number in the Padding 

Character field. 

3. Select the byte order for the resultant card number from the Byte Order field. 

By default, MSB Order is selected. 

4. In the Example section, you can type any number in the Card Number field and 

see the result in the Formatted Card Number field (which will show you the 

complete custom card number by combining the number, padding character 

and the byte order). 

5. Click Save. 

6. Click Close. 
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9.6 Configuring a Custom Data Format 

You can define Custom Data Block that can be assigned to a file of an application 

and contains the Data Type, Access Control Type, Database Field, Start Position, 

Length and Output Type. The same data block can be assigned to different files. 

1. Click the Custom button (or click the small arrow on the Custom button and 

select the Data Format option) located at the bottom of the DESFire Profile 
Configuration dialog. 

2. Enter name for the format into the Custom Data Format Name field. 

3. Enter the maximum length of the format (number of characters) into the Data 

Length (byte) field. 

4. In the editable field table below: 

5. Select the Offset used. 

6. Select the Length of the data to be written (in characters) 

7. Select the Output format: 

8. Select the Access Control format to be encoded on the card. 

9. Select the Data Type to be encoded to the card sector (only for custom format 

selections). 

10. Select or enter the Data to be encoded in the sector or block. The data entered 

will depend upon the format and data type selected in the previous two steps. 

11. Repeat the above process until all the required information to be encoded is 

configured. 

12. Choose Save. 

13. Click Close. 

The custom data blocks (formats) will appear in the Data dropdown list when 

Custom Data Format is selected as the Data Type while entering File Details for an 

application. 
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9.7 Assigning a Profile 

Once you have configured your card profiles for different purposes, they must be 

assigned to a cardholder before a card can be encoded and issued to that 

cardholder. This assignment can be conducted through two different mechanisms, 

by either assigning the profile to a card template, or assigning the profile directly to 

the cardholder themselves. 

9.7.1 Assigning a Profile to a Card Template 

A profile can be associated with a card template when you create that template in 

SiPass integrated. This method ensures that all cardholders with the same type of 

cards will end up with the same smart card configuration and basic setup. 

 Ensure that you have configured your smart card profiles, including read / write 

keys, and information that will be written to each sector. 

1. Create or edit and existing card template as described in the Photo ID and 
Graphics chapter. 

2. Click once on the Smart Card icon located on the Drawing toolbar. 

3. Place the mouse pointer over the card template and click the left mouse button 

once. 

4. Using the selection list available in the Smart Card Profile Selection dialog, 

select the profile that you wish to use for the card template currently being 

created. 

5. Click OK. The dialog will now disappear and the smart card icon will appear on 

the card template. 

6. Complete the card template as required by adding further graphics, database 

fields etc. 

7. Ensure that you save the card template will a logical name before exiting the 

Card Template design window. 

9.7.2 Assigning a Profile to an Individual Cardholder 

A profile can be associated with an individual cardholder and this profile can be 

used to encode the card directly on a one-on-one basis when cardholders are 

issued a card. 

 Ensure that you have configured your smart card profiles, including read / write 

keys, and information that will be written to each sector. 

1. Open the Cardholder dialog by choosing Cardholder from the Operation 

toolbar. 

2. Create a new cardholder or open an existing account for the cardholder who 

will be issued with a smart card. 

3. Ensure all the details for that cardholder have been completed. 

4. Click once on the Personal tab in the Cardholder dialog. 

5. Select the appropriate smart card profile from the Profile drop-down list located 

at the bottom at the dialog. 

6. Click Save. 

 When issuing a card to a Cardholder, the profile and appropriate smart card 

contents will now be written to the smart card itself when a card is presented at 

the smart card encoder connected to the SiPass Client and the Encode Card 

button is pressed. 
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9.8 Reading a card with the Profile Viewer 

With the Profile Viewer you can place a card on your smart card reader, select the 

appropriate profile and then read back the data on the card. 

1. Select Operation > Profile Viewer. 

2. Select a profile name. Depending on the profile that is selected, the fields 

displayed in the Profile Viewer dialog changes accordingly. 

3. Select Raw Data or User Format. 

– Raw Data is just the data on the card, whereas User Format presents the 

data in the profile defined format. 

4. Ensure the card is placed on your smart card reader and click Read Card. 

5. Select different sectors to display the contents of that sector. 

6. Click Close. 

9.9 Configuring a Smart Card Printer 

To ensure that you get the best results possible, SiPass integrated allows you to 

configure the settings for each of the different printer types available. This includes 

card printers. 

 Ensure that you have configured your smart card printer and driver correctly. 

1. From the File menu, select Print Setup to show the Setup Global Printers 

dialog. 

2. Select the Card Printer tab. 

3. If you wish to nominate a card printer other than the one displayed as the 

current printer, choose Select Printer to open the Print Setup dialog and display 

a list of appropriate printers. 

4. Select the printer type from the Printer Type drop-down list. 

5. Select the com port to be used to transmit encoding details, by selecting the 

appropriate port from the Encoding COM Port drop-down list. 

6. To encode the smart card at the same time as printing ensure that the Encode 

Smart card when printing checkbox has been enabled. 

7. Click OK. 
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9.10 Configuring a Card Reader  

(Smart card or Enrollment) 

To extract information from a card, you have to be able to read it. When assigning 

a card to a new employee, you may need to determine the card number and other 

important information. The information from the card reader dialog is stored in the 

local registry so each SiPass integrated client will have its own reader configuration 

settings. 

 Ensure that you have installed the drivers required for your readers. 

1. From the Options menu, select Enrollment Reader Configuration. 

2. Click the Add button to bring up a dialog where you can select a reader to be 

configured. 

 

 

DESFire encoding/reading is supported only for OmniKey CardMan 5 ×21 family 

of readers and 5422 readers. 

3. Select a reader and click OK. 

 

 

To delete a selected reader; select the reader from the Select Type drop down 

list, and click Remove. 

4. The address of the reader appears in the Reader Address field by default. 

5. If the selected reader is to be used only for Card Reading, tick the Reading 

checkbox. 

6. If this reader is to be used for card reading and encoding, tick the Encoding 

checkbox. The Reading checkbox will be selected automatically. 

7. Select the profile to be used for reading the card from the Profile Name drop-

down list. 

8. If you have connected a smart card reader, enter the sector/app and block/file 

to be read into the Sector (0-39)/App (0-27) and Block (0-14)/Dile (0-31) fields. 

9. If the reader is not connected by USB, select the serial port to which the reader 

has been connected from the Port Name drop-down list. 

10. If the reader is Wiegand or Clock & Data select the card format to be read 

using the Card Format drop-down list and the reader supply voltage (or source) 

from the Voltage drop-down list. 

11. Choose OK. 

9.10.1 Reader Types Supported 

Due to constant changes in technology, Sipass integrated keeps on updating to 

support the latest technology. To know about the the supported enrolment readers 

and Smart Card Encoders, see the SiPass integrated Product Release Notes in 

your software bundle.
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10 Dial-up 
Dial-up refers to communications via a modem (as opposed to a direct connection) 

between a PC running the SiPass integrated software and an ACC controller. 

Using SiPass integrated, an operator can achieve the same functionality from a 

dial-up unit as they can from a unit directly connected to the PC. For example, an 

operator can lock a door, unlock a door and even change a cardholder’s access 

control privileges at a remote location by using dial up functions. Database 

changes from the SiPass Server and audit logs from the remote unit are 

downloaded and uploaded automatically each time a connection is initiated with a 

remote ACC. 

10.1 Dial-up Components 

The components involved in a dialup system will depend on the complexity. A 

single remote connection consists of the following components: 

● Dialup Bus 

● Modem(s) 

● RAS Connection 

● Remote ACC (or Remote ACC network) 

Dialup Bus 

The Dialup Bus represents a connection from the SiPass Server to a remote 

modem or modem bank. One Dialup Bus has to be configured for each remote 

ACC or ACC network; essentially, one Dialup Bus per remote “connection point”, 

meaning a remote modem or group of modems. 

Modem – Remote side 

The remote modem communicates with the ACC via the RS-232 Modem port 

directly in the case of single remote ACC, or through a remote RAS client in the 

case of a remote ACC network. Any Hayes-compatible modem, that supports a 

baud rate of 2400bps or above, may be connected to the ACC. 

 

 

An RS-232 connector must be used to connect the remote modem to the Modem 

port on the ACC. Other connections, such as an RJ45 phone line connector 

cannot be used. 

Modem – Server side 

The modem should support a minimum Baud rate of 2400bps (Bits per second). 

The SiPass Server must have at least one serial connection port available for 

connection to a modem. The local modem(s) may only be defined on the same PC 

as the SiPass Server. 

 

 

You should install the latest modem manufacturer’s drivers for the modem you 

are using for Dialup control. The default Windows drivers should not be used. 
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RAS Connection – Server Side 

SiPass integrated uses the Windows RAS protocol to handle communications 

between the Server and the remote connection. The number of RAS connections 

you will need to create on the SiPass Server will vary, depending on how your 

modem or modems are set up. A single RAS connection, regardless of the number 

of remote ACCs, is able to manage multiple connections at the same time. 

RAS Connection – Remote Side 

 If the remote site has multiple ACCs present, instead of using a single modem for 

each ACC, a PC may be used as an RAS connection manager on the remote side. 

This allows you to manage large remote ACC networks without the need for a 

modem assigned to each ACC. 

 

 

No SiPass integrated components need to be installed on a remote RAS client at 

all. The remote client only needs to have Windows installed and the RAS 

connection to be configured. 

Remote ACC or ACC Network 

 Configuring a remote ACC involves supplying the communications parameters, 

like RAS Connection and IP address details. Once configured, a remote ACC will 

operate in the same manner as a local ACC. 

A Dialup ACC must be initially configured with dialup communications parameters 

(using HyperTerminal or similar access program) before it can be configured from 

the SiPass GUI. 

Remote devices do not need to be configured any differently in the SiPass 

integrated Components dialog. 
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10.2 Pre-requisites 

The following lists the recommended pre-requisites for a successful SiPass 

integrated dialup configuration: 

● If there is more than one modem connected to the SiPass Server PC, it is 

highly recommended that Windows 2003 / 2008 Server be used as the 

operating system. Windows XP Professional is not recommended unless only a 

single modem is connected. The appropriate changes to the Server profile 

configuration also need to be made. 

● The modems used on both the Server side and Remote side should preferably 

be of the same make and model. 

 

 

Note: The Dial-up configuration instructions, provided in the sections that follow, 

can be applied for a PC that uses either the Windows 2003 or 2008 Server as the 

operating system. Although the overall configuration is essentially the same for 

both operating systems, there may be slight variations in the configuration dialogs 

when using the Windows 2008 Server. 

 

10.3 Dialup Setup Checklist 

The following checklists can be used when configuring your remote ACC 

network(s) and the SiPass Server for dialup communication: 

● If the remote ACC is connected directly to the modem: 

– Install a modem on the PC hosting the SiPass Server, 

– Create a dialup connection on the PC hosting the SiPass Server 

– Connect modem(s) to the remote ACC unit(s) 

– Configure the Dialup Bus in SiPass integrated 

– Configure the dialup ACC(s) in SiPass integrated 

– Initialize the dialup ACC(s) with the configuration details 

● If the remote ACC network is connected via remote RAS Client: 

– Install a modem on the PC hosting the SiPass Server, 

– Create a dialup connection on the PC hosting the SiPass Server 

– Connect modem(s) to the remote RAS client 

– Create a dialup connection on the remote Client 

– Configure the Dialup Bus in SiPass integrated 

– Configure the dialup ACC(s) in SiPass integrated 

– Initialize the dialup ACC(s) with the configuration details 
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10.4 Creating the Dialup Connection  

You must create a dialup connection on the PC hosting the SiPass Server, in order 

to dial and send data to a remote ACC. The dialup connection uses the Windows 

RAS protocol to send and receive messages from the remote units. Only one RAS 

connection has to be configured; this connection is used by all remote ACCs for 

access. 

If your remote ACC network uses a “gateway” PC on the remote side, you must 

also configure a remote dialup connection on that PC. Steps 2 and 3 below do not 

apply to the remote PC. 

It is recommended that the following procedures be carried out by a Systems 

Administrator or a similar person who is familiar with setting up dialup and network 

connections in the Windows operating environment. 

Local Administrator privileges are required to set up a dialup connection on a PC in 

a Windows network. 

 

 

Whichever user is logged in during the creation of the dialup connection must be 

assigned to the SiPass Server Service as described in the next procedure. This 

applies to connections created on the SiPass Server only. 

 

10.4.1 Step 1: Making the Connection 

1. Select Settings > Network and Dial up Connections > Make a new connection 

from the Windows Start menu. 

2. Choose Next. 

3. Select the Dial-up to private network option. 

4. Enter the Phone Number of the remote modem you want to dial. If you are 

dialing a different state or country, tick the Use Dialing Rules checkbox to 

enable those fields. 

5. A “0” can be placed in front of the number if necessary, to indicate dialling an 

outside line. A comma can also be placed before the Phone number to indicate 

a pause. 

6. If you are configuring this connection on the SiPass Server, this number will be 

the number of the remote ACC or remote gateway PC that you wish to dial. 

7. If you are configuring this connection on the remote gateway PC, this number 

will be the number of the SiPass Server that you wish to dial. 

8. Choose Next. 

9. Leave the Enable Internet Connection Sharing for this connection un-ticked. 

Choose Next. 

10. Select the For all users option. Choose Next. 

11. Enter a meaningful name for the dialup connection. This is the name that will 

appear in the Connection drop-down box in the SiPass integrated Components 

dialog (SiPass Server only). 

12. Enter the Username and Password of the user that you want to assign to this 

connection. The username/password you assign here must be the same that is 

assigned to the ACC, as shown in the procedure To configure an ACC for 

dialup communications. 
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13. Choose Properties. Choose Configure. 

– The value selected in the Maximum Speed (bps) field should be 

approximately twice the rated speed of the modem used to dial the remote 

ACC. For example, for a 28.8k modem, select 57600. 

14. Ensure all of the Hardware features options are selected. Choose OK. 

15. Select the Security tab. 

16. Select the Advanced (custom settings) option. Choose Settings. 

17. Select the Allow these protocols option, and disable all protocols except for 

Unencrypted password (PAP). Choose OK. 

18. Select the Networking tab. 

19. Un-tick all options except for Internet Protocol (TCP/IP). Select the Settings 

button. 

20. Disable all settings in this dialog. Choose OK. 

21. Choose OK to exit the Connection Properties dialog. 

22. Choose Dial to dial and test the connection you have just created, or choose 

Cancel to exit to the desktop. 

10.4.2 Step 2: Assigning a username and password to the SiPass 

Server Service 

1. Choose Settings > Control Panel from the Windows Start menu. 

2. Double click on the Administrative Tools icon. 

3. Double click on the Services icon. 

4. Scroll down the list until you find the SiPassServer entry. Right click on 

SipassServer and select Properties from the menu. 

5. Select the Log On tab. 

6. Select the This Account option. Choose Browse to assign a user to this 

Service. 

7. Select a user from the list. The user you select must be the same user who 

was logged in while the dialup connection was being created, as described in 

the previous procedure. 

8. Choose OK. 

10.4.3 Step 3: Setting up an ACC for remote communications 

This procedure describes how to assign the address details, username and 

password you have configured on the SiPass Server to the remote ACC. A 

program such as Telnet or HyperTerminal is used to connect to the ACC for 

configuration. 

 

 

The Firmware Instruction set must be downloaded before the ACC can be 

configured for Dialup Communications. 

 Ensure that the ACC is connected and communicating with the SiPass Server, 

and you have configured HyperTerminal for communications with the ACC. 

1. Choose Start > Programs > Accessories > Communications> > HyperTerminal. 

2. Choose File > Open and select the connection to the ACC. 
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3. Press the <Enter> key on the keyboard until the Username prompt appears. 

4. At the Login prompt type “SIEMENS“ and press the <Enter> key on the 

keyboard. Please note the user name is case sensitive. 

5. At the Password prompt type “spirit“ and press the <Enter> key on the 

keyboard. 

6. If you have successfully logged into the ACC the message “User SIEMENS 

logged In” will appear. 

7. Ensure that you are logged into the Application Level of the ACC. If you have 

successfully downloaded the latest firmware instruction set, you will 

automatically be logged into the application level when connecting to an ACC 

via HyperTerminal. 

8. Type “get modem” and press the <Enter> key. A list of default dialup settings 

will appear in the HyperTerminal window, The ‘set modem’ command is used to 

set the Connection parameters. 

9. To set the IP address of the ACC (for PPP communications), type “set modem 

local address “ACCAddress”” at prompt. Where “ACCAddress“ refers to the IP 

address of the modem connected to the ACC. 

10. To set the IP address of the Host (for PPP communications), type “set modem 

remote address “HostAddress”” at the prompt. Where “HostAddress“ refers to 

the IP address of the PPP link on the Server PC which the ACC will be dialing. 

This will have been configured by you as described in the section To assign a 
static IP address to a network connection. 

11. To set the subnet mask (if any), type “set modem subnetmask “SubnetMask”” 

at the prompt. Where “SubnetMask“ refers to the subnet mask used to access 

the remote network of ACCs. 

12. To set the username property, type “set modem username 'UserName'” at the 

prompt. Where “UserName“ refers to the Windows user name assigned to the 

SiPass Server Connection in the procedure To Create the Connection. 

13. To set the password property, type “set modem password “Password” 

command at the prompt. Where “Password“ refers to the Windows password 

assigned to the SiPass Server Connection in the procedure To Create the 
Connection. 

14. To set the phone number property, type “set modem number “PhoneNumber”” 

at the prompt. Where “PhoneNumber“ refers to the phone number of the 

modem connected to the SiPass Server. 

15. Type the command “reboot” at the prompt and press <Enter> 

 

 
NOTICE 

Important: These parameters, except for “username” and “password”, can also be 

set from SiPass integrated. Any values entered in the SiPass GUI will over-ride 

the above settings. This means that you must enter the same values in SiPass 

integrated as configured above before establishing the first connection, otherwise 

the dialup parameters will be over-ridden by the default settings and you will have 

to re-configure the ACC. 
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10.5 Creating the Dial-up Bus Service 

You may have selected to install a dialup bus during your SiPass integrated 

installation. If this is the case, you can proceed to defining a Dialup Bus. 

1. Select Components from the System dialog or menu. 

2. Select the Server name in the left hand pane. 

3. Choose New Bus. A menu displaying a list of options will appear. Select Dialup 

/ Remote Network. 

4. Select the RAS connection that you defined in the previous section from the 

Connection drop-down box. 

5. Select the Alarm Class that will apply to this dialup bus from the Bus Alarm 

drop-down box. 

6. The default Initial Maximum number of cards per ACC is 25,000. If you need to 

change this value, enter a new number into the field. The actual maximum 

number of cards per ACC will depend on the license you have purchased. 

7. The Number of commands to unit before auto-download field determines how 

many database commands at the Server can occur, before the SiPass 

integrated server will automatically dial the remote ACCs and download the list 

of database changes. The default is 1000. 

8. Choose Connect to connect to the remote ACCs. The Status field will be 

updated according to whether the connection was successful or not. 

 Once a connection has been made, a remote ACC and any connected devices 

will operate exactly like a local ACC plus devices. 

10.5.1 Defining the Dial-up ACC 

The remote ACC must be configured with communications and address 

parameters. The steps required to define a Dial-up ACC are as follows: 

1. Select Components from the System menu or toolbar. 

2. Select the remote Bus that you defined in the previous section from the 

Components tree. Choose New Unit. 

 A new ACC will appear under the remote Bus and two new tabs will 

become available. The fields in the ACC Controller tab are filled in exactly 

the same as for a local ACC unit. 

3. Select the Dialup/PPP Properties tab. 

4. Tick the Allow incoming Connections checkbox if you want the SiPass Server 

to be able to initiate a connection to the ACC. 

5. Enter the number of the first modem connected to the SiPass Server into the 

first Server Phone Number field. 

6. If you are only using one modem to dial in to the Server, enter the same 

number into the second Server Phone Number field.  If two modems are 

connected to the SiPass Server, enter the number of the second modem into 

this field. 

7. Complete the fields in the Other Properties section: 

– The command list must be terminated with the ‘^M’ character. 

8. Click Save. 



 

 

Dial-up 

Creating the Dial-up Bus Service 
10 

A6V101068156  169 | 313 

 

10.5.1.1 Dialup Properties 

The following table explains the available properties when configuring dialup 

ACCs. 
 

Property Description 

ACC PPP Address The PPP Address of the connection on the remote ACC. Note that this is different to the TCP/IP 
address configured for the PC during initial installation. 

Host PPP Address The PPP Address of the connection on the SiPass Server. Note that this address is different to 
the TCP/IP address of the Server PC. 

Subnet Mask The Subnet Mask (if applicable) used to access ACCs on the remote network. 

Idle Timeout (min) The length of time after which, if there has been no communication either from or to the ACC, the 
ACC will disconnect the Dialup connection to the SiPass Server. 

No. of Retries The number of times the ACC will attempt to dial the first phone number. If there has not been a 
successful connection, the ACC will attempt the same number of tries on the second phone 
number, and continue to alternate between the two numbers. 

Baud Rate The baud rate of the serial dialup connection. This should be set to the next fastest speed above 
the baud rate of the modem connected to the ACC. 

Modem Initialization 
String 

The commands that are sent to a modem prior to sending information; for example, to turn off 
sounds or to disable a certain communications mode. Consult your modem’s User Guide for a list 
of modem commands that are understood. 

Dial Server When The number of Audit Trail messages that accumulate in the ACC Audit Trail buffer before the ACC 
dials the SiPass Server to upload. 

 

10.5.2 Defining other Components 

Once you have defined the dialup bus for the ACC Series platform, all other 

components, including FLN connections, Devices and Points, are defined earlier in 

this manual. 

10.5.3 Alarm Class on Dial-up Controllers 

If you want an alarm on a dial-up unit to be reported immediately to the system, 

you must define an Alarm Class for each remote ACC, device and point. The Alarm 

Class assigned must require acknowledgement from an operator, and also have 

the Dial Back checkbox ticked. 

Alarm Classes on a dial-up unit are defined in exactly the same manner as Alarm 

Classes on a local unit. 

 

 

The Alarm Class you define must include all the appropriate states. For example, 

each door should have a state for door open, door forced, door held and door 

closed. This ensures that an alarm will be up-loaded to the Server immediately, if 

any of these changes of state occurs. 

If you do not assign an Alarm Class to a point on the dial-up controller, or do not 

select the Dial Back option, you will not be notified immediately when a change in 

state occurs. The unit will generate a message (and place it in the Audit Log) 

stating that the point has changed state, but this will not reach the Server until the 

unit uploads its Audit Trail buffer to the Server. 

Furthermore, the message will never be displayed unless a report is generated. 
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10.5.4 Initialization and Downloading 

Data at your site has to be downloaded to remote Controllers and Devices just like 

local units. Changes to the SiPass Server database are downloaded to remote 

units by initialization.  

Initialization can be performed manually, or automatically initiated by SiPass 

integrated depending on your configuration settings in the Components dialog. 

Initializing a remote unit 

 Ensure that you are able to dial a dialup ACC before you intialize a dialup unit. 

1. Select Initialize from the System dialog or menu. 

 A list of every ACC defined in the Components dialog, and currently online, 

will appear in the Available field. 

2. Select the remote unit(s) in the Available list that you want to initialize. 

3. Choose Add >. 

 The unit will be moved to the Selected list. 

4. You can select which data is downloaded to units during Initialization by ticking 

the Initialization Options checkbox. This step is optional; you may choose to 

stick with the default settings. 

5. A confirmation dialog will appear asking if you are sure you want to change 

these settings. Click Yes to proceed. 

6. Any data component can be downloaded by ticking or un-ticking the 

appropriate checkbox. 

7. Click Full Initialize. 

 The data you selected will be downloaded to the remote ACC(s). The 

initialization process will be displayed in the Audit Trail. 

10.5.4.1 Initialization Options 

The following table explains the available initialization options. 
 

Option Description 

Memory This option is disabled and is not applicable. 

Holiday All defined holidays will be downloaded on initialization. 

Time Schedule All defined Time Schedules will be downloaded on initialization. 

Point All information about the points that belong to the selected units will be downloaded on 
initialization. 

Employee Access All cardholders’ access control information will be downloaded on initialization. 

Anti-Passback Anti-Passback information, such as areas, points and modes will be downloaded on initialization. 

Intrusion Area All intrusion area information will be downloaded on initialization. 
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Option Description 

Download expired 
cards 

Expired cardholder cards will be downloaded on intialization. 

Download all cards to 
all ACC’s 

All cardolder cards will be downloaded to each of the ACC’s. 

Elevator All elevator data will be downloaded on initialization. 

Event Task All controller-based event task data will be downloaded on initialization. 

 

10.5.4.2 Automatic download of data to a remote ACC 

When creating an ACC dialup bus, the value in the field No. of commands to unit 

before auto-download determines how often the SiPass Server will automatically 

initiate a connection to remote ACCs to download recent database changes. 

It is important to note that this value refers to database commands, not changes. A 

single database command may generate a relatively high number of commands. 

When this value is reached, the Server will dial each remote ACC and download 

database changes to the following items: 

● Cardholders 

● Points (input and output) 

● Time Schedules 

● Holidays 

● Point Groups 

● Workgroups 

 

 

The lower the value in the No. of Commands to unit before auto-download field, 

the higher the frequency of automatic downloads. Setting the value too low may 

have an effect on the speed of your network, depending on network bandwidth 

and the normal traffic generated by your site. 

Initialization messages 

During both manual and automatic initialization, messages are displayed in the 

Audit Trail indicating the progress and status of the dialup connection and 

database download. 

10.5.4.3 Uploading data from a remote unit 

There are four scenarios under which data from an ACC may be uploaded to the 

SiPass Server: 

● The ACC Audit Log (buffer) approaches capacity. 

● An alarm is generated on a remote unit. 

● A manual “Establish Dialup Connection” command is sent to a remote unit. 

● A “Establish Dialup Connection” Event Task is triggered. 
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The ACC Audit Log (buffer) approaches capacity 

Each Advanced Central Controller has an Audit Log, called a buffer, used to store 

Audit Trail events that have occurred. When the ACC buffer reaches a defined 

value, the remote ACC will automatically initiate a connection back to the SiPass 

Server and upload the Audit Log to the Server Database. 

The value at which an ACC will initiate a connection and upload is defined in the 

Dial Server when xxx messages have been accumulated at the controller field of 

the Components dialog. The default value is 100. 

An alarm is generated on a remote unit 

Alarms generated at a remote controller are sent immediately to the SiPass Server, 

if the point or unit in alarm has been assigned an appropriate Alarm Class. The 

Alarm Class assigned must have the Dial Back checkbox ticked. 

If the point or unit has not been assigned an Alarm Class, the remote ACC will not 

automatically initiate a connection if an alarm occurs. 

A manual “Establish Dialup Connection” command is sent to a 
remote unit 

It is possible to send a manual “Establish Dialup Connection” command to a unit, 

which will cause the remote ACC to dial in to the SiPass Server. 

An “Establish Dialup Connection” Event Task is triggered on the SiPass Server. 

The Establish Dialup Connection command may be used as an effect in a SiPass 

Event Task. For example, you may want to establish a connection at 3 a.m. nightly 

to upload the ACC audit trail and download the latest database changes. 

Creating an Event Task to establish a dialup connection 

1. Select Program > Event Task > Host. 

2. Enter a name for the Event Task into the Event Name field. 

3. Select the Time Schedule during which this Event Task will be triggered. 

4. Select “Time Schedule” from the Source1 drop-down box. 

5. Select “Start” from the State1 drop-down box. 

6. Select “Unit” from the Target drop-down box. 

7. Select “Establish Dialup Connection” from the Command drop-down box. 

8. Select the Remote ACC to which you want to initiate a dialup connection, from 

the Location drop-down box. 

9. Click Save. 

 A connection will be established with the remote unit at the start of the Time 

Schedule selected in step 3. The latest database changes will be downloaded 

to the ACC and the Audit Trail uploaded. 
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10.6 Redundant Communications 

SiPass integrated contains a number of mechanisms to protect the Server-

Controller communications channel in case of failure. These mechanisms use 

additional, redundant communications channels to automatically switch over if the 

previous channel is disabled. 

There are three levels of communications redundancy that can be configured. 

● Ethernet Level Redundancy 

● Dialup Backup Redundancy 

● Secondary Phone Number Dialup Redundancy 

The first level is completely transparent to the user. SiPass integrated will actively 

reroute data if a node fails in the Ethernet architecture between the Server and the 

ACC. This requires no configuration or action on the part of the SiPass operator 

and is not discussed in this User’s Guide. 

Dialup Backup Redundancy involves creating a normal dialup connection between 

the Server and the ACC(s) and designating the connection as redundant. If the 

Ethernet connection fails altogether, an ACC equipped with redundant dialup will 

automatically dial in to the SiPass Server. 

You can also supply a second phone number with which to dial in. If the ACC 

encounters a busy signal on the first attempt, it will automatically retry using the 

backup number. You will need to configure two modems into the SiPass Server PC 

to use a secondary phone number. 

 

 

 

CAUTION 

Redundant Communications will not work in conjunction with Co-stand by server, 

unless a network modem system such as a Shield modem box is connected. 

 

10.6.1 Pre-requisites 

The following lists the recommended pre-requisites for a successful Redundant 

Communications configuration: 

● If there is more than one modem connected to the SiPass Server PC, it is 

highly recommended that Windows 2003 Server is used as the operating 

system. Windows XP Professional is not recommended unless only a single 

modem is connected. The procedures in this section assume you are using 

Windows 2003 Server as the operating system for setting up dialup 

communications. 

● It is recommended that the SiPass Server is also located on a network domain, 

controlled by a Windows 2003 server domain controller, instead of a 

standalone or Workgroup PC. SiPass integrated does not necessarily have to 

be installed on the domain controller itself, only located on a PC within a 

domain. 

● The modems used on both the Server side and Remote side should preferably 

be of the same make and model. 

  



 

 

Dial-up 

Redundant Communications 
10 

174 | 313  A6V101068156 

 

10.6.2 Redundancy Configuration Summary 

The following is a summary of the dialup redundancy configuration process: 

● Enable the storage of passwords using reversible encryption at the Domain 

Controller (for SiPass Servers within a domain only). 

● Create the dialup connection for the redundant ACC dialup. 

● Configure the appropriate ACC(s) for redundant dialup communications. 

● Define the ACC in SiPass integrated 

10.6.3 Setting up Dialup Redundancy 

10.6.3.1 Creating the Dialup Connection 

1. Select Settings > Network and Dialup Connections > Make new connection 

from the Windows Start menu. 

2. Choose Next. 

3. Select Set up an Advanced connection and choose Next. 

4. Select the Accept incoming connections option. Choose Next. 

5. If the SiPass Server PC is located on a domain, you will be prompted to 

proceed. 

6. Choose Yes. 

7. Right click the name of the PC you are using, from the tree in the left hand 

pane. Select Properties from the menu. 

8. In the General tab, ensure that the Remote Access Server checkbox is ticked. 

9. Select the Security tab. Choose the Authentication Methods button. 

10. De-select all options except for Unencrypted Password (PAP). 

11. Select the IP tab. Choose Add. 

12. Enter a starting IP address and an End IP address into the field. This address 

range represents the number of addresses that the Server can allocate to 

incoming connections. The addresses in this range must be unique; that is, 

they cannot already have been assigned to existing PCs on the network in 

which the Server is located. You should allocate a number of addresses no 

less than the number of ACCs on the remote site. 

13. Select the PPP tab. 

14. Deselect all options in this tab. 

15. Choose Apply. 

16. Choose OK to exit the dialog. 

 Configuring your SiPass Server PC to accept an incoming call from a remote 

ACC is now complete. 
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10.6.3.2 Setting-up password storage 

1. Select Settings > Control Panel from the Windows Start menu. 

2. Double click on the Administrative tools icon. 

3. Select the Local Security Policy icon. 

4. Open Account Policies, and then Password Policy in the tree on the left hand 

side by clicking on them. A list of options will appear in the right hand pane. 

5. Double click on the item Store password using reversible encryption. 

6. Select the Enabled option. Choose OK. 

7. Exit from the Local Security Settings dialog. 

8. Reboot the computer for the change to take affect. 

10.6.3.3 Setting up an ACC for remote communications 

This procedure describes how to assign the address details, username and 

password you have configured on the SiPass Server to the remote ACC. A 

program such as Telnet or HyperTerminal is used to connect to the ACC for 

configuration. 

 

 

The Firmware Instruction set must be downloaded before the ACC can be 

configured for Dialup Communications. 

 Ensure that the ACC is connected and communicating with the SiPass Server, 

and you have configured HyperTerminal for communications with the ACC. 

1. Choose Start > Programs > Accessories > Communications > HyperTerminal. 

2. Choose File > Open and select the connection to the ACC. 

3. Press the <Enter> key on the keyboard until the Username prompt appears. 

4. At the Login prompt type “SIEMENS” and press the <Enter> key on the 

keyboard. Please note the user name is case sensitive. 

5. A Password prompt will now appear. 

6. At the Password prompt type “spirit” and press the <Enter> key. If you have 

successfully logged into the ACC the message “User SIEMENS logged In” will 

appear. 

7. Ensure that you are logged into the Application Level of the ACC. If you have 

successfully downloaded the latest firmware instruction set, you will 

automatically be logged into the application level when connecting to an ACC 

via HyperTerminal. 

8. Type “get modem” at the prompt. A list of default dialup settings will appear in 

the HyperTerminal window. 

9. To set the IP address of the ACC (for PPP communications), type “set modem 

localaddress “ACCAddress” at the prompt. Where “ACCAddress” refers to the 

IP address of the modem connected to the ACC. 

10. To set the IP address of the Host (for PPP communications), type “set modem 

remoteaddress “HostAddress”” the following command at the prompt. Where 

“HostAddress“ refers to the IP address of the PPP link on the Server PC which 

the ACC will be dialing. This will have been configured by you as described in 

the section To assign a static IP address to a network connection. 
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11. To set the subnet mask (if any), type “set modem subnetmask “SubnetMask”” 

the following command at the prompt. Where “SubnetMask“ refers to the 

subnet mask used to access the remote network of ACCs. 

12. To set the username property, type “set modem username “UserName”” at the 

prompt. Where “UserName“ refers to the Windows user name assigned to the 

SiPass Server Connection in the procedure To Create the Connection. 

13. To set the password property, type “set modem password “Password”” at the 

prompt. Where “Password“ refers to the Windows password assigned to the 

SiPass Server Connection in the procedure To Create the Connection. 

14. To set the phone number property, type “set modem number “PhoneNumber”” 

the following command at the prompt. Where “PhoneNumber“ refers to the 

phone number of the modem connected to the SiPass Server. 

15. Type the command “reboot” at the prompt and press the <Enter> key. 

 The ACC is now configured for Dialup communications. 

 

 

These parameters, except for “username” and “password”, can also be set from 

SiPass integrated. Any values entered in the SiPass GUI will over-ride the above 

settings. This means that you must enter the same values in SiPass integrated as 

configured above before establishing the first connection, otherwise the dialup 

parameters will be over-ridden by the default settings and you will have to re-

configure the ACC. 

 

10.6.4 Setting-up redundant dialup on an ACC 

1. Select Components from the System menu. 

2. Select the ACC from the Components tree for which you are configuring 

Redundant Dialup. 

3. Select the Dialup/PPP Properties tab. 

4. Tick the Enable Communications Redundancy checkbox. The fields in the 

dialog will be enabled. 

5. Tick the Allow incoming Connections checkbox if you want the SiPass Server 

to be able to dial in to the ACC. 

6. Enter the number of the first modem connected to the SiPass Server into the 

first Server Phone Number field. 

7. If you are only using one modem to dial in to the Server, enter the same 

number into the second Server Phone Number field. 

8. If two modems are connected to the SiPass Server, enter the number of the 

second modem into this field. 

9. Complete the fields in the Other Properties section: 

– The command list must be terminated with the ‘^M’ character. 

10. Select from the drop-down box in the Unit Connection section the RAS 

connection used to connect back to the SiPass Server. 

11. Click Save. 
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10.6.4.1 Dialup ACC Options 

The following table explains the configuration options for dialup ACCs. 
 

Option Description 

ACC PPP Address The PPP Address of the connection on the remote ACC. Note that this is different to the 
TCP/IP address configured for the PC during initial installation. 

Host PPP Address The PPP Address of the connection on the SiPass Server. Note that this address is different to 
the TCP/IP address of the Server PC. 

Subnet Mask The Subnet Mask (if applicable) used to access ACCs on the remote network. 

Idle Timeout (min) The length of time after which, if there is no communication either from or to the ACC, the ACC 
will disconnect the Dialup connection to the SiPass Server. 

No. of Retries The number of times the ACC will attempt to dial the first phone number. If there has not been 
a successful connection, the ACC will attempt the same number of tries on the second phone 
number, and continue to alternate between the two numbers. 

Baud Rate The baud rate of the serial dialup connection. This should be set to the next fastest speed 
above the baud rate of the modem connected to the ACC. 

Modem Initialization String The commands that are sent to a modem prior to sending information; for example, to turn off 
sounds or to disable a certain communications mode. Consult your modem’s User Guide for a 
list of commands 

Dial Server When The number of Audit Trail messages that accumulate in the ACC Audit Trail buffer before the 
ACC dials the SiPass Server to upload. 
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11 Elevators 
The elevator function of SiPass integrated can control the access of cardholders 

and the public to particular floors, and the times during which they may access 

those floors. Floor access control privileges are assigned to cardholders in exactly 

the same manner as access to doors. 

The ACC maintains a database of cardholders and access control privileges. When 

a cardholder presents his/her card to the card reader located inside an elevator 

car, the controller reads its database and establishes the floors to which they have 

access. Only those floors will be made available to the cardholder. 

It is also normal for floors to be unsecured during particular times of the day. For 

example, during office hours where any member of the staff or public can access a 

company’s floors. The Time Schedule downloaded to the controller determines 

when floors are secured (access privileges are required) or unsecured (anyone can 

access the floor). 

In high-rise residential buildings, visitors generally require access to elevators after 

being allowed into the building via the tenant’s intercom unit. 

The following table explains some of the key terms used to describe Elevator and 

Access Control systems: 
 

Term Description 

Bank A bank is a group of one or more elevators that service identical floors. A bank can also be 
known as a “Rise” or a “Group”. 

Floor A floor is a level in a building at which an elevator can stop and take on or release passengers. 
In SiPass integrated, a floor is treated like an access point; it can be assigned a Time 
Schedule, and a cardholder can be granted permission to access the floor. 

Elevator (Car) This is the physical carriage which carries passengers. A card reader located inside the 
elevator car allows cardholders to badge their card before selecting a secure floor. 

Floor Group A group of one or more floors. A floor group is treated like a point group in SiPass integrated; 
actions can be performed on the entire group, and floor groups assigned to access levels. 

Crossover Floors In tall buildings with very many floors, there may not be an elevator or bank that services every 
floor in the building. A crossover floor is a floor that is common to a set of elevators, some of 
which service lower floors, some of which service upper floors. 

Unserviced Floors Floors which are not serviced by a particular elevator or bank. 

Fire Override (FOR) Fire Override refers to the ability to modify the access control behaviour of an elevator system 
in the event of a fire or emergency. 

The default Fire Override behaviour will depend upon the legal requirements for elevator 
systems in your location. 

Access Control System 
(ACS) 

The application responsible for managing access to floors by cardholders. 

Low Level Interface (LLI) In a Low Level Interface, the ACS is also responsible for energizing and de-energizing the 
buttons located inside the elevator car. The ACS interfaces with the elevator itself by way of 
hardware called a Service Interface Module (SIM). 
In SiPass integrated, the role of a SIM is carried out by the Output Point Module (OPM), which 
connects to the buttons inside the elevator car. 
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11.1 Elevator Control 

There are two individual systems that control the operation of elevators. The 

Elevator Management System regulates and controls the mechanical operation of 

the elevators, while the Access Control System regulates the access of elevators 

to floors. 

This section details how the Access Control system is configured, from both a 

software and a hardware perspective, to provide correct elevator operation and a 

level of security. 

Floor security is controlled via a hardware (low-level) interface; in this case, an 

Output Point Module, or OPM. The inputs and outputs of the OPM are connected 

to the buttons inside the elevator car, and enable or disable them according to 

whether a cardholder has access permissions to that floor or not. 

Low Level Elevator Control incorporates relay-logic. Relays are energized and de-

energized to activate and de-activate the security of floors, according to the Time 

Schedule and cardholder access control privileges. 

● Requires an Output Point Module (OPM) for every 16 floors. 

● Fire override is accomplished by the OPM. 
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11.2 Fire Override 

This section applies only to setting up Low-Level Elevator Control. 

Fire Override (FOR) refers to the override of access control during an emergency 

by the Elevator Management or Fire systems. FOR is carried out as a result of a 

trigger, usually a FOR Input like a fire alarm. The trigger may come from SiPass 

integrated or another application, but SiPass integrated receives and forwards a 

trigger through the FOR inputs and outputs on the OPM. 

When a Fire Override input on an OPM is activated, it de-energizes the outputs on 

that OPM. This in turn de-energizes the elevator buttons connected to the outputs, 

making those floors accessible in an emergency. This allows any passengers 

inside the elevator car to exit safely at any floor, and permits access to the 

elevators by passengers wishing to leave a floor. 

In practice however, fire regulations in your region may require different behavior 

from the Elevator Management System. For example, in an emergency situation, it 

may be required that elevators travel to the nearest floor, open the doors and then 

are disabled until reset by a master control. 

For an exact description of how Fire Override must be carried out in your 

jurisdiction, consult the local fire regulations and the Elevator Management System 

manufacturer. 

11.2.1 Fire Override and Wiring 

Whether or not Fire Override is implemented at a facility will affect how OPMs are 

wired to each elevator. As stated in the previous section, triggering the FOR inputs 

will de-energize the outputs on an OPM, unsecuring the corresponding floors.  

If there is an overlap between OPMs – that is, if the outputs on one OPM are 

shared between elevators – this means with FOR enabled, both elevators will be 

affected if the FOR input is triggered. Such a scenario may not be desirable; for 

example, independent elevator operation may be required in an emergency 

situation. 

This requires therefore that sites with FOR enabled be wired with no overlap. 

A third scenario also exists, as the OPM actually has two FOR inputs which can 

independently control blocks of up to eight outputs. This allows you to keep 

independent control of elevators for sites with a small number of floors and/or 

elevators. 
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11.3 Setting up an Elevator System 

Setting up a low-level elevator system in SiPass integrated requires a knowledge 

of how the SiPass integrated system hardware has been wired to the Elevator 

system; specifically, the order in which input and output points on the Output Point 

Module(s) have been wired to the destination floor buttons inside the elevator car. 

There are seven major steps in configuring a low-level elevator system in SiPass 

integrated: 

● Pre-configuration 

● Configure the ACC Elevator Controllers 

● Configure the Output Point Modules used to connect to the Elevator system 

● Configure the Reader Interface Modules inside each Elevator Car 

● Configure the Banks 

● Configure the Floors in each Bank 

● Configure the Elevators 

11.3.1 Low-level System Pre-Configuration  

This section explains how to work out the requirements for your facility’s elevator 

access control system, and how the Fire Override wiring of your system will affect 

its configuration under SiPass integrated. 

The following are the theoretical maximums that may be configured for a single 

ACC: 
 

Component Theoretical Maximum 

Banks 64 per controller 

Elevators 255 per controller 

Floors 255 per system 

Cardholders Up to 1 million per controller 

 

In a real scenario however, the actual maximums will be less. Possible reasons for 

this are as follows: 

● One OPM may only connect up to 16 floors 

● If FOR is required you may not overlap floors between OPMs. 

● One ACC may only connect up to 36 OPM devices (6 per FLN Channel) 

● One reader is required for each elevator car that accesses secure floors. 

11.3.2 Defining the Advanced Central Controller (ACC) 

The Advanced Central Controller stores the cardholder floor access privileges, 

including floor Time Schedules, and communicates with OPMs and the Elevator 

Management System. 

Defining an Elevator Controller is the same as defining an access controller, as 

described earlier in the section Adding an ACC. 

 

A High Level Interface can be configured on FLN1/FLN 2/FLN3. Hence any of 

these three FLN’s can be used to configure HLI on the ACC-Granta unit. 
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11.3.3 Defining the Output Point Modules (OPM) 

The OPM is connected to the floor buttons inside the elevator car, and permits 

access to secure floors if the cardholder has the correct privileges. 

1. Select Components from the System toolbar or menu. 

2. Select the ACC and then the FLN channel to which the OPM will be connected. 

3. Choose New Device, and select OPM from the menu. 

4. Enter a suitable name for the OPM into the Name field. 

5. Select an Alarm Class for the OPM from the Alarm Definitions drop-down 

menu. 

6. Click Save. 

Input and Output points that are used for elevator access control do not need to be 

configured from the Components dialog. Any settings in the Input and Output tabs 

for these points will be over-ridden by the settings in the Elevator Configuration 

dialog, and these points will be disabled in the Components dialog if assigned to an 

elevator. 

Input and Output points that are used for other purposes, like duress buttons or 

PIRs, are configured from the Components dialog as per System Components. 

11.3.4 Defining the Card Readers 

A Reader Interface Module (RIM) must be configured inside each elevator car. The 

RIM allows cardholders to badge their card and attempt to access secure floors. A 

RIM inside an elevator car can either be a DRI (Dual Reader Interface) or an SRI 

(Single Reader Interface).  

1. Select Components from the System toolbar or menu. 

2. Select the ACC and then the FLN channel to which the RIM will be connected. 

Choose New Device, and select DRI or SRI from the menu. A new device will 

appear in the Components tree and several new tabs will appear. In this 

example we will choose an SRI. 

3. Enter a descriptive name for the SRI into the Name field. 

4. Select an Alarm Class from the Alarm Definitions field. 

5. Select the Reader tab. 

6. Select an Alarm Class for the reader from the Alarm Definition drop-down box. 

7. Select the correct operation mode from the Operation Mode drop-down box. 

The mode will determine how the SRI should operate. 

8. Select the Time Schedule during which the daily code is enabled from the Daily 

Code Time Schedule drop-down box. 
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9. Complete the following fields, as they apply: 

– Host Verify Timeout:  

The time in seconds that the Image Verification dialog will wait for a 

response from an operator, before closing and allowing access to be re-

attempted. 

– PIN Timeout:  

The time in seconds that a cardholder has to enter a PIN on the keypad. 

The timeout begins once the first digit is entered, or a card is badged and 

the reader is set to Card and PIN operation mode. 

– Daily Code:  

The daily code for this reader. This may or may not be the same daily code 

used at other access points. 

– Daily Code No. of Digits:  

The exact number of digits in the daily code. 

10. Tick the Void Card After 3 Wrong PIN Entries checkbox, if you want any card 

that enters a wrong PIN number three times at this reader to be temporarily 

voided. 

– To re-activate a card that has been temporarily voided after 3 wrong PIN 

entries: In the Cardholder screen uncheck the 3 PIN disabled box 

11. Complete the Input/Output and Image Verification tabs, as described earlier in 

this manual. 

12. Click Save. 

11.3.5 Defining the Banks 

Banks are groups of one or more elevators that service the same floors. Elevator 

components including Banks, Floors and Elevators are configured in a separate 

dialog, called Elevator Configuration. 

1. Select Elevator from the System menu or toolbar. 

2. Select the ACC Elevator Controller for which you are defining a Bank, from the 

Components tree. Select the Bank Wizard option in the ACC details tab, or 

right-click and select Create Bank from the menu. A Bank will appear under the 

ACC in the Components tree and a new tab will appear. 

3. Enter a descriptive name for the Bank into the Bank Name field. 

4. Select “Low” from the Bank Type drop-down menu. The options available in the 

Bank Type menu will depend on the options you have chosen in the Validity 
Check dialog during SiPass integrated installation. 

5. Click Save. 

  



 

 

Elevators 

Setting up an Elevator System 
11 

184 | 313  A6V101068156 

 

11.3.6 Defining the Floors  

You must define which floors that a bank will service. Defining the floors for a 

single bank may require more than one use of the Bank Floor Wizard. The Wizard 

is designed to easily “correct” the type and number of floors in a bank. This means 

you can configure the below-ground floors for a bank first, assigning them a unique 

label, and then add the above-ground floors later using a different label. 

The following terms are used when defining floors: 

● Rise Number 

Rise Numbers are an internal address used by SiPass integrated as a reference 

for the floor, to be passed to the Elevator Management System. Each floor in the 

building is assigned only one Rise Number. 

In SiPass integrated, Rise Number 1 normally represents the lowest possible 

serviceable floor in the building; for example, Rise Number 1 could be Basement 

Level 3. 

● Floor Number 

Floor Numbers are user-assigned labels, and are not used in SiPass integrated for 

anything other than indicating the position of the floor with respect to Ground.  

Defining the floors in a bank 

1. Select Elevator from the System menu or toolbar. 

2. Select from the Components tree the Bank for which you are defining the 

floors. 

3. Select the Floor Wizard option, or right-click on the Bank and select Bank Floor 

Wizard. 

4. Choose Next. 

– The Floor Name Prefix field indicates the text that will be used when these 

floors appear in SiPass integrated dialogs; for example, “Above Ground”. 

The default is the Bank Name. 

– The Floor Name Postfix field indicates the text that appears before the floor 

number, when these floors appear in SiPass integrated dialogs; for 

example, “Floor” or “Level”. The default is “Floor”. 

 

 

Every floor in SiPass integrated must have a unique name. 

5. Enter into the Rise Numbers field the floors you are defining to be serviced by 

this bank. Single floor numbers are separated by commas. You can use a dash 

to represent a range of serviced floors, and use a comma to separate Rise 

Numbers; for example “1-4, 9-20’. 

 The Current Rise Numbers field indicates the Rise Numbers that you have 

already defined for this Bank. You can override currently defined floors by 

re-entering all or some of the current rise numbers into the Rise Numbers 

Field. Entering additional Rise Numbers will add those floors to existing 

floors for this Bank. Only the Time Schedule, Alarm Class and Enabled 

fields will be over-ridden if you re-enter defined Rise Numbers. Floor 

names are only changed through the Floor Name column of the Bank Floor 
details tab. 
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6. Complete the Floor Number Suffix details: 

– Append Number:  

Tick this checkbox to append the Floor Number to the Floor as it appears in 

SiPass integrated dialogs. 

– Keep Rise Increments:  

Tick this checkbox if you want to match the increments in Floor Numbers to 

increments in the Rise Numbers. For example: the numbers “1-3, 5-7, 11-

20” are entered into the Rise Numbers field, and the Start Number is 4. The 

corresponding Floor Numbers for this group of floors would be “4-6, 8-10, 

14-23”. 

– Start Number:  

Select where to begin numbering floors. 

– Ascending/Descending:  

Tick the appropriate option to count upwards or backwards from the Start 

Number when assigning Floor Numbers. 

7. Select a Time Schedule that will be applied to every floor selected. Individual 

floor Time Schedules can be changed later. 

8. Select an Alarm Class that will be applied to every floor selected. Individual 

floor Alarm Classes can be changed later. 

9. Select from the Floor Enabled drop-down box whether all floors will be enabled 

or disabled by default. 

10. Choose Finish. 

 You will be returned to the Elevator Configuration dialog. A table of floors 

will have been created under the selected Bank. 

11. You can modify the properties of individual floors by clicking in the appropriate 

cell and selecting or entering a new value. This allows you to define groups of 

floors with the same attributes and then alter details for particular floors later. 

– Disabling a floor means that it will not be accessible from any elevator in 

the bank. 

12. Click Save. 
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11.3.7 Defining the Elevators  

Defining an elevator requires that you select the OPM inputs and outputs that are 

connected to the floor buttons in that elevator. 

1. Select Elevator from the System toolbar or menu. 

2. Select the Bank in the Components tree for which you are defining an elevator. 

3. Select Elevator Wizard from the Bank Details tab, or right-click on the Bank and 

select Create Elevator. 

4. Choose Next. The Select OPMs list lists all of the Output Point Modules (OPM) 

that you have defined through the Components dialog. Ticking the checkbox 

next to an OPM will list all of that OPM’s available input and output points in the 

two columns to the right. Multiple OPMs may be selected. You can re-order the 

points in the input/output lists by clicking and dragging the OPMs in the Select 

OPMs list. Points will be listed in order of OPM. Ticking a checkbox next to an 

Input point or Output point indicates that it should be assigned to a floor. Any 

surplus inputs or outputs that have been ticked will be ignored. 

– SiPass integrated will assign all ticked Input points and Output points to 

serviced floors in the order they appear in the Bank Floor Details tab. 

– For example, an elevator services from the Ground Floor to Floor number 

12, and the OPM wired to this elevator is called “OPM Elevator 1”. The first 

input on this OPM is connected to the button for Ground Floor, the second 

input is wired to the first floor button, and so forth, until 13 inputs have been 

assigned. 

5. Ticking the Match IN/OUT checkbox will match input point selections to 

outpoint point selections. 

6. Un-tick the Floor Reporting checkbox to disable Floor Reporting. That is, if 

OPM input points are not used for floor reporting for this elevator. 

7. Ticking the Invert Input checkbox will set the default Invert Input for each floor. 

8. Choose Finish. A new elevator will be created under the selected Bank and a 

new tab will appear containing the details you entered in the Elevator Wizard. 

9. You can enter a new name for the elevator into the Name field if required. 

10. Select the Reader located in the elevator car from the Reader drop-down box. 

11. Enter an ID to be assigned to this elevator from the ID field. Each Elevator 

must have a unique ID number. In a Low Level Interface, the Elevator ID is 

assigned by the Access Control System (SiPass integrated). 

– The value in the Delay field represents the time allowed between a valid 

card badge and being able to select a secure floor. If a floor has not been 

selected within this Time Schedule (and Floor Reporting is enabled), the 

floor buttons will be re-secured and the person will have to badge the card 

again to attempt access. 

12. Tick the Inputs Inverted checkbox to invert the input received from this 

elevator’s input and point points by SiPass integrated. Only values in the Input 

Point / Output Point columns may be changed in the table. 

– Individual floors cannot be added or removed from single Elevators. This is 

because each elevator in a Bank must service exactly the same floors. If 

you want to add or remove serviced floors from elevators, you must either 

create a new Bank for that elevator, or remove the floors from the Bank 

itself. 

13. Click Save. 



 

 

Elevators 

Access Control 
11 

A6V101068156  187 | 313 

 

11.4 Access Control 

Access to particular floors at a site is determined by the access privileges 

configured for the cardholder attempting to gain access (including the Time 

Schedule applied to those privileges). 

For example, cleaners may be contracted to clean the first and second floors of a 

building. These floors have been assigned general public access during 8:00 am 

and 5:00 pm weekdays (anyone can access the floors during these times). Outside 

these hours, verification is required before access will be granted. However, the 

cleaners must clean the floors outside these hours. To prevent them from having 

access to the floors at all times, they are provided with access privileges to the 

floors between 9:00 pm and 11:00 pm on weekdays only. 

If the cleaners attempt to access the floors between 9:00 and 11:00 pm, they will 

be granted access upon verification. If the cleaners attempt to access the floors 

outside these hours (other than the general public access hours), they will be 

denied access. 

11.4.1 Assigning Floor Access to Cardholders 

SiPass integrated treats floors like doors. A cardholder must badge their card 

before attempting “entry” and the floor button will only be enabled if they have the 

correct access privileges during that time. Floors can also be assigned to floor 

groups, which are just like point groups. Floor groups can be assigned to access 

groups in the same manner as access groups. 

Creating a Floor Group 

1. Select Point Group from the Program menu. 

2. Enter a descriptive name for the floor point group into the Group Name field. 

3. Choose Add Members. 

4. Select Floor Points from the Group Type drop-down box. 

 The Available list will be populated with all of the floors that have been 

defined. 

5. Select from the Available list those floors you want to add to the group. 

6. Use the Add button to shift selected floors to the Selected list. The Add All 

button will select all floors. 

7. Choose OK. 

 You will be returned to the Point Group dialog. 

8. Select an Alarm Class for the Floor Point Group. 
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9. Complete the Alarm Trigger and Group Action fields. 

– Group:  

Specifies the number of group members that must be in alarm state, or 

have returned to normal but whose timers have not yet timed out, before 

the group goes into alarm. If 0 is entered, it prevents an alarm. 

– Timer:  

An internal timer starts counting (in seconds) for each member of the group 

that was in alarm after it returns to normal. The group goes into alarm if the 

number of points counting down or currently in alarm reaches the Group 

Count. If a point times out, the current count is decreased by one. This 

means that if a certain number of group members have entered an alarm 

state simultaneously or in a configurable time interval, the group alarm will 

be generated. 

– Isolate:  

When checked, disables the group messages. However, individual member 

messages will still appear in the Active Audit Trail window. 

– Clearance Required:  

When checked, the member(s) that caused the group to enter an alarm 

state must be restored before the group can return to normal. 

10. Click Save. 

Assigning Floors and Floor Groups to a Cardholder 

1. Select Access Level from the Program menu or toolbar. 

2. Enter a descriptive name for the Access Level into the Name field. 

3. Select the Time Schedule during which access to the Selected Points or Point 

Groups is possible. The List View button displays all defined Access Levels by 

Time Schedule. 

4. Select either Floor Point or Floor Point Group from the Type drop-down box. 

The floors or floor point groups you have defined will appear in the list below. 

5. Select those points or groups from the list, and choose Add to add them to the 

Selected list above. 

6. When you have selected all the items you want to add to the Access Level, 

choose Save. 
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11.5 Destination Control 

If your SiPass integrated license includes the Destination Control function, you 

additionally get a high-quality access system with modern thyssenkrupp elevators 

to enable smart and intelligent interfaces via keycard technology. 

The features in this fully integrated security solution are tailored for the best in 

access, security and convenience: 

● Customized access privileges 

● Special effects during elevator travel 

● Favorite floor selection 

● Prioritized elevator call and landing 

● Automated elevator provisioning 

● Customizable time for elevator access 

● Latest Access System Technology powered by SIEMENS 

 

11.5.1 Configuring System Components 

The Destination Control elevator system of SiPass integrated uses thyssenkrupp 

elevators that must be configured differently than the low level elevators. The 

coming sections provide information about how to configure the different elevator 

components and how to set up the special features of the Destination Control 

elevator system. 

To support the Destination Control elevator features, the following terms have been 

introduced: 

● DSCT – Destination Selection Control Terminal 

● LOP - Landing Operating Panel 

● COP - Car Operating Panel 
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11.5.1.1 thyssenkrupp Elevator Controller 

The thyssenkrupp Elevator Controller is the gateway responsible for 

communication with ACC. Multiple controllers can be configured, as required. 

1. Select Elevator Configuration > Destination Control from the System menu. 

 The Elevator Configuration – Destination Control dialog appears displaying 

the name of the SiPass server in the Operational tab on the right. You can 

change the name of the server by selecting Components from the System 

menu. 

 Note: Click the Server name in the left side pane of the dialog (if the 

Operational tab is not visible on the right side). 

2. Click the Add Controller button. 

 The Elevator Controller tab appears in the right side of the Elevator 
Configuration – Destination Control dialog. The left side of the dialog now 

displays <New Controller> (unnamed controller) in the sub-level of the 

server tree. 

3. Enter a descriptive name for the thyssenkrupp Elevator Controller into the 

Name field. 

 The Elevator Type dropdown list has thyssenkrupp Elevator pre-selected. 

4. Enter the URL of the physical elevator being configured into the URL field. 

5. Select the applicable alarm class from the Alarm Class dropdown list. 

 The alarm class states Elevator Controller Offline and Elevator Controller 

Online (configured through Alarm Class Definition dialog) indicate if the 

elevator controller is online or not. 

6. Enter the certificate thumbprint in the Certificate Thumbprint field. 

7. Enter the desired time for polling between the controller and the ACC into the 

Poll Period (sec) field. 

8. Enter the desired time for getting a response from the controller into the 

Response Max Time (sec)  field. If no response is received from the controller 

within this time, the alarm is triggered and the offline status is displayed in the 

audit trail. 

9. Select the applicable ACC for audit trail reporting from the Comm. Reporting 

ACC dropdown list. 

 The Status field displays the status of the controller as Online or Offline. To 

get the most recent status, click the Refresh button. 

10. Click Save. 

11. Click Yes (if prompted) to save the changes. 

 The new thyssenkrupp Elevator Controller is now configured. The <New 
Controller> that was listed under server tree on left side of the dialog is now 

replaced by the name of the controller you entered in step 3 above. 

12. Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components. 
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11.5.1.2 Elevator Bank 

Banks are groups of one or more elevators that share common floors. The Elevator 

components including Banks, Elevators and Floors (with sides) are configured 

through the Elevator Configuration dialog. You can assign ACCs and select the 

time for enabling VIP and caretaker privileges for a bank. 

Defining an ACC Cluster 

An ACC cluster for a bank can comprise of up to 97 ACC units. Only the readers 

belonging to the ACCs in the cluster can be assigned as provision readers, or 

readers for COP, LOP and DSCT. Only one ACC unit in the cluster will be used for 

reporting the communication status in the audit trail (selected in the Comm 

Reporting ACC dropdown list on the Elevator Configuration dialog). 

1. Select Elevator Configuration > Destination Control from the System menu. 

 The Elevator Configuration – Destination Control dialog appears with the 
name of the SiPass server. 

 Note: Click the Server name in the left side pane of the dialog (if the 
Operational tab is not visible on the right side). 

2. Click the Add Bank button on the Operational tab. 

 The Bank Details tab appears on the right side of the Elevator 
Configuration – Destination Control dialog. The left side of the dialog now 
displays <New Bank> (unnamed bank) in the sub-level of the server tree. 

3. Enter a descriptive name for the elevator bank into the Bank Name field. 

4. Enter the desired time (in seconds) for enabling the caretaker access in the 
Caretaker Timeout (sec) field. 

 The Elevator Type dropdown list has a pre-selected value thyssenkruppp 
Elevator. 

5. Tick the VIP Enabled checkbox to enable VIP privileges for the bank . 

 Note: VIP privileges cannot be disabled once a bank is created with VIP 
Enabled checkbox as ticked and the VIP Floor is assigned to a cardholder. 
The checkbox can be unchecked only if no cardholders reference the VIP 
floor. 

6. Enter the desired time (in seconds) for enabling the VIP Privileges into the VIP 
Timeout (sec) field. 

7. In the ACC Cluster section, click the Define Cluster button. 

 The Cluster Definition dialog appears displaying the available ACC units. 

8. Select the ACC unit to be included in the cluster and click the Add button. 

 The selected unit moves to the right side pane of the Cluster Definition 
dialog. To remove a selected unit from the cluster, select the unit in the 
right side pane and click Remove. 

9. Click OK. 

 The ACC units selected in the cluster are displayed in the ACC Cluster 
section. 

10. Click Save. 

11. Click Yes (if prompted) to save the changes. 

 The new elevator bank is now configured. The <New Bank> that was listed 
under server tree on left side of the dialog is now replaced by the name of 
the bank you entered in step 3 above. 

Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components. 

 

In case of a VIP bank, the VIP Status is not displayed on the Elevator 
Configuration – Destination Control dialog but is visible on the Access Assignment 
dialog (while assigning VIP privileges to a cardholder). 
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11.5.1.3 Floors 

The Floor Wizard helps you define the floor (and side) that a bank will service. 

Defining the floor for a single bank may require more than one use of the wizard. 

You can delete a floor side created by the wizard, define individual time schedule 

and assign alarm class to each side so the floor can be monitored from site plan 

and alarm queue. 

The following terms are used when defining floors: 

● Rise Number 

 Rise Numbers are an internal address used by SiPass Integrated as a 

reference for the floor, to be passed to the Elevator Management System. Each 

floor in the building is assigned only one Rise Number. 

 In SiPass Integrated, Rise Number 1 normally represents the lowest possible 

serviceable floor in the building; for example, Rise Number 1 could be 

Basement Level 3. 

● Floor Number 

 Floor Numbers are user-assigned labels to indicate the position of the floor with 

respect to Ground. 

Defining the floors in a bank 

1. Select Elevator Configuration > Destination Control from the System menu. 

2. From the Components tree on the left, select the Bank for which you are 

defining the floors. 

3. Click the Floor Wizard button . 

 The Bank Floor Wizard dialog is displayed. 

4. Click Next. 

5. In the Floor Name Prefix field, enter the text that will be used when these floors 

appear in SiPass Integrated dialogs; for example, “Above Ground”. The default 

is the Bank Name. 

6. In the Floor Name Postfix field, enter the text that appears before the floor 

number, when these floors appear in SiPass Integrated dialogs; for example, 

“Floor” or “Level”. The default is “Floor”. 

 

 

Every floor in SiPass Integrated must have a unique name. 

7. In the the Rise Numbers field, enter the floors you are defining to be serviced 

by this bank. Single floor numbers are separated by commas. You can use a 

dash to represent a range of serviced floors, and use a comma to separate 

Rise Numbers; for example “1-4, 9-20’. 

 The Current Rise Numbers field indicates the Rise Numbers that you have 

already defined for this Bank. Entering additional Rise Numbers will add 

those floors to existing floors for this Bank. Only the Time Schedule, Alarm 

Class and Enabled fields will be over-ridden if you re-enter defined Rise 

Numbers. Floor names are only changed through the Floor Name column 

of the Destination Details tab. 

8. Select the sides applicable to the elevator for the specific floor by checking the 

respective checkbox. Options are Front | Rear | Left | Right. 

 Note: At least one side must be selected for every floor. Front is selected 

by default. 
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9. Complete the Floor Number Suffix details: 

– Append Number  

Tick this checkbox to append the Floor Number to the Floor as it appears in 

SiPass Integrated dialogs. 

– Keep Rise Increments  

Tick this checkbox if you want to match the increments in Floor Numbers to 

increments in the Rise Numbers. For example: the numbers “1-3, 5-7, 11-

20” are entered into the Rise Numbers field, and the Start Number is 4. The 

corresponding Floor Numbers for this group of floors would be “4-6, 8-10, 

14-23”. 

– Start Landing Number  

Select where to begin numbering floors. 

– Ascending/Descending  

Tick the appropriate option to count upwards or backwards from the Start 

Number when assigning Floor Numbers. 

10. Select a Time Schedule that will be applied to every floor selected. Individual 

floor Time Schedules can be changed later. 

11. Select an Alarm Class that will be applied to every floor selected. Individual 

floor Alarm Classes can be changed later. 

12. From the Floor Enabled dropdown list, select if all the floors will be enabled or 

disabled by default. Individual floors can be enabled or disabled later. 

13. Click Finish. 

 You will be returned to the Elevator Configuration – Destination Control 
dialog. A table of floors will have been created under the selected Bank 

with an individual list entry created for each side of a floor. 

 You can delete or modify the properties of individual floors (and sides) by 

clicking in the appropriate cell and selecting or entering a new value in the 

Destination Details tab on right side of the Elevator Configuration dialog. 

This allows you to define groups of floors with the same attributes and then 

alter details for particular floors later. 

 You can also disable a floor (or side) by unchecking the Enabled checkbox. 

This means that it will not be accessible from any elevator in the bank. 

 You can also assign a different time schedule to each side. The default is 

Never (point always secure). 

14. Click Save. 

15. Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components. 

  



 

 

Elevators 

Destination Control 
11 

194 | 313  A6V101068156 

 

11.5.1.4 Elevator 

While defining an elevator for a bank, you can select one or more readers to be car 
provision readers. A standard door access reader can act as a car provision reader 

with an additional function of calling the elevator (with a preset time delay) after a 

cardholder is authenticated. The time delay can be configured to make the elevator 

available by the time the cardholder reaches the elevator from the card reader 

location. 

1. Select Elevator Configuration – Destination Control from the System menu. 

2. Select the Bank in the Components tree for which you are defining an elevator. 

3. Click the Add Elevator button from the Bank Details tab. 

 The Elevator Details tab is displayed on the Elevator Configuration – 
Destination Control dialog. 

4. Type an appropriate name for the elevator in the Name field. 

5. Select thyssenkrupp Elevator Controller for the elevator from the Controller 

dropdown list. 

6. Select an alarm class that will be applied to the elevator from the Alarm Class 

dropdown list. 

 The alarm class states Elevator Available and Elevator Unavailable 

(configured through Alarm Class Definition dialog) indicate if the elevator is 

available or not. 

 Note: The above feature is under development and not available in this 

build. 

7. Type a description for the elevator (if required) in the Description field. 

8. To add a car provision reader to the elevator, click the Add button in the Car 
Provision Readers section. 

 The first row in the Car Provision Readers section is enabled for input. 

9. From the Reader dropdown list, select a card reader to be assigned as the car 

provision reader. 

– A reader is not available for selection if it is a provision reader, or 

previously assigned to a cardholder's personal access, workgroup, point 

group, venue or access level, or already assigned to another 

COP/LOP/DSCT. 

– Only the readers that belong to an ACC in the ACC cluster defined for the 

bank, and available for selection will be listed. 

10. From the Floor Destination dropdown list, select the floor (with side) on which 

the elevator must be available. 

11. Enter an estimated delay time in the Time Delay field for making the elevator 

available (provision) to the cardholder after a valid card badge. 

12. The Door State dropdown list allows you to select if the elevator doors are 

opened or closed: 

– Open: The doors remain open for the time specified in the Access Time 

Delay field to allow the cardholder to enter the elevator. 

– Closed: The doors remain closed for the time specified in the Access Time 

Delay field until the same cardholder badges the card again at LOP or 

DSCT reader. 

13. Click Save. 

14. Click Yes (if prompted) to save the changes. 

 The new elevator is now configured and listed under the respective bank 

listing on left side of the Elevator Configuration – Destination Control dialog. 
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11.5.1.5 Destination Selection Control Terminal (DSCT) 

Once you have configured the banks and floors, you can define one (or more) 

DSCT for each floor side. The DSCT has a unique identity (ID) per bank and also 

requires an Elevator Controller to be linked. Once created, a card reader must be 

assigned to a DSCT. 

1. Select Elevator Configuration – Destination Control from the System menu. 

 The Elevator Configuration – Destination Control dialog appears displaying 

the name of the SiPass server on left. 

2. Expand the components tree below the server name and select the floor for 

which the DSCT is required to be added. 

 The Destination Details tab on right of the Elevator Configuration – 
Destination Control dialog displays the details for the selected floor side. 

3. Click the Add DSCT button. 

 The Floor DSCT details tab on right of the Elevator Configuration – 
Destination Control dialog lists the fields for defining a DSCT. 

4. Type an appropriate name in the Name field to identify the DSCT. 

5. Select or type an identifier (unique for a bank) in the ID box to map the DSCT 

to thyssenkrupp device configuration. 

6. Select the card reader to be configured with the DSCT from the Reader 

dropdown list. 

– A reader is not available for selection if it is a provision reader, or 

previously assigned to a cardholder's personal access, workgroup, point 

group, venue or access level, or already assigned to another 

COP/LOP/DSCT. 

– Only the readers that belong to an ACC in the ACC cluster defined for the 

bank, and available for selection will be listed. 

7. Select the applicable elevator controller to be linked with the DSCT from the 

Elevator Controller dropdown list. 

8. Select or type an applicable time period (ranging from 1 to 250 seconds) in the 

Floor Selection Timeout (sec) box, after which the floor selection is disabled. 

9. Type a suitable description about the DSCT (if any) in the Description field. 

10. Click Save. 

11. Click Yes (if prompted) to save the changes. 

 The new DSCT is now configured and listed under the respective floor 

listing on left side of the Elevator Configuration – Destination Control dialog. 

Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components. 
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11.5.1.6 Landing Operation Panel (LOP) 

Once you have configured the banks and floors, you can define one (or more) LOP 

for each floor side. The LOP has a unique identity (ID) per bank. Once created, an 

elevator controller and card reader can be linked to the LOP. Both Up and Down 

directions can be selected to indicate direction of travel. 

1. Select Elevator Configuration – Destination Control from the System menu. 

 The Elevator Configuration – Destination Control dialog appears displaying 

the name of the SiPass server on left. 

2. Expand the components tree below the server name and select the floor for 

which the LOP is required to be added. 

 The Destination Details tab on right of the Elevator Configuration – 
Destination Control dialog displays the details for the selected floor side. 

3. Click the Add LOP button. 

 The Floor LOP Details tab on right of the Elevator Configuration – 
Destination Control dialog lists the fields for defining the LOP. 

4. Type an appropriate name in the Name field to identify the LOP. 

5. Select or type an identifier (unique for a bank) in the ID box to map the LOP to 

thyssenkrupp device configuration. 

6. Select the card reader to be configured with the LOP from the Reader 

dropdown list. 

– A reader is not available for selection if it is a provision reader, or 

previously assigned to a cardholder's personal access, workgroup, point 

group, venue or access level, or already assigned to another 

COP/LOP/DSCT. 

– Only the readers that belong to an ACC in the ACC cluster defined for the 

bank, and available for selection will be listed. 

7. Select the applicable elevator controller to be linked with the LOP from the 

Elevator Controller dropdown list. 

8. Select or type an applicable time period (ranging from 1 to 250 seconds) in the 

Floor Selection Timeout (sec) box, after which the floor selection is disabled. 

9. Type a suitable description about the LOP (if any) in the Description field. 

10. In the Buttons section, tick the Up or Down (or both) checkboxes to indicate the 

direction of travel of elevator with respect to the floor. Both are checked by 

default. 

11. Click Save. 

12. Click Yes (if prompted) to save the changes. 

 The new LOP is now configured and listed under the respective floor listing 

on left side of the Elevator Configuration – Destination Control dialog. 

13. Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components. 
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11.5.1.7 Car Operating Panel (COP) 

Once you have configured the elevators, you can define one (or more) COP for 

each elevator side. The COP has a unique identity (ID) per elevator and a card 

reader can be linked to it. 

1. Select Elevator Configuration – Destination Control from the System menu. 

 The Elevator Configuration – Destination Control dialog appears displaying 

the name of the SiPass server on left. 

2. Expand the components tree below the server name and select the Elevator for 

which the COP is required to be added. 

 The Elevator Details tab on right of the Elevator Configuration – Destination 
Control dialog displays the details for the selected elevator. 

3. Click the Add COP button. 

 The Elevator COP Details tab on right of the Elevator Configuration – 
Destination Control dialog lists the fields for defining the COP. 

4. Type an appropriate name in the Name field to identify the COP. 

5. Select or type an identifier (unique for an elevator) in the ID box to map the 

COP to thyssenkrupp device configuration. 

6. Select the card reader to be configured with the COP from the Reader 

dropdown list. 

– A reader is not available for selection if it is a provision reader, or 

previously assigned to a cardholder's personal access, workgroup, point 

group, venue or access level, or already assigned to another 

COP/LOP/DSCT. 

– Only the readers that belong to an ACC in the ACC cluster defined for the 

bank, and available for selection will be listed. 

7. Select or type an applicable time period (ranging from 1 to 250 seconds) in the 

Floor Selection Timeout (sec) box, after which the floor selection is disabled. 

8. Type a suitable description about the COP (if any) in the Description field. 

9. In the Sides section, select the sides applicable to the COP for the specific 

elevator by checking the respective checkbox. Options are Front  | Rear | Left | 

Right. 

 Note: At least one side must be selected. Front is selected by default. 

10. Click Save. 

11. Click Yes (if prompted) to save the changes. 

 The new COP is now configured and listed under the respective elevator 

listing on left side of the Elevator Configuration – Destination Control dialog. 

12. Click Close to close the Elevator Configuration – Destination Control dialog or 

proceed to configure more elevator components.
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12 Guard Tour 
Guard Tour is used to monitor the movement of security guards throughout your 

site and ensure that they visit and check their assigned tour points at the required 

times. An operator can start a guard tour, and add, delete or modify the details of 

guards and guard tours. Tour groups can be created to assist with the 

management and choice of tours. Guard Tour monitors a guard’s progress around 

the points of contact or stops that make up a tour. These points or tour stops are 

configured from those defined in the SiPass integrated database. 

12.1 Configuring Guard Tour 

In order to operate guard tour on-site, specific components are required to be 

configured. These include: 

● Adding a Guard to the system 

● Creating a Tour 

● Defining a Group of tours  

12.1.1 Adding a Guard to the System 

For a cardholder to be configured as a guard, they must already be defined as a 

cardholder in the SiPass integrated system. 

 

 

Registering a cardholder as a guard does not affect the cardholder’s status in any 

other part of the SiPass integrated system. Being registered as a guard simply 

means that the cardholder can be assigned to tours. 

From time to time, it may be necessary to view the details of cardholders prior to 

being configured as guards. It is also a simple way to verify that the person is a 

defined cardholder within SiPass integrated. 

Viewing Cardholder Details 

1. Select the Program > Guard Tour > Guards. 

2. In either the Members of SiPass integrated list or the Members of Guard Tour 
list, highlight an Cardholder whose details you wish to view. 

3. Select the Details button. 

4. Select the Close button to exit from the User Details dialog. 

Adding a Guard to the system 

1. Select the Program > Guard Tour > Guards. 

 The Guard Specification dialog will appear, displaying a list of Cardholders 

available for configuration as guards. 

2. From the Members of SiPass integrated list, select the desired Cardholder(s). 

Hold down the CTRL or SHIFT keys on the keyboard to select multiple records. 

3. Select the Add button. 

 The selected member(s) will be added to the Members of Guard Tour list. 

4. Repeat Steps 2 and 3 until all the required Cardholders have been added to 

the Members of Guard Tour list. 

5. Click Save. 
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12.1.1.1 Creating a Tour 

A guard’s tour is the primary component of Guard Tour and consists of two main 

elements: 

● The guard 

● The physical journey through the site 

Each tour is assigned a name and is defined by the points that the guard must visit 

to complete their security check. 

There are two types of tours: 

● Ordered Tours 

● Random Tours 

All tours, irrespective of their type, consist of points to be visited and the expected 

times of arrival at those points. A configurable tolerance either side of the expected 

time of arrival allows guards to carry out their rounds with some flexibility without 

jeopardizing security at your site. 

Ordered Tours 

Since a tour is made up of the points that the guard must visit in order to complete 

their rounds, the guard must check those points in the sequence specified. The 

guard will be informed of the stopping pattern via a report that is normally prepared 

by the operator prior to tour commencement. 

This type of tour ensures compliant guard behavior during tours. Guards are 

compelled to followed pre-defined routes and carry out specified card reader 

activities during the course of their tour, thereby ensuring that all the points on the 

tour are visited according to tour parameters. 

Random Tours 

A Random Tour, sometimes referred to as an Unordered Tour, is one that is 

created by the system. The points are identical to those in an ordered tour at the 

same site, except that the visiting pattern is generated randomly. 

The visiting pattern for a Random Tour is generated randomly when the tour is 

registered with the guard. It is not feasible to require the guard to visit any one 

point of a Random Tour within a certain time frame, simply because there is no 

effective method to predict the interval required to travel between any two tour 

points. 

However, a time restriction is applied for the completion of the whole tour. This 

ensures that the tour is completed within the designated time frame. 

The greatest advantage to be gained from using random tours is that they prevent 

the tours from becoming predictable to an outside observer. This enhances the 

effectiveness of security guards. 

Tour Completion Time 

Guard Tour allows a guard a certain amount of time to proceed from one point to 

the next. This time can be specified exactly. However, you can also specify a 

tolerance either side of the expected time of arrival to allow for unforeseen 

circumstances, such as bad weather. If the guard arrives early at a designated 

point outside the specified bandwidth (Tolerance), an Early alarm is raised. If the 

guard takes more than the maximum allowable time to reach the point (expected 

time of arrival plus the tolerance), a Late alarm is raised. 

This feature is useful for two reasons. Firstly, it will assist in ensuring the personal 

safety of the guard force by triggering an alarm when a tour point is not reached 

due to restraint or assault. Secondly, if guard activity is under scrutiny as part of 
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normal management practice, it also provides the operator with more effective 

control over both the tours and guards. 

Each tour created by Guard Tour has several parameters that are required to be 

set. These parameters apply to both Ordered and Random tours. The parameters 

are as follows: 

● Net Expected Time 

● Tolerance 

The Net Expected Time refers to the total time to complete the tour. 

The Tolerance refers to the allowable time either side of the expected time of 

arrival at each point. The Tolerance value that appears in the dialog applies to 

each point and can be adjusted if required. 

Assigning these times prevents a guard from taking too long to complete the 

security check, or from hurrying through the tour so they can rest at their desk. 

Grace Period 

Normally, a tour is completed when the guard has visited all of the tour stops in the 

tour. 

Examples of these situations are: 

● When a guard has missed a tour stop on a tour 

● When a guard has quit a tour without visiting all of the tour stops on a tour 

● When a guard is running extremely late for the last tour stop on a tour 

Under these conditions, the indication of appropriate alarm states in the SiPass 

audit trail cannot be shown and a “Grace Period” may come into effect. 

The “Grace Period” defines a period of time between when the last event was 

received or expected and when the tour can be completed, and it is unlikely that 

any further events for that tour are to be received. 

By default, the “Grace Period” is set to 30 minutes. The “Grace Period begins 

when: 

● A random tour is marked as running late 

● The last tour stop in an ordered tour is late (or visited) 

 

 

The “Grace Period” is reset if a tour stop is visited after either of the events above 

has occurred AND before the tour is set to Completed. 
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Checking a Point 

Guards must show that they have visited tour points by performing the points’ 

defined actions. 

Tour points can be one of two types: 

● Access - If it is an access point, this will require a card swipe, set with the 

appropriate mode of operation. (These are indicated in the Tour Definition 

dialog). 

● Input - If it is an input point, the point must change state. The type of sensor 

attached to the point will determine the action required by the guard. No 

authentication will take place. The system “assumes” the identity of the guard. 

 

 

Elevator access points (floors), areas and sub-areas are not supported by Guard 

Tour. 

Creating a Tour 

 Ensure that you have correctly configured the card readers at your facility. 

1. Select Program > Guard Tour > Tours. 

 The Tour Definition dialog will appear, displaying a list of available points. 

2. To enter the name of a new tour, select the New button. 

3. Enter the name of the tour in the Enter New Tour Name field. All tour names 

must be unique. 

4. Choose the OK button. 

5. Check the Default Start as Ordered Tour checkbox, if your wish the tour to be 

an Ordered Tour. Leave this checkbox empty, if you wish the tour to be 

Random. 

6. From the Available Points list, highlight the first point that you wish to include in 

the tour. 

– Points configured for Image Verification can not be included in a guard tour. 

7. Select the Add button. 

 The point will be added to the Tour Order list. 

8. Repeat the previous two steps until all the desired points have been added to 

the tour. 

 All points added to a tour are automatically assigned default values. The 

default values are detailed in the Default Values table at the end of this 

section. 

9. Alter the values for each of the tour stops added in the tour to suit this distance 

and time required between stops 

10. Alter the sequence of points, if required. 

11. Enter the Random Tour Details. 

12. Enter the total time to complete the tour in the Net Expected Time field. 

13. Enter the allowable tolerance for the whole tour in the Tolerance field. 

14. Click Save. 
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Aspect Point Type Default Value 

Time Access / Input 4 minutes 

Tolerance Access / Input 2 minutes 

Card Req Access Only Yes 

Card Req Input Only No 

Disabled Access / Input No 

 

Table 1: Default Values 

12.1.2 Creating a Tour Group 

The Tour Groups option is used to define a collection of tours based on those 

already defined in the system. A Tour Group usually consists of tours that are 

logically similar. Tour Groups enable an operator to select a random tour for a 

guard, and still retain some control over the selected tour. Defining a Tour Group 

consists of adding or removing tours to or from a group. 

1. Select Program > Guard Tour > Tours. 

2. Select the New button. 

3. Enter the name of the Tour Group in the Enter New Tour Group Name field. All 

Tour Group names must be unique. If you attempt to assign the name of an 

existing tour group an error dialog will appear. 

4. Select the OK button in the New Group Name dialog. 

5. Select the newly created Tour Group from the Tour Group Name field. From 

the Available Tours list, highlight the tour that you wish to add to the Tour 

Group. 

6. Select the Add button. 

 The tour will be added to the Tours in Group list. 

7. Repeat Steps 6 and 7 for each tour that you wish to add to the Tour Group. 

8. Click Save. 

12.1.3 Starting and Monitoring Tours 

Once you have successfully logged into SiPass integrated, Guard Tour starts 

automatically and runs in the background, until required. Guard Tour uses its own 

window to show guard-related activity, similar to the Active Audit Trail. 

The Guard Tour window is displayed by selecting the Guard Tour button on the 

main SiPass integrated toolbar, The Guard Tour button has its own associated 

toolbar that appears directly below the main toolbar. 
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12.1.3.1 Registering and starting a Tour  

Registering a tour consists of selecting tour parameters and starting a tour, 

effectively creating a guard and tour combination. It is a five-stage process 

involving both the Register dialog and the Guard Tour Monitor screen. These 

stages are as follows: 

● Determining the status of the tour (Ordered or Random) 

● Selecting a tour 

● Selecting a guard for the tour 

● Selecting the tour properties 

● Starting the tour 

Starting a Tour 

1. Select Data > Guard Tour Status. 

2. If you wish to randomly select a tour, tick the Use Random Tour Selection 

checkbox. Guard Tour will then select a tour at random from those available in 

the database. When you choose to select a tour at random by ticking this 

checkbox, the Random Tour from Group, Select a Tour Group and Select a 

Tour fields will be disabled. 

3. If you wish to further refine your selection of a tour from a particular Tour 

Group, Select a Tour Group from the Select a Tour Group field and then check 

the Random Tour from Group checkbox. Guard Tour will select a tour at 

random from the nominated Tour Group. When you choose to select a tour at 

random from a particular Tour Group, the Select a Tour field will be disabled. 

This will prevent you from selecting a tour yourself from the Tour Group. 

The Checkbox Combination table at the end of this section, describes the effect of 

various checkbox combinations. 

1. If you wish to select guards at random, tick the Use Random Guard Selection 

checkbox. This will disable the Select a Guard field and a guard will be chosen 

at random from those available. If you wish to manually select a guard, leave 

the checkbox vacant. 

2. If you have chosen to manually select a guard in Step 5, choose a guard from 

the Select a Guard field. 

3. Complete the Tour Properties. 

– Radio Controlled:  

When this checkbox is ticked, it implies that some form of verification 

process should be in place 

– Ordered checkbox:  

This checkbox allows the operator to override the tour type as specified in 

the Tour Definition dialog. The value displayed will default to that of the 

original configuration for the selected tour. 

4. Complete the Start Options. 

– Start Immediately:  

This indicates that the tour will begin as soon as the SiPass operator has 

selected the Register button. When starting tours in this way, ensure that a 

time has been allowed for the guard to reach the first tour stop. 

– Start on First Tour Stop:  

This indicates that the tour will start as soon as the guard reaches the first 

tour stop and badges their card. When starting a tours in this way, ensure 

that the time to reach the first point in the tour has been set to ‘0”. 
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5. Select the Register button. The Tour Selection dialog will appear containing 

details of the Guard / Tour pairing. 

6. Select the Yes to begin the tour with the selected options. 
 

Option Checkbox Combination End Result of Configuration 

1 Use Random Tour 
Selection 

This combination of checkboxes sets the tour selection process to random and then 
automatically directs the system to select a tour at random from all those available. 
However, the options to manually select a specific Tour Group and then to select a tour 
from within that group will be disabled. 

2 Random Tour From 
Group 

This combination of checkboxes sets the Tour Group selection process to manual. 
However, the selection of tours from a Tour Group is disabled. 

3 No Selection This combination of checkboxes sets the tour selection process to manual. You may 
select any valid combination of tour group and guard. 

 

Table 2: Checkbox Combinations 

12.1.3.2 Monitoring Tours 

Guard Tour allows you to closely monitor guard activity through the Guard Tour 
Monitor. In addition to providing the current status of any given tour, the Guard 
Tour Monitor alerts you to any potential problems, early or late arrivals by guards 

and reports the progress of each tour under way. 

When you start Guard Tour, the Guard Tour Monitor screen appears and may or 

may not contain tour information. This will depend upon whether or not there is any 

pending or currently running tours at the time of start up. The Guard Tour Monitor 
displays the configured settings, in tabular form, for the tours that are either under 

way or pending. 

To open the Guard Tour Monitor: 

◈ Select Data > Guard Tour > Status. 

 The Guard field (column) displays icons indicating the status of tours. These 

assist in readily identifying the progress of tours displayed in the Guard Tour 
Monitor screen. 
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12.1.3.3 Displaying Tour Stop Log 

Guard Tour allows you to view the details of a tour as it progresses, from within the 

Guard Tour Monitor. This information can be used to assist with the management 

of this and any other tours that are scheduled. 

1. From the Guard Tour Monitor, highlight the tour whose details you wish to view. 

2. Double-click the mouse. The Tour Stop Log dialog will appear containing 

current details of the tour points and the guard activity for each. From this 

dialog, you can view the progress of the tour and identify any points where 

problems have occurred or are likely to occur. The Tour Stop Log fields are 

described in the Tour Stop Log Fields table at the end of this section. 

3. Select the Close button to close the Tour Stop Log dialog. 
 

Field Description 

Name This field displays the name of the tour point. The first record in the list is the name of the tour. 

Status This field displays the current status of the points; i.e., the activity logged by the guard at each of 
the points in the tour. The Status field incorporates an icon to provide a visual reference of the 
status of the tour. 

Occurred This field displays the time at which the guard activity, if any, has taken place. 

 

Table 3: Tour Stop Log Fields 

12.1.3.4 Printing a Guard Tour Report 

Guard Tour provides a facility to prepare and print detailed tour reports for use by 

either the operator or the guards. These tour reports are normally prepared 

immediately prior to commencing a tour. In addition, you can prepare historical 

reports on the activity of Guard Tour for review and auditing purposes. 

● Mobile / Pager 

● Two-way radio 

“Self-guided” tours by the guards require that they be given copies of the report, 

and place the obligation on them to conduct the tour as per the list of tour points 

and time limits in the report. The following steps explain how a Guard Tour Report 

can be printed. 

1. From the Guard Tour Monitor, highlight a tour from which you want to create a 

report. 

2. Select the Print button. The report will be created. 

3. Select the Report Preview button. 

4. Select the OK button to close the Print Setup dialog. 

5. Select the print icon at the top of the screen. 

6. The standard Windows Print dialog will appear. 

7. Complete all the required details. 

8. Select the OK button. The report will be printed. 

 When the report is printed it will contain all the necessary information for the 

guard to complete their tour. 
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12.1.3.5 Starting a Tour from the Guard Tour Monitor 

Once a tour has been created and moved to the Guard Tour Monitor, it can be 

started immediately or at the discretion of the operator. The physical tour by the 

guard should commence at or about the same time. 

 Ensure that the guard is actually available for the tour that you are about to 

commence. 

 Ensure that you have printed out the appropriate report for the guard to use on 

their tour. 

 Ensure that the guard has received a copy of the tour report and they have 

familiarized themselves with the tour. 

 Ensure that you have advised the guard of any unusual circumstances that 

may affect the progress of the tour, such as Disabled points. 

1. Select Data > Guard Tour Status. 

2. From the displayed list of pending tours, highlight the tour that you wish to start. 

Pending tours can be identified by their status. All pending tours have a status 

of “Ready”. 

3. Select the Start Button. 

 The tour will commence. 

12.1.3.6 Stopping a Tour 

Guard Tour allows you to stop a tour at any time. Stopping a tour can be done for a 

number of reasons; for example, a guard may be unable to continue because he 

has deviated from the tour, or due to other unforeseen circumstances. 

1. From the Guard Tour menu, select Monitor, or select the Status button from the 

Guard Tour toolbar. The Guard Tour Monitor screen will appear. 

2. Highlight the tour that you wish to stop from those that are currently running. All 

active tours will have a status of “Running”. 

3. Choose the Stop button. The tour will be stopped. 

4. A number of events will then take place: 

– The audible alarm will sound, requiring an appropriate response. 

– The tour icon will change from GREEN to RED. 

– The status of the tour will change to “Completed”. 

– Messages will be passed to the SiPass audit trail indicating which tour 

stops have been visited. 

– A message will be passed to the SiPass audit trail indicating that the tour 

has been stopped. 

5. Choose the Alarm button to acknowledge and silence the alarm. 

 By pressing this button, the system is advised that there has been a response 

to the alarm. 
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12.1.3.7 Skipping a Tour Point  

Guard Tour allows the guard to skip tour points. A tour point can be skipped if, for 

example, it has been taken out of service to be repaired. The points are generally 

shown as Disabled in the Tour Report and may be subject to alternate checking 

procedures by the guard. 

 

▪ You can only skip the next tour point in the sequence. There is no option to skip 

a tour point out of sequence. 

▪ You cannot skip points in a tour that is not already running. 

▪ You cannot skip points that have already been visited. 

▪ You cannot skip points in a Random Tour. 

1. Select Data > Guard Tour Status. 

2. From the tours that are currently running, double-click the tour that contains the 

point you wish to skip. 

3. Highlight the tour stop that you wish to skip. 

4. Choose the Skip button. 

 The icon associated with the skipped tour point will change accordingly and the 

tour point’s Status will change to “Skipped”. This point in the sequence will be 

ignored by the system and no alarm will be triggered as a result. 

 The internal timer for that point will be stopped and re-set. In the case of an 

Ordered tour, the internal timer will be re-set to show the remaining time to 

arrive at the next point. In the case of a Random tour, the internal timer will not 

change. 

When a tour point is skipped, a message to that effect is passed to the SiPass 

integrated audit trail and the status of the point is updated to “Skipped” in the Tour 

Stop Log dialog. 

12.1.3.8 Acknowledging an Alarm 
When you stop a tour for any reason or if a guard is early or late when arriving at a 
tour point, an audible alarm will be triggered by Guard Tour. 

1. Select Data > Guard Tour Status. The Guard Tour Monitor screen will appear. 
You will notice that the background color of the icon associated with the tour 
that has gone into an alarm state has changed from GREEN to RED. 

– Guard Tour alarms are not propagated to the SiPass integrated Status Bar 
Alarm Panel. 

2. Select the tour in which the alarm has occurred. 

3. Choose the Alarm button. The audible alarm will be silenced and the tour 
record will remain visible in the Guard Tour Monitor for one minute. In the case 
where an alarm is triggered by a late arrival by a guard at a tour point, or a 
missed tour stop, the tour will remain displayed on the Guard Tour Monitor until 
the tour is completed (“Grace Period” timeout) or until stopped by the operator. 

4. To find out why the alarm was raised, double click on the selected tour, to 
display the Tour Stop Log dialog. This dialog will show any tour stops that have 
triggered an alarm due to the late or early arrival of guard, or if the tour has 
been stopped all together. 

5. Carry out any designated response to the alarm. 

 

It is not necessary to halt the tour in order to respond to a raised alarm. All raised 

alarms will log an entry to the SiPass Audit Trail. 
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12.1.3.9 Aborting a Tour 

Guard Tour allows you to cancel a tour prior to its commencement, or abandon a 

running tour. Although you can abort a tour that is already running, the Abort option 

is primarily used to abandon a tour prior to its commencement. It is recommended 

that, where you wish to abandon a currently running tour, you use the Stop option. 

1. Select Data > Guard Tour Status. 

2. Highlight the tour that you wish to abort from those displayed in the list. 

3. Choose the Abort button. 

 The tour will be aborted. 

 The tour record will remain in the Guard Tour Monitor for a period of one 

minute and then be deleted. 

 

 

No audible alarm will sound. However, a message will be passed to the SiPass 

audit trail indicating that the tour has been aborted. The principal difference 

between “Stopping” a tour and “Aborting” a tour lies in the fact that when a tour is 

stopped prematurely, this causes an alarm condition. 

 

12.1.3.10 Guard Tour Window 

The Guard Tour window is used to display the details of currently running tours. 

The fields in the table are described below. 
 

Column Name Description 

Guard This column displays the name of the guard assigned to the tour. 

Tour This column displays the name of the tour. 

Last Point This column displays the name of the last tour point visited by the guard. 

Next Point This column displays the name of the next scheduled tour point to be visited. 

Time This column counts down the remaining time to reach the next tour point.If the guard arrives at 
the tour point ahead of schedule, the countdown values will display as positive (+) values and 
if they arrive after the scheduled arrival time, the values will display as negative (-). The 
internal timer will continue to operate until the guard reaches the next point or until re-set by 
the operator. 

Tolerance A guard may be early or late when visiting the next point. This column displays the time range 
either side of the scheduled time of arrival that is allowable by Guard Tour. If they arrive at the 
tour point outside this allowable time range, an alarm will be triggered and displayed in the 
SiPass audit trail to alert the operator. As the tour progresses, the tolerance value is subject to 
a cumulative effect in random tours and may display a value as high as the total of the 
tolerances for all of the configured tour points. In a random tour, it is possible for the guard to 
catch up over the total tour time, depending upon the circumstances under which the tour is 
being conducted. 
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12.1.3.11 Right Mouse Button Options 

By right-clicking the mouse button inside the Guard Tour Monitor Window, you can 

access an alternate series of options: 
 

Option Description 

Acknowledge Alarm This option is used to silence the audible alarms that occur when guards arrive late or early at 
tour points. 

Start Tour This option allows you to start a tour. 

Stop Tour This option allows you to stop a tour or to formally shut down a completed tour. 

Abort Tour This option allows you to abort a tour prior to its commencement 

Close This option allows you the close the Guard Tour Monitor. 

Report Preview This option allows you to preview a report. 
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13 Biometric Integration 

13.1 Introduction 

The Bioscrypt functionality allows operators to capture fingerprint templates and 

encode the fingerprint template into the smart card during enrollment. 

An optional feature allows operators to capture and store the fingerprint template 

into the SiPass integrated database. This feature is configurable based on the 

individual country regulations regarding fingerprint storage. 

This functionality allows operators to encode fingerprint templates as cardholder 

data into the smart card, while enrolling the card at the same simultaneously. 

It supports the 1K and 4K Mifare cards, and the 2K, 4K and 8K DESFire Card 

Technology. 

It utilizes the Triple DES (also known as 3DES), mechanism for encryption. 

The Bioscrypt reader can be connected to RIM devices (DRI, ERI and SRI) for 

Access Control. 

13.1.1 Prerequisites  

Before proceeding to create a Bioscrypt components in SiPass integrated, the 

operator must ensure that the following prerequisites are available with the 

SecureAdmin application. 

● Install the Server and Client of the SecureAdmin version 4.1.9. 

 

 

After the SecureAdmin application is installed, the documentation for the 

application should also be available on your PC. Please refer the same for 

information on how to use the application. 

● Register the BIOSCRYPT V-Station reader in SecureAdmin. Please refer the 

Secure Admin documentation for detailed information on how to register. 

● Configure the Wiegand output for the BIOSCRYPT V-Station reader. This can 

be done through the following steps: 

1. Navigate through Device Settings to locate the Wiegand tab of the 

BIOSCRYPT V-Station device. 

2. In the Miscellaneous Settings section of this tab, check the Activate Wiegand 

Output checkbox. 

3. Select Always Output in the adjacent dropdown field. 

4. Next, operators can choose to configure either a Mifare Classic or Mifare 

DESFire card template. For details, refer the two sections that follow. 

5. Click the Wiegand Output Settings button. Set Verification Output. 

6. Proceed to create a Site Key to authenticate the Mifare Smart Card. A detailed 

guide for the same can be found in the SecureAdmin documentation. 

 While enrolling Mifare cards for a site, set the 'Key B' for Read/Write 

operations or select the Use ESI Site Key encryption option to prevent the 

default Key A being assigned to all the cards. 
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7. Set the Site Key and Smartcard Layout on the BIOSCRYPT V-Station reader. 

Refer the SecureAdmin documentation to set the Site Key. 

8. Open the SmartCard Device Manager and ensure that the Use Wiegand String 

option is ticked for every device integrated into the system. Overwrite Card 

Wiegand String should also be ticked for Mifare DESFire card. 

To configure the Mifare Classic card template: 

 The custom format is used to send the CSN number of cards that use the 

Mifare Classic card technology. 

1. Click the Custom Wiegand Settings button, and configure the template in the 

Weigand Format dialog displayed. 

2. Enter the Name of the configuration. 

3. Enter Length as 40. 

4. In the Weigand ID settings, Enter Start Position as 0, Length as 32, Heart Beat 

Value as 0. 

5. In the User fields settings, specify the following information: 

– Name – Successful code 

– Start Position – 32 

– Length – 8 

– Success Value – 0 

– Failure – 250 

6. Click Apply. 

 

 

This configuration is required only if the system is required to configure the Mifare 

Classic card. 
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To configure the Mifare DESFire card template: 

 The Card Type has to be set to DESFire to configure a DESFire card. To select 

the card type as DESFire, perform the following steps: 

1. Click the Smart Card tab from SecureAdmin to open the Smart Card Device 
Manager dialog. 

2. Select DESFire Smart Card from the Smart Card Type pop-up. 

 The custom format is used to send the UID number of cards that use the Mifare 

DESFire card technology. 

1. Click the Custom Wiegand Settings button, and configure the template in the 

Weigand Format dialog displayed. 

2. Enter the Name of the configuration. 

3. Enter Length as 72. 

4. In the Weigand ID settings, Enter Start Position as 0, Length as 64, Heart Beat 

Value as 0. 

5. In the User fields settings, specify the following information: 

– Name 

– Start Position -64 

– Length-8 

– Success Value-0 

– Failure-250 

6. Click Apply. 

 

 

This configuration is required only if the system is required to configure the Mifare 

DESFire Classic card. 

In case of L1 readers using Mifare DESFire cards, the Master key should not be 

modified. If changed, the key will not be read by the L1 reader. 
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13.2 Configuring the Bioscrypt Bus 

This section details the steps required to configure a Bioscrypt bus in SiPass 

integrated. 

1. Select System > Components on the SiPass integrated main menu to open the 

Components dialog. 

2. Selected the SiPass integrated server required. 

3. Click the New Bus button, and select Bioscrypt System. 

4. Enter a name for the bus in the Name field. 

5. Enter the Site Key. The Site Key entered here should match the Site Key 

configured in SecureAdmin. The Site Key should be of 12 digits. 

6. In the Biometric Quality Section, configure the expected quality of the 

fingerprint. Adjust the Minimum Quality and the Minimum Content of the finger 

print. 

 

 

Note: In order to be accepted by the SiPass integrated system, fingerprints 

presented through the Bioscrypt reader must meet the minimum standards set in 

the Minimum Quality and Minimum Content fields. By default the Minimum Quality 

and Minimum Content is 50. 

7. Click Save. 

 The Bioscrypt bus will be saved with the configured settings. 

 The ACC should be initialized for changes to take effect. 
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13.3 Saving the Custom Card Configuration 

1. Select System > FLN Configuration from the SiPass integrated main menu to 

open the FLN Configuration dialog. 

2. Expand the Global Settings item in the tree hierarchy on the left hand pane. 

3. Select the Custom Card Format tab. 

4. Click the Add button. 

 The Custom Card Configuration dialog appears with a default configuration. 

Change the default configuration of the Custom Card Configuration 

according to the below steps. 

5. Enter a new Name for the custom card to be used for the Bioscrypt 

functionality. 

6. Set the Total Length field from 1 to 40 for Mifare smart card and 1 to 72 for 

DESFire smart card. 

7. Set the Number field from 1 to 32 for Mifare smart card and 1 to 64 for DESFire 

smart card. 

8. Un-tick the Facility field checkbox. 

9. Tick the Revision field checkbox, and set this field from 33 to 40 for Mifare 

smart card and 65 to 72 for DESFire Smart Card. 

10. Un-tick the Even Parity and Odd Parity fields. 

11. Click OK to save the custom card configuration. 

 The newly created custom card configuration is added to the Custom Card 
Format list. 

12. Navigate to the door reader device being used in the FLN Configuration dialog 

from the tree hierarchy. 

13. Click the Configuration tab for the device. 

14. Ensure that Custom Card (Wiegand) is selected in the Technology field. 

15. In the Configuration field, select the newly created custom card 

(Mifare/DESFire) format from the drop down list. 

16.  Click the Save Configuration button to save the custom card configuration. 

17. Click the Close button.
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14 Intrusion Arming Terminal  

(ATI5100 / IAT-010) 
The IAT-010 is an Intrusion Arming Terminal, developed to efficiently secure and 

provide privileged access to high security intrusion areas. 

 

 

The ATI5100 is referred to as the IAT-010 within the SiPass integrated software. 

Utilizing the existing SiPass integrated access control architecture, the IAT-010 

device can be easily configured into the system to allow cardholders with access 

privileges to arm or disarm intrusion areas. Audit Trail messages will appear in 

SiPass integrated as the arming status of each intrusion area changes. 

Partial Arming is another key feature of the IAT-010. This feature allows the 

cardholder to arm / disarm perimeter points alone, and allow movement to continue 

in the remaining areas. 

All these features have been explained in detail in the sections that follow. 

 

 

The IAT-010 does not support Sintony Intrusion Areas. 
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14.1 IAT-010 Terminal Types 

An IAT-010 (ATI5100) can be configured to function as either of the following 

terminal types: 

● Intrusion Terminal 

● Intrusion Terminal with Access Control 

The configurations required for both these terminal types will be explained in detail 

in the sections that follow. 

Intrusion Terminal 

● When the Intrusion Terminal is configured to this mode, it may be used only for 

Intrusion Control. 

● In this mode, the cardholder uses the IAT-010 keypad to enter a valid PIN 

number and thereby change the arming state of the intrusion areas configured 

to the terminal. 

Intrusion Terminal with Access Control 

● When the Intrusion Terminal is configured with Access Control, it can be used 

for Intrusion Control as well as for Access Control. 

● When configured with Access Control, the IAT-010 terminal is assigned to a 

door reader, and is operated by the reader operation mode configured in 

SiPass integrated. When configured to this mode, the IAT-010 keypad is not 

represented as an access point in the system. 

14.2 Configuring a New Intrusion Terminal (Standalone) 

This section explains how the user can create a new IAT-010 (ATI5100) device as 

an Intrusion Terminal (standalone). 

1. Discover a new IAT-010 device on the FLN Configuration dialog 

2. Configure a new IAT-010 device on the Components dialog 

3. Assign the IAT-010 to an intrusion area as an arm/disarm point 

4. Configure an Access Level with the intrusion area, and assign it to an access 

group 

5. Enter the PIN on the IAT-010 terminal to arm / part-arm / disarm the intrusion 

area 

Each of the steps mentioned above, have been detailed in the sections that follow. 
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14.2.1 Configure / Discover a New IAT-010 Device 

An operator can configure / discover a new IAT-010 device can be done in either of 

the following ways: 

● Discovering the IAT-010 device through the FLN Configuration dialog, 

OR 

● Creating a new IAT-010 device on the Components dialog 

 

 

Although either of these methods can be used to create a new IAT-010 device, it 

is recommended that the operator utilize the FLN configuration dialog. The 

following sections will explain how to discover and create an IAT-010 device on 

the FLN Configuration dialog. 

Discovering the IAT-O10 device on the FLN Configuration dialog 

The following steps explain how the IAT-10 device can be discovered from the FLN 

Configuration dialog: 

1. Select FLN Configuration from the System menu. 

2. Right-click the respective ACC and select Search Exhaustive. 

 This action will search for and display devices that have been physically 

connected to the ACC. The user will notice that the new IAT-010 device 

appears at the FLN that the device was physically connected to. Further, 

note that the Device Number will also be displayed on this tab. 

3. Locate the Terminal Type on the Device Details tab 

4. Select Intrusion Terminal. 

5. Provide a name for this Intrusion Terminal in the Name field. 

6. Click Save New Device. 

Creating a new IAT-O10 device on the Components dialog 

The operator also has the option of creating and configuring this device on the 

Components dialog. The following steps can be used for this option: 

1. Open the Components dialog. 

2. Select the appropriate FLN under the respective ACC, to which the ATI5100 

device has been physically connected. 

3. Click New Device and select IAT. 

4. Enter a name into the Name field on the Device tab of this new item. 

5. Ensure that the Device Number is correct. (To retrieve the right device number, 

run an Exhaustive Search as described in the section Discovering Devices of 

this user manual. 

6. From the drop-down list of the Terminal Type field, select the type of intrusion 

terminal you want to configure. 

7. Click Save New Device. 
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14.2.2 Configuring the IAT-010 device on the Components Dialog 

The following section explains how to configure a new IAT-010 device on the 

Components dialog: 

1. Open the Components dialog. 

2. Expand the given FLN under the respective ACC. The IAT-010 device 

‘IntrusionTerminal-Standalone’ that was saved in the FLN Configuration dialog 

will appear under the given FLN. 

3. Verify the Device Number of the IAT-010 on this dialog. 

 

 

If a correct device number has not been entered into this field, the user will not be 

able to save the device. If saved without the right device number, the device will 

appear to be offline. 

The user will be able to confirm the right device number from the respective 

device information provided in the FLN Configuration dialog. This will be 

discussed in the following section. 

4. Select the Keypad tab of this new IAT-010 device. 

 

 

The Keypad tab appears for IAT-010 device only when it is created as an 

Intrusion Terminal (standalone). It will not appear when the device is created with 

Access Control. 

5. The Name field is entered by default. Select the required Alarm Definitions. 

6. Set the Time Schedule to Always (point unsecure). 

7. Enter the timeout for PIN entry in the Command Timeout (sec) field. By default, 

this field is set to 10 seconds. 

8. Click Save. 

 Once these selections have been saved, the Current State field is displayed as 

‘Enabled’. 

 

 

Please ensure that the input point to be assigned to the Intrusion Area has been 

configured to the Intrusion Area Entry / Exit Operation Mode on the Input / Output 
tab of the associated reader. 
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14.2.3 Assigning an IAT-010 to an Intrusion Area as an 

Arm/Disarm Point 

The operator will now have to create an intrusion area with arm / disarm, entry 

lockout and input points. Please refer the section Configuring an Intrusion Area this 

user manual for information on how to configure an intrusion area. 

To configure an input point for part-arming, please refer to the sections under 

Partial Arming / Part- Arming [➙ 225] of this user manual. 

14.2.4 Configuring an Access Level and an Access Group, with 

the Intrusion Area 

In this step, the operator will have to configure an Access Level to include the 

Intrusion Area on the Access Level dialog. 

Next, the operator will need to add this Access Level to an Access Group on the 

Access Group dialog. 

14.2.5 Configuring a Cardholder’s Access Privilege with the 

Access Group 

As the next step, the operator has to configure a valid cardholder’s Access 

Privilege to include the Access Group. This can be done by using the Define 

Access Privileges button on the Cardholder dialog. 

The defined privileges should be then saved on the Cardholder dialog. 

14.2.5.1 Configuring the IAT-010 Terminal to Arm / Part-arm / 

Disarm the Intrusion Area 

Next, the operator needs to configure the IAT-010 Terminal to arm / part-arm / 

disarm the intrusion area. 

1. Tick the PIN as Card checkbox and click Save. 

2. The Pin Number field on the Cardholder dialog will provide a valid PIN number. 

Enter this Pin Number on the intrusion terminal keypad. Press the Enter key. 

3. The terminal will provide options for Arm / part-arm / disarm of the Intrusion 

Area. Selecting the appropriate options will allow the user to effectively utilize 

the Intrusion Arming Terminal in the Standalone mode. 

For information on how to operate the IAT-010, please refer to the ATI5100 
Operations Manual. 
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14.3 Overview of Configuring an Intrusion Terminal with 

Access Control 

This section explains how the user can create a new IAT-010 device with Access 

Control in the Components dialog. 

1. Discover the IAT-010 device on the FLN Configuration dialog 

2. Configure the new IAT-010 device on the Components dialog 

3. Link the IAT-010 device to a door reader 

4. Create an Intrusion Area specifying Arm / Disarm, and Input (Aux) points 

5. Configure an Access Level with the Intrusion Area, and the Access Point. 

Assign it to an Access Group. 

6. Configure a cardholder’s Access Privilege to include the Access Group 

7. Operate the IAT-010 according to the configured Operation Mode of the door 

reader 

These steps have been explained in detail in the sections that follow. 

14.3.1 Discovering the IAT-010 Device 

This section details the steps required to discover the new IAT-010 device on the 

FLN Configuration dialog. 

This can be done in either of the following ways: 

● Discovering the IAT-010 device on the FLN Configuration dialog 

● Creating a new IAT-010 device on the Components dialog 

 

 

Although either of these methods can be used to create a new IAT device, it is 

recommended that the operator utilize the FLN configuration dialog. 

 

14.3.1.1 Creating a new IAT-010 device on the Components dialog 

1. Select Components from the System menu or tool bar. 

2. Expand the given FLN under the respective ACC. 

 The IAT-010 device that was saved in the FLN Configuration tool will 

appear under the given FLN. 

3. Select this new IAT-010 device. Verify its Device Number and ensure that its 

Status is Online. 

Please refer section Configure / Discover a new IAT-010 device [➙ 216] for 

information on using the Components dialog to create a new IAT-010 device, 

instead of the FLN Configuration dialog. 
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14.3.1.2 Discovering the IAT-010 device on the FLN Configuration 

dialog  

1. Select FLN Configuration dialog from the System menu. 

2. Right-click the respective ACC and select Search Exhaustive. 

 This action will search for and display the devices that have been 

configured to the ACC. The user will notice that the new IAT-010 device 

appears at the FLN it was created under. Further, note that the Device 

Number will also be displayed on this tab. 

3. Enter a name for the device in the Name field. 

4. Locate the Door Set on the Device Details tab. 

5. Select Intrusion Terminal with Access Control. 

6. Click Save New Device. 

14.3.2 Linking a Door Reader to the IAT-010 for Intrusion Control 

This section details the steps required to link reader to the newly created ATI5100 

device for intrusion control. 

 

 

An IAT-010 can be linked to any RIM device (DRI, SRI, ERI). 

1. Select an available DRI from an FLN bus on the ACC. 

2. Select either Door Reader 1 / Door Reader 2 tab of the DRI. 

3. Select the Intrusion Control tab of this Door Reader. 

4. In the Terminal Device field, select the created IAT-010 device from the drop 

down menu. 

 Once a Terminal Device has been selected, the other reader will not be 

configurable for the same Intrusion Terminal. 

5. From the Time Schedule field, specify a required time-schedule. 

6. Click Save. Once these selections have been saved, the Current State field of 

this tab displays the device as Enabled. 

7. On viewing the tab of the newly created IAT-010 device, the user will note that 

the Linked Reader field displays the door reader that was configured for 

intrusion control with this device. 

 

 

Please ensure that the input point to be assigned to the Intrusion Area has been 

configured to the Intrusion Area Entry / Exit Operation Mode on the Input / Output 
tab of the associated reader. 
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14.3.3 Creating an Intrusion Area with Arm / Disarm and  

Input Points 

The operator will now have to create an intrusion area with arm / disarm, entry 

lockout and input points. Please refer the section Configuring an Intrusion Area of 

this user manual for information on how to configure an intrusion area. 

To configure an input point for part-arming, please refer the section Partial Arming / 

Part-Arming [➙ 225] of this manual. 

14.3.4 Access Level Configuration to include Intrusion Area and 

Input Point, and assigning of an Access Group 

In this step, the operator has to configure an Access Level to include the Intrusion 

area and the Input point/s assigned to the IAT-010, using the Access Level dialog. 

Next, the operator has to assign this Access Level to an Access Group, using the 

Access Group dialog. 

14.3.5 Configuring a Cardholder’s Access Privilege to the Access 

Group 

In this step, the operator has to configure a valid cardholder’s Access Privilege to 

include the Access Group. This can be done by clicking the Define Access 

Privileges button on the Cardholder dialog. This will bring up the Define Access 

dialog, where the user can select the access privileges to the configured to the 

cardholder. 

14.3.6 Operating the IAT-010 Terminal to Arm / Part-arm / Disarm 

the Intrusion Area 

This section describes the steps required to operate the IAT-010 Terminal to arm / 

part-arm / disarm the intrusion area. 

1. Operate the IAT-010 terminal according the Operation Mode configured on the 

Components dialog. 

2. Use the IAT-010 keypad to control the intrusion area. 

_Ref01650570F9C987451063BB33615941E5
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14.4 Intrusion Control for Multiple Areas 

The IAT-010 terminal can be used to arm / disarm / part-arm multiple areas. The 

user can then choose to operate on all the areas, or on a specific area alone. 

Selection of the areas available to the user will depend on the Intrusion Area 

configuration, as well as User Privileges. 

For example, consider a situation where the IAT-010 terminal is assigned as an 

arm / disarm point for areas A, B and C. However, a particular user has arming 

privileges only for areas A, B and D. In such a case, only areas A and B will be 

available to the user at that particular intrusion terminal. 

14.5 Executing Manual Override commands for the IAT- 

010 device 

Manual commands can be used to override and control existing configurations of 

the IAT-010 device with SiPass integrated. 

14.5.1 Manual Commands for the Standalone Intrusion Terminal 

When configured as a standalone device, the user will only be able to send 

Intrusion Control commands using the IAT-010 device keypad as an Access point. 

The ACC does not support manual commands to allow access, block / lock door 

etc., when the standalone keypad is selected as an access point. 

When the IAT-010 keypad is selected as the Access Point, only 6 manual 

commands can be configure for the Standalone IAT-010 device. These commands 

are as follows: 

● Intrusion Control – Disable 

● Intrusion Control – Enable 

● Intrusion Control – Restore Config 

● Reader Buzzer Off 

● Reader Buzzer On 

● Reset Reader Tamper 

14.5.2 Manual Commands for the Intrusion Terminal with Access 

Control (linked terminal) 

When configured as an Intrusion Terminal with Access Control (linked terminal), 

the ACC will support manual commands that are available for any access point. 
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14.6 Deleting an ATI5100 Device 

In order to delete an IAT-010 device, it is mandatory that the user conform to an 

essential sequence of deletion. 

The user will have to progressively delete every access level/s, Intrusion Areas 

where the IAT-O10 device exists, before finally deleting it from the Components 

dialog. 

14.6.1 Deleting an Intrusion Terminal (Standalone) 

In order to delete an Intrusion Terminal (standalone), the operator will need to 

apply the following steps: 

1. Open the Intrusion Area Configuration dialog. 

2. Select the Intrusion Area Members tab and remove the required Intrusion 

Terminal from the Selected List. 

3. Click Save. 

4. Next, open the Components dialog. 

5. Select the required Intrusion Terminal, and click the Delete button. 

 The terminal will be deleted. 

14.6.2 Deleting an Intrusion Terminal with Access Control 

In order to delete an Intrusion Terminal with Access Control, the operator will need 

to apply the following steps: 

1. Open the Intrusion Area Configuration dialog. 

2. Select the Intrusion Area Members tab and remove the access point that the 

IAT-010 is linked to from the Selected List. 

3. Next, open the Components dialog and select the Intrusion Control tab of the 

access point door reader. 

4. Make a blank selection from the Terminal Device drop down menu. 

5. Click Save. 

6. This action will de-link this access point from the respective IAT-010 device. 

7. Select the IAT-010 device to be deleted from the respective FLN, and click 

Delete. 
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14.7 Partial Arming / Part-Arming 

In addition to Arming and Disarming an intrusion area, a user also has the option to 

Partially Arm / Part-arm the area. This functionality is called Partial Arming or Part 

Arming. 

Consider an Intrusion Area where Input Points A, B and C are configured as Part-

Arm. These points are called Perimeter Inputs. 

Further, Input Points D and E of the same Intrusion Area are configured as Full-

Arm. 

When the area is part-armed, only part-armed (perimeter) inputs A, B and C 

become enabled. 

When the area is armed, all the inputs A, B, C, D and E become enabled. 

14.7.1 Configuring Input Points for Partial / Part Arming 

In order to enable an input point for part / partial arming, the operator will need to 

configure the point accordingly, on the Intrusion Area dialog. This section explains 

how this can be done. 

For both Intrusion Terminal types, the steps required to configure input points for 

part-arm are the same. 

1. Select the Input Point of the Intrusion Area, on the Intrusion Area Configuration 
dialog. 

2. From the Intrusion Area Link column, select the cell corresponding to the Input 

point required. 

3. Right-click this cell and select Part Arm. 

4. Click Add. 

5. Click Save and Close. 
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14.8 Intrusion Terminal Alerts of Unsealed Inputs 

● Situation: The user has selected an area to be armed / part-armed. However, 

the area is not ready to arm because of an unsealed input in the area. Further, 

the cardholder in this case, does not have Isolation Privileges. 

 LCD Message: 

 Intrusion Area 1 

 Not Ready to Arm 

 Press ? to list 

 unsealed inputs 

● Situation: If the user presses the ? key on the IAT-010 terminal; 

 LCD Message: 

 Unsealed input – 

 input 040101 

● Situation: If there are more than 3 unsealed inputs; 

 LCD Message: 

 Unsealed inputs – 

 Scroll for more – 

 Input 040101 

 Input 040102 

 Input 040103 

At this point, the user can use the Scroll button to move down and view the 

displayed list of unsealed points on the LCD screen. 

In order to grant the cardholder Isolation Privileges to isolate the unsealed inputs, 

check the Isolation checkbox on the Cardholder dialog and save. This will give the 

cardholder privileges to isolate any unsealed input, and proceed to arm / part arm 

an intrusion area with unsealed inputs. 

14.9 Isolation Privileges for Multiple Unsealed Inputs 

● Situation: The user wants to arm an area with multiple unsealed points, and 

has been given Isolation Privileges. They will be offered an extra option to seal 

/ isolate an unsealed input, instead of just viewing the list of unsealed inputs. 

 LCD Message: 

 Input 040101 

 is unsealed 

 Press <return key symbol> to seal 

 ? for full list 

If the user presses the <Return> key, the arming process will continue in the usual 

manner. 

If the user presses the <?> key, the arming process will be terminated and the IAT-

010 will display the list of unsealed inputs, as described in the previous section. 
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14.10 Trouble-Shooting 

The following section provides important user information about how he can fix 

possible trouble-shooting situations. 

The IAT-010 continues to remain offline after Component and FLN 
configuration 

It needs to be mentioned that if the IAT-010 continues to remain offline even after 

FLN Configuration, the following problems could be considered: 

● The ACC needs to be initialized. Please refer the section Initializing Units of 

this user manual for further details. 

● The device has not been configured with the right device number. 

● The IAT-010 has not been physically connected to the right FLN on the ACC. 

The IAT-010 does not present intelligent characters / numbers on the 
LCD, on pressing the keys 

Please ensure that the latest firmware of the ACC and the IAT-010 has been 

downloaded. For further information, please refer the section Device Firmware 

Download and Configuration of this user manual.
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15 DVR 
The SiPass integrated DVR solution allows SiPass to communicate with DVR 

equipment using a high level interface. This interface allows control and 

manipulation of the equipment connected to the DVR system, such as DVR units, 

cameras and auxiliary devices. The DVR High Level Interface allows you to view 

and record digital images from a SiPass workstation. 

Whilst SiPass integrated supports many DVR systems, Siemens SISTORE DVR 

system is the recommended system for reliability and performance. 

A DVR communicates with SiPass integrated workstations by TCP/IP protocol 

across an Ethernet network. This allows even greater flexibility when integrating 

your DVR camera system with the SiPass integrated access control and security 

system. You only need to connect a DVR to the network on which the desired 

SiPass DVR workstation is located. 

If you only require the use of a single operator and therefore a single PC, the DVR 

Client files can be installed on the same machine that the SiPass server and Client 

are installed. If you require a separate SiPass workstation for viewing and 

recording functionality, the DVR Client files can be installed on a separate PC, 

along with a SiPass Client. 

 

 

The SISTORE interface cannot be used to control PTZ type cameras, but can be 

used to control the recording mechanism on a SISTORE system. 

DVR Configuration Summary 

The following list provides a summary of the configuration and setup for the SiPass 

DVR option. 

● Ensure that Windows and the same service pack have been installed on all 

PCs in the SiPass integrated access control and security network. 

● If your access control and security network is to be configured using more than 

one PC, ensure that all machines are connected together using an appropriate 

communications protocol. 

● Install the appropriate SiPass integrated software onto each PC in your access 

control and security network, ensuring that exactly the same version of SiPass 

integrated is used for all installed components. 

● Ensure that the DVR system architecture has been planned in advance. 

● Ensure that you have programmed the DVR unit using the System 

Administration software and that all DVR devices have been connected. 

● Ensure that the DVR unit has been connected to the SiPass PC where the 

DVR bus service has been installed. 

● Install the DVR Client files on the PC(s) where DVR images are to be viewed. 

Configure the DVR Client with the address and details of the DVR. 

● Program and configure the DVR Bus and DVR using SiPass integrated. 

● Program the necessary cameras and camera groups in SiPass integrated. 
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15.1 Programming SiPass integrated for DVR 

In order for the SiPass DVR option to function correctly, SiPass integrated must be 

programmed with the appropriate data. This includes programming DVRs, DVR 

cameras, and camera groups. 

15.2 Configuring the DVR Comms Channel 

SiPass integrated sends and receives information to and from the DVR system 

using TCP/IP across an Ethernet network. As both Windows and the DVR switcher 

understand the TCP/IP protocol, there is no need to configure any additional 

components.  

 Ensure that you have installed the SiPass Server. 

 Ensure that you have installed the DVR Client on the workstation that you are 

going to view DVR images. 

 Ensure that you have assigned the correct operator privileges. 

 Ensure that you have programmed any DVRs with the correct information. 

1. Choose the Components button from the System toolbar or menu. 

 The Components dialog will appear, displaying a hierarchical tree structure 

of SiPass integrated components. 

2. Select the Server Name by double clicking on it. 

3. Click the New Bus button. 

 A menu will appear showing a list of buses that your license allows you to 

create. 

4. Select the DVR option. 

 A new bus will appear connected to the Server and a new tab option will 

become available. 

5. Select the Add button. A new DVR unit type will appear under the DVR 

Column. 

6. Click on the unit to display a drop down menu, and select your desired unit. 

7. Enter the location of the folder on the PC’s hard disk where you have installed 

the DVR client software, into the Install Directory field. 

– The DVR Client software must be installed in the same directory on each 

PC. 

8. Click Save. 
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15.3 Configuring the SISTORE/DVR Client in SiPass 

integrated 

Before SISTORE/DVR cameras can be manipulated from either SiPass integrated 

or the DVR Client, you must add the location of the client folder to the Windows 

Environment Variables path. This section applies to both SISTORE AX and 

SISTORE -clients. 

 

 

SISTORE CX / SX Units that are Version 3.1 or later can be controlled directly 

from SiPass integrated so these steps may not be required. 

1. Select Settings > Control Panel > System from the Windows Start menu. The 

System dialog will appear, and the General tab will be open by default. 

2. Choose the Advanced tab. 

3. Choose Environment Variables. The Environment Variables dialog will appear. 

4. Select the “Path” row and choose Edit. 

5. Place a semicolon after the last entry in the Variable Value field. Immediately 

after the semicolon, type the location of the SISTORE client files. For example: 

C:\SISTORE AX 

6. Choose OK. 

 The environment variable path has now been configured. 
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15.4 Configuring a DVR unit 

The main component of a DVR system is the DVR unit itself. This device controls 

the operation of DVR cameras in the system and is responsible for the recording of 

images. SiPass integrated uses a high level interface to send commands to and 

receive messages from the DVR. After you have configured a DVR with the 

System Administrator software, the address, type and security details must be 

programmed in SiPass integrated. 

 Ensure that you have configured the DVR comms channel. 

 Ensure that you have connected the DVR to a SiPass workstation PC, or to the 

network on which the workstation PC is located. 

 

If the Type is “General SISTORE” and SISTORE CX unit is connected, the Video 

Port should read “12050” and the PTZ Port should read as “23479” by default. 

If the Type is “General SISTORE” and SISTORE MX unit is connected, both 

Video Port and PTZ Port should read as “12050”. 

1. Choose the Components button from the System toolbar or menu. 

2. The Components dialog will appear, displaying a hierarchical tree structure of 

SiPass integrated components. Select the Server Name by double clicking on 

it. The Operational tab will appear. 

3. Select the DVR bus created and click the New Unit button. A new DVR unit will 

appear connected to the bus and a new tab will become available. 

4. Enter a unique name for the DVR into the Name field. 

5. Select the type of DVR unit from the Type drop-down box. 

6. Assign an Alarm Class to the DVR from the Alarm Class drop-down box. 

7. The only alarm states that will apply to DVR Alarm Classes will be 

“Communications Lost” and “Communications Restored”, which correspond to 

“Alarm” and “Restore” respectively. 

8. Enter a description for the DVR Switcher in the Description field. 

9. Enter the IP address of the network card installed on the Host PC into the Host 

Server IP field. You only need to supply a Host IP address if there is more than 

one network card installed on the PC running the SiPass Server. In this case, 

you must supply the IP address of the network card on the SiPass Server 

which the DVR uses to communicate. 

10. Enter the IP address of the DVR into the DVR IP field. 

11. Enter the Port number that the switcher will use to communicate with the 

SiPass PC. 

12. Enter the User Name and Password used to configure the DVR by the DVR 

Administration software. 

13. Enter a name for the device in the Device Name field. 

14. Enter a device version in the Device Version field. 

15. Enter the SW Version. 

16. Enter the number of Video Inputs/Outputs and Digital Inputs/Outputs in the 

respective fields. 

17. The Refresh button will update the communications status of the switcher that 

appears in the read-only field. 

18. Click the Save button. The DVR unit details will be saved to SiPass integrated. 
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15.4.1 Configuring Input / Output Points for a DVR Unit 

The operator can configure DVR Input / Output Points on the Components dialog in 

two ways: 

● Using the Auto Discover button to automatically discover Input and Output 

points that have not yet been configured in the dialog. 

● By specifying the maximum number of Input and Output points that he wishes 

to configure. 

Auto-Discovery of Input / Output points 

1. Select the Input/Output points tab of the new DVR unit that was created. 

 

 

The Input/Output points tab will appear only when the DVR unit has been 

configured as General SISTORE in the Type field. This field appears in the DVR 
Switcher tab. 

2. Click the Auto Discover button. The Digital Input and Output Points will be 

displayed on this tab. 

3. The Auto-Discover button will be disabled if the Comm Status details of the 

DVR Unit (as given in the DVR Switcher tab) has not been updated. To update 

these details, click the Refresh button on this tab. 

Specifying the number of Input / Output points to be configured 

1. Select the Input/Output points tab. 

2. Select the maximum number of inputs required from the Max inputs drop-down 

list. The specified number of input points will be displayed. 

3. Select the maximum number of outputs required from the Max outputs drop-

down list. The specified number of output points will be displayed. 

4. Any of these points can be deleted by highlighting it and pressing the DEL key. 

15.4.1.1 Field Definitions for Digital Input / Output Points 

The Digital Input Points section defines the Input Points by the following fields on 

the Input/Output tab: 

● Input Name 

● Enable Input 

● Invert Input 

● Status 

● Alarm Definition 

A DVR Digital Input Point uses Normal / Alarm as alarm class states. 

 

 

The operator will need to specify a required Alarm/Restore state. Once 

configured, the Digital Input Point can be configured with this Alarm Definition. 
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15.4.1.2 Field Definitions for Digital Output Points 

The Digital Output Points section defines the Output Points by the following fields 

on the Input/Output tab: 

● Output Name 

● Status 

● Alarm Definition 

A DVR Digital Output Point uses Lock / Unlock as the alarm class states. 

Once configured, the Digital Output Point can be configured with this Alarm 

Definition. 

15.4.1.3 Configuring Host Event Tasks for Digital Input/Output 

points 

The operator can perform the following Host Event Task (HET) configurations: 

● Configure a HET triggered by a Digital Input / Output Point 

● Define a HET to change the state of a DVR Digital Input / Output Point 

 The operator can configure a Host Event Task to change the state of a 

selected DVR digital output. For example, a HET can be configured to change 

the state of a Digital Input / Output point from the Trigger State Open to the 

Target State Close. In this case, the Output Point has to be configured as the 

target. 

15.4.1.4 Configuring a Manual Command to Change the State of a 

DVR Digital Output 

Operators can configure manual commands to change the state of a DVR Digital 

Output. 

1. Select Operation > Manual Override. 

2. Select the Output button from the Type box. 

3. Select the required DVR unit name from the Unit Name field. 

4. Choose the required state change from the box above Unit Name. 

5. The available states for the DVR unit are: 

– Close 

– Open 

– Single Pulse 

6. Select the DVR output point for the state change from the Points tab. 

7. Click Send and Close. 
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15.4.1.5 Configuring a DVR Digital Input / Output Point Group 

Operators can configure DVR Digital Input / Output Point Groups on the 

Component Group dialog. 

1. Select Program > Component Group. This will bring up the Component Group 

dialog. 

2. Enter a name for the group in the Group Name field. 

3. From the left panel of groups, select Point Group. 

4. Click the Add Members button. This will bring up the Create Group dialog. 

5. If you want to configure an Input Point Group, select Input Points from the 

Group Type drop-down field. If an Output Point Group is to be configured, 

select Output Points from this field. 

6. Select the Input / Output points that you want to add to this group from the 

Available box. 

7. Click Add All >>. This action will add them to the Selected box. 

8. Click OK. 

9. Select an alarm from the Alarm Class drop-down field. 

10. Click Save and Close. 

15.4.2 Configuring Monitors for a DVR Unit 

The operator can configure Monitors for DVR units on the Monitors tab of the 

Components dialog in two ways: 

● Using the Auto Discover button to automatically discover Monitors that have 

not yet been configured in the dialog 

● By specifying the maximum number of Monitors he wishes to configure on the 

Max Monitors: drop-down list. 

The Monitors section defines the Monitors by the # (Monitor Number), Monitor 

Name and Video Output Channel fields. 

15.4.2.1 Configuring Remote Video Inputs for the DVR Unit 

The operator can configure Remote Video Inputs for DVR units in on the Remote 
Video Inputs tab of the Components dialog in two says: 

● Using the Auto Discover button to automatically discover Remote Video Inputs 

that have not yet been configured in the dialog 

● By specifying the maximum number of Remote Video Inputs he wishes to 

configure on the Max Points: drop-down list. 

The Remote Video Inputs section defines the inputs by the # (Input Number), Input 

Name, Alarm Definition, IP Address, Port and Protocol fields. 
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15.4.2.2 DVR Unit Functions Available from Site Plans 

Operators can add, modify or remove DVR digital Input or 0utput Points/Groups to 

or from Site Plans. 

Adding DVR input / output points / groups a Site Plan 

1. From the tool bar of the Site Plan, select the Add Location / Group button. 

2. Click on a desired location in the Site Plan to apply it. This action will bring up 

the Add Location / Group to Site Plan dialog. 

3. Select Point or Group from the Type drop-down field. 

 

 

Select Point to add an Input/Output Point to the plan. Select Group to add an 

Input/Output Point Group to the plan. 

4. Only Point/Groups that have Alarm Classes assigned will be displayed on this 

dialog. 

5. Click OK. 

Deleting DVR input / output points / groups from a Site Plan 

To delete any of these points / groups, select the particular point/group, and click 

Delete. 

Refer the section Adding System Components (symbols) to Your Site Plan [➙ 254] 

detailed instructions on how to add a system component (like a DVR Point or 

Group) to a site plan. 

15.4.3 Configuring a DVR Camera 

SiPass integrated allows you to program either a fixed or a PTZ (Pan/Tilt/Zoom) 

type DVR camera. Up to 16 cameras can be created for each DVR. 

 

 

SiPass integrated does not support PTZ Cameras on MX or AX SISTORE units. 

 Ensure that you have configured the DVR comms channel and at least one 

DVR unit 

 Ensure that you have connected the DVR unit to a SiPass workstation PC, or 

to the network on which the workstation PC is located. 

1. Choose the Components button from the System toolbar or menu. 

2. Select the Server Name by double clicking on it. 

3. Select the DVR comms channel. 

4. Select the DVR for which you want to define a camera. 

5. Choose the New Point button. 

 A new camera will appear connected to the Switcher and a new tab will 

become available. 

6. Enter a unique name for the camera into the Name field. 

7. Enter a unique title for the camera into the Camera Title field. 

8. Select a type of camera from the Type drop down box. 

9. Assign an Alarm Class to the DVR from the Alarm Class drop-down box 
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10. Enter a unique number for the camera into the Camera No. field. 

11. Enter the number of preset positions for the camera into the Max. Preset field. 

12. Enter a value in the Pre-Recording Interval field. 

 

 

An operator can configure a Host Event Task to playback a recorded video. The 

duration of the recorded video to be played back, is specified in the Duration field 

of the Host Event Task dialog (when the Target is set to ‘DVR’, and the 

Command is set to ‘DVR Recording’). Assume that the Duration field is configured 

for 60 seconds, and the Pre-Recording Interval (on the Components dialog, as 

described above in this section), is configured for 15 seconds; When the DVR 

recording playback is triggered using the Host Event Task, it will playback 60 

seconds of recorded video (as configured in the Host Event Task), preceded by 

video recorded 15 seconds before this duration. 

13. Enter a description for the camera in the Description field. 

14. Click Save. 

15.4.3.1 Discovering configured DVR video alarms (sensors) 

Operators can configure DVR video alarms in two ways: 

● Using the Auto Discover button to automatically discover Video alarm 

● By specifying the maximum number of alarms to be configured 

Auto-discovery of video alarms 

1. Select a defined camera under a DVR unit. 

2. Select the Video Alarm tab of this camera. 

3. Click the Auto Discover button. 

 This action will display all the alarms configured for this camera in the Video 

Alarm section of this dialog. 

 

 

The Input/Output Points, Monitors and Remote Video Inputs will appear only if the 

Type selected for the DVR Switcher is General SISTORE. 

Specifying the video alarms to be configured 

1. Select a defined camera under a DVR unit. 

2. Select the Video Alarm tab of this camera. 

3. Select the maximum number of alarms to be configured from the Max. Alarm 

drop-down field. 

 This action will display the configured number of sensors in the Video Alarms 

section of this dialog. 
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15.4.3.2 Field Definitions for Video Alarms (sensors) 

The Video Alarms section defines the sensors by the following fields on the Video 
Alarms tab: 

● # (Video Alarm Number) 

● Sensor Name 

● Sensor Type 

● Time Schedule 

Alarms related to the sensor points of a camera can be controlled using time 

schedule. Time Schedule field can be set to Always(point unsecure), Never(point 

always secure) or System Function. 

● Alarm Definition 

An Alarm Class needs to be defined specifically for the Video Alarms, with the 

following configuration: 
 

Field Required Configuration 

Type Input 

Status Alarm / Normal 

Alarm / Restore Ignore / Alarm / Restore 

 

Once configured, the Video Alarms can be configured with this Alarm Definition. 

15.4.3.3 Setting up a Host Event Task to change the DVR Video 

Alarm program 

The operator can configure a Host Event Task to change the program of a video 

alarm sensor. 

1. Select Program > Event Tasks > Host Event Task. 

2. Specify an Event Name. 

3. Specify a Time Schedule. 

4. Specify Source 1 as an Input Point or Output Point. 

5. Select a required State 1. 

6. Specify a Location 1. 

7. Select DVR in the Target field, select DVR. 

8. Select a desired switcher in the Switcher field. 

9. Select EDS / ODR program switching from the Command field. 

10. Select a camera in the Cameras field. 

11. Enter a message for the Host Event Task in the Message field. 

12. Click Save. 
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15.4.3.4 Setting up a HET to create a connection between a DVR 

camera and monitor 

An operator can configure a Host Event Task to create a connection between a 

DVR camera and a selected analog monitor. 

1. Select Program > Event Tasks > Host Event Task. 

2. Specify an Event Name. 

3. Specify a Time Schedule. 

4. Select Time Schedule in the Source 1 field. 

5. Select Start / Start and Stop / Stop in the State 1 field. 

6. Select DVR in the Target field. 

7. Select Camera/Monitor Connecting in the Command field. 

8. Select a switcher in the Switcher field. 

9. Select a camera in the Cameras field. 

10. Select a monitor in the Monitors field. 

11. Enter a message in the Message field. 

12. Click Save. 

 The Host Event Task has now been configured. 

15.4.4 Grouping DVR Cameras 

SiPass integrated allows DVR components to be grouped together. These groups 

are used during configuration and operation processes. Grouping components also 

allows you to partition the control that operators have over DVR points. The 

following section outlines the procedure used to group DVR components. 

1. Go to Component Group from the Program toolbar or menu and choose Point 

Group from the list in left pane of the Component Group dialog. 

2. Select a point group from the Group Name dropdown list (or create a new 

group by clicking the New button). 

3. Choose Add Members. 

4. Select “DVR Camera” from the DVR Points drop-down list. 

 The available members for that group will appear in the Available list. 

5. Select the name of the camera to be added to the group from those displayed 

in the Available list. 

6. Choose Add >. 

 The selected camera/monitor will be added to the selected list. 

7. Repeat Steps 4 and 5 until all members have been added to the Selected list. 

8. Choose the OK button. 

 The Alarm Class, Group Alarm Triggers, Group Actions and Group Alarm 

Status components in the Group dialog have no effect when defining a 

camera group. 

9. Click Save. 
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15.4.5 Configuring an IP Camera 

SiPass integrated allows an operator to configure IP Cameras in the system. 

There are four main applications of the IP Camera configuration: 

● To view IP Camera video using the DVR Live Monitor 

● To view IP Camera video using the Virtual Monitor 

● To use an IP Camera as a Remote Video Source 

● To use an IP Camera for Cardholder Imaging 

To apply any of these features, the camera will first have to be configured in the 

SiPass integrated system. 

The IP Camera is configured as a new bus on the server. The steps required to 

configure it are as follows: 

1. Choose the Components button from the System toolbar or menu. 

2. Select the Server Name by double clicking on it. 

3. Click the New Bus button. 

4. Select IP Cameras from the drop-down list that appears. 

5. Next, select the New Unit button. 

6. Enter a name for the unit in the Name field. 

7. Enter a description for the unit in the Description field. 

8. Click Save. 

9. Click the New Point button. 

10. Enter a name for the camera in the Name field. 

11. Enter a title in the Title field. 

12. Enter a camera number in the Number field. 

13. Select the desired Aspect Ratio of the camera image from the Display Ratio 

field. 

14. Enter the IP address of the camera in the IP field. 

15. Enter an appropriate username in the User Name field for logging into the 

camera securely. 

16. Enter a strong password in the Password field for logging into the camera 

securely. 

Note: Symbols like @ , : , / can not be used for the password. 

 

Please note that the type of IP Camera being configured must support the RTSP 

protocol. 

1. Enter a port number in the Port field. This port number depends on the type of 

IP Camera being used. Refer relevant manuals of the specific IP Camera for 

information on the Port number. 

2. If the IP Camera being used carries extra URL requirements, enter this URL 

into the Extra URL field. 

3. A description for IP Camera can be entered in the Description field. 

4. If the IP Camera is to be used for Cardholder image capture, tick the check box 

for This IP Camera can be used for cardholder’s image capture. 

5. Click Save. 
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15.4.5.1 Configuring an IP Camera for Cardholder Imaging 

Once an IP Camera has been configured on the Components dialog, it can be 

used for the purpose of Cardholder image capture in the following manner: 

Ensure that the right IP address has been entered for the camera in the 

Components dialog. 

Ensure that the tick box is ticked for This IP Camera can be used for cardholder 

image capture in the Components dialog. 

1. Select Options > Preferences. 

2. Click on the Imaging tab. 

3. Click the IP Camera option and select the IP Camera device from the drop 
down menu. 

4. Click Save and Close the Preferences dialog. 

15.4.5.2 IP Camera Supported Protocols 

For Live streaming withIP Cameras, SiPass supports the RTSP protocol as a 

command protocol and RTP for the data stream. 

The following Codecs are supported: 

● MJPEG 

● MPEG4 

● H264 

 

 

The RTSP URL is dependant on the type of IP Camera.  

Example: rtsp://user:password@ip:port/axis-media/media.amp 

The rtsp://user:password@ip:port part of the URL is the default for the VSS SDK 

player. The rest is the request string for the camera. 

Not all cameras require a user and password so in that case it may be omitted. 

E.G. rtsp://ip:port/axis-media/media.amp. 

If there is no port defined for the RTSP server E.G rtsp://ip/axis-media/media.asp 

the 554 is used by the player as it is the default port for the RTSP control channel. 
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15.5 Configuring a Generic DVR unit 

This section explains how operators can configure generic DVR units in the SiPass 

integrated system. 

 Ensure that you have configured the DVR comms channel. 

 Ensure that you have connected the DVR to a SiPass workstation PC, or to the 

network on which the workstation PC is located. 

1. Open the Components dialog and configure a DVR bus and a New Unit. Steps 

1 to 4 of the section Configuring a DVR unit [➙ 231] of this chapter explains 

how this can be done. 

2. Next, select Generic from the Type drop-down field of this dialog. 

3. Assign an Alarm Class to the DVR from the Alarm Class drop-down box. 

4. The only alarm states that will apply to DVR Alarm Classes will be 

“Communications Lost” and “Communications Restored”, which correspond to 

“Alarm” and “Restore” respectively. 

5. Enter a description for the DVR Switcher in the Description field. 

6. Configure the DVR Server field. 

7. Enter the IP address of the network card installed on the Host PC into the Host 

Server IP field. You only need to supply a Host IP address if there is more than 

one network card installed on the PC running the SiPass Server. In this case, 

you must supply the IP address of the network card on the SiPass Server 

which the DVR uses to communicate. 

8. Enter the IP address of the DVR into the DVR IP field. 

9. Enter the Port number that the switcher will use to communicate with the 

SiPass PC. 

10. Enter the User Name and Password used to configure the DVR by the DVR 

Administration software. 

11. Enter a name for the device in the Device Name field. 

12. Enter a device version in the Device Version field. 

13. Enter the SW Version. 

14. Enter the number of Video Inputs/Outputs and Digital Inputs/Outputs in the 

respective fields. 

15. The Refresh button will update the communications status of the switcher that 

appears in the read-only field. 

16. Click the Save button. The DVR unit details will be saved to SiPass integrated. 

  



 

 

DVR 

Configuring a Generic DVR unit 
15 

242 | 313  A6V101068156 

 

15.5.1 Configuring Input / Output Points for a Generic DVR Unit 

The operator can configure generic DVR Input / Output Points on the Components 

dialog in exactly the same manner as SISTORE DVR units. This means that the 

operator can either automatically discover Input and Output points using the Auto 

Discover button; or specify the maximum number of Input and Output points to be 

configured. 

The configuration steps required to do this have been explained in the section 

Configuring Input / Output Points for a DVR Unit [➙ 232]. 

Other functionalities supported by Input/Output Points of Generic 
DVR units: 

The following functionalities are also supported with the Input/Output points 

configured for generic DVR units: 

● Input / Output points can be used as a Triggers for Host Based Event Tasks 

● An alarm configured to the Input Point will be displayed in the Alarm Queue 

● Input Point events will be logged in Audit Trails 

● Input Points can be monitored from Site Plans 

● Alarm Classes can be configured to the unit 

● Input / Output points are supported in Input / Output point groups 

● Operator Partitioning is possible for these Input / Output points 

● Commands can be sent to Output points through Manual Commands and Site 

Plans 

● SiPass integrated Reports support these Input / Output points 

Configurable fields for Input / Output Points of a generic DVR unit: 

As with other DVR units, the following fields can be configured for Input Points for a 

generic DVR unit: 

● Input Name / Output Name 

● Alarm Definition: This field can be used to configure an alarm class to the input 

/ output point of a generic DVR unit. 

● Enable Input (for Input Points) 

● Invert Input (for Input Points) 

● Status 

15.5.2 Configuring Monitors/DVR Cameras/IP Cameras for a 

Generic DVR Unit 

The configuration of Monitors, DVR Cameras, IP Cameras for a generic DVR unit 

can be done in the manner as other DVR units. 

To configure a monitor for a generic DVR Unit, please refer the section Configuring 

Monitors for a DVR Unit [➙ 234] of this manual. 

To configure a DVR Camera for a generic DVR unit, please refer the section 

Configuring a DVR Camera [➙ 235] of this manual. 

To configure an IP Camera for a generic DVR unit, please refer the section 

Configuring an IP Camera [➙ 238] of this manual. 

_Ref9816B0E1FCA89D2AA4F576C3770394F6
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15.6 Setting up a DVR Recording Event Task 

SiPass integrated allows you to set up an event task to trigger recording of up to 

600 seconds of live images. 

1. Choose Event Tasks > Host from the Program toolbar or menu. 

2. Complete the Trigger details as for a normal Event Task. For example, if an 

access point registers an alarm outside of business hours you may want a 

camera to record any individuals entering through that point. 

3. Select DVR from the Target drop-down field. 

4. Select the desired DVR unit from the Switcher drop-down box. 

5. Select DVR Recording from the Command drop-down field. 

6. Enter the length of time in seconds that you want the DVR camera to record 

into the Duration field. Acceptable times range between 1 and 600 seconds. 

7. Select the camera from which live images should be recorded, from the 

Camera drop-down box. 

8. If the camera is a PTZ camera, select the position from which the camera 

should begin recording, from the Preset drop-down box. 

9. Enter a message describing the event task into the Message field. 

10. Click Save. 

 If the specified trigger occurs, the DVR camera will record a live image for the 

entered duration. A message will appear in the Audit Trail stating the trigger 

has occurred. This will be followed by a DVR Recording message giving the 

date and time, as well as whether the recording was successful or failed.
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16 Photo-ID and Graphics 
Video imaging and card printing is an optional module of the SiPass integrated 

access control system. It allows cardholder photographs and signatures to be 

captured on-screen or imported, card templates to be created and access cards to 

be printed. 

The Photo ID module allows you to connect a video or digital camera to the SiPass 

integrated system and capture a cardholder’s photograph and signature. These 

images can be saved to the SiPass integrated database along with any other 

cardholder information. They can then be viewed on-screen as part of the record or 

imported into a card template and printed onto an access card. 

SiPass integrated allows you to create your own customized card templates. These 

templates can include any combination of text, graphics, images, photographs, 

signatures, or cardholder database information. Once created a card template is 

attached to a cardholder’s record and then recalled or printed when appropriate. 

The additional SiPass Card Encoding module also allows you to include a bar code 

or magnetic stripe in your card templates, in a range of formats. Once inserted onto 

a template and attached to a cardholder’s record, all you need to do is print the 

card. 

The SiPass Photo ID module also allows you to print your own access cards. You 

can print a single cardholder’s card when their record is opened or a group of cards 

based on criteria that you supply. 

16.1 Graphics 

Using the optional SiPass Graphics module, you can view and monitor your 

secured area or site, create and modify floor plans, card templates and alarm 

instructions from a graphical perspective. When the Graphics module is configured 

and an alarm is activated, you can choose to see a graphical representation of the 

point, area, group or unit in question shown on the surrounding floor plan. 

SiPass integrated allows you to draw floor plans, import plans, and insert symbols 

representing input and output points, as well as any areas, groups and units at 

your site. These symbols allow you to monitor each of the inputs, areas, groups 

and units. If the status of a component changes, its symbol automatically changes 

color. 
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16.2 Drawing toolbar 

 The Drawing toolbar enables elements of the graphics package. This enables you 

to create, modify and view graphics components that allow you to monitor your 

site. 

◈ Choose New > Drawing from the File menu. 

 After you have selected New Drawing, an extended File menu then 

becomes available to add a new or open an existing graphic object. Three 

File Menu commands now provide access to sub-menus – New, Open and 

Import. 

The table below shows the commands that are available in the extended File 

menu. 
 

Command Description 

New Allows you to open a sub menu, from which you can choose to create a new drawing, symbol, 
site plan, card template, or alarm instruction. 

Open Allows you to open a sub menu, from which you can choose to open an existing drawing, 
symbol, site plan, card template, or alarm instruction. 

Close  Allows you to close the current graphic. If you have edited the graphic, a dialog appears 
asking if you wish to save the graphic before closing. 

Save  Allows you to save changes to the currently open graphic. 

Save As  Allows you to save the currently open file (symbol, site plan, card template or drawing) under a 
different file name. 

Import Allows you to open a sub menu, from which you can choose to import an image/AVI file, 
AutoCAD/DXF file, photo, signature, or drawing. 

Refresh Imported Drawing Allows you to return to the original imported graphic. If you have made any modifications to the 
graphic these will be lost upon refreshing. 

Save As Drawing Allows you to save a drawing created in a card template, symbol or site plan. For example, 
when creating a site plan, you can save the graphic, minus any symbols, as a drawing. This 
allows you to import the drawing when creating other graphic types. 

Print Setup Displays a dialog that allows the printer, paper size and page orientation to be selected. 

Print Preview Allows you to view the print job before it is sent to the printer. 

Print Sends the print job to the nominated printer. 

Lock Workstation Allows you to manually lock the workstation. Manually locking and unlocking the workstation 
generates an event that is recorded in the Active Audit Trail. 

Logoff Allows you to log off from SiPass integrated, without disconnecting from the Server. 

Exit Allows you to log off from SiPass integrated, shut down the SiPass Client and disconnect from 
the Server. 
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16.2.1 Additional Menus 

Once an existing drawing, symbol, site plan, card template, or alarm instruction has 

been opened or a new one created, three additional menus become accessible: 

● Edit (Extended) 

● View (Extended) 

● Drawing 

16.2.1.1 Edit Menu 

The type of graphic determines the available functions in the Edit menu. The Edit 

menu allows drawings, site plans, symbols, card templates and alarm instructions 

to be edited. It also allows the individual components to be modified. The following 

list outlines the functions contained in the menu. 

The following table shows the full range of commands available in the Edit menu. 

Depending upon the graphic object being edited, menu items may vary. 
 

Command Description 

Undo Allows you to undo your last action. 

Redo Allows you to cancel the last undo action. 

Cut Deletes the selected object and places it in the clipboard. 

Copy Copies the selected object and places it in the clipboard. 

Paste Pastes the last object placed in the clipboard into your alarm instruction or graphic at the 
cursor position. 

Paste Special Pastes text with extra options. 

Clear Deletes the selected object(s) from the alarm instruction. 

Select All Selects all the text and graphics objects. 

Find Allows you to search the text contained in your alarm instruction for a specific word, phrase or 
text string. 

Find Next Allows you to search the text contained in your alarm instruction for a second or subsequent 
occurrence of a text string that was searched for, using the Find command. 

Insert Date & Time Inserts the current date and time in a desired format, into an alarm instruction. 

Insert Object Allows you to insert an object created in another application into an alarm instruction. For 
example, you can insert a bitmap into your instruction and display the bitmap or an icon that 
represents that bitmap. 

Format Font Displays the Font dialog that allows you to format text characters in an alarm instruction to 
match the attributes required. 

Format Bullet Style Allows you to change the selected paragraph(s) from normal text to a bulleted list. 

Format Paragraph Displays the Paragraph dialog that allows you to alter the paragraph attributes of the selected 
text, such as the text indentation and paragraph alignment. 

Format Tabs Displays the Tabs dialog that allows you to specify the tab stop positions for the selected 
paragraphs. The tab stop positions are created relative to the ruler displayed at the top of the 
Alarm Instruction window. 
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Command Description 

Links Displays the Link Dialog that lists all the links (to text or graphics, created in another 
application) that you have inserted into your alarm instruction, and allows you to change the 
attributes of each link. 

Object Properties Displays the Picture Properties dialog that allows you to view the general details regarding the 
selected object and change the attributes of that object. 

Image Object Allows you to open the application where the object was created and edit that object. 

Edit Allows you to edit the selected text or drawing object. When chosen, the attributes dialog for 
the selected text or drawing object will appear. 

Group Allows you to combine two or more selected text or graphic objects into a single object. 

Ungroup Allows you to return a set of selected grouped objects to their original state as single elements. 

Move To Front Allows you to promote the selected text or drawing object to the front of the graphic. All other 
objects in the graphic will appear in a layer beneath the selected object. 

Move to Back Allows you to demote the selected text or drawing object to the rear of the graphic. All other 
objects in the graphic will appear in a layer above the selected object. 

Align Allows you to align two or more selected text or drawing objects in a graphic. 

Size To Image Allows you to revert to the imported image’s original size. 

Rotate Image Clockwise Allows you to rotate an imported image in a clockwise direction, by the specified amount. 

Flip Image Allows you to flip an imported image about either its vertical or horizontal axis. 

Invert Image Colors Allows you to invert or reverse the colors displayed in an imported image, effectively creating a 
negative of the original. 

Process Image Displays the Process Image dialog that allows you to change the brightness and contrast of 
the selected imported image. 

Optimize Image Allows you to optimize the selected imported image. 
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16.2.1.2 View Menu 

The View menu enables status bar and also allows you to zoom in or out on a 

graphic. 

The following table shows the full range of commands available in the View menu. 
 

Command Description 

Status Toolbar When selected, the Status Bar is displayed at the bottom of the screen. The Status Bar 
displays system or other messages that are relevant to the task being performed. 

Color Palette When selected, the Color toolbar is displayed. 

Zoom In Allows you to magnify the graphic being created or modified, with the selected point appearing 
at the center of the screen. 

Zoom Out Allows you to reduce the size of the graphic being created or modified. This is useful for you to 
view more text and drawing objects on screen at one time. 

Normal Size Allows you to display the graphic being created or modified at its original size. 

Grid When selected, a grid will appear in the background of the graphic as a static display when 
you are creating or modifying graphic objects. 

Bar Code When selected, the cursor will change to a Bar Code and the Bar Code Encoder dialog will 
open to insert a Bar Code into a card template. 

Magstripe When selected, the cursor will change to a Magstripe and the Magstripe Encoder dialog will 
open to insert a Magnetic Stripe into a card template. 

Smart Card When selected, the cursor will change to a Smart Card chip and the Smart Card Encoding 
Configuration dialog will open to insert a Smart Card chip into a card template. 
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16.2.1.3 Drawing Menu 

The Drawing menu allows the attributes of the selected object in a graphic to be 

changed. 

The following table shows the full range of commands available in the Drawing 

menu. 
 

Command Description 

Select Displays the Select tool that allows you to select a graphic or text object. 

Delete Allows you to delete the selected text or graphic object. 

Duplicate Allows you to copy and paste the selected object(s). 

Line Displays the Line tool that allows you to draw a straight line. 

Ellipse Displays the Ellipse tool that allows you to draw an ellipse. 

Arc Displays the Arc tool that allows you to draw an arc. 

Rectangle Displays the Rectangle tool that allows you to draw a rectangle. 

Polygon Displays the Polygon tool that allows you to draw a polygon. 

Text Displays the Text tool that allows you to insert text into a graphic. 

Insert Database Field Allows you to insert a Database field box into a card template. 

Note: This option is only available when creating or modifying a card template. 

Left Justify Any selected or new text that you add to the graphic will be left justified. 

Center Justify Any selected or new text that you add to the graphic will be center justified. 

Right Justify Any selected or new text that you add to the graphic will be right justified. 

Font Displays the Font dialog that allows you to format the font characteristics. 

Vertical Arcs When selected, all arcs drawn using the Arc tool will have their start and finish points in the 
vertical plane. 

Line Color Displays the Color dialog that allows you to modify the color of the line of a selected object or 
any new drawing object to be created. 

Fill Shapes When selected, all new drawing objects created will be automatically filled. 

Fill Color Displays the Color dialog that allows you to modify the fill color of a selected object or any new 
drawing object to be created. 

Thin Pen When selected, the lines of all new or selected objects will be set to a thin thickness. 

Medium Pen When selected, the lines of all new or selected objects will be set to a medium thickness. 

Thick Pen When selected, the lines of all new or selected objects will be set to a wide thickness. 
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16.3 Graphics Tools 

When creating or modifying a drawing, symbol, site plan, card template or alarm 

instruction, a number of drawing and graphics tools become available. 

The Drawing and Font toolbars can be moved by clicking and holding the mouse 

pointer over the top of the toolbar, and dragging the toolbar to a new location. 

Drawing Toolbar 

The Drawing toolbar allows you to create and modify many drawing symbols 

(circles, squares, etc.) and text objects. By default, the Drawing toolbar will appear 

on the right-hand side of the screen. The available drawing tools include: 
 

Command Description 

New Drawing Allows you to create a new drawing, which can be incorporated into a card template, symbol or 
plan. 

Open Drawing Allows you to open an existing drawing, which can then be either edited or incorporated into a 
card template, symbol or plan. 

Save Graphic Allows you to save changes to the graphic on which you are currently working. 

Print Graphic Allows you to print the current graphic. 

Cut Selection Deletes the selected text or graphic and places it on the clipboard 

Copy Selection Copies the selected text or graphic and places it on the clipboard 

Paste Selection Inserts a copy of the clipboard contents into the active graphic at the cursor’s current position 

Select Allows you to select objects in the active graphic 

Straight Line Draws a straight line 

Ellipse Draws an ellipse 

Arc Draws an arc 

Rectangle Draws a rectangle 

Polygon Draws a polygon 

Text Allows you to place text in the active graphic 

Zoom In Allows you to zoom in closer within the active graphic 

Zoom Out Allows you to zoom out within the active graphic 

Left Justify Left justifies the text within a text box 

Center Justify Center justifies the text within a text box 

Right Justify Right justifies the text within a text box 

Font Displays the Font dialog that allows you to change the font attributes 

Align Left Aligns the left edges of two or more selected objects in the graphic 

Align Right Aligns the right edges of two or more selected objects in the graphic 
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Command Description 

Align Top Aligns the top edges of two or more selected objects in the graphic 

Align Bottom Aligns the bottom edges of two or more selected objects in the graphic 

Align Center Aligns the centers of two or more selected objects in the graphic 

Import Image/AVI Allows you to import an image file or AVI 

Import Photo Allows you to insert a cardholder photo field into a card template 

Import Signature Allows you to import cardholder signatures into a card template 

Insert Database Field Allows you to insert a field from the Database into a card template 

Add location/Group Allows you to add a location or group to a site plan 

Crosshairs Displays the drawing crosshairs, which allow for more accurate drawing 

Add Action/Shortcut Adds a shortcut for a manual command to a site plan 

Grid Displays the drawing grid that allows for more accurate drawing and alignment 

Bar Code Allows you to add a Bar Code strip to a card template 

 

Text Toolbar 

The Text toolbar allows you to size, justify and style text that is to be added to a 

graphic. By default, the Text toolbar will appear along the top border of the window. 

The available text tools include: 
 

Command Description 

Font Allows you to select the font 

Font Size Allows you to select the font size 

Bold Allows you to apply a Bold style to the text 

Italics Allows you to apply an Italic style to the text 

Underline Allows you to apply an underline style to the text 

Colour Allows you to select a font color from a drop down list. (Only available for an Alarm Instruction) 

Left Justify Left justifies the text in a text box 

Center Justify Center justifies the text in a text box 
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16.4 Drawings 

You may need a graphic that is neither a symbol, plan or card template. In SiPass 

integrated such graphics, called drawings, can be saved and then later imported 

into symbols, plans and card templates. 

For example, by creating a drawing of a familiar layout that will be used in more 

than one site plan, you can create the graphic once as a drawing and then import it 

into every site plan that contains that layout. 

Creating a drawing 

1. Select New > Drawing from the File menu. 

2. Use the graphics tools provided to create your drawing. 

3. When finished, select Save As from the File menu. You will be prompted to 

supply a filename and location for the drawing file. 

4. Click Save. 

 

 

You may open more than one drawing at any given time. When you have more 

than one drawing open, you may copy and paste drawing and text objects from 

one drawing to another. 

Importing Graphics into Your Drawing 

SiPass allows you to import a wide variety of image formats (for example, 

AutoCAD/DXF) into your drawing. This allows you to create graphics using other 

applications, and then use them in SiPass integrated. 

 

 

The GIF file format is not supported by SiPass integrated as this is a proprietary 

image format. 
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16.5 Symbols 

A symbol is a graphic element used to represent the status of a system point, area, 

group or unit on a site plan. Symbols are drawn using the same graphical tools as 

those used for creating site plans, card templates, and drawings. The color of the 

symbol is set by the system to indicate its current state. 

SiPass integrated comes bundled with a number of built-in symbols that you can 

use. If you require symbols that are more representative or relevant to your site, 

you can create your own symbols. 

If a point, area, group or unit status does not have a symbol, the system will 

represent it with a “?” symbol on the site plan. 

SiPass integrated allows you to create a new symbol that can be used to represent 

the status of a point, area, group or unit in your site plan. You may create symbols 

using the graphics tools provided or import graphics from an external source or 

from an existing drawing created in SiPass integrated. 

16.5.1 Creating a symbol 

1. Select New, then Symbol from the File menu. 

2. Use the graphics tools provided to create your symbol. 

3. When finished, select Save As from the File menu. 

 You will be prompted to supply a filename and location for the drawing file. 

4. Click Save. 

 

 
NOTICE 

If you want the symbol to change color according to the point’s status, it must be 

filled with the standard RED fill color. 

 

16.5.2 Importing graphics to make your own symbol 

SiPass integrated allows you to import a wide variety of graphics when creating 

symbols. They allow you to create graphics in other applications or by using the 

drawing functions in SiPass integrated, and then to use them when creating or 

modifying a symbol. 
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16.6 Site Plans 

A site plan is a graphical representation or drawing of the secured area or site. It 

includes symbols that represent the current status of points, areas, groups and 

units. Each site plan is dynamically updated by the system as it monitors changes 

to points, areas and groups. 

The scale of plans is determined by your needs. You may have one plan for each 

floor of a building, or you may include only one section of the floor in each plan. 

You may also have an overview plan for the entire site that displays a small-scale 

version of the site. 

16.6.1 Creating a site plan 

SiPass integrated allows you create a graphical representation of part or your 

entire site, which can be used to monitor and control access. You may create 

drawing objects using the graphics tools provided or import graphics from an 

external source and then insert symbols to represent the status of various points, 

areas, groups and units contained at your site. 

1. Select New > Site Plan from the File menu. 

2. Use the graphics tools provided to create your site plan. 

3. When finished, select Save As from the File menu. 

4. Enter the name of the plan into the New Name field. 

5. Click OK. 

 

 

Site plans can also be imported. See next section. 

16.6.2 Importing graphics into your site plan 

SiPass integrated allows you to import images files, AVI files, AutoCAD/DXF 

images and drawings created in SiPass integrated into a site plan. This allows you 

to create graphics using other applications and then use them when creating or 

modifying a plan. 
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16.6.3 Adding System Components (Symbols) to Your Site Plan 

Symbols can be used on a site plan to monitor the status of points, areas, groups 

and units. You can configure a symbol on a site plan to change, as the component 

represented by that symbol changes. 

 Create the graphical symbols that you wish to use on your site plan. 

 Create an alarm class for the type of point, area, group or unit and specify the 

symbol to appear for each status in the Current Defined States list box. 

 Assign the alarm class to the points, areas, groups or units that will be 

represented by a symbol. 

1. Open or Create the site plan where the symbol is to be added. 

2. From the Edit menu, select Add Location/Group to Plan, from the Edit menu. A 

Paste icon will appear. 

3. Position the cursor over the site plan where you want to place the symbol and 

click the left mouse button. The Add Location/Group to Plan dialog will appear. 

4. You can choose the Point Details button to display an overview of the points 

configured at your site. 

5. Select the location type from the Type drop-down menu. Specify the name of 

the specific type for which a symbol will be added in the Name field. Brief 

configuration details regarding the selected element will appear at the bottom 

of the dialog. 

– Only those elements that have been assigned an alarm class will appear in 

the Name list. 

6. Choose OK 

7. To save changes to your site plan, select Save from the File menu. 

16.6.4 Adding Shortcuts to Your Site Plan 

Shortcuts can be used on a site plan to perform manual commands quickly. 

 Create the image (icon) to represent the shortcut on a site plan. 

1. Open or Create the site plan where the shortcut will be added. 

2. Select Add Action Shortcut from the File menu. 

3. The Paste icon will appear. 

4. Position the cursor over the site plan, where you wish to place the shortcut and 

click the left mouse button. 

5. The Edit Action Shortcut Details dialog will appear. 

6. Select the Action type. 

7. Complete the Options details. 

8. Enter a message into the Message field. 

9. This text will be sent to the Audit Trail when the shortcut is executed, and also 

displayed as help text when the mouse pointer is held over the shortcut icon on 

a site plan. 

10. Choose Browse in the Button Icon section of the dialog. 

11. Select the image you wish to appear as the trigger for the shortcut. 

12. Choose OK. 

 The shortcut will be created and the image selected will appear as a button on 

the site plan. 
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16.6.4.1 Shortcut Action Types 

The following table explains the available action types. 
 

Action type Description 

Manual Control Allows you to create a shortcut to a manual command. Once created, clicking on the icon that 
represents that shortcut will execute the manual command. 

Open Plan Allows you to create a shortcut that opens another site plan. 

Toggle State Allows you to create a shortcut to a toggle command, which allows you to specify both an on-
action and an off-action. 

CCTV Action Allows you to create a shortcut to a CCTV camera command, such as switching a camera on 
or off, or running a predefined sequence. 

DVR Action Allows you to create a shortcut to a DVR camera command, such as recording a live image or 
moving the camera to a fixed preset. 

 

16.6.4.2 Shortcut Actions 

The following table explains the available actions. 
 

Action Description 

Manual Command Select the point type by choosing the appropriate button in the Point Type section. 

● Select the command to be sent to the point, from the Commands drop-down menu. Additional fields 

may have to be filled in depending on the point type and the command chosen. 

● Select the Unit Name which controls the point to which you want to send the manual command, from 

the Unit Name drop-down menu. 

● Select the point group or single point to which you want to send the command, by selecting the Group 

Name (group) or Location (single) radio buttons, then selecting from the drop-down menu. 

● The Time Zone drop-down menu only applies to Unsecure commands. It specifies during which times 

this shortcut may be used to send an Unsecure (unlock or disable) command to a point or area. 

Open Plan Select from the Options section of the dialog the Plan you want to be opened when the 
shortcut is activated. 

Toggle State Perform the procedure for setting a Manual Command, described above. Do this for both the 
On-Action and Off-Action tabs. 

● The on-action will be executed when the shortcut icon is first clicked. The icon will then appear 

recessed on the site plan. Clicking on the shortcut again will execute the off-action and return the icon 

to its original state. 

DVR Action Select from the Command drop-down menu the command to be executed when the shortcut is 
clicked. 

● If you chose DVR Recording as the Command, enter the desired recording time into the Duration 

field. Valid times are between 1 and 600 seconds. 

CCTV Action Select from the Switcher drop-down menu the DVR Switcher connected to the camera that will 
perform the selected command. 

● Select from the Camera drop-down menu the Camera that will perform the selected command. 

● Select from the Presets drop-down menu which Preset will be executed when the shortcut is clicked. 
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16.6.5 Adding Counters and Timers to your Site Plan 

Counters and Timers can be added to your site plan. Many more uses exist for 

Counter/Timers with the assistance of ASP. Counters can be used on a site plan 

for monitoring how many people badge at a reader or how many people are in an 

anti-passback area as just some examples. While timers can be used to time how 

long someone is in the building or how long before the next badge at a reader as 

examples. 

Before you can add a Timer/Counter to your site plan, it first needs to be 

configured in ASP. See section Advanced Security Programming (ASP) for further 

information on configuring Counters/Timers in ASP. 

To add a Counter/Timer to your site plan: 

1. Open or create the site plan where the Counter/Timer will be added. 

2. From the buttons toolbar on the right-hand side, click the Add Counter/Timer 

Button. 

3. Click the area on the site plan that you want to create the Timer/Counter. The 

Add Counter/Timer to site plan dialog will appear. 

4. Choose a Type from the drop down list. This can be (Counter, Timer or APB 

Area Count.) 

5. Choose the Counter/Timer/APB area from the Name drop down list. 

 

 

If the name for the Timer/Counter is short, the default size of the counter/timer 

that appears on the site plan will be large enough to display the counter/Timer 

information. The object can be resized but if it is made too small then it is possible 

the counter/Timer value may not be displayed in entirety when the site plan is 

opened for monitoring. 

6. Selections for the general text appearance such as Font, text Color, 

Background Color and Vertical/Horizontal alignment can be configured under 

Text Edition. 

7. If it is a Timer that is being added, a format drop box will appear where you can 

select whether to display the timer in seconds, minutes and seconds etc. 

8. Click OK to add the Counter/Timer. 
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16.7 Alarm Instructions 

An alarm instruction is a procedure that outlines the steps to be taken when a 

particular alarm has been triggered. By creating alarm instructions, you ensure 

consistency and efficiency when dealing with alarm situations. 

SiPass integrated allows you to create an alarm instruction that can be a 

combination of written procedure and intuitive graphics. 

Creating an alarm instruction: 

1. Select New > Alarm Instruction from the File menu. 

2. Use the text tools provided to create your alarm instruction. 

3. When you have finished, select Save As from the File menu to save the alarm 

instruction. 

 

 

You have created and saved an alarm instruction, it can be incorporated into an 

alarm class definition that allows the instruction to be viewed when an alarm is 

activated. 
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16.8 Card Template Design and Encoding 

SiPass integrated incorporates an advanced card production suite that allows you 

to design, print, and issue customized access cards for any aspect of your site. 

The card design tools provided by SiPass integrated allow you to include 

watermark images, cardholder photographs, cardholder signatures, database 

information and text onto a single or double sided card template. 

To further enhance the card production capabilities of SiPass integrated an 

additional module can be added that allows a card to be encoded with a bar code, 

magnetic stripe or smart card. 

16.8.1 Creating a Card Template 

A Card Template is a user-created card design. This design is created using the 

same graphical tools as those used to draw symbols, site plans, and drawings in 

SiPass integrated. Card templates allow you to create multiple card designs, and 

use them for different cardholders throughout your site. You may design a template 

for both the front and reverse of a card. 

SiPass integrated allows you to incorporate cardholder photographs, signatures, 

database information, text, graphics, watermarks, and company logos onto a card 

template. A card saved to an employee record using a card template will be 

updated whenever the database field is changed. 

You may also insert a bar code or magnetic stripe into the card template that can 

be used to further enhance the access security at your site. All cards printed using 

this template will contain either a bar code or a magnetic stripe, and depending 

upon whether the template is single-sided or duplex may contain both. 

1. Select New > Card Template from the File menu. 

2. Configure the card template page setup, by selecting Card Template Page 

Setup from the File menu.  

3. Ensure that the correct printer is assigned in Print Setup for correct template 

size. 

4. Complete the card template page setup details: 

– Double Sided Card:  

When checked allows you to create a double-sided card template.  

– Page 1:  

Allows you to specify the front side of the employee card. 

– Page 2:  

Allows you to specify the reverse side of the card. 

5. Use the graphics and drawing tools provided by SiPass integrated to design 

your card template. 

6. When finished, Select Save As from the File menu. 

 The Card Template Name dialog will appear. 

7. Enter the name of the card template into the Enter Name field. Card template 

names cannot exceed 20 characters. 

8. Choose OK. 
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16.8.2 Adding a Cardholder Photograph to a Card Template 

The SiPass integrated graphics package allows you to create a field that displays 

the photograph of a cardholder on their access card. The employee’s photograph 

is captured using SiPass’ video imaging capabilities. 

1. Open or Create the card template to which cardholder photograph will be 

added. 

2. Select Import > Photo from the File menu. The cursor will change to a paste 

icon. 

3. Position the cursor over the card template, where you wish to place the photo 

box and click the left mouse button. A photo box will appear on the card 

template. 

4. Resize the photo box by selecting it and placing the mouse pointer over one of 

the corner handles. 

5. While holding down the left mouse button, drag the corner out until the desired 

size has been achieved. 

6. Click Save. 

 

 

Once you have placed the photo box on the card template, you can move it by 

placing the mouse pointer over the photo box, holding down the left mouse 

button, and dragging it to a new location. 
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16.8.3 Adding a Bar Code to a Card Template 

SiPass integrated allows you to add elements to a card template that display a bar 

code on an access card. 

 

 

Ensure that you are aware of the bar code format used at your site before adding 

a bar code to a card template. 

1. Open or Create the card template where the bar code will be added. 

2. Select the Bar Code icon from the drawing toolbar. The cursor will change from 

an arrow to a Bar Code. 

3. Position the cursor on the area of the template where you wish to place the Bar 

Code and click the left mouse button. The Bar Code Encoder dialog will 

appear. 

4. Select the bar code format to be used from the Select Format drop down list. 

See table below. 

5. Choose the OK button. 

6. Reposition, orient and size the Barcode frame to fit within the card template. 

7. Select Save from the File menu to save the template. 
 

Bar Code Format Description 

3 of 9 - Access This is an industry standard Bar Code containing automatically selected database fields. 

3 of 9 - Generic This is an industry standard Bar Code. Any cardholder custom field may be selected and 
encrypted with the standard 3 of 9 algorithm. 

Asco Encrypted Bar 
Code 

This is a proprietary Bar Code format and contains automatically selected database fields for 
encryption. These fields are unknown to the operator. 

Asco Facility Bar Code This is a proprietary Bar Code format that makes use of the site’s facility code, together with 
database fields, for encryption. This format is used on older sites, and may be used when 
software is upgraded. New installations should use Asco Encrypted Bar Code, which has higher 
security. 

 

  



 

 

Photo-ID and Graphics 

Card Template Design and Encoding 
16 

262 | 313  A6V101068156 

 

16.8.4 Adding a Magstripe to a Template 

A Magnetic Stripe object can be inserted on the reverse of an existing card 

template, to represent a Magnetic Stripe itself that is physically part of the card. 

 Ensure that the card printer that you intend using is Magstripe capable. 

 Ensure that you are aware of the exact magstripe format used at your site. 

1. Open or Create the card template into which the magnetic stripe will be added. 

2. From the Edit menu select Card Template Page Set Up then enable the Double 

Sided card checkbox 

3. Select the Magstripe icon on the drawing toolbar. Position the cursor over the 

template where you wish to place the Magnetic Stripe and click the mouse. 

4. Select the type of Magnetic Stripe from the Select Format drop-down list. 

– Asco Encrypted Magstripe:  

This is a proprietary Magnetic Stripe format and contains automatically 

selected database fields for encryption. These fields are unknown to the 

operator. 

– Custom Field:  

Allows a Custom Field to be selected for printing on a magstripe. 

 

 

The Magnetic Stripe frame will be placed at the default position on the reverse 

side of the card template. The Magnetic Stripe’s position is fixed. 

5. Select the Track to be encoded from the Track ID drop down box. 

6. Select the custom Field to be used for encoding from the Field drop down box. 

7. Click Save. 
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16.9 Image Verification 

SiPass integrated allows you to perform image verification on cardholders. This 

advanced functionality increases the security of your site, by allowing security 

operators to visually confirm the identity of personnel attempting access. 

Image verification can be configured to be mandatory at particular access points, 

requiring the guard to manually verify identity before allowing access. It can also be 

configured to allow access according to cardholder access privileges, but 

automatically take a snapshot of the cardholder to be displayed on a selected 

monitor. 

16.9.1 Configuring Image Verification at an Access Point 

Before you can use the Image Verification feature of SiPass integrated, you need 

to configure those access points at which image verification will apply. Image 

verification is configured through the Image Verification tab in the Components 

dialog. The steps required to do this are as follows: 

1. Choose Components from the System toolbar or menu. 

 The Components dialog will appear. 

2. Select the Server name in the components hierarchy. 

3. Select the ACC Controllers ethernet comms. 

4. Select the ACC to which the access point is connected. 

5. Select the FLN connection to which the device controlling the access point is 

connected. 

6. Select the door controller device connected to the access point. 

7. Select each Reader tab in turn and configure each individually. 

8. Select from the Operation Mode drop-down box the image verification mode 

that you want to apply to this access point. The available modes are detailed in 

the Available Modes table, at the end of this section. 

9. Enter a value into the Host Verify Timeout field. This is the length of time, in 

seconds, that the system will wait for an operator response after a card is 

badged. If the Allow Access check box is not ticked and the response times 

out, the card reader will reset and access may be attempted again. If the Allow 

Access check box is ticked and the response times out, the access will be 

granted. 

10. Select the Input/Output tab and select the time schedule during which image 

verification will be enabled, for each input and output point, from the Time 

Schedule drop-down box. The Time Schedule table at the end of this section 

details the effect a time schedule has on image verification. 

11. Select the Image Verification tab. 

12. Select the CCTV sequence to run when a cardholder presents their card at the 

access point, from the CCTV Sequence drop-down box for each reader. 

13. Select the monitor on which you want the selected sequence to be shown, from 

the Monitor drop-down box for each reader. 

14. Select an Alarm Class for the image verification access point, from the Alarm 

Class drop-down box for each reader. 

15. Select the Save Image Snapshot checkbox to save live images to disk when an 

access attempt is made at the point for each reader. 

16. Enter the snapshot delay in seconds into the Snapshot Delay field for each 

reader. This number represents the time taken for the camera to move from the 

start of the selected camera sequence to the ideal position for taking a 

snapshot of the cardholder. 

17. Choose Save. 
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Available Modes 
 

Access Mode Description 

Host Verification – 
Card only 

A card is required for access at this point; if a valid cardholder makes an access attempt, the 
Image Verification screen will be displayed on the SiPass GUI and a security operator will be 
prompted to allow or deny access. 

Host Verification – 
Card and PIN 

Both a card and a PIN code are required for access at this point; if an access attempt is made by 
a valid cardholder, the Image Verification screen will be displayed on the SiPass GUI and a 
security operator will be prompted to allow or deny access. 

View Only – Card only A card is required for access at this point; if a valid cardholder makes an access attempt, access 
will be determined by normal access privileges, but a CCTV snapshot of the access attempt will 
be taken and stored in the database. 

View Only – Card and 
PIN 

Both a card and a PIN code are required for access at this point; if an access attempt is made by 
a valid cardholder, access will be determined by normal access privileges, but a CCTV snapshot 
of the access attempt will be taken and stored in the database. 

 

Time Schedule 
 

Time Schedule Description 

Always (point 
unsecured) 

Image verification mode will always be enabled. 

Never (point secure) Image verification mode will always be disabled 

Office Hours (9-5) Image verification mode will be enabled between 9:00am and 5:00pm. 
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17 Video Imaging and Card Printing 
SiPass integrated allows you to capture live images using a video or digital camera 

and store these images with the record or a cardholder. You can also import 

images from over 32 different file types. Once the Video Imaging and Card Printing 

Module has been installed, each operator can configure the image settings to their 

own preferences. 

 

 

By using SiPass integrated to set the camera or video card properties, the 

settings will not be permanently recorded and will only be configured for the 

current session. It is recommended that you configure settings with the video 

capture card or digital camera’s own installation software. 

 

17.1 Configuring the video image settings 

 Ensure that at least one video capture card, or USB-compatible digital camera, 

and the appropriate software has been installed. 

1. Select Preferences from the Options menu. 

2. Choose the Imaging tab. 

 If your PC does not have a suitable camera or video capture card installed, 

an error dialog will be displayed. The following steps in the procedure are 

based upon a Logitech QuickCam digital camera. The screens displayed 

and the configurable settings contained may vary, depending upon the 

camera and video capture card installed and the driver being used. 

3. Choose the Video Source button. 

4. Configure the Video capture settings according to your preferences. 

 The Video Capture settings will normally deal with video capture source, 

picture quality (resolution, brightness) and the physical settings of the 

camera, like tilt. 

5. Choose the OK button. You will be returned to the Imaging tab of the System 
Preferences dialog. 

6. Choose the Video Format button. 

 The Video Format dialog will appear. The screens displayed and 

configurable settings contained may vary, depending upon the camera, 

video capture card installed and the driver being used. 

7. Configure the video format settings according to your preferences. 

 You will be returned to the Imaging tab. 

 

 

Video Overlay has been added to the GUI in anticipation of future SiPass 

integrated development. This feature may or may not be supported, and will 

depend upon your installed video capture card. Currently, the recommended card 

(Videum VO) does not support Video Overlay. The button will be disabled, 

indicating that your installed hardware is incompatible with this feature. 

The configuration of the video display and capture card is now complete. It may 

also be necessary to configure these options permananetly using the software 

installed when the video capture card was installed. 
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17.2 Card Printing 

The SiPass integrated Video Imaging and Card Printing module also provides the 

tools you need to print access cards on-site. SiPass integrated allows you to print a 

single card from a cardholder’s record, or print a group of cards based on 

selectable criteria. Card Printing is normally carried out as a function of the Video 

Imaging and Card Printing Module and requires a dedicated printer for the 

purpose. Card printing cannot be carried out on conventional printers. However, 

conventional printers can be used to proof card templates. 

Depending upon your requirements, cards can be printed as single-sided or 

double-sided (duplex). Many card printers are capable of duplex printing. 

 

 
NOTICE 

You should keep in mind that used printer ribbon contains negative images of 

data contained on cards. Ensure that you dispose of used printer ribbons 

according to your policy for handling confidential information. 

 

17.2.1 Configuring a Card Printer 

Configuring a card printer is a two-stage process. The printer must first be 

configured in SiPass integrated, and then through the Windows Printers and Faxes 

utility. 

For the purposes of this procedure, a Magna Class Card Printer has been used. 

This is currently a preferred type of card printer and is supported by SiPass 

integrated. 

Stage 1: Configuring a Card Printer 

 Refer to the printer manufacturer’s literature and release notes. You may need 

to upgrade the host PC with a Service Pack to ensure correct printer operation. 

1. From the File menu, select the Print Setup option. 

2. Choose the Card Printer tab. 

3. Select the brand of printer from the Printer Type drop-down list 

4. If you wish to nominate another card printer as the default, choose the Select 

Printer button to open the Print Setup dialog. 

5. Select the printer from the Name drop-down list. 

6. Set the Orientation to either Portrait or Landscape. 

 The card template used in the design of the cards will determine this 

setting. 

7. Choose the Properties button. 

8. Select the appropriate printer settings. 

9. When you are satisfied with the printer settings, choose the OK button. 

 You will be returned to the Print Setup dialog. 

10. Choose OK. 

 You will be returned to the Setup Global Printers dialog. 

11. Choose the Apply button. 
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Stage 2: Configuring a Card Printer 

1. Select Settings > Printers and Faxes from the Windows Start menu. 

2. Highlight the card printer icon, right click the mouse and then select the 

Properties option from the menu. 

3. Select the Advanced tab. 

4. Highlight the following options: 

– Highlight the Spool print documents so program finishes printing faster 

option. 

– Highlight the Start printing immediately option. 

 These settings are required to ensure that card printing can take place. 

 

 

Do not use the Print directly to the printer option. 

5. Select the Ports tab. 

6. Tick the Enable bi-directional support checkbox. 

7. Choose the OK button. 
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17.2.2 Batch Printing Card Filters 

The following table explains the available card filters for batch printing 
 

Filter Description 

Card Range This option allows you to select a range of cards based on specified card numbers. For 
example “12 - 56”, 10, 100 – 145”. 

Only These Workgroups This option allows you to select one or more workgroups to which cardholders belong. Simply 
select a single workgroup by clicking on it. To choose multiple workgroups hold down the 
CTRL key while selecting each workgroup. 

Card Template This option allows you to select a card template. All cardholders with the template associated 
with their database record will be included. 

Custom Field This allows you to select a custom field from a list of all defined custom fields in the system. 
Once selected, you will then be able to select a specific value associated with that custom 
field. All cardholders with a record that matches the selected custom field value will be 
included. 

Cards Last Printed This allows you to select cardholders based on the date and time their card was last printed, 
from the following conditions: 

–Before, On or before, After, or On or after 

Any cardholder whose card was printed in the selected range will be included, dependant 
upon the other criteria you have chosen. 

Filter on Card Printed 
State 

Allows you to select all cardholders that have or have not had their access card previously 
printed based on your selection. 

Cardholder Modified This allows you to select cardholders whose database record was changed based on the 
following conditions: 

–Before, On or before, After, or On or after 

Any cardholder whose record was changed within the selected range will be included, 
dependant upon the other criteria you have chosen. 

Filter on Employee 
Modified State Since Last 
Printed 

Allows you to select all cardholders whose database record has either been changed or 
remained unchanged since their card was last printed. 

Filter Out Void Cards Allows you to ignore all cardholders with a void status. 
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17.2.3 Batch Card Printing Monitor 

This section shows how to open and use the Batch Card Printing Monitor window. 

This window allows you to monitor the progress of print jobs, and to pause, start, 

abort, or resume a batch card print job. 

1. From the Data menu, select Batch Card Printing Monitor. The Batch Card 
Printing Monitor window will appear displaying the status of each batch card 

print job that has been generated. The following describe each column in the 

window: 

– Batch: Batch card printer number – auto generated based on date and 

time. 

– Status: paused, queuing (another currently printing in a queue of batch 

jobs), printing, aborted. 

– Progress: The number of cards that have been printed out of the total 

number. 

– Current: Card number that is currently being printed. 

– Printer: Printer to which the job will be sent. 

2. To start, pause, abort or resume card batch print jobs, right-click on the job you 

want to action. A menu will appear showing a list of options: Start, Pause, 

Resume, Abort. Select the action you want to perform on the print job. 

3. Close the Batch Card Printing Monitor window when you have finished.
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18 Advanced Security Programming (ASP) 
The Advanced Security Programming (ASP) functionality operates like a 

programming logic engine running in the controller. Presented through a user-

friendly interface, this feature gives operators the unique ability to construct their 

own logical activities using the ASP graphical user interface. With the help of the 

graphical designer, operators can now customize ‘Activities’ for multiple triggers, 

and resulting effects/changes. 

● ASP supports a variety of SiPass integrated entities like Access, Input and 

Output point, Access Events, Intrusion Areas, Anti-Passback areas, 

Workgroups, Floors, etc. 

● Virtual Components (Flags / Timers / Counters) can be incorporated into 

activities as Triggers and Effects. 

Representation of an Activity 

● ASP presents the logical relationship graphically, and they are referred to as 

‘Flows’. 

● Each Flow has a flexible structure and may contain multiple triggers, and 

effects. 

● Multiple Flows can be added to one ‘Activity’. 

● An activity is enabled or disabled by the Time Schedules configured to it. 

● The flows within an activity are executed from top to bottom. 

● ASP supports multiple activities. 

Note: ASP executes the activity ONLY when there is state change in the 

conditions. If the condition is true but the effect is also controlled by any other 

function like Time Schedule or Manual Control, the effect will NOT be overridden 

by ASP activity until there is state change in the conditions. 
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18.1 Overview of the ASP Designer 

In this section, you’ll find information regarding the user-friendly ASP designer. 

Data Grid, Menus and Toolbars 

The ASP menus and toolbars are context-sensitive. This means that they may 

change depending on the selection that has been made. The ASP -specific buttons 

and menu options are explained in the section The ASP Data-grid, Toolbar and 

Buttons [➙ 271]. 

The ASP Activity Design Workspace 

On creating a new activity, an ASP Activity Design Workspace is displayed on the 

right hand side. This workspace contains a few ASP elements by default. 

The workspace also contains a Toolbar and a Property Grid. 

● The Toolbar 

 The tools contained in the toolbar are explained in the table below. 
 

Tool Description 

Pointer This tool is used to select ASP objects on the workspace. 

Flow This tool is used to add a new flow above or below an existing flow. For 
details, refer the section Creating Multiple Flows within an Activity [➙ 280]. 

Trigger This tool is used to add a new Trigger object to an existing flow. For 
details, refer the section Configuring Multiple Trigger / Effect Activities [➙ 276]. 

Branch This tool is used to add a branch to an existing flow. For details, refer the 
section Configuring a Trigger Branch/s in a Flow [➙ 278]. 

Sequence This tool is used to add an effect to the existing flow. For details, refer the 
section Creating a Sequence of Effects [➙ 280] 

 

 

● The Property Grid 

 The property grid has the ability to display all the properties of the selected 

ASP activity, a flow, or individual objects. 

 Operators can configure various properties of the ASP activity and its individual 

objects on the Property Grid. 

18.2 The ASP Data-grid, Toolbar and Buttons 

The ASP Data-grid 

The Data-grid is a general navigation control used by ASP and the Virtual 

Components. It lists all the ASP activities that are saved. 

To display the data grid, click the ASP tree node Navigation pane. 

_Ref4E8540DF67D0A3D1BC3C61DC54F9EDFA
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ASP Data-grid Field Column Description 
 

Column Description 

Name This field displays the name of the activity, and is limited to 128 
characters. 

Unit This field displays the unit on which the activity resides. 

Time Schedule The Time Schedule controls whether the activity is running on the ACC 
or not. The default value of this field is Always (point unsecure). 

Description This field displays a short description of the ASP activity. 

 

How to Use the Data-Grid 

The data-grid can be used in the following manner: 

● To Find or Filter ASPactivities in the data-grid: 

◈ Click the Find button on the tool bar. Or, right-click and select Find from the 

context menu. 

● To Open ASPactivities from the data-grid: 

◈ Double-click the arrow adjacent to each of the listed activities. Or, right-click an 

activity and select Open from the context menu. 

● To Edit ASP activity parameters inline, within the data-grid: 

1. Double-click within a cell of an activity to highlight it. The parameters of this cell 

can now be edited inline by typing into it, or by making selections from drop-

boxes where available. 

2. Click the Save button on the tool bar to save the data-grid. 

● To Delete ASPactivities from the data-grid: 

1. Select the ASP activity to be deleted. 

2. Click the Delete button on the toolbar. Or, click Edit > Delete on the main 

menu. Or, right-click an activity and select Delete from the context menu. 

 

 

The Delete function can also be used to delete multiple activities that are selected 

together. To select multiple activities together, hold down the Shift key and click 

all the activities you want selected together. 

● To Group ASPactivities in the data-grid: 

1. Click the Group button on the task bar. 

 An area appears above the data grid. 

2. Drag and drop a grid column header to the new area that has appeared above 

the grid. 

 The ASP activities will be grouped based on the column head that was 

selected. 

● To Filter and Sort activities in the data-grid: 

◈ Click on the column headers of the data grid. 

 The activities are sorted based on the column header chosen. 



 

 

Advanced Security Programming (ASP) 

Activity Designer 
18 

A6V101068156  273 | 313 

 

18.3 Activity Designer 

The Activity Design work space is an area that is used to design and display an 

activity. There exists a flow within an activity. By default a single flow is present 

when a new activity is created. 

An Activity has an Activity Description field that is used to type the description of 

the activity. 

A flow consists of the following objects 

Trigger – To configure a Trigger, click the trigger box and set its various properties 

under the Properties Grid. 

Effect – To configure an Effect, click the effect box and set its various properties 

from the Properties Grid. 

The flow also contains the Start of flow and the End of flow which marks the 

beginning and the ending of the flow respectively. The arrows within the flow 

represent the nature of flow. There is a Flow Description field in Activity Designer 

workspace that can be used to type the description of the flow. 
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18.4 Configuring ASP activities 

This section explains the basic ASP Objects and Object Properties. It also explains 

the configurations required for creating various kinds of activities. 

18.4.1 Configuring a Single Trigger/Effect Activity 

This section details the steps required to configure a single effect activity in the 

ASP. 

 As a prerequisite, ensure that an ACC and a RIM device have been configured 

in the Components dialog. 

◈ Right-click Activities in the ASP navigation tree, and then select New Activity. 

 A new ASP workspace will be loaded. By default, a single Flow containing 

a Trigger and Effect object will be displayed here. 

Configuring a Flow and its Properties: 

1. Click on the ASP design workspace, outside the Flow displayed. 

 This action displays the ASP activity properties in the Properties grid. 

Please refer the SiPass integrated Reference Manual for details on 

property options. 

2. Specify a Time Schedule. The time schedule controls whether the activity is 

running on the ACC or not. 

3. In the cell adjacent to Description, enter a description of the Activity being 

configured. 

4. In the cell adjacent to Name, enter a name for the activity. This field is limited to 

128 characters. 

5. In the cell adjacent to Unit, select a unit on which this activity will run. 

Configuring a Trigger and its Properties: 

A Trigger represents a set of parameters that must be met as a result of an event, 

for a configured effect to be triggered. 

 The displayed Flow already contains a Trigger object 

◈ Click the trigger object and configure the trigger properties in the Properties 

section of this dialog. Please refer the SiPass integrated Reference Manual for 

details on property options. 

Configuring an Effect and its Properties: 

An Effect represents an action to the object 

 The displayed Flow already contains an Effect object. 

◈ Click the effect object and configure the effect properties in the Properties 

section of this dialog. Please refer the SiPass integrated Reference Manual for 

details on property options. 
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Saving an Activity 

1. After the Trigger and Effect object/s properties are configured, the ASP activity 

can now be saved. 

2. The ASP activity can be saved in two ways by clicking either Save Only or 

Save and Download. 

The Save Only button saves the activity to the SiPass database and does not send 

any data to ACC. 

The Save and Download button saves the activity to the SiPass database and also 

downloads data to the ACC. 

The progress dialog will be displayed with any one of the following messages 

(described in the table below) when the activity is being saved into SiPass 

integrated database and also sent to the ACC. The messages displayed are 

described in the table below: 
 

Message Description 

Saving and downloading activity This means the activity has been saved and sent to the 
ACC but yet no status has been received from the 
ACC. 

The server was unable to receive a response from the 
controller. The request times out 

This means there was no response from the ACC. This 
usually happens when the ACC is offline and cannot be 
contacted. 

Activity was saved successfully but no activity data was 
loaded in the ACC. 

This means the activity was saved in the SiPass 
database but data was not loaded in ACC. 

Activity saved waiting for download file This means the ACC received the initial activity 
configuration command and is waiting to receive the 
activity’s data. 

Download in progress This means the ACC has started receiving the activity’s 
data. 

Error occurred while downloading the activity This means the activity was not saved properly. 

Activity downloaded successfully validating contents This means that the ACC has received the activity and 
its contents and is validating the activity. 

Activity downloaded and validated successfully This means that the ACC has received and validated 
the activity. 

There was an error when validating the activity. The 
activity was not enabled or run. 

This means the activity’s data was not validated in the 
database. 

Activity not loaded This means that the activity data was not received. 

Initializing activity This means that the activity downloaded to the ACC 
and was validated successfully and is now being 
initialized successfully. 

Activity is currently disabled This means that the activity is not currently running on 
the ACC. 

Activity is enabled and running. This means the activity is currently running on the 
ACC. 

Activity saved successfully This means that the activity was saved in the SiPass 

integrated database. (applicable only for ‘Save Only’ 

command) 
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Further, this saved ASP activity will be displayed in the ASP data-grid. 

 

 

If Save Only is selected, the revision number of the activity will be incremented 

only in SiPass, whereas the ACC will still contain the old revision number. This 

revision number mismatch is notified to the user by appending a caption 

Download required along with the activity name. This caption can be viewed when 

the activity is opened after Save Only. The caption can also be viewed when the 

activity does not exist in ACC. 

If the activity is assigned to an offline unit then SiPass integrated cannot 

determine whether the activity requires downloading or not, so SiPass integrated 

appends the Unit Offline caption instead of Download required. 

18.4.2 Configuring Multiple Trigger / Effect Activities 

Configuring multiple triggers and trigger properties: 

 The displayed Flow will already contain a Trigger object. The operator can add 

to and modify event objects as described below: 

1. Drag and drop a Trigger object from the Toolbox onto a link in the flow activity. 

You can drop the trigger object on links that turn red when the object hovers 

above it. 

2. Configure the Trigger properties in the Properties section of this dialog. Please 

refer the SiPass integrated Reference Manual for details on property options. 

Configuring multiple effects and effect properties: 

 The displayed Flow already contains an Effect object. The operator can add to 

and modify Effect objects as described below: 

1. Drag and drop a Sequence object from the Toolbox onto a link in the flow 

activity. You can drop the Sequence object on links that turn red when the 

object hovers above it. 

2. Configure the Sequence properties in the Properties section of this dialog. 

Please refer the SiPass integrated Reference Manual for details on property 

options. 

 

 

You can delete a Trigger or Effect object by selecting the objecting and pressing 

Delete. Or, by right-clicking the object, and selecting Delete from the context 

menu. You can also move the location of the existing effect by drag and drop to 

another available link (available links will appear red on mouse-over.) 
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18.4.3 Configuring Virtual Flags as Triggers 

This section introduces the functionality that allows Virtual Flags to be configured 

as Triggers within an ASP activity. The configuration required for this functionality 

is explained below. 

 Ensure that an appropriate Flag is configured within the Virtual Components. 

For more information on Virtual Flags, please refer the section Flags [➙ 286] of 

this manual. 

1. Create a new ASP activity, or open an existing activity. 

2. Select the Trigger object that you want to configure as a Flag Trigger. 

3. In the Property grid, click the Category drop down list. 

4. Select Flag from this list. 

5. Select the ACC Unit where the flag belongs to, from the Unit drop down list. If 

the ACC Unit is not selected all the flags configured in the system will be 

displayed in the next step. 

6. Select the Location of the flag by clicking the … button and select the flag from 

the pop-up window. 

7. Select the property for the flag from the Property download field. 

8. Configure the Operations field. 

 This specifies whether this Trigger is for a Trigger change or an Effect 

change. 

9. Set the Next State field. 

10. Click Save. 

18.4.4 Configuring Virtual Flags as Effects 

This section explains the functionality that allows Virtual Flags to be configured as 

Effects in a ASP activity. The configuration required for this functionality is 

explained below. 

 Ensure that an appropriate Flag is configured within the Virtual Components. 

For more information on Virtual Flags, please refer the section Flags [➙ 286] of 

this manual. 

1. Create new ASP activity or open an existing activity. 

2. Select the Effect object that you want to configure as a Flag Effect. 

3. In the property grid, click the Category drop down list. 

4. Select Flag from this list. 

5. Select the ACC unit where the flag belongs, from the Unit drop down list. If the 

ACC unit is not selected, all the flags configured in the system will be displayed 

in the next step. 

6. Select the flag for this activity by clicking the … button of the Location field and 

select the flag from the pop-up window. 

7. Select the property for the flag from the Property drop down list. 

8. Configure the Condition True Value field to specify the state of the flag when 

the event conditions are met. 

9. Configure the Condition False Value field to specify the state of the flag when 

the event conditions are NOT met. This is an optional field. 

10. Click Save. 
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18.4.5 Configuring a Trigger Branch/s in a Flow 

ASP allows the user to create trigger branches in a flow activity. This section 

details the steps required to create a branch/s in a flow. 

 To create a branch, the flow activity must have at least one Trigger and one 

Effect object. 

1. Drag the Branch object from the toolbox, and drop it on the link where the 

branch should begin. You can drop the Branch object only on links that turn red 

when the object hovers over it. 

 The Start-Point of the Branch will appear at the dropped point on the line. 

2. Next, specify the End-Point of the Branch by clicking on the link where the 

branch should end. You can place the End-Point only on links that turn red 

when the object hovers over it. 

 The Branch has now been created in the flow. 

 

 

If the end-point is not specified by clicking on a valid location, the branch will 

disappear. 

Trigger AND/OR Logical Operations 

1. When placing multiple Triggers side by side on a single branch, the Trigger 

result for that branch is calculated by applying ‘AND’ logical operation for every 

trigger. In other words, the Effects at the End-Point as the first branch or the 

second branch will only be executed if all the Triggers are true. 

2. If a new branch created is leading to the same End-Point as the first branch, 

the Effects will be executed if either the Trigger result in the first branch or the 

second branch are true. This is because the Trigger result in the first branch is 

OR’d with the Trigger result in the second branch, leading to the final Trigger 

result to determine whether the Effects will be executed. 

18.4.5.1 Creating a Nested Branch 

Nested Branches can be configured by creating a branch that contains or nests 

another branch. 

18.4.5.2 Joining Branch Endpoints 

Operators can choose to merge different branches within a workflow. To do this, 

simply drag and drop the Start-Point of one branch next to the Start-Point of 

another branch. The start point of the dropped branch will merge with the existing 

start-point. The same can be done with the End of branch. 

 

 

Start and End points of a branch can be moved: 

- Drag & drop the Start or End Point of the object onto an available red link 

- Delete existing links to or from Start/End Point, and specify the new location by 

pointing to an available red link 
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18.4.5.3 Creating Parallel Branches 

Parallel Branches in a ASP flow use the same Start-Point and End-Point. They can 

be created in the following manner: 

1. Created a complete branch (containing a start-point and end-point) in a flow. 

2. Drag and drop another Branch object onto the start-point of the flow. 

3. Click the link next to the existing end-point to end the branch. 

 A Parallel Branch that shares the start and end-point of the first branch has 

been created. 

It is possible to create multiple parallel branches in the same manner. 

18.4.5.4 Disjoining Branch Ends 

Operators can diverse a parallel branch by deleting a link to an existing end-point, 

and creating a new end-point on a different link. This can be done in the following 

manner: 

1. Identify the parallel branch that you wish to diverse . 

2. Click the end-point link of this branch and press Delete. 

3. Next, click on a link where you wish to place the new end-point for the branch. 

You can place the end-point only on links that turn red on mouse-over. 

 A Branch Diverse will be created. 

18.4.5.5 Deleting a Branch 

A Branch can be removed or deleted by deleting the start-point of the branch. 

1. Select the start-point of a branch. 

2. Press Delete. 

 The entire branch will be deleted from the flow. 

 

 

Important: Please note that if multiple branches share the same start-point, all 

these branches will be deleted when the start-point is deleted. 
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18.4.6 Creating a Sequence of Effects 

If there are multiple effects to be configured, this can be done by creating a 

Sequence. The Sequence tool adds an effect to the flow by default. 

This section explains how this can be done. 

1. Create a new flow, or open an existing one within an activity. 

2. Click and drag the Sequence tool from the Toolbox. 

3. Drop the Sequence tool onto a link before an Effect object. The link where the 

tool can be dropped will be highlighted in red on mouse-over with the 

Sequence tool. 

 This will create a new Sequence with a new effect object being created, with a 

new node, below the existing effect. 

To delete a Sequence object 

◈ Right-click a sequence object, and select Delete from the context menu. Or, 

select a sequence object and press Delete. 

 The sequence object will be deleted. 

 

 
NOTICE 

When multiple branches share the same sequence node, all these branches will 

be deleted when the sequence object is deleted. 

Alternatively, when the last effect of the sequence node is deleted, the sequence 

object will also be automatically deleted. 

 

18.4.7 Creating Multiple Flows within an Activity 

An operator can configure a single activity with multiple flows within it. This section 

explains the steps required to do this. 

1. Locate the Flow object in the adjacent toolbox. 

2. As you drag it to the ASP workspace, a green plus sign (+) will appear above, 

below and between the existing flow. Drop it on the plus sign above or below 

the existing flow depending on where you it to be placed. 

3. Proceed to configure the Trigger and Effect object properties within the flow as 

explained in the section Configuring a Single Activity Flow. 

Creating Duplicate Flows 

A Flow that is already present in the activity can be duplicated by using the 

Duplicate Flow button. To duplicate a flow: 

Select the flow to be duplicated and press the Duplicate Flow button. Or, right-click 

the flow and select Duplicate Flow. 
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18.4.7.1 Reordering / Deleting Flows 

Re-ordering Flows in an Activity 

To reorder flows, select, drag and drop them on the green plus signs that will 

appear above and below the other unselected flows on the workspace. 

Deleting a Flow 

◈ Select the flow to be deleted and press the Delete button. Or, right-click the 

flow and select Delete. 

 

 

Note that the last remaining flow on the ASP workspace cannot be deleted. 

18.4.8 Configuring an Alternative Effect for an Activity 

This section explains the ASP functionality that allows operators to configure an 

Alternative Effect when Event conditions have NOT been met. 

1. Create a new ASP activity, or open an existing activity. 

2. Configure the properties of the Trigger object. 

3. Click the Trigger object. 

4. Configure the Category and Controller fields for this effect object within the 

property grid. 

5. Click the drop down list of the Condition True Value field. 

 This configures the effect that is to be produced when any branch of the 

triggers’ condition is met. 

6. Click the drop down list of the Condition False Value field. 

 This configures the alternative effect that is to be produced when no branch 

of triggers’ condition is met. 

7. Click Save. 

 

 
NOTICE 

Alternative effect is not supported in the following cases: 

● When an event is configured as a trigger in the flow. 

● When certain types of effects such as Execute only is configured in the flow. 
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18.4.9 Stateless Effects 

Stateless effect and Stateful effect differs in the following way: 

1. Repeated execution of the same Stateless effect produces visible outcome for 

each execution 

2. Repeated execution of the same Stateful effect produces visible outcome only 

for the first execution 

Event Driven Flow 

Event driven flow starts with an event or a combination of events and may have 

zero or more conditions and one or more effects. Event driven flow is executed 

when a matching event occurs. 

State Driven Flow 

State driven flow starts with a condition or a combination of conditions and does 

not contain events and one or more effects. State driven flow is executed 

whenever any of conditions in the flow changes its state. State driven flow can also 

be in a mixed flow state that starts with an OR-combination of an event and 

condition. 

 

 

Event driven flow does not execute if the condition has changed but event did not 

occur. 

Configuring Trigger with Stateless Effect 

◈ While configuring a trigger when there is an existing Stateless Effect in the 

flow, under the Type property only Event type is visible as the Condition type is 

invalid. 

 

 

When a Condition Trigger co-exists with Stateless effect (eg: adding a new 

branch or deleting an event trigger) an error icon appears in the property grid of 

stateless effect to indicate trigger is not compatible with stateless effect. The 

saving process is interrupted with an error message box. 
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18.5 Creating Copies of ASP Activities 

This explains the Copy ASP functionality that allows operators to use an existing 

activity as template to create a new activity. 

The configuration required for this is explained below: 

1. Navigate to the ASP data-grid. For more information, please refer the section 

The ASP Data-grid, Toolbar and Buttons [➙ 271]. 

2. Select an ASP activity to be copied. 

3. Right-click and select Copy Activity from the context-menu. Alternatively, click 

File > Copy Activity from the File menu. 

 The ASP designer will now display a Copy of the selected activity in the 

ASP designer, leaving all Events and Effect object properties unchanged. 

4. Enter a unique name for this activity in the Name field of the Properties grid. 

Please refer the SiPass integrated Reference Manual for details on property 

options. 

 

 

By default, the Time Schedule field of the Properties grid is set to Never  

(point always secure). This can be modified as required. 

5. Click the Location Manager to change the locations configured in the activity. 

6. Click Save to save the activity. 
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18.6 Location Management 

The Location Management functionality of ASP allows users to locate all triggers 

and effects that share the same location and optionally define a new location. This 

functionality becomes available in the toolbar when any activity is opened and 

displayed in the ASP workspace. 

1. Open an existing ASP activity. 

2. Click the Location Management button on the toolbar. 

3. This action displays the Location Management dialog. A description of the 

fields of this dialog is provided in the table below. 
 

Field Name Description 

Type This field lists of the types of various points 
that have been configured in the activity. 

Old Location This field displays the previous location of 
the chosen point. 

New Location This field displays the new location of the 
chosen point. 

 

Table 4: Field Property Description 

18.6.1 Locating Points that share Common Locations 

To locate points that share common locations: 

◈ Select any row on the Location Management dialog. 

 All the triggers and effects that share the same location as the one selected will 

be highlighted in red on the ASP activity workspace. 

18.6.2 Modifying Point Locations in Location Management 

To modify point locations using Location Management: 

1. Open the Location Management dialog. 

2. Double-click the point that requires a location change. 

 This action displays an address picker dialog that lists all the available 

locations that can be newly configured to the point. 

3. Double-click on a location in the list to configure it as the new location for the 

point. 

 The Location Management dialog will now display the new location in the 

New Location field. The previous location that was configured is displayed 

in the Old location field. 

4. Click OK. 

 All the location changes will be applied to the respective triggers / events. 
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18.7 ASP Partitioning 

An Advanced Security Programming System Function is available in the Operator 
Group dialog. 

Operators can set three types of operator permissions for this system function: 

1. [c] create 

2. [e] edit 

3. [v] view 

The details of the privileges available for each operator permission is explained 

below. 

[c] create Operator Permission Privileges 

If operators have [c] privileges assigned, they are granted full access to the 

Advanced Security Programming feature. 

[e] edit Operator Permission Privileges 

If the operators have [e] privileges assigned, the following permissions and 

restrictions apply: 

● The operator will not be able to create or delete Activities, Timers, Counters or 

Flags. 

● The operator will not be able to create Copies of activities. 

● The operator will be allowed to change Trigger or Effect property values in the 

PropertyGrid of the ASP workspace. 

● The operator will not be able to edit entities in the activity layout designer; e.g., 

deleting existing events/effects, addition of new events/effects, addition of new 

flows, etc. will not be possible. 

[v] view Operator Permission Privileges 

If the operators have [v] privileges assigned, the following restrictions apply: 

● The operator will not be able to save Activities, Counters, Timers or Flags. 

● The operator will not be able to edit the Trigger/Effect property values in the 

PropertyGrid of the ASP workspace. 

 

 

While the above ‘Advanced Security Programming’ system functions can define 

operator permissions on all Activities, Counters, Timers and Flags. Individual 

create/edit/view partitioning of these objects can be achieved through the use of 

Component Groups assignment. Operators should have permissions for 

Component Group(s) containing the necessary Activities, Counters, Timers and 

Flags, in order to use them. For more information refer the SiPass integrated User 

Manual. If there is a difference in the privilege level between the system function 

and the Component Group assignment, the lower privilege will apply. 
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18.8 Virtual Components 

This chapter details various aspects about three main Virtual Components: 

1. Flags 

2. Counters and 

3. Timers 

To open a new Flag / Counter / Timer dialog: 

1. In the ASP tree menu, navigate to Virtual Components > Flags or Counter or 

Timer. 

2. Right-click Flags or Counter or Timer, and select New Flag or New Counter or 

New Timer. 

 A new dialog for the respective virtual component will be displayed. 

OR 

1. Click the New button on the toolbar. 

2. Make the required selection of a virtual component from the dialog that 

appears. 

18.8.1 Flags 

A Flag can behave as a virtual digital point. Flags can be linked to other 

functionalities like ASP in SiPass integrated. 

The section that follows provides the steps required to configure a flag. 
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18.8.1.1 Configuring a New Flag 

This section explains the steps required to configure a new virtual flag. 

1. Open a new flag dialog (Refer the section Virtual Components [➙ 286] for 

more information.) 

2. Enter a name for the Flag in the Name field. 

3. Select an option from the Default Value drop down list. 

4. Select an option from the Message Priority drop down list. 

5. Select a Unit. 

6. Select an Alarm Class. 

7. Click OK. 

 All saved flags can be viewed by clicking the Flags item in the Navigation panel 

of ASP designer. 

Field Properties of Virtual Flag 
 

Field Name Field Property 

Name This field is limited to 128 characters. 

Default Value This field displays the initial value of the flag, as well as the value it 
is set to when it is sent a Reset command. 

Message Priority This field specifies whether flag event information is sent to SiPass 
integrated. 

Unit This field specifies the unit on which the flag resides. 

Alarm Class This field allows the operator to specify an alarm class. 

 

18.8.2 Counters 

The Counter Functionality of Advanced Security Programming enables the 

operator to configure a program that counts / stores and displays the number of 

times a particular event or process has occurred. The counter value can either be 

incremented or decremented during ASP activity execution. Counters can be linked 

to other functionalities like ASP in SiPass integrated. 

The section that follows provides the steps required to configure a counter. 

  



 

 

Advanced Security Programming (ASP) 

Virtual Components 
18 

288 | 313  A6V101068156 

 

18.8.2.1 Configuring a New Counter 

This section explains the steps required to configure a new virtual counter 

1. Open a New Counter dialog (Refer the section Virtual Components [➙ 286] for 

more information). 

2. Enter a name for the counter in the Name field. 

3. Select an option from the Default Value drop down list. 

4. Select an option from the Message Priority drop down list. 

5. Select a Unit. 

6. Click OK. 

 All saved counters can be viewed by clicking the Counters item in the 

Navigation panel of ASP Designer. 

Field Properties of Virtual Counters 
 

Field Name Field Property 

Name This field is limited to 128 characters. 

Default Value This field displays the initial value of the 
counter. 

Preset Value When the value set in this field is reached, 
the counter sends an event. 

Max Value This field displays the value beyond which 
the counter cannot proceed further. 

Count Mode This field specifies 
the behavior the 
counter should 
produce when the 
max value is 
reached. 

Wrap Around - The 
timer value changes 
to 0. 

End Limit – The timer 
value remains at the 
max value. 

Audit Trail Reporting This field specifies 
whether counter 
event information is 
sent to SiPass 
integrated. 

No Audit Trail 

Report to Audit Trail 

Unit This field specifies the unit on which the 
counter resides. 
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18.8.3 Timers 

Timers can be linked to other functionalities like ASP in SiPass integrated. The 

section that follows provides the steps required to o configure a timer. 

18.8.3.1 Configuring a New Timer 

This section explains the steps required to configure a new virtual timer. 

1. Open a New Timer dialog (Refer the section Virtual Components [➙ 286] for 

more information). 

2. Enter a name for the timer in the Name field. 

3. Configure a Period (sec) for the timer. 

4. Select a Timer Mode. 

5. Select an option from the Message Priority field. 

6. Select a Unit. 

7. Click OK. 

 All saved timers can be viewed by clicking the Timers item in the Navigation 

panel of ASP Designer. 

Field Properties of Virtual Timers 
 

Field Name Field Property 

Name This field is limited to 128 characters. 

Period (sec) This field displays the time period (in seconds) that the timer will count 
up to. It is limited to 2,147,483.6 seconds. 

Timer Mode This field 
specifies the 
behavior of the 
timer. 

On-Delay Timer - The timer value increases when the 
timer is enabled, but disabling the timer causes the 
timer value to return to 0. The timer value stops 
increasing when it reaches the Period value. 

Retentive On-Delay Timer - The timer value begins 
increasing when the timer is enables. When the timer 
is disabled the timer value is retained, and proceeds 
to increase when the timer is enabled. The timer 
value stops increasing when it reaches the Period 
value. 

Periodic Timer – When the value of the enabled timer 
reaches the Period value, it automatically begins to 
increase again, beginning at 0. Disabling the timer 
causes the timer value to return to 0. 

Message 
Priority 

This field specifies whether timer event information is sent to SiPass 
integrated. 

Unit This field specifies the unit on which the timer resides. 
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18.8.4 Editing Virtual Components 

There are two ways to edit configured virtual components: 

● By clicking the required component (Flags / Counters / Timers) under the 

Virtual Components tree hierarchy. 

● The configured virtual component/s will appear in a data grid, which can be 

edited by clicking on the required cells, and saving changes. 

● Alternatively, select a specific virtual component in the data grid, and click 

Open on the ASP Designer main menu. A dialog for the specific virtual 

component will be displayed, which can then be edited and saved. 

 

 

If changes made to a virtual component dialog are not saved, the respective 

dialog will indicate this with an asterisk (*) symbol in the dialog’s title. 

Multiple rows of a data grid can be selected and deleted by clicking the Delete 

button on the main menu. This action will not be possible if one of the 

components is already part of an activity. 

18.8.5 Runtime Mode Support for Virtual Components 

The virtual component data grid views can be operated in two modes: Design 

mode and Runtime mode. 

1. Design mode is used by the operator to configure the virtual components. This 

is the initial mode whenever the data grid is first opened. 

2. Runtime mode is used by the operator to monitor and edit the runtime value of 

virtual components. While in this mode, changes can only be made to the 

runtime value. The virtual component cannot be deleted, and its other 

properties cannot be changed. 

After opening the virtual components in the data-grid view, click the Mode button to 

switch between design mode and runtime mode. 

If the runtime mode us selected, a runtime Criteria dialog appears which displays 

all the ACCs present in SiPass. The operator can select any ACC before entering 

the runtime mode, the intention being to filter the virtual components the operator 

wants to display in runtime mode. Only the virtual components that exist under the 

selected ACCs are listed in the resulting data grid view. 

 

 

When a controller is initialized, SiPass integrated will re-download all virtual 

components for that controller. This means all virtual components residing on that 

controller are reset to their default value, potentially affecting ASP activities that 

include these virtual components. 

 

 
NOTICE 

Offline ACC’s appear greyed-out and disabled in the runtime Criteria dialog. 
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18.9 Programmable Authorization for an access point 

through an ASP Activity 

Programmable Authorization is a type of access mode that grants/denies access to 

an access point through an ASP activity. There are two types of Programmable 

Authorization modes: 

1. Programmable Authorization-Card only 

2. Programmable Authorization-Card and PIN 

When a card is badged at an access point in any of the above modes, the following 

steps occur: 

1. Standard card access validation is performed. 

2. If the cardholder has access privilege to the door, then the system generates a 

‘Programmable Authorization’ event that can be used to trigger ASP activity. 

3. The outcome of the access attempt will depend on which ASP effect is 

executed: 

– Access at the door will be granted only when ASP effect category = Access 

Point and Programmable Authorization Granted Property = True is 

executed. 

– Access at the door will be denied when ASP Effect Category = ‘Access 

Point’ and Programmable Authorization Granted Property = ‘False’ is 

executed. 

– Access at the door will also be denied in the case when the ASP effect 

setting Programmable Authorization Granted Property of ‘True’ or ‘False’ is 

NOT executed during the Programmable Authorization Timeout period 

(Configured in the Components dialog). 

18.9.1 Programmable Host Authorization Criteria Configuration 

You can create new Host Authorization Criteria or edit/delete existing criteria. 

To Create New Host Authorization Criteria: 

1. In the left-hand Navigation pane right-click on Host Authorization Criteria under 

the Advanced Security Programming tree and select New Host Authorization 

Criteria. The New Host Authorization Criteria Dialog will appear. 

2. Enter a name for the criteria into the Name field. 

3. Enter a description for the criteria into the Description Field 

4. Click Click here to add filter criterion. Here you can add and remove filter 

criteria and when done click OK. 

 

 

If the selected filter criteria column is of Date Type it is possible to: 

Compare it to a configured date; or 

Compare it to number of days from the Current Date. 

Current Date will appear as the last operator command available for selection. If 

Current Date is selected, the DateTime field will be replaced by a textbox in which 

number of days can be entered. The number can be positive or negative. If a digit 

value of 1 is entered for example, this would equal to Current Date +1 
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18.9.2 Configuring Programmable Authorization 

Perform the following steps to configure Programmable Authorization: 

1. In the Components dialog, Set the Reader’s operation mode to one of the 

following modes: 

Programmable Authorization – Card Only 

Programmable Authorization – Card and Pin 

2. Create Host Authorization Criteria, if required. 

3. Create an ASP Activities that contain Programmable Authorization Triggers 

and Effects (See Tables Below) and optional additional triggers, conditions and 

effects. 

The Programmable Authorization Event Triggers are listed in the following table: 
 

Type Category Host Criteria Event 
Category 

Event 
Reason 

Comment 

Event Programmable 
Authorization 
Access Event 

<None> Programmable 
Authorization 
Status 

Requeste
d 

Triggered when valid 
card is presented at the 
door. 

Event Programmable 
Authorization 
Access Event 

Name of 
Host 
Authorizatio
n Criteria 

Programmable 
Authorization 
Status 

Host 
Criteria 
Passed 

Triggered when valid 
card is presented at 
door and Host 
Authorization Criteria 
has Passed. 

Event Programmable 
Authorization 
Access Event 

Name of 
Host 
Authorizatio
n Criteria 

Programmable 
Authorization 
Status 

Host 
Criteria 
Failed 

Triggered when valid 
card is presented at 
door and Host 
Authorization Criteria 
has Failed. 

Event Programmable 
Authorization 
Access Event 

Name of 
Host 
Authorizatio
n Criteria 

Programmable 
Authorization 
Status 

Host 
Timeout 

Triggered when valid 
card is presented at the 
door and Host failed to 
respond within the 
configured Timeout 
Period. 

 

 

Host Authorization Timeouts are expected only in case Host is offline. Host 

Authorization Timeouts may also occur time to time in case of heavy network 

traffic – try increasing “Programmable Authorization Timeout” configured in the 

components dialog if Timeouts occur regularly. 

 

Maximum of 255 different Host Authorization Criteria can be configured with any 

single access point. 

The Programmable Authorization Event Effects are listed in the following table: 
 

Category Property Value Comment 

Access Point Programmable 
Authorization Granted 

True Results in Programmable 
Authorization Access 
Granted. 

Access Point Programmable 
Authorization Granted 

False Results in Programmable 
Authorization Access 
Denied. 
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19 Custom Page Design 
Some sites require minimal information concerning their cardholders, while others 

require very detailed information. SiPass integrated allows you customize 

cardholder records to suit your requirements. 

This can be done in two ways: 

● By customizing Predefined Pages 

● By adding customized pages to the Cardholder or Visitor dialog called 

CUSTOM PAGES 

Access to this function is normally for use by database administrators, and is 

controlled by the access privileges of Operator Groups. 

Pre-existing page titles in the Cardholder and Visitor dialogs are listed in the table 

below: 
 

Cardholder Dialog Visitor Dialog 

Definition Visitor Definition 

Advanced Advanced 

Personal Personal 

Vehicle Visitor Management 

Imaging Imaging 

Tracking Visitor Details 

Control  

 

 

 

 

The custom fields of the Visitor Details page of the Visitor dialog can be edited. 

Further, the Siemens Corporate Card custom page will be visible only if you have 

the Siemens Corporate Card license option selected. 
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19.1 Creating Custom Pages 

The sections that follow describe how to add / delete Custom Pages, and various 

other aspects of defining the availability and views of Custom Pages. 

19.1.1 Adding / Deleting a Custom Page 

◈ Select Custom Page Design from the System menu. 

 The Custom Page Designer dialog is displayed. 

◈ Click the New Page button at the bottom of the dialog to add a new Custom 

Page. 

 A New Tab Page is added to the right of the last tab on the dialog. You can 

design the custom page here. 

 

 

Note: The functions of the Delete button will take affect only after using the Save 

button to save any changes made the Custom Page Designer dialog. 

 

19.1.1.1 To Title a Custom Page 

1. Add a new Custom Page. 

2. From the Properties panel, select the cell adjacent to Label (under 

Appearance). 

3. Click this cell, and type in a desired title for the new custom page. 

 On clicking outside this cell, the tab of the new custom page will be re-titled 

with the new label text. 

19.1.1.2 Choosing Between the 'Cardholder' and 'Visitor' Custom 

Page View 

The operator can coose to view / edit the custom pages of either the Cardholder or 

Visitor dialog, or both. This can be done using the following steps: 

1. Click the Custom Page View button on top left corner of the Custom Page 
Designer dialog. 

2. From the drop-down menu that appears, select All Pages to view all the custom 

pages. 

3. From the drop-down menu that appears, select Cardholder to view custom 

pages of the Cardholder dialog. 

4. Select Visitor to view custom pages of the Visitor dialog. 

5. Select None to view pages that have not been assigned. 

19.1.1.3 Refreshing a Custom Page 

Click the Refresh button on the Custom Page Designer dialog to refresh the 

current view of the screen. 

This action will refresh the page and remove any information that was not saved. 

Any updates that were made by other operators will also be displayed on refresh. 
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19.1.1.4 Arranging the Order of Custom Pages 

If more than one custom page is added, the user has the option of rearranging the 

order of the custom pages in any of the following ways: 

● Right-click on the custom page, and select the Move Page Left or Move Page 

Right options, as required; or 

● Select Edit > Move > Move Page Left / Move Page Right; or 

● From the bottom of the right hand panel, select the Move Page Left or Move 

Page Right options. 

19.2 Designing Pages 

SiPass integrated is equipped with a number of handy tools and custom fields that 

allow you to control the look of your Cardholder / Visitor dialog. This can be done 

by: 

● Designing Custom Pages, OR 

● Customizing the Predefined Page design 

The sections that follow discuss these options listed above. 

19.2.1 Custom Fields 

The Custom Fields available in the Toolbox allow the user to control the design of 

Custom or Predefined Pages for both the Cardholder and Visitor dialogs. They can 

also customize the appearance of the page by altering the position and sizes of the 

chosen custom fields. 

A brief description of the Custom Fields and Tools available in the Toolbox are 

contained in the following table: 
 

Tool Name Tool Function Description 

Pointer This tool can be used to select a custom field 
from the Toolbox, and place it on desired 
location on a page. 

While the other way of applying custom fields on 
to a page is by selecting the field and dragging it 
onto the page; the user can also apply a custom 
field in the following way: 

1. Select the Pointer tool with a mouse-click 

2. Select a desired custom field from the toolbox 

with a mouse-click 

3. Hover over a page to choose a location for the 

selected custom field (hovering displays a + 

pointer) 

4.  Mouse-click on a desired location to display the 

selected custom field. 

Label This custom field can be used to add a ‘Labels’ 
on a page. 

Select this custom field and apply it onto the 
page. For details on how to modify the sub-
properties relevant to this custom field, (L), refer 
the table in the section Custom Field Properties 

[➙ 300]. 

Textbox This custom field can be used to add a Text box 
to a page. 

can be used to add text or numeric data 

Formats and Data Types can be specified. 

Select this custom field and apply it onto the 
page. For details on how to modify the sub-
properties relevant to this custom field (TB), 
refer the table in the section Custom Field 

Properties [➙ 300]. 

_Ref63078BA69DE51021C4E9B72A55F02774
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Tool Name Tool Function Description 

Drop-down 
List 

This custom field can be used to add a Drop-
down list to a page. 

Select this custom field, and apply it onto the 
page. For details on how to modify the sub-
properties relevant to this custom field (DDL), 
refer the table in the section Custom Field 

Properties [➙ 300]. 

Populating Drop-Down Lists: 

For instructions on how populate drop-down 
lists, refer the sections Populating a Drop-down Lis 

[➙ 298]t and Dynamic Insertion of Drop-down Items 

[➙ 298] of this manual. 

Date Picker This custom field can be used to add a Date 
Picker to a page. 

Select this custom field, and apply it to the 
page. For details on how to modify the sub-
properties relevant to this custom field (DP), 
refer the table in the section Custom Field 

Properties [➙ 300]. 

Checkbox This custom field can be used to add a 
Checkbox to a page. 

Select this custom field, and apply it to the 
page. For details on how to modify the sub-
properties relevant to this custom field (CB), 
refer the table in the section Custom Field 

Properties [➙ 300]. 

Button This custom field can be used to add a Button to 
a page. This field allows you to execute a 
command line when the button is clicked. 

Select this custom field, and apply it to the 
page. 

Command Line feature: 

For further information on this feature, please 
refer the section Customizing the Button Custom 

Field [➙ 299] of this manual. 

Attachment This custom field can be used to add an 
Attachment field to a page. This file can be used 
to save a file, like an image / document, etc. that 
can be opened from the custom page. 

 

Select this custom field, and apply it to the 
page. 

Add Attachment feature: 

For further information on this feature, please 
refer section Customizing the Attachment Custom 

Field [➙ 300] of this manual. 

Groupbox This custom field can be used to add a 
Groupbox to a page. A group box can be 
designed to group other custom fields under a 
single box. 

Select this custom field, and apply it to the 
page. For details on how to modify the sub-
properties relevant to this custom field (GB), 
refer the table in the section Custom Field 

Properties [➙ 300]. 

Image This custom field can be used to add an image 
to a page. 

Select this custom field, and apply it to the 
page. For details on how to modify the sub-
properties relevant to this field, refer the table in 
the section Custom Field Properties [➙ 300]. 

GridEx This custom field can be used to add a Grid Box 
to a page. 

Select this custom field, and apply it to the 
page. For details on how to modify the sub-
properties relevant to this field, refer the table in 
the section Custom Field Properties [➙ 300]. 
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19.2.2 Customizing Pre-defined Pages 

The flexible design of SiPass integrated allows operators to customize the look and 

function of the fields on the Pre-defined Pages of the Cardholder / Visitor dialog. 

This means that you can change the layout of the predefined pages by: 

Moving the location of existing fields: 

● Select a field on the predefined page, and drag-and-drop using the mouse to a 

desired location. Click Save. 

Adding new custom fields: 

● Add a new custom field from the Toolbox to the predefined page. For more 

information, refer the section Applying/Modifying Custom Fields [➙ 297]. Click 

Save. 

Modifying or removing existing fields: 

● Select an existing field on a predefined page, and edit its properties. For more 

information on the properties of each field, refer the section Custom Field 

Properties [➙ 300]. 

● To remove an existing field, select the field and click the Delete button on the 

toolbar. OR, right-click a field, and select Delete from the context menu. 

● Click Save. 

Duplicating an existing field: 

● Select a field on the predefined page, and CTRL+drag-and-drop using the 

keyboard and mouse, to a desired location on the same page. Click Save. 

19.2.3 Applying/Modifying Custom Fields 

The sections that follow describe how Custom Fields can be applied to Custom 

Pages, or customized for Predefined Pages of the Cardholder / Visitor dialog. 

1. From the Toolbox, select a specific custom field. 

2. Drag this field to the custom page, or apply it onto the page using the Pointer 

tool. OR 

3. Select the Pointer tool with a mouse-click. 

4. Select a desired custom field from the toolbox with a mouse-click. 

5. Hover over a page to choose a location for the custom field. (hovering displays 

a + pointer) 

6. Mouse-click on a desired location to display the custom field. 

7. From the Properties panel, edit the Appearance and Behavior properties for 

this custom field. For more information on how to edit these properties, refer 

the section Custom Field Properties [➙ 300]. 

– NOTE: To customize fields of predefined pages, ensure that the IsPrimary 

field under Behavior property is set correctly. 

8. Click Save. 

 The Cardholder / Visitor dialog will be updated, and the changes will be visible 

on these pages. 

Note: Some fields like Drop down, Button and Attachment may have additional 

options for field configuration. For detailed information on each of these field, refer 

the sections Customizing the DROP DOWN Custom Field [➙ 298], Customizing 

the BUTTON Custom Field [➙ 299], Customizing the ATTACHMENT Custom Field 

[➙ 300]. 
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19.2.3.1 Customizing the DROP DOWN Custom Field 

Rather than typing text into various fields, the options displayed on a drop-down list 

can be imported using a tool called the Look-Up Table. This tool gives the operator 

the flexibility to create a new look-up table, or edit / delete an existing look-up table. 

The following steps describe how a Drop-down list can be populated: 

1. From the Toolbox, select the Drop Down List custom field. 

2. Drag this field to the custom page, or apply it onto the page using the Pointer 

tool. 

3. From the Properties panel, select the drop down list in the cell adjacent to 

Lookup Table. 

4. Select a Look-up Table from the available list to populate the drop-down list. 

Dynamic Insertion of Drop-down Items  

The Drop-down list custom field can be configured to allow an operator who uses 

this custom page to insert list items in three different ways. It is up to the custom 

page designer to decide on which populating option he wishes to grant to the 

operator.  

The following options that can be used to allow operators to fill a drop-down list in 

three different ways: 

● Insert On Save 

● Don’t Insert on Save 

● Drop Down Only 

These three options have been discussed in detail in the sections that follow. 

Insert on Save 

With the ‘Insert on Save’ option, the operator is given the choice of adding items to 

the drop-down list on the Cardholder dialog itself. When the items added are 

saved, they get automatically inserted into a previously selected Look-up Data file. 

This will happen only if these don’t previously exist in the Look-up Table. 

The Custom Page Configuration instructions for this option are as follows: 

1. Add the Drop-Down List custom field to the custom page. 

2. From the Properties panel, click the drop down list in the cell adjacent to Look-

up Table, and select a required Look-Up table from the list that appears. 

3. From the Properties panel, click the drop down list in the cell adjacent to 

Behavior. 

4. Select Insert On Save. 

5. Click Save. 
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Usability: 

1. Return to the Cardholder / Visitor dialog. You will find the drop down list on the 

custom page that was added. 

2. Select the drop-down list and type in a new value for the list. 

3. Save the changes made to the cardholder dialog. 

4. From the Navigation panel, select Import Data > Lookup Data 

5. From the Look-up Data list, select the Look-Up Table that was selected for this 

drop-down list (in step 2 of Custom Page Design Configuration). 

6. The new items that were typed into the drop-down list have been inserted into 

this Look-Up Table. 

 

In order to allow operators to use this function on a Cardholder / Visitor dialog, 

they need to be given Edit (e) or Complete (c) privileges for the Look-Up Table 

through the Operator Group dialog. 

Don’t Insert on Save 

The Custom Page Design Configuration for this option is the same as that for 

Insert On Save. In this case, the value that is typed into the drop-down list and 

saved will not be inserted into the Look-up Data table. 

Drop Down Only 

With the ‘Drop Down Only’ option, once the custom page has been designed, the 

operators can only choose drop-down items from those given on the drop-down 

list. They cannot insert or type-in new items to the drop-down list. 

That is, the operators will have to make a selection from the items provided in the 

drop-down list. 

 

Note: If an operator is not given Edit (e) or Complete (c) privileges for the Look-up 

Table through the Operator Group dialog, the Behavior property for the Drop-

Down List custom field will default to Drop Down Only. 

For more information on how to import Look-up Table, or create new Look-up Data 

or edit existing lists, refer the SiPass integrated Operation Client manual. 

19.2.3.2 Customizing the BUTTON Custom Field 

The user can configure the Button custom field to invoke a Command Line when 

the button is clicked. 

Invoking a Command Line: 

1. From the Toolbox, select the Button custom field. 

2. Drag this custom field to the custom page, or use the pointer tool to apply it 

onto the custom page. 

3. From the Properties panel, select the cell adjacent to the Command sub-

property (under Behavior). 

4. In this cell, specify the command to be executed when a user clicks this button 

on the custom page. 

For details on how to further modify this custom field, refer all the sub-properties in 

the table in the section Custom Field Properties [➙ 300], corresponding to the 

custom field (B). 
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19.2.3.3 Customizing the ATTACHMENT Custom Field 

Adding an Attachment: 

This custom field can be used to add an attachment to the custom page. 

When applied to the custom page, it consists of the following: 

● ‘Select’ button: 

 This button will display an ‘Open File’ dialog. The user can select a file from 

this dialog that they want to add to the cardholder or visitor. The file that is 

selected can be a file of any type. 

● Picture Box: 

 When the file is selected, a preview of the selected file will be displayed in the 

picture box of this custom field. This preview will consist of a thumbnail image 

of the file, or an icon associated with the attached file. 

 When the user saves the cardholder or visitor after selecting an image/ file, the 

file will be saved as part of the cardholder’s custom data. 

 On clicking on the image displayed in the picture box of this custom field, an 

enlarged attachment associated with this custom field will be displayed in a 

separate window. 

● ‘Clear’ button: 

 This button removes the image in the picture box, and leaves it blank. When 

the user saves the cardholder/visitor after clearing the file, no files will be saved 

as part of the cardholder’s custom data. Any existing files that have been 

uploaded will also be removed. 

Optional custom fields that can be linked to the attachment 

The Dropdown List, Text box and Date Picker are the three optional custom fields 

that can be added to the Attachment custom field. 

 

 

Note: Any number of instances of these three custom fields can be added to the 

attachment. 

For details on how to modify the sub-properties relevant to this custom field (A), 

refer the section Custom Field Properties [➙ 300]. 
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19.2.4 Custom Field Properties 

The Custom Fields Properties can be customized by modifying the sub-properties 

of each of the custom fields, in the Properties panel.  

While the cell is selected and active, there are three methods of altering the 

content of the cell. 

● Double-click in the centre of the cell to highlight the cell and then overwrite its 

contents (some properties like Label, don’t need to be highlighted); or 

● For drop-downs, select from the drop down list, or double-click the right-hand-

side of the cell to toggle between “Yes” and “No”. 

● The properties can be arranged by using either of the following buttons: 

– Categorized button – Clicking the is button categorizes / groups the 

properties based on whether they determine the Appearance, Behavior or 

Database of the Custom Field. 

– Alphabetical button – This button arranges the properties alphabetically. 

A brief summary of the properties and sub-properties displayed in this panel of 

each field is contained in the following table: 
 

Properties Sub-Properties Description 

Appearance Attachment 
Properties 

This sub-property is specific to the ‘Attachment’ custom field. On clicking on the 
… button of this cell, a Control Collection Editor dialog is displayed. 

Select the Add button, and choose any of the three custom fields displayed in 
the drop-down list. 

The properties of the selected custom field can be modified in the adjacent 
Properties panel. 

Select the Remove button to delete a custom field from the list. 

Select the OK button to add all the selected custom fields and their properties to 
the Attachment custom field. 

 Clear Button Text The text entered in this field defines the text that appears on the ‘Clear’ button. 

 Field Enabled This field defines whether or not a control is accessible to the user. If this field is 
disabled by setting it to FALSE, it will not be visible to the operator. 

 Format A format can only be specified for a text box, with the text data type selected. 
Refer to Data Type below. 

 Label The text entered in this field is displayed in the Cardholder or Visitor dialog as 
the name of the particular custom field. This name may or may not be the same 
as that contained in DBField Name. 

 Location This field has two sub-fields – ‘X’ and ‘Y’ – that determine the coordinates of this 
field from the top-left of the custom page. 

 Select Button Text The text entered in this field defines the text that appears on the ‘Select’ button. 

 Size This field has two sub-fields – ‘Width’ and ‘Height’ and determines the total size 
of the custom field. The numbers entered in these subfields define the size of all 
the custom fields that can be used from the toolbox. 

Behaviour Behaviour This is the dynamic insertion of drop-downs. 

 Command This is where the command line is typed in for a button control. 

 IsPredefined If this field is set to TRUE, it implies that this is a default field. 

If this field is set to FALSE, it implies that this is a new custom field, or an edited 
predefined field. 
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Properties Sub-Properties Description 

 IsPrimary If this field is set to TRUE, it implies that this is an editable field. 

If this field is set to FALSE, the field is read-only, and cannot be 
edited/customized. 

 Label Left Align If this field is set to TRUE, the label text of this field will be left-aligned. 

If this field is set to FALSE, the label text of this field will be right-aligned. 

 Label Max. Length This field allows the operator to specify the maximum length of the label. 

 Lookup Table This field allows the operator to select a look up table that will be displayed as a 
list on the cardholder dialog. Its values can be selected from the drop-down list 
in the Cardholder dialog. 

 Max. File Size This field defines the maximum size of the file that can be uploaded for a 
cardholder. 

 Page Number This field displays the current custom page number. 

 Pages Used This field displays whether the custom page displayed is for the Cardholder or 
Visitor dialog. 

 TabIndex This field specifies the tab order number of each custom field on the specified 
page. This becomes useful when an operator uses the TAB key to move across 
various fields on the Cardholder/Visitor dialog, instead of using the mouse to 
click and select each field. 

For example, if the TabIndex number is set to 2 for a field; when the operator 
presses the TAB key on the keyboard twice while on the Cardholer/Visitor 
dialog, the field whos TabIndex is set to 2, will be highlighted. 

Database Compulsory This field defines whether or not the presence of data in this field is required. 
Data must be entered before the cardholder record can be saved in the system. 
Discretion should be used when establishing whether or not a field is 
compulsory. 

 Data Type This field defines the data type of the field. It is used for information related to 
saving the field in the database and the control that is displayed. The type must 
be chosen from those shown in the drop-down list. Once saved in the system, 
this field cannot be altered; so, care should be exercised when using this 
property. Primarily, the data types selected are either Numeric or Text. 

 Field Name The name entered in this field is used to identify the field in the database. It can 
be chosen from a list of potential database names or a new name can be 
created. Duplication of database field names is not permitted. Once saved in the 
system, this field cannot be altered; so, care should be exercised when using 
this property. This name does not appear in any dialog. 

 Max. Length This field defines the maximum number of characters that can be entered within 
this field. 

 Unique If this field is set to “Yes”, SiPass integrated will check that the value in this field 
is unique to the cardholder. For example, Social Security Numbers or Tax File 
Numbers are considered to be unique. Once saved in the system, this field 
cannot be changed. Exercise care when using this property. 

This field can be set to true only if existing values on the custom page are 
already unique. 
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19.2.5 Resizing Custom Fields 

Custom Fields can be resized in two different ways: 

● By clicking on the edge of the applied custom field and dragging it to the 

desired size, or 

● In the Properties panel, maximize the Size sub-property. The custom field can 

be resized by editing the field values of the X and Y coordinates. 
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19.3 Custom Page Partitioning 

Setting Operator Privileges for Custom Pages takes place at two levels: 

● Operator Privileges to view or edit custom fields in the Cardholder / Visitor 
dialog. 

 This can be set by selecting Operator Functions > Cardholder Fields, and 

selecting the custom pages and fields for which appropriate privilege should be 

granted. 

● Operator Privileges to view or edit custom pages in SiPass integrated. This sort 

of privilege would generally be granted to a Custom Page Designer. 

 This can be set by selecting Operator Functions > System Functions. 

 Next, select Custom Pages from the Available panel, and click Add. 

19.3.1 Operator Privileges for Custom Fields in the Cardholder / 

Visitor Dialog 

If the operator does not have any privileges for the custom field, they will not be 

able to view the data in that field, nor edit it. The following are the kinds of 

privileges that can be assigned: 

VIEW (v) Privileges Assigned: If the operator has been assigned only VIEW (v) 

privileges for a custom field, they will only be able to view the cardholder/visitor 

data, and not edit it. 

EDIT (e) Privileges Assigned: If the operator has been assigned EDIT (e) or 

Complete privileges for a custom field, they will be able to both view and edit the 

cardholder / visitor data in that field. 

No Privileges Assigned For a Certain Custom Field: If an operator does not have 

any privileges for ANY of the custom fields on a particular page, they will not be 

able to view the page in the Cardholder / Visitor dialog at all. It will be missing from 

all the tab pages. 

19.3.2 Operator Privileges for Custom Pages 

The Custom Page privileges assigned to an operator group, will define whether the 

Custom Page Designer can design / edit the page. 

The following are the operator privileges that are available: 

VIEW (v) Privileges Assigned: If the designer has been assigned view privileges for 

a custom pages, they will only be able to view the custom fields, and also view it’s 

properties in the Properties panel. 

EDIT (e) Privileges Assigned: If the designer has been assigned edit privileges for 

custom pages, they will have the ability to edit all properties of the custom fields, 

and move the custom fields. They will NOT be able to delete the fields. 

COMPLETE (c) Privileges Assigned: If the designer has been assigned complete 

privileges for a custom pages, they will have the ability to edit field properties, 

move and delete the custom fields. 

No Privileges Assigned: If a designer does not have any privileges assigned for a 

Custom Field, they will still be able to see the field. However, they will not be able 

to view or edit the properties of the custom field in the Properties panel. 

No Privileges Assigned For a Certain Custom Field: If the designer does not have 

any privileges for any of the Custom Fields on a page, they will not be able to view 

the custom page. 
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19.4 Importing / Exporting Custom Pages 

SiPass integrated allows the custom page designer to Import and Export custom 

pages as XML files. 

19.4.1 Importing Custom Pages 

The Custom Page Designer will need to select an XML file that was previously 

exported from SiPass integrated. 

1. Select the Import Pages button on the Custom Page Designer dialog. 

2. From the Open dialog that appears, select an XML file and click Open. 

3. From the Import dialog that appears, select the custom page/s to import. Click 

Import. 

 The selected custom pages will be imported. 

 

 

More than one custom page can be imported on the Custom Page Designer 
dialog. 

 

19.4.2 Exporting Custom Pages 

The Custom Page Designer will need to select an XML file to export from SiPass 

integrated. 

1. Select the Export Pages button on the Custom Page Designer dialog. 

2. From the Export dialog that appears, select a Custom Page. One or more 

Custom Pages can be selected. 

3. Click Export. 

4. Using the Save As dialog that appears, save the file to be exported in a 

suitable location.



 

 

Index 

306 | 313  A6V101068156 

 

Index  

A 
ACC ....................................................................  41 

ACC series, Devices ............................................  51 

ACC Series, Points ..............................................  65 

ACC, configuring .................................................  45 

ACC, configuring for remote access ...................  166 

Access Control ..................................................  178 

to floors ........................................................... 187 

Access Points, configuring ...................................  65 

ACCs 

remote ............................................................. 163 

Action Shortcut ..................................................  255 

Add 

Action .............................................................. 251 

Group .............................................................. 251 

Host Event Task ............................................... 96 

Location .......................................................... 251 

Shortcut .......................................................... 251 

Adding 

Bar Code ......................................................... 261 

Photo Boxes ................................................... 260 

Adding a DVR Camera ......................................  235 

Adding a Guard to the System ...........................  198 

Address Range, IP .............................................  174 

Advanced ..................................................  270, 270 

Alarm 

Instruction ....................................................... 123 

Status .............................................................. 125 

Symbols .......................................................... 125 

Alarm Class for dialup components ....................  169 

Alarm Instruction ................................................  258 

Close ............................................................... 245 

Creating .......................................................... 258 

New ................................................................. 245 

Open ............................................................... 245 

Save ................................................................ 245 

Align ..................................................................  247 

Bottom ............................................................ 251 

Centre ............................................................. 251 

Left .................................................................. 250 

Top .................................................................. 251 

Align Right .........................................................  250 

Appearance ...............................................  301, 301 

Arc ....................................................................  250 

Arc Tool .............................................................  249 

Areas 

Intrusion .......................................................... 107 

Attachment ........................................................  296 

ATTACHMENT Custom Field ............................  300 

Attachment Properties .......................................  301 

Audit Trail 

Backup ............................................................ 136 

Columns ............................................................ 20 

Purge .............................................................. 140 

Restore ........................................................... 139 

AutoCAD DXF File 

Import .............................................................. 245 

B 
Backup 

Audit Trail ........................................................ 136 

Database ........................................................ 132 

Location .......................................................... 133 

Backup - Log Book ............................................  141 

Bar Code ...................................................  251, 261 

Baud Rate .........................................................  162 

Behaviour ..........................................................  301 

Bold ...................................................................  251 

Button ................................................................  296 

BUTTON Custom Field ......................................  299 

C 
Camera .............................................................  243 

Capture Card 

Installation ....................................................... 263 

Card Template 

Bar Codes ....................................................... 261 

Close ............................................................... 245 

_Ref45A1C5C4EDE891E71C0ED6C4287F1EC9
_Ref45A1C5C4EDE891E71C0ED6C4287F1EC9
_Ref6228DB66AB241A9CCB40BB59BD80C275
_Ref6228DB66AB241A9CCB40BB59BD80C275
_Ref9A8134B184AE806E3BFC867576DD58ED
_Ref9A8134B184AE806E3BFC867576DD58ED
_RefF652F070B4E66F2307A7FCF8FF0D858E
_RefF652F070B4E66F2307A7FCF8FF0D858E
_Ref3ED197AF5A34DED3FF2CE538C643EA32
_Ref3ED197AF5A34DED3FF2CE538C643EA32
_Ref2908E5E5A51AAB9E2AFF261062FC7C0C
_Ref2908E5E5A51AAB9E2AFF261062FC7C0C
_Ref700D1C1592C155AA87F29F3DC50ECDE1
_Ref700D1C1592C155AA87F29F3DC50ECDE1
_RefAA75CEA013A82433FFE297839C1C93C4
_RefAA75CEA013A82433FFE297839C1C93C4
_Ref25305F03DD6B3BF18684B217632E63A9
_Ref25305F03DD6B3BF18684B217632E63A9
_RefF0AEA73CE1F83F82F77B6A4DDE5D2EF4
_RefF0AEA73CE1F83F82F77B6A4DDE5D2EF4
_RefD93256523BE57683C6704FA30F443C24
_RefD93256523BE57683C6704FA30F443C24
_RefD6A3996E448B8D9E6FEC3A5D001C406E
_RefD6A3996E448B8D9E6FEC3A5D001C406E
_RefF9830CB6ECA57495CC80B23DBA151345
_RefF9830CB6ECA57495CC80B23DBA151345
_RefBEA9F6F7EFB81CABF187FF192553C04C
_RefBEA9F6F7EFB81CABF187FF192553C04C
_Ref49004F78FD37DA404E2E20CE353DACFD
_Ref49004F78FD37DA404E2E20CE353DACFD
_RefC2C18C1CF2D123B999BCB876D3D6FB0F
_RefC2C18C1CF2D123B999BCB876D3D6FB0F
_RefDA846D820595179D11F943BC17E9185C
_RefDA846D820595179D11F943BC17E9185C
_RefE02AB36E4280432D4CE4BBFF565B8F14
_RefE02AB36E4280432D4CE4BBFF565B8F14
_Ref05798C39DEC8807014874D0DFA04D518
_Ref05798C39DEC8807014874D0DFA04D518
_Ref7FB43F77E70598BE8CE25AC14086C52E
_Ref7FB43F77E70598BE8CE25AC14086C52E
_RefED80B977C889FEF924E427D72EB6D708
_RefED80B977C889FEF924E427D72EB6D708
_Ref7DE9D4603219C3A29B4FA767D3CDA6BE
_Ref7DE9D4603219C3A29B4FA767D3CDA6BE
_Ref867D4C39DDE8871D5B174A521B9D2B5C
_Ref867D4C39DDE8871D5B174A521B9D2B5C
_RefC8F592952137B45003FCF390EEE9D626
_RefC8F592952137B45003FCF390EEE9D626
_RefAF9593D48F57E38E6F08E40454382DC1
_RefAF9593D48F57E38E6F08E40454382DC1
_Ref8B07468BEC389562C37B64BB0C60F9D3
_Ref8B07468BEC389562C37B64BB0C60F9D3
_Ref31B0B697BF79A696DF9AD684054C71C7
_Ref31B0B697BF79A696DF9AD684054C71C7
_RefD96519385DB8F3947E476F5E38F05CB0
_RefD96519385DB8F3947E476F5E38F05CB0
_RefAEA05D3C219FD35BDBBFECE08673F835
_RefAEA05D3C219FD35BDBBFECE08673F835
_RefD253997AF9D74940F9A89D040D93D406
_RefD253997AF9D74940F9A89D040D93D406
_RefA797FF3FD2CE399999332F756EE5307C
_RefA797FF3FD2CE399999332F756EE5307C
_Ref7A5B8FA214B337645F19C57C4DEE3ACB
_Ref7A5B8FA214B337645F19C57C4DEE3ACB
_Ref5578CA712BBCB9EB78D8C664992F3DBC
_Ref5578CA712BBCB9EB78D8C664992F3DBC
_Ref4783CE9FFEB6467907EB61098869294B
_Ref4783CE9FFEB6467907EB61098869294B
_Ref0B232EA28FA22CDC9E17D08C110BDC2F
_Ref0B232EA28FA22CDC9E17D08C110BDC2F
_Ref4504D104B4D5894814941768D7CA0685
_Ref4504D104B4D5894814941768D7CA0685
_RefEF55DFC14B7F1552E634C0F08054D0CA
_RefEF55DFC14B7F1552E634C0F08054D0CA
_RefE8E63F68C04DB79FB06AF82D4604062F
_RefE8E63F68C04DB79FB06AF82D4604062F
_RefEC386E2078C2B56C2C7C18B5BF1D73CD
_RefEC386E2078C2B56C2C7C18B5BF1D73CD
_Ref6D45BFAA77A4FFC3B7179B2C1D1CB164
_Ref6D45BFAA77A4FFC3B7179B2C1D1CB164
_Ref13B4C153BCDC609F2A52BC6ED3580A6E
_Ref13B4C153BCDC609F2A52BC6ED3580A6E
_Ref048260C6717C2597DA9F733BB2541427
_Ref048260C6717C2597DA9F733BB2541427
_Ref3FCB9BEC3E826675CF2CFAE314E5D67B
_Ref3FCB9BEC3E826675CF2CFAE314E5D67B
_RefE833E4C961A2A1BC09F23F413E37C7E4
_RefE833E4C961A2A1BC09F23F413E37C7E4
_RefADEFBC185D05B7D190940B50E15BA44E
_RefADEFBC185D05B7D190940B50E15BA44E
_RefC92814B2EE15B4E7BE9C2F7A782654B2
_RefC92814B2EE15B4E7BE9C2F7A782654B2
_RefD6B04EFC0F41C26CD81B8A16F91F154D
_RefD6B04EFC0F41C26CD81B8A16F91F154D
_RefFA556C1F2911E1ABA747F4A4160F44BC
_RefFA556C1F2911E1ABA747F4A4160F44BC
_Ref21E8344D90796D4683ECB4229DF597CB
_Ref21E8344D90796D4683ECB4229DF597CB
_Ref5CE92B68E1DC5EEDD827CA91CC51FD18
_Ref5CE92B68E1DC5EEDD827CA91CC51FD18
_RefCFA54050106B5E62BBD425AB93E7F388
_RefCFA54050106B5E62BBD425AB93E7F388
_RefC92DF1A3D9D5FE04B15668BD630F0F8A
_RefC92DF1A3D9D5FE04B15668BD630F0F8A
_RefEED46996CB2F69199F90C57E02AC6F45
_RefEED46996CB2F69199F90C57E02AC6F45
_Ref23F3648DC11CA3C467BB304D10E13ED3
_Ref23F3648DC11CA3C467BB304D10E13ED3
_RefE83368B2F804B10A0DA14D624E0DD7E9
_RefE83368B2F804B10A0DA14D624E0DD7E9
_RefCB1D7FA7113F2CE9D5ABC25651241E8F
_RefCB1D7FA7113F2CE9D5ABC25651241E8F
_Ref54932CB7A8CB9FF41627D1851A5F71F0
_Ref54932CB7A8CB9FF41627D1851A5F71F0
_Ref59A79B1CC5A633C33BA65C1BBA20A7DF
_Ref59A79B1CC5A633C33BA65C1BBA20A7DF
_RefEA273674EC899B016B8CA6260DD76AC1
_RefEA273674EC899B016B8CA6260DD76AC1
_RefA9F8F8190646F3FE691E8D9F761B2F7C
_RefA9F8F8190646F3FE691E8D9F761B2F7C
_Ref76E2D3C547190539FE8942445CD80FE9
_Ref76E2D3C547190539FE8942445CD80FE9
_Ref412D539C76281E0BF864F221B9695A05
_Ref412D539C76281E0BF864F221B9695A05
_Ref80A2A49B4E363DC22ED9EBA2BCA6E31C
_Ref80A2A49B4E363DC22ED9EBA2BCA6E31C
_RefFD24208898D12CB8A9DD749B62E8587D
_RefFD24208898D12CB8A9DD749B62E8587D
_Ref1263BB083BCBAC9E6F133E2D36856A5E
_Ref1263BB083BCBAC9E6F133E2D36856A5E
_Ref312FC2D363545D4628DFA5AB7F0939B2
_Ref312FC2D363545D4628DFA5AB7F0939B2


 

 

Index 

A6V101068156  307 | 313 

 

Design ..................................................... 259, 259 

New .................................................................  245 

Open ...............................................................  245 

Page Setup .....................................................  259 

Photo Box .......................................................  260 

Save ................................................................  245 

Centre Justify .............................................  249, 250 

Change Password ..............................................  19 

Checkbox .......................................................... 296 

Clear .................................................................. 246 

Clear Button Text ............................................... 301 

Clearance Reqd ..................................................  91 

Clock-off ............................................................ 144 

Clock-on ............................................................ 144 

Close ................................................................. 245 

Colour ................................................................ 251 

Colour Palette .................................................... 248 

Command .......................................................... 301 

Compulsory ....................................................... 302 

Configuration Checklist ...................................... 228 

Configuring a SISTORE Client ........................... 230 

Controller Event Task 

configuring ......................................................  101 

Copy ..........................................................  246, 250 

Count ..................................................................  91 

Crosshairs ......................................................... 251 

Custom Field Properties ..................................... 301 

Custom Fields .................................................... 295 

Custom Fields Properties ................................... 301 

Custom Page Partitioning .................................. 304 

Cut ............................................................  246, 250 

D 
Data Type .......................................................... 302 

Database ...................................................  178, 302 

Backup ............................................................  132 

Field ................................................................  251 

Restore ...........................................................  134 

Date Picker ........................................................ 296 

Default Settings, Devices ....................................  62 

Defining the Dialup ACC .................................... 168 

Delete ................................................................  249 

Design 

Card Template ................................................  259 

Designing a Custom Page .................................  295 

Device, configuring .............................................  51 

Devices ..............................................................  41 

Dial-up 

ACC ................................................................  164 

bus service......................................................  168 

Defining Other components ............................  169 

Definition .........................................................  162 

Dial-up Bus ........................................................  162 

Dialup components overview .............................  162 

Dialup configuration checklist .............................  164 

Dialup redundancy configuration ........................  174 

Dialup/PPP Properties .......................................  168 

Door Interlocking................................................  110 

Double Sided Card ............................................  259 

Download 

Server to ACC.................................................  171 

Download, automatic .........................................  171 

Drawing 

Close ...............................................................  245 

Import ..............................................................  245 

New ......................................................... 245, 250 

Open ....................................................... 245, 250 

Save ........................................................ 245, 250 

Drawing Toolbar ........................................  245, 250 

Drawings ...........................................................  252 

Drop-down List ..................................................  296 

Dual Custody ......................................................  68 

Duplicate ...........................................................  249 

DVR Bus............................................................  229 

DVR Camera Groups .........................................  238 

DVR Comms Channel ........................................  229 

DVR IP Address.........................................  231, 241 

DVR Recording ..................................................  243 

Dynamic Insertion ..............................................  298 

E 
Edit ....................................................................  247 

_RefF7D5D5E1975032F149B1C9AD1BA0D6C8
_RefF7D5D5E1975032F149B1C9AD1BA0D6C8
_Ref2A718B7DA519B755BBAD1D4DADB30AE2
_Ref2A718B7DA519B755BBAD1D4DADB30AE2
_Ref6F5A1FE0248BCDCF9269B8A4E98D44AE
_Ref6F5A1FE0248BCDCF9269B8A4E98D44AE
_Ref39B319CE3D6A148B9788D515869DE34F
_Ref39B319CE3D6A148B9788D515869DE34F
_Ref41A2FCF8A5052588880CB203C83690AE
_Ref41A2FCF8A5052588880CB203C83690AE
_Ref770007F92F6428377D3B0F14E62065C6
_Ref770007F92F6428377D3B0F14E62065C6
_Ref2E44A45A935703D1F54B1A645877252D
_Ref2E44A45A935703D1F54B1A645877252D
_Ref3FC9386854CF44C13094CE9C779261B2
_Ref3FC9386854CF44C13094CE9C779261B2
_Ref508FDCC9374E9DD4075F4256FB836B88
_Ref508FDCC9374E9DD4075F4256FB836B88
_Ref9AE22BACD16E852EA04CD71B3C096A32
_Ref9AE22BACD16E852EA04CD71B3C096A32
_RefB438CC7DAD82298F05082E30C04CA865
_RefB438CC7DAD82298F05082E30C04CA865
_Ref3774F8FB442BEEFF0F3A611E8A7149C7
_Ref3774F8FB442BEEFF0F3A611E8A7149C7
_Ref9E127A5F7EF0B29F9F463E4C27A4E4CC
_Ref9E127A5F7EF0B29F9F463E4C27A4E4CC
_Ref423725BDEF78EE182EB87F9E11B42C43
_Ref423725BDEF78EE182EB87F9E11B42C43
_Ref88808D2AF6FAF99488CDE7466A999172
_Ref88808D2AF6FAF99488CDE7466A999172
_Ref0C5547E89F1B623B7F6E07466816D50A
_Ref0C5547E89F1B623B7F6E07466816D50A
_Ref0169D27B85D1DFCB04EFD4CCE862A9CA
_Ref0169D27B85D1DFCB04EFD4CCE862A9CA
_Ref7AF998B7D9AAC7E5BBFB9AFADF83E660
_Ref7AF998B7D9AAC7E5BBFB9AFADF83E660
_Ref4A76D093C5E412EB7C9D218D09A7B2F7
_Ref4A76D093C5E412EB7C9D218D09A7B2F7
_Ref0E0FEA237DACAA550C1D174B86826FF6
_Ref0E0FEA237DACAA550C1D174B86826FF6
_Ref515C06E3530C433EE8FC250E2A2A8501
_Ref515C06E3530C433EE8FC250E2A2A8501
_RefA40294EEB944AFE1AC6BDF70C95403DB
_RefA40294EEB944AFE1AC6BDF70C95403DB
_Ref82FA9503506F4A8B846F84118F559BA0
_Ref82FA9503506F4A8B846F84118F559BA0
_Ref8A69D6148E13B4781CE4A0196ACFB366
_Ref8A69D6148E13B4781CE4A0196ACFB366
_Ref56D1C5B665A1C7CF4569146A2799E32E
_Ref56D1C5B665A1C7CF4569146A2799E32E
_RefD9A94A8A014AD31F191B6386658FF94D
_RefD9A94A8A014AD31F191B6386658FF94D
_Ref588F5D8E3528AF518787FC2104B6283F
_Ref588F5D8E3528AF518787FC2104B6283F
_RefC9987B1E30B2733F98DDFF15D01A9954
_RefC9987B1E30B2733F98DDFF15D01A9954
_Ref333CF9C29F80F230E410FE0D280A2DE2
_Ref333CF9C29F80F230E410FE0D280A2DE2
_RefF3BB4E9217C64B3B51B0E102DBAF9376
_RefF3BB4E9217C64B3B51B0E102DBAF9376
_RefADE27628C91D371168EF6324D10F3FEC
_RefADE27628C91D371168EF6324D10F3FEC
_RefDEE81F3086FDABF67B8DACAAAED6F814
_RefDEE81F3086FDABF67B8DACAAAED6F814
_Ref2DC6C33052758BAA6144CA6180A5809E
_Ref2DC6C33052758BAA6144CA6180A5809E
_Ref98D4C0686B75DF204FF1434F2750D52B
_Ref98D4C0686B75DF204FF1434F2750D52B
_Ref1AE573386A97C4120DE9803E70A9DB56
_Ref1AE573386A97C4120DE9803E70A9DB56
_RefACC98ED8F26A2DBC826C9A913144B5E0
_RefACC98ED8F26A2DBC826C9A913144B5E0
_Ref9816A647C6E01107A3ED630CB6E35C04
_Ref9816A647C6E01107A3ED630CB6E35C04
_Ref04782437F56934444675A93847176ACC
_Ref04782437F56934444675A93847176ACC
_Ref96B50F4456DBB2BAF0A212307F9C69F4
_Ref96B50F4456DBB2BAF0A212307F9C69F4
_Ref39F825AF79C707A52623D31A259B26FB
_Ref39F825AF79C707A52623D31A259B26FB
_Ref103FD9E28C400EC0D03BC002B69333AB
_Ref103FD9E28C400EC0D03BC002B69333AB
_RefDD65171124484CD9E4C794C3AB2D2C45
_RefDD65171124484CD9E4C794C3AB2D2C45
_RefD40793EC5C6F71E6E332CA5709082321
_RefD40793EC5C6F71E6E332CA5709082321
_Ref50063407DB7B868C66108EFDDC00F2ED
_Ref50063407DB7B868C66108EFDDC00F2ED
_RefCD7035AE9B86C55C20DE228DFF999F3F
_RefCD7035AE9B86C55C20DE228DFF999F3F
_Ref36780AA047DA6192F1D9F7C4E1397FA9
_Ref36780AA047DA6192F1D9F7C4E1397FA9
_Ref00D75BF3451FF5A1863E082B1FBCD0BF
_Ref00D75BF3451FF5A1863E082B1FBCD0BF
_RefF2EA8D77A48A916038BA218537B749B5
_RefF2EA8D77A48A916038BA218537B749B5
_Ref11F34191D739A8450415B781451851E4
_Ref11F34191D739A8450415B781451851E4
_RefD1313651A4AEAF32A3D352D7A8173037
_RefD1313651A4AEAF32A3D352D7A8173037
_Ref613626D6439F4F76710B96269C522CBF
_Ref613626D6439F4F76710B96269C522CBF
_Ref8BC078C3F736A7BC556ADBA5457A13D8
_Ref8BC078C3F736A7BC556ADBA5457A13D8
_Ref1FAA7C5824D5C92C68C39186AFE39D64
_Ref1FAA7C5824D5C92C68C39186AFE39D64
_RefE87467E415264A7B919EF6FC8D88F48F
_RefE87467E415264A7B919EF6FC8D88F48F
_Ref798764506005E8B3A1B73298FC948D06
_Ref798764506005E8B3A1B73298FC948D06
_Ref9CEADEC3B3805166B922CF3B04FA3CA8
_Ref9CEADEC3B3805166B922CF3B04FA3CA8
_Ref82596D657F5B7E9EB47C608924DFD012
_Ref82596D657F5B7E9EB47C608924DFD012
_Ref766CA4A0DEBCE6BE03654714F7E7C438
_Ref766CA4A0DEBCE6BE03654714F7E7C438
_Ref8BB3753112EE6B85D8BC274BEC53EB0C
_Ref8BB3753112EE6B85D8BC274BEC53EB0C
_Ref1E2D456E3D447F686E8E4459B3C494D0
_Ref1E2D456E3D447F686E8E4459B3C494D0
_Ref710E54D911FEB3DBF383CBF9767A32E0
_Ref710E54D911FEB3DBF383CBF9767A32E0
_Ref57997C680D9D35722A484D383136DBB9
_Ref57997C680D9D35722A484D383136DBB9
_RefF5105C9F3ECE48E23EE6428991E06CD8
_RefF5105C9F3ECE48E23EE6428991E06CD8
_Ref9260ED99541C81694AA8A887A21BCB3D
_Ref9260ED99541C81694AA8A887A21BCB3D
_Ref92F88AFCCF9B85E27473AC34633DCE38
_Ref92F88AFCCF9B85E27473AC34633DCE38
_RefBF536B1EB8050CEFCBFC3950CC28BCAE
_RefBF536B1EB8050CEFCBFC3950CC28BCAE
_RefE1EBF9353F3AB6F044F46B9EF32BF7E0
_RefE1EBF9353F3AB6F044F46B9EF32BF7E0
_Ref1818EE886863B02030A1F926150430CA
_Ref1818EE886863B02030A1F926150430CA
_Ref8A61E3BD72AE243C4A46B0A03A37EF40
_Ref8A61E3BD72AE243C4A46B0A03A37EF40
_Ref36A9434704F62491135AE510DF0BC0DD
_Ref36A9434704F62491135AE510DF0BC0DD
_Ref6919BBE9989AF4B83142481B9E10A48D
_Ref6919BBE9989AF4B83142481B9E10A48D
_RefB8DA5484CC164E3E5FAE4E599ECE0C79
_RefB8DA5484CC164E3E5FAE4E599ECE0C79
_Ref8CBECBBFD443135AA7F1B1DDCB80C5F9
_Ref8CBECBBFD443135AA7F1B1DDCB80C5F9
_Ref0061EA252E733F58D49CE6F1888E0DE0
_Ref0061EA252E733F58D49CE6F1888E0DE0
_Ref4B1DA3914290B5A57B5D62C046191F39
_Ref4B1DA3914290B5A57B5D62C046191F39
_RefF2805AB1359DCBC1BEB952BB3B2F4D03
_RefF2805AB1359DCBC1BEB952BB3B2F4D03
_RefC16E39488DCC382A5A0F15DF006AF8EF
_RefC16E39488DCC382A5A0F15DF006AF8EF
_RefBCB9B3AB8DC7EFA70D3CE5C83192B547
_RefBCB9B3AB8DC7EFA70D3CE5C83192B547
_Ref8CAFD2975F433816844D8CED8C7BFA74
_Ref8CAFD2975F433816844D8CED8C7BFA74
_Ref5A9DEA668C8977BD11A1A5F12582AB2B
_Ref5A9DEA668C8977BD11A1A5F12582AB2B
_Ref8BA5CB96E21BC641C056807E4DFDFC7B
_Ref8BA5CB96E21BC641C056807E4DFDFC7B
_RefE24C75F2E6930BA0F56EB44F45D2255B
_RefE24C75F2E6930BA0F56EB44F45D2255B
_RefA6ED9480CEF1C83EFF75253095963025
_RefA6ED9480CEF1C83EFF75253095963025


 

 

Index 

308 | 313  A6V101068156 

 

Elevator Control .................................................  179 

Elevator Controller 

low level .......................................................... 181 

Ellipse ...............................................................  250 

Ellipse Tool ........................................................  249 

Encoding ...........................................................  145 

Ethernet Comms ..................................................  41 

Event Name .................................................  96, 106 

Event Task ........................................................  243 

Event Task, establish connection .......................  172 

Exit ....................................................................  245 

Export Pages .....................................................  305 

Exporting Custom Pages ...................................  305 

F 
Field Enabled ....................................................  301 

Field Name ........................................................  302 

Fill Colour ..........................................................  249 

Fill Shapes.........................................................  249 

Find ...................................................................  246 

Find Next ...........................................................  246 

Fire Over-ride 

overview .......................................................... 180 

wiring .............................................................. 180 

Flip Image..........................................................  247 

FLN .....................................................................  41 

FLN, configuring ..................................................  49 

Font ...................................................  249, 250, 251 

Size ................................................................. 251 

Format ...............................................................  301 

Format Bullet Style ............................................  246 

Format Font .......................................................  246 

Format Paragraph..............................................  246 

Format Tabs ......................................................  246 

G 
Graphics ............................................................  245 

Graphics Module ...............................................  244 

Graphics Tools ..................................................  250 

Grid ...........................................................  248, 251 

Group ................................................................  247 

Type .................................................................. 90 

Groupbox ..........................................................  296 

Groups ..............................................................  238 

Work................................................................ 117 

Guard Tour 

Starting ........................................................... 202 

Guard Tour Window ...........................................  208 

Guard .............................................................. 208 

Last Point ........................................................ 208 

Next Point ....................................................... 208 

Time ................................................................ 208 

Tolerance ........................................................ 208 

Tour................................................................. 208 

Guards ..............................................................  198 

Adding a Guard to the System ....................... 198 

Viewing Employee Details .............................. 198 

H 
OSDP Readers ....................................................  84 

HIP OSDP ...........................................................  84 

Host Event Task 

Add.................................................................... 96 

Create ............................................................... 96 

New ................................................................... 96 

Time Zone ......................................................... 96 

Host IP Address .........................................  231, 241 

HyperTerminal, commands ................................  167 

HyperTerminal, using .........................................  166 

I 
Icons .................................................................  204 

Imaging Preferences ..........................................  265 

Import ................................................................  245 

Photo .............................................................. 251 

Raster Image .................................................. 251 

Signature ........................................................ 251 

Import Pages .....................................................  305 

Importing Custom Pages ...................................  305 

Importing Graphics ....................................  253, 254 

Initialization 

Dialup .............................................................. 170 

Input point ...........................................................  73 

Insert Database Field .........................................  249 

_RefDCAA427ED5B0BFF8D6279917BEA39357
_RefDCAA427ED5B0BFF8D6279917BEA39357
_Ref9610F3D528FBF57305031C105767D8FE
_Ref9610F3D528FBF57305031C105767D8FE
_Ref5EC2A85D8FC2A28EFBBA3CB4AA1F2E92
_Ref5EC2A85D8FC2A28EFBBA3CB4AA1F2E92
_Ref11900EEA300319B8343562882805DD70
_Ref11900EEA300319B8343562882805DD70
_Ref93ED26CF2DBD7EBAF2EBA35A396D6CE7
_Ref93ED26CF2DBD7EBAF2EBA35A396D6CE7
_Ref3A62956673C574ECFCEE0AEC5CCA85D4
_Ref3A62956673C574ECFCEE0AEC5CCA85D4
_RefCF2AF0F3CB7DB4A74C557D99F532FA87
_RefCF2AF0F3CB7DB4A74C557D99F532FA87
_Ref1C86A010F03D9FA30ACB6F6DB049CB82
_Ref1C86A010F03D9FA30ACB6F6DB049CB82
_Ref5EC5DEB4947C76EED927A5C4C4AC999D
_Ref5EC5DEB4947C76EED927A5C4C4AC999D
_RefA1E48836D0DF000AAC24914D6537E9B4
_RefA1E48836D0DF000AAC24914D6537E9B4
_Ref0C496F108C020313E2947EFEDF57C0EE
_Ref0C496F108C020313E2947EFEDF57C0EE
_Ref5A1E0ABE39C3745A4240D1B1CB57CC78
_Ref5A1E0ABE39C3745A4240D1B1CB57CC78
_Ref82B28B638B0629BBC4D70B5DA9A542CB
_Ref82B28B638B0629BBC4D70B5DA9A542CB
_Ref3F3ABA4DE2F846A9826C95606393EEB2
_Ref3F3ABA4DE2F846A9826C95606393EEB2
_RefC16F86217CA9241847FDED9D9474EA1F
_RefC16F86217CA9241847FDED9D9474EA1F
_RefC1391DCC453377B81DFAD4A4CDD6A2FC
_RefC1391DCC453377B81DFAD4A4CDD6A2FC
_Ref80AD6DF3FDF541B11B5B8C01CA6F1323
_Ref80AD6DF3FDF541B11B5B8C01CA6F1323
_Ref3E76CB0D4CD2030A194852B3826CD62A
_Ref3E76CB0D4CD2030A194852B3826CD62A
_Ref1630DCDA075458F5D5DED9471C155CF9
_Ref1630DCDA075458F5D5DED9471C155CF9
_Ref16A80181FC330BF5080EF9ADB3D58602
_Ref16A80181FC330BF5080EF9ADB3D58602
_Ref8FC1A9B4984C9D5E60E526EB71F86105
_Ref8FC1A9B4984C9D5E60E526EB71F86105
_RefED8EEB9990C038202DA0CCE9151798A9
_RefED8EEB9990C038202DA0CCE9151798A9
_RefA34E5CA077839E51B97B16E88D6BFA94
_RefA34E5CA077839E51B97B16E88D6BFA94
_RefAFC5C98E644E3B5B52BE3C8A52555E31
_RefAFC5C98E644E3B5B52BE3C8A52555E31
_Ref785263B6EFBE1DF205F03211039A0AAB
_Ref785263B6EFBE1DF205F03211039A0AAB
_RefC5D06B0BB3A59CB3E67F3C9173CAB827
_RefC5D06B0BB3A59CB3E67F3C9173CAB827
_RefDA0F4B21CC2D2712090982096C1527DE
_RefDA0F4B21CC2D2712090982096C1527DE
_Ref4B6E6D637B24CF176E6E56A6B1F68AC9
_Ref4B6E6D637B24CF176E6E56A6B1F68AC9
_RefDD8680092754C746749CFCC243A5B095
_RefDD8680092754C746749CFCC243A5B095
_Ref81C3CCE6B957EF7FB08BCB07B843F2FE
_Ref81C3CCE6B957EF7FB08BCB07B843F2FE
_RefE838BEC5D3458971D75E90CFC1B39CAD
_RefE838BEC5D3458971D75E90CFC1B39CAD
_Ref4915BF9A731EA76E9FDC6006CAF9F9E0
_Ref4915BF9A731EA76E9FDC6006CAF9F9E0
_Ref2F7872E5CD9BBBD2F5741B8E8530B2D8
_Ref2F7872E5CD9BBBD2F5741B8E8530B2D8
_RefAAB21CDAE29014D7EEE71C88157E79F5
_RefAAB21CDAE29014D7EEE71C88157E79F5
_RefBCFE20EA210FDE9BCBA2832A59878E4C
_RefBCFE20EA210FDE9BCBA2832A59878E4C
_RefA622168AE1D4C9624C231ED0E4B03F32
_RefA622168AE1D4C9624C231ED0E4B03F32
_Ref0B53CC4D5C5D6573CCB68023DA530879
_Ref0B53CC4D5C5D6573CCB68023DA530879
_Ref89DFF121868196773913B5FA4FFAC84C
_Ref89DFF121868196773913B5FA4FFAC84C
_Ref0C4DFC3744B3F7A35A9752FDAEF1AC13
_Ref0C4DFC3744B3F7A35A9752FDAEF1AC13
_RefD52CB8AA6AB20C7A1A9781F4E13105EB
_RefD52CB8AA6AB20C7A1A9781F4E13105EB
_RefC8C4FAF3BDB0EF6B4E18749AB17CE10D
_RefC8C4FAF3BDB0EF6B4E18749AB17CE10D
_Ref49622F091FBA1BC62742C5BD285A019E
_Ref49622F091FBA1BC62742C5BD285A019E
_RefEEB5C53BCA3C957571D6F8A871C4202B
_RefEEB5C53BCA3C957571D6F8A871C4202B
_Ref1121BA849B4429BEE22A94F7E5E7C73D
_Ref1121BA849B4429BEE22A94F7E5E7C73D
_Ref1FF01F42B91A5D385758C19705465990
_Ref1FF01F42B91A5D385758C19705465990
_Ref96BEF53A654C7669C1D5E7631B1AEE5C
_Ref96BEF53A654C7669C1D5E7631B1AEE5C
_Ref0431F48E1EE6F3C1A2616A1522FF57A0
_Ref0431F48E1EE6F3C1A2616A1522FF57A0
_Ref69A0E94866E3E18BF3F808B8A58EFD06
_Ref69A0E94866E3E18BF3F808B8A58EFD06
_Ref09A9E4BE90331E21F00717E187B0C3B0
_Ref09A9E4BE90331E21F00717E187B0C3B0
_Ref2F3546FFD80F047C941DCE61C679188A
_Ref2F3546FFD80F047C941DCE61C679188A
_RefA195DB7CFCECF1ED6FFCCB24F6090EAB
_RefA195DB7CFCECF1ED6FFCCB24F6090EAB
_Ref94BE435A23FAC09C1F6DBE982800E257
_Ref94BE435A23FAC09C1F6DBE982800E257
_Ref52B8D0A206EF71C7F035B8FFC1956D8F
_Ref52B8D0A206EF71C7F035B8FFC1956D8F
_RefD65769751E09EA8EF5DE9E7FEA5CD706
_RefD65769751E09EA8EF5DE9E7FEA5CD706
_RefC54ABC85B8303504956C6BA3B9740ECC
_RefC54ABC85B8303504956C6BA3B9740ECC
_Ref6BAB451497FAB22926A5288EA4F7BFA0
_Ref6BAB451497FAB22926A5288EA4F7BFA0
_Ref86C3022F60B562823A92D6EA1029B0CF
_Ref86C3022F60B562823A92D6EA1029B0CF
_RefA6BB957293676DD61797A4486C6C2854
_RefA6BB957293676DD61797A4486C6C2854
_Ref2F7E3B767EE77D5A7C4B17D9802464F7
_Ref2F7E3B767EE77D5A7C4B17D9802464F7
_Ref872BC364D41295AC8EE9953451857E4F
_Ref872BC364D41295AC8EE9953451857E4F
_RefB8D87557E6F4771B67781CEB318203CE
_RefB8D87557E6F4771B67781CEB318203CE
_Ref2E75AD37FA5E3177FED05BA000990A21
_Ref2E75AD37FA5E3177FED05BA000990A21
_RefE92BB1DCC6CC3E2A21C54B6B7DC1BB6F
_RefE92BB1DCC6CC3E2A21C54B6B7DC1BB6F
_Ref05E76E1BB7F103007A4BDFA266B059E8
_Ref05E76E1BB7F103007A4BDFA266B059E8
_RefCA0BB8DFAEB9B10ADD7E728C13DCEFFA
_RefCA0BB8DFAEB9B10ADD7E728C13DCEFFA
_RefBC7627458277E3D50B4D8BCCE33D90E7
_RefBC7627458277E3D50B4D8BCCE33D90E7
_RefEDFF9892FBFECEE4619A79C808AC7A36
_RefEDFF9892FBFECEE4619A79C808AC7A36
_Ref65BC89C8D0FA677881A5C1CC2039A23E
_Ref65BC89C8D0FA677881A5C1CC2039A23E
_Ref9C7C66A3189FA5D9FD172C9E56E2566C
_Ref9C7C66A3189FA5D9FD172C9E56E2566C
_Ref90ABC691E9AF609C6758B92DBBDD512F
_Ref90ABC691E9AF609C6758B92DBBDD512F
_Ref2A991EBB1BFCB70594B29F6E434BE924
_Ref2A991EBB1BFCB70594B29F6E434BE924
_RefF2ADB4A96173EFD347F877D6E7F5D9FF
_RefF2ADB4A96173EFD347F877D6E7F5D9FF
_RefD961294BAB28EB4265653428A2EC7EAF
_RefD961294BAB28EB4265653428A2EC7EAF
_Ref40F0CCEFC098707573CCC84F203EF9C4
_Ref40F0CCEFC098707573CCC84F203EF9C4
_Ref05717CC773DE5CA916C9AD890479A9ED
_Ref05717CC773DE5CA916C9AD890479A9ED
_Ref68C902EA05E8E394DB93931791911207
_Ref68C902EA05E8E394DB93931791911207
_Ref53305102379B3C4C5E5832BDAB1F7876
_Ref53305102379B3C4C5E5832BDAB1F7876


 

 

Index 

A6V101068156  309 | 313 

 

Insert Date & Time ............................................. 246 

Insert Object ...................................................... 246 

Insert On Save ................................................... 298 

Interruptible Commands ......................................  93 

Introduction ........................................................ 244 

Intrusion Area .................................................... 107 

Intrusion Area Name .......................................... 107 

Invert Image Colours .......................................... 247 

Italics ................................................................. 251 

J 
Justify 

Centre ..................................................... 249, 251 

Left .......................................................... 249, 251 

Right ...............................................................  249 

L 
Label .................................................  295, 301, 301 

Left Justify .................................................  249, 250 

Line Colour ........................................................ 249 

Line Tool ............................................................ 249 

Links .................................................................. 247 

Live Audit Trail ................................................... 127 

Location ............................................................. 301 

Lock Workstation ............................................... 245 

Log Book 

Backup ............................................................  141 

Purge ..............................................................  143 

Restore ...........................................................  142 

Log Off .............................................................. 245 

Logical Operators, Controller Event Task ............  98 

Lookup Data ...................................................... 299 

Lookup Table ..................................................... 302 

Look-up Table .................................................... 298 

Low level 

Banks ..............................................................  183 

Card Readers .................................................  182 

Elevators .........................................................  186 

Floors ..............................................................  184 

OPMs ..............................................................  182 

M 
Max. File Size .................................................... 302 

Max. Length .......................................................  302 

Maximum cards per ACC ...................................  168 

Medium Pen ......................................................  249 

Menus 

Additional ........................................................  246 

MIFARE .............................................................  145 

Modems 

Remote ...........................................................  162 

Server .............................................................  162 

Monitoring Tours ................................................  204 

Move to Back .....................................................  247 

Move to Front ....................................................  247 

Multiple Facility Codes ........................................  65 

N 
Net Expected Time ............................................  200 

New ...........................................................  245, 250 

Normal Size .......................................................  248 

Number of commands before auto-download .....  168 

O 
Object Properties ...............................................  247 

Open .........................................................  245, 250 

Operator Group Privileges 

Audit Trail Reports ..........................................  116 

Operator Privileges ............................................  304 

OPM as interface module ...................................  179 

Optimising an Image ..........................................  247 

OSDP .................................................................  84 

Output point ........................................................  73 

P 
Page Number ....................................................  302 

Pages Used .......................................................  302 

Password Management ......................................  19 

Paste .........................................................  246, 250 

Permanent Commands .......................................  93 

Phone Number, Server ......................................  168 

Photo 

Import ..............................................................  245 

Photo Boxes ......................................................  260 

Plan 

Close ...............................................................  245 

_RefA3C7B462B9E558DE16302CD2CF3DA3CF
_RefA3C7B462B9E558DE16302CD2CF3DA3CF
_Ref9934E8A377C812012F9C46FF8924693B
_Ref9934E8A377C812012F9C46FF8924693B
_Ref609C1AAE54CB013EA81C056271262FC3
_Ref609C1AAE54CB013EA81C056271262FC3
_RefFEF690D1E6BEDE619AB6235EB6D278E4
_RefFEF690D1E6BEDE619AB6235EB6D278E4
_Ref0115B15B2711C4CADBDD776B23D02743
_Ref0115B15B2711C4CADBDD776B23D02743
_RefAED847F1E08B35F374E56591652ECC43
_RefAED847F1E08B35F374E56591652ECC43
_Ref9307162E70D258A1CA4009676F99AC1C
_Ref9307162E70D258A1CA4009676F99AC1C
_RefF5935AE38BA6D5EF4177A0BB6C07B4B6
_RefF5935AE38BA6D5EF4177A0BB6C07B4B6
_RefB7597631072C86C95D9085FC61DDF98C
_RefB7597631072C86C95D9085FC61DDF98C
_Ref7D7E1D836C9F29213ECA1CD2F4123DF4
_Ref7D7E1D836C9F29213ECA1CD2F4123DF4
_RefF7AF4C5A4AB3227639B73D196342F015
_RefF7AF4C5A4AB3227639B73D196342F015
_Ref0896CF1844B1ACCF0E3755087019F413
_Ref0896CF1844B1ACCF0E3755087019F413
_Ref32781C7B4EB4D0E57781B25F47350E02
_Ref32781C7B4EB4D0E57781B25F47350E02
_Ref3E78E9CA864A67304D6B863E3434DAEB
_Ref3E78E9CA864A67304D6B863E3434DAEB
_RefCDA7A35A967CCC568F7EC70809961218
_RefCDA7A35A967CCC568F7EC70809961218
_RefD74B84029385473BBF0578C74848B2C9
_RefD74B84029385473BBF0578C74848B2C9
_Ref8FFCE35383510035D5D338D7B660602F
_Ref8FFCE35383510035D5D338D7B660602F
_Ref10AA2A2FC7FF6BBA8FBF4F4C25602A53
_Ref10AA2A2FC7FF6BBA8FBF4F4C25602A53
_RefCBDA1525112D4C0B1F33656A99ED3F05
_RefCBDA1525112D4C0B1F33656A99ED3F05
_RefA87C7405181D3F68566716A49573E12F
_RefA87C7405181D3F68566716A49573E12F
_Ref474F8E5C6C90D6871FC774A1817DAA3B
_Ref474F8E5C6C90D6871FC774A1817DAA3B
_RefCFA999408F3EB354D2DC807E6E7EEF91
_RefCFA999408F3EB354D2DC807E6E7EEF91
_Ref861AC895A6AA5823D276E5F45507EBF3
_Ref861AC895A6AA5823D276E5F45507EBF3
_RefA56A7FFD2B627D436FB1BC9D6E81AFEC
_RefA56A7FFD2B627D436FB1BC9D6E81AFEC
_Ref36D3225778C4BE0DDB3980758FC18E83
_Ref36D3225778C4BE0DDB3980758FC18E83
_RefA68A72F3D1DB601B1F9643FA2E54DA1C
_RefA68A72F3D1DB601B1F9643FA2E54DA1C
_Ref3BDAED4945A084121C53540133A94848
_Ref3BDAED4945A084121C53540133A94848
_RefBFC52300DFAF91BE2E28871709BC9AA4
_RefBFC52300DFAF91BE2E28871709BC9AA4
_Ref82CB58C0210DC2043D090FCABC3D2E09
_Ref82CB58C0210DC2043D090FCABC3D2E09
_Ref30EC0A843FFCB0792F8004D08FEC1D08
_Ref30EC0A843FFCB0792F8004D08FEC1D08
_Ref09FE565B36B1A8D17392709B3F6264DB
_Ref09FE565B36B1A8D17392709B3F6264DB
_Ref8FCF3863D654776422D3B70E1A19FD97
_Ref8FCF3863D654776422D3B70E1A19FD97
_Ref8128B3D8B5F36773E339A7DC4D7B5EA6
_Ref8128B3D8B5F36773E339A7DC4D7B5EA6
_Ref7A4F6E0248E269F853B183777F01E79C
_Ref7A4F6E0248E269F853B183777F01E79C
_Ref468F619E3B3396912B1E0563A1808690
_Ref468F619E3B3396912B1E0563A1808690
_Ref1DC1EB13D4592E37F261AE305B9C572D
_Ref1DC1EB13D4592E37F261AE305B9C572D
_Ref2BEE1DB66D30CD0C7988F1DB0233044F
_Ref2BEE1DB66D30CD0C7988F1DB0233044F
_Ref014F5D2C6377F1B261124018D0772B35
_Ref014F5D2C6377F1B261124018D0772B35
_Ref84D1DACF292AB652777843196CAF9858
_Ref84D1DACF292AB652777843196CAF9858
_RefA6B89A7517EED8D3559BAE1169CA930D
_RefA6B89A7517EED8D3559BAE1169CA930D
_RefBD649178013A6E41F083FB033BA81D67
_RefBD649178013A6E41F083FB033BA81D67
_Ref9B5304685D47D32832BB7F50A4583C5E
_Ref9B5304685D47D32832BB7F50A4583C5E
_RefFAD56AB1B652993F65AAF9EE5A129389
_RefFAD56AB1B652993F65AAF9EE5A129389
_RefE66FA53ADD7763F51D0B8B9DE26AD872
_RefE66FA53ADD7763F51D0B8B9DE26AD872
_Ref528491515C5E5C3D2BEF22364E1B8E2D
_Ref528491515C5E5C3D2BEF22364E1B8E2D
_Ref07AA8C1FF7CC9CDC4895299C09244A1A
_Ref07AA8C1FF7CC9CDC4895299C09244A1A
_RefB7FB59AAEBB1BA113AF3512DB5B5D5F4
_RefB7FB59AAEBB1BA113AF3512DB5B5D5F4
_Ref45675DFE416A8888817B60E11779A954
_Ref45675DFE416A8888817B60E11779A954
_Ref5F8C1CEEEC8B0184C502EA655FD661E8
_Ref5F8C1CEEEC8B0184C502EA655FD661E8
_Ref39A7D3C75EC2AFCF3FBF49F0536AF680
_Ref39A7D3C75EC2AFCF3FBF49F0536AF680
_RefEE2172EBA0ACA7741F4F7C7923128F48
_RefEE2172EBA0ACA7741F4F7C7923128F48
_RefA0E5E310297CEC0B58A5848874D5C4C9
_RefA0E5E310297CEC0B58A5848874D5C4C9
_RefCCFC4D30FCEE61D9DDA6D5E3E9F1CB83
_RefCCFC4D30FCEE61D9DDA6D5E3E9F1CB83
_Ref936C856E15B9B440F308407288B534E0
_Ref936C856E15B9B440F308407288B534E0
_Ref037763C31BE5615762B508E568EF4234
_Ref037763C31BE5615762B508E568EF4234
_Ref7CAC7216A694185C63E984ADA2E68D85
_Ref7CAC7216A694185C63E984ADA2E68D85
_RefD1B72C2122B19264284469EFDD03B8A0
_RefD1B72C2122B19264284469EFDD03B8A0
_Ref544AB0D7BFA0EDF55278BD8C5710CAC5
_Ref544AB0D7BFA0EDF55278BD8C5710CAC5
_Ref5F0ECD0B53AF47645CD8ADF0259D3653
_Ref5F0ECD0B53AF47645CD8ADF0259D3653
_Ref61974B5E349E72348361E866C50426B5
_Ref61974B5E349E72348361E866C50426B5
_RefB4363B115B640D617AB6BD40E710E9EE
_RefB4363B115B640D617AB6BD40E710E9EE
_Ref7AC89B98739C275DA790518290DE5334
_Ref7AC89B98739C275DA790518290DE5334
_RefF022A63E7BEF7532C96645152A75B0F1
_RefF022A63E7BEF7532C96645152A75B0F1
_Ref00A10B54934FB78721FB9DBEA1A6AFAB
_Ref00A10B54934FB78721FB9DBEA1A6AFAB
_Ref97B8CB6674BC4A8A966E95112E76CE1B
_Ref97B8CB6674BC4A8A966E95112E76CE1B
_Ref7B6A2483ADEC4C2AF06CEE510CC0B53B
_Ref7B6A2483ADEC4C2AF06CEE510CC0B53B
_Ref0575B86C465FCB2DD121F976C5D6956F
_Ref0575B86C465FCB2DD121F976C5D6956F
_Ref43984D4649537289656E475E72BCA539
_Ref43984D4649537289656E475E72BCA539
_RefB9D0466FE16AE044F5FFD00503800D27
_RefB9D0466FE16AE044F5FFD00503800D27
_RefDEAFA8F98894435C45B538E30F8FB973
_RefDEAFA8F98894435C45B538E30F8FB973
_RefB5ABEAFABD360B17D585AB37FA0DEAE3
_RefB5ABEAFABD360B17D585AB37FA0DEAE3
_RefF8870179FCDA143B4180DA60D8AB0A81
_RefF8870179FCDA143B4180DA60D8AB0A81
_Ref99397E55F07F0716E0F9B8AF17543C2E
_Ref99397E55F07F0716E0F9B8AF17543C2E
_Ref5E2FFE9EADCB48EBC029277F1AC4C605
_Ref5E2FFE9EADCB48EBC029277F1AC4C605


 

 

Index 

310 | 313  A6V101068156 

 

New ................................................................. 245 

Open ............................................................... 245 

Save ................................................................ 245 

Pointer ...............................................................  295 

Points ..................................................................  41 

Points, Configuring ..............................................  65 

Polygon .............................................................  250 

Polygon Tool .....................................................  249 

Port number ...............................................  231, 241 

Preferences 

Imaging ........................................................... 265 

Print ...........................................................  245, 250 

Print Preview .....................................................  245 

Print Setup.........................................................  245 

Printing a Guard Tour Report .............................  205 

Privilege Level ...................................................  116 

Process Image ...................................................  247 

Profile ................................................  145, 147, 148 

Profile Configuration ..........................................  145 

Pulse Mode, output points....................................  77 

Purge Audit Trail ................................................  140 

Purge Log Book .................................................  143 

R 
Random Tour ....................................................  199 

RAS connection 

remote ............................................................. 163 

Server ............................................................. 163 

Raster Image 

Import .............................................................. 245 

Rectangle ..........................................................  250 

Rectangle Tool ..................................................  249 

Redo .................................................................  246 

Redundant comms, pre-requisites ......................  173 

Redundant communications overview ................  173 

Refresh Imported Drawing .................................  245 

Registering a Tour .............................................  203 

Reports ..............................................................  169 

Reset Menu and Toolbar .....................................  24 

Resizing Custom Fields .....................................  303 

Restore 

Audit Trail ........................................................ 139 

Database ........................................................ 134 

Restore Log Book ..............................................  142 

REX input 

Operation Mode ................................................ 74 

Right Justify ...............................................  249, 250 

Right Mouse Button Options ..............................  209 

Rotate an Image 

Clockwise ........................................................ 247 

S 
Save ..........................................................  245, 250 

Save As .............................................................  245 

Save As Drawing ...............................................  245 

Scheduled Reporting .........................................  129 

Secured .............................................................  178 

Select ................................................................  250 

Select All ...........................................................  246 

Select Button Text .............................................  301 

Select Tool ........................................................  249 

Server 

Name ................................................................ 42 

Signature 

Import .............................................................. 245 

SiPass Server Service .......................................  166 

Site Plans ..........................................................  254 

Adding Shortcuts ............................................ 255 

Adding Symbols .............................................. 255 

Importing Graphics ......................................... 254 

Size ...................................................................  301 

Smart Card ........................................  145, 147, 148 

Snapshots .........................................................  127 

Starting a Tour 

From the Guard Tour Monitor ......................... 206 

Status ................................................................  125 

Status Toolbar ...................................................  248 

Straight Line ......................................................  250 

Summary ...........................................................  228 

Symbol ......................................................  125, 253 

Close ............................................................... 245 

Importing Graphics ......................................... 253 

_Ref06845C628C464454CDEB13448504F5AC
_Ref06845C628C464454CDEB13448504F5AC
_RefDB1877BD262C88BEB9FF7A3FD0D0BD75
_RefDB1877BD262C88BEB9FF7A3FD0D0BD75
_Ref9E5BEE183C653666092509FD0EB73C57
_Ref9E5BEE183C653666092509FD0EB73C57
_RefEA549F0F218CE263B26A19D10E7BAF80
_RefEA549F0F218CE263B26A19D10E7BAF80
_RefCBB29BAA169475AFAA6E7AC212AF0149
_RefCBB29BAA169475AFAA6E7AC212AF0149
_Ref9F24853F3CD5D6E6C6B656C54A3D9A08
_Ref9F24853F3CD5D6E6C6B656C54A3D9A08
_RefFF0BBCB06A7FC9C1704A43E057EC2288
_RefFF0BBCB06A7FC9C1704A43E057EC2288
_RefE158A0AB46338676DA59A22D14F60ECB
_RefE158A0AB46338676DA59A22D14F60ECB
_RefB097BBEBD7FB84377AE8301F3E04B701
_RefB097BBEBD7FB84377AE8301F3E04B701
_Ref0C9B0239851ACB7059BFC8E4B045C09F
_Ref0C9B0239851ACB7059BFC8E4B045C09F
_Ref050F28C182FBFE8651626A0FF9365D68
_Ref050F28C182FBFE8651626A0FF9365D68
_Ref5F44F4D2E70300E0181207E05FE9C898
_Ref5F44F4D2E70300E0181207E05FE9C898
_Ref730E225FE3CC2595F63598EBCD4DE7BB
_Ref730E225FE3CC2595F63598EBCD4DE7BB
_Ref056FC6215D61ED56634BCE02BF79CEE0
_Ref056FC6215D61ED56634BCE02BF79CEE0
_RefB6A176F16F04314ACB399D9C9F04E9A8
_RefB6A176F16F04314ACB399D9C9F04E9A8
_Ref136E05CB4E79FC10B28A2C59053EB291
_Ref136E05CB4E79FC10B28A2C59053EB291
_Ref29F23F459C2DB4E1D36F9A180378F086
_Ref29F23F459C2DB4E1D36F9A180378F086
_RefFD8B30577E1CD8BD965160A5047E7045
_RefFD8B30577E1CD8BD965160A5047E7045
_Ref47DD0B6B28E068B42093812D2F180015
_Ref47DD0B6B28E068B42093812D2F180015
_Ref800CC3AFBB1FBB17E1756393076B0E05
_Ref800CC3AFBB1FBB17E1756393076B0E05
_Ref71A203E63D37ABFBF4ABD1FD3F3F94FD
_Ref71A203E63D37ABFBF4ABD1FD3F3F94FD
_RefB21E2DD3DBD9C0FA7ADEA82AD9C62DFB
_RefB21E2DD3DBD9C0FA7ADEA82AD9C62DFB
_RefB6FC2B9FC3240FB0C127EF327DD76A40
_RefB6FC2B9FC3240FB0C127EF327DD76A40
_Ref61E505CF3B25DE6224D2557DB519AA22
_Ref61E505CF3B25DE6224D2557DB519AA22
_RefBDF4B39C3558F240F5987D7DB2BEF664
_RefBDF4B39C3558F240F5987D7DB2BEF664
_Ref5DC256CE9FF8326E34AF52B90EFC039F
_Ref5DC256CE9FF8326E34AF52B90EFC039F
_Ref6AA430A9CCE8E6810255F87B7D597DDD
_Ref6AA430A9CCE8E6810255F87B7D597DDD
_Ref606457D343A62FEAC567970542F514FB
_Ref606457D343A62FEAC567970542F514FB
_Ref2CF983CE86F67EE704527BBE0C8B7F15
_Ref2CF983CE86F67EE704527BBE0C8B7F15
_RefA45B6A38080AFCCD32A94862C6C9AD08
_RefA45B6A38080AFCCD32A94862C6C9AD08
_Ref972372ED2081DB04B89BC970C88CA05F
_Ref972372ED2081DB04B89BC970C88CA05F
_Ref0B51E3B5E5ABD56B82C925FC7D4A52CF
_Ref0B51E3B5E5ABD56B82C925FC7D4A52CF
_RefA9D887FDD4BF4AC93A3BE1EAFA3ABC74
_RefA9D887FDD4BF4AC93A3BE1EAFA3ABC74
_Ref7B6CB35603A66566A63F2B741EF823A4
_Ref7B6CB35603A66566A63F2B741EF823A4
_Ref248B39BE558D6F2E0587475C48A752D3
_Ref248B39BE558D6F2E0587475C48A752D3
_Ref8AE5D7A0853C4F5517D7FCC8832FEA6D
_Ref8AE5D7A0853C4F5517D7FCC8832FEA6D
_RefA966FD5FF12C8CEEB1EF3415B9314336
_RefA966FD5FF12C8CEEB1EF3415B9314336
_Ref1FE80C1D580836A925A2FC15484AE64C
_Ref1FE80C1D580836A925A2FC15484AE64C
_RefA9E3F17F8B7818E0FDEEC78F4FCB3F93
_RefA9E3F17F8B7818E0FDEEC78F4FCB3F93
_RefE1B9DEF6A8C997AE2A44E8D0D69B4B3B
_RefE1B9DEF6A8C997AE2A44E8D0D69B4B3B
_Ref7FD41B91A42C985FC8CC17BFC4D02E66
_Ref7FD41B91A42C985FC8CC17BFC4D02E66
_Ref9F42533DDB08DD59D110D011100BBEA8
_Ref9F42533DDB08DD59D110D011100BBEA8
_RefC091041D7A1406B9C85397335BFDCAB8
_RefC091041D7A1406B9C85397335BFDCAB8
_RefFB8874407577548DEE50BFA882C1EAE0
_RefFB8874407577548DEE50BFA882C1EAE0
_RefB8A1F00D09BB75FE82D723A7987541E0
_RefB8A1F00D09BB75FE82D723A7987541E0
_RefD1650ECD0652622B5081026618A553CD
_RefD1650ECD0652622B5081026618A553CD
_Ref6C7AF1703966050BC40BF5B245983A60
_Ref6C7AF1703966050BC40BF5B245983A60
_RefEE4C19B6AD261DBA15EC08A2D375DDBE
_RefEE4C19B6AD261DBA15EC08A2D375DDBE
_RefD078FFB5D8B4AD83405C6C622B2DFF0C
_RefD078FFB5D8B4AD83405C6C622B2DFF0C
_Ref55DFF43AF2EB02DE78300773E95D1BB2
_Ref55DFF43AF2EB02DE78300773E95D1BB2
_Ref2F8A196707E0B7ABAFF65B12A0D64A50
_Ref2F8A196707E0B7ABAFF65B12A0D64A50
_Ref625C16927A6124C7F8BD6D4F2C5B1521
_Ref625C16927A6124C7F8BD6D4F2C5B1521
_RefF979E393EDEECBCA70F23CAD300E6AE6
_RefF979E393EDEECBCA70F23CAD300E6AE6
_Ref492418BF047B32B88AD40509EF2B456F
_Ref492418BF047B32B88AD40509EF2B456F
_Ref47F35143427D3F2034D48EC83DB4C85E
_Ref47F35143427D3F2034D48EC83DB4C85E
_Ref4CF92CF63E39A8511EA70394BEE41957
_Ref4CF92CF63E39A8511EA70394BEE41957
_Ref7B98F57C843F5CE88F23DA26071D8DBD
_Ref7B98F57C843F5CE88F23DA26071D8DBD
_RefA7FB3726FF88EB79A375A849E14F9920
_RefA7FB3726FF88EB79A375A849E14F9920
_Ref4F8FA836A5F8BCD800EC1CCCC0CB71D1
_Ref4F8FA836A5F8BCD800EC1CCCC0CB71D1
_Ref33268C3EA6B8ACB68B41D77E79331F42
_Ref33268C3EA6B8ACB68B41D77E79331F42
_RefDE60BE13EAE64EF397632C20497DE0F6
_RefDE60BE13EAE64EF397632C20497DE0F6
_Ref64385C9ADB3CB08DCA6BDF82889027B9
_Ref64385C9ADB3CB08DCA6BDF82889027B9
_RefBF5FD7E3118D5FF8EB5A11033A205AB3
_RefBF5FD7E3118D5FF8EB5A11033A205AB3
_Ref9C4C27636A4AF05F3D48A2165BA6CE32
_Ref9C4C27636A4AF05F3D48A2165BA6CE32
_Ref8982700C8F48EDBDC41C74583A0D57BF
_Ref8982700C8F48EDBDC41C74583A0D57BF
_RefD440CF3507EC0D399053F5960D4C0B74
_RefD440CF3507EC0D399053F5960D4C0B74
_Ref2A622174F16B52F492D2A12C48DD3FB3
_Ref2A622174F16B52F492D2A12C48DD3FB3
_RefC89BBDB28FD18455EBE4899B0D3667C5
_RefC89BBDB28FD18455EBE4899B0D3667C5
_Ref7D8942FF1B774C8A4A0C141B1A8EC90F
_Ref7D8942FF1B774C8A4A0C141B1A8EC90F
_Ref7AC98155A9ECDA70321ECF41C1C69919
_Ref7AC98155A9ECDA70321ECF41C1C69919
_Ref2E60999BB06ACBA1622A8E6A508BB904
_Ref2E60999BB06ACBA1622A8E6A508BB904
_Ref07E08E3CBA6CE6657E412328FDC09D55
_Ref07E08E3CBA6CE6657E412328FDC09D55
_Ref187C3D45A18BCE5948781E2C12A93EC2
_Ref187C3D45A18BCE5948781E2C12A93EC2
_Ref9F4DFAC4E38E5B61C770F879CC4E4AC9
_Ref9F4DFAC4E38E5B61C770F879CC4E4AC9
_Ref1BBB7FA50878A3A3C2EAC647EB589C2C
_Ref1BBB7FA50878A3A3C2EAC647EB589C2C
_RefE903D3BDEB5C5A59ED46BC4F174E38AB
_RefE903D3BDEB5C5A59ED46BC4F174E38AB
_Ref34709B638F6DCDDDCB095B0C66083EC8
_Ref34709B638F6DCDDDCB095B0C66083EC8
_Ref4845257A45800F44A2FB23F3BE553CC5
_Ref4845257A45800F44A2FB23F3BE553CC5


 

 

Index 

A6V101068156  311 | 313 

 

New .................................................................  245 

Open ...............................................................  245 

Save ................................................................  245 

System Architecture ........................................... 228 

System Components 

Groups ..............................................................  41 

Server ...............................................................  41 

T 
Text 

Bold .................................................................  251 

Centre Justify ..................................................  251 

Colour .............................................................  251 

Italics ...............................................................  251 

Left Justify .......................................................  251 

Underline ........................................................  251 

Text Tool ...................................................  249, 250 

Text Toolbar ...................................................... 251 

Textbox ............................................................. 295 

Thick Pen .......................................................... 249 

Thin Pen ............................................................ 249 

Time and Attendance Interface .......................... 144 

Time Schedule Control .......................................  94 

Timer ..................................................................  91 

Tolerance .......................................................... 200 

Tool 

Add Action ......................................................  251 

Add Group ......................................................  251 

Add Location ...................................................  251 

Add Shortcut ...................................................  251 

Align Bottom ...................................................  251 

Align Centre ....................................................  251 

Align Left .........................................................  250 

Align Right ......................................................  250 

Align Top .........................................................  251 

Arc ..................................................................  250 

Bar Code .........................................................  251 

Centre Justify ..................................................  250 

Crosshairs .......................................................  251 

Database Field ...............................................  251 

Ellipse .............................................................  250 

Font .................................................................  250 

Grid .................................................................  251 

Import Photo ...................................................  251 

Import Raster Image .......................................  251 

Import Signature .............................................  251 

Left Justify .......................................................  250 

Polygon ...........................................................  250 

Rectangle ........................................................  250 

Right Justify ....................................................  250 

Straight Line....................................................  250 

Text .................................................................  250 

Zoom In ...........................................................  250 

Zoom Out ........................................................  250 

Tool Menu .........................................................  249 

Tool Select ........................................................  250 

Toolbar 

Drawing ...........................................................  250 

Text .................................................................  251 

Tools 

Graphics .........................................................  250 

Tour Groups ......................................................  202 

Tour Points 

Access ............................................................  201 

Input ................................................................  201 

Tour Stop Log ....................................................  205 

Name ..............................................................  205 

Occurred .........................................................  205 

Status ..............................................................  205 

Tours .................................................................  199 

U 
Underline ...........................................................  251 

Undo..................................................................  246 

Ungroup ............................................................  247 

Unique ...............................................................  302 

unsealed input ...................................................  226 

Unsecured .........................................................  178 

Upload 

ACC to Server.................................................  172 

V 
Vertical Arcs ......................................................  249 

_Ref92A551C999B046DF7CA98309947123BE
_Ref92A551C999B046DF7CA98309947123BE
_RefDDABBDC9E2D92E7A87FDCB7909C292EC
_RefDDABBDC9E2D92E7A87FDCB7909C292EC
_RefE956229DAF8F74AABD3FAB80D4994531
_RefE956229DAF8F74AABD3FAB80D4994531
_RefDC21EEEA9298238B1C82581DC1E83B4C
_RefDC21EEEA9298238B1C82581DC1E83B4C
_Ref78DD8FBE8A7A9779645911AAAF244E0C
_Ref78DD8FBE8A7A9779645911AAAF244E0C
_Ref56CC368F70455CD0C3DC2108CC48065D
_Ref56CC368F70455CD0C3DC2108CC48065D
_Ref3E26A94F9FAFE8FB7D5D396518F19FE4
_Ref3E26A94F9FAFE8FB7D5D396518F19FE4
_Ref3F1DA34944E36D8EC8780DD3E3FCA0D7
_Ref3F1DA34944E36D8EC8780DD3E3FCA0D7
_Ref89AAC86FDE17112268546FE61CE81F21
_Ref89AAC86FDE17112268546FE61CE81F21
_RefBBA1C50B7286315938656962EEA0A47A
_RefBBA1C50B7286315938656962EEA0A47A
_RefE446BBB86597322F3C6CA3503B7EE00E
_RefE446BBB86597322F3C6CA3503B7EE00E
_RefB76819B436D7D383F937AD517C6C9EDC
_RefB76819B436D7D383F937AD517C6C9EDC
_Ref5ADEF467EE1DF1A4D567F4B87858780D
_Ref5ADEF467EE1DF1A4D567F4B87858780D
_RefE1EDC4972D61D07C816DED5B974E4757
_RefE1EDC4972D61D07C816DED5B974E4757
_Ref5A07C77785B43245042FF5CD2E6DFDF4
_Ref5A07C77785B43245042FF5CD2E6DFDF4
_Ref9ED7BC84991FA4D2DA0E860778C68AC4
_Ref9ED7BC84991FA4D2DA0E860778C68AC4
_RefD6031A009FD8A1C2DB7BB79185F458BA
_RefD6031A009FD8A1C2DB7BB79185F458BA
_Ref1D78E9CF883519750A22CFD68C19DD34
_Ref1D78E9CF883519750A22CFD68C19DD34
_Ref0248D411362C86993E7BA474629D1DE2
_Ref0248D411362C86993E7BA474629D1DE2
_Ref6303008BE267C6A7E188CBE19B627F25
_Ref6303008BE267C6A7E188CBE19B627F25
_RefB030085E89CC4A059E242AC0F82F5AB3
_RefB030085E89CC4A059E242AC0F82F5AB3
_RefC02E5FE0D22D1060D2C444FB9889FF83
_RefC02E5FE0D22D1060D2C444FB9889FF83
_RefB9805D9E7E6B18091F45B76BBCA73CAC
_RefB9805D9E7E6B18091F45B76BBCA73CAC
_Ref2072C6DA205C6F9659D6FC95513A9E57
_Ref2072C6DA205C6F9659D6FC95513A9E57
_RefB54BAB3355163DFDE34CD23370B275EA
_RefB54BAB3355163DFDE34CD23370B275EA
_RefE7785CE04D5478C45DFA8FA05C2948E7
_RefE7785CE04D5478C45DFA8FA05C2948E7
_RefB7F22DFC8EE591C199ACF2F824E04139
_RefB7F22DFC8EE591C199ACF2F824E04139
_Ref2B0F022BF22EEC742303F5C0B653ADF9
_Ref2B0F022BF22EEC742303F5C0B653ADF9
_Ref88B0BE52E1F61D6BA0905852D40EE0C9
_Ref88B0BE52E1F61D6BA0905852D40EE0C9
_RefAD1435010016815F4585E018BECF04ED
_RefAD1435010016815F4585E018BECF04ED
_Ref37933DA386E8001DA789CB6C8B2C9772
_Ref37933DA386E8001DA789CB6C8B2C9772
_RefC4A8E15FE2177A2EDCA8978D4DDEC3BB
_RefC4A8E15FE2177A2EDCA8978D4DDEC3BB
_RefA435F5C0B09F45105FF022C61B3D120F
_RefA435F5C0B09F45105FF022C61B3D120F
_Ref74B1D717E7389CC89BF7F2D0F8ED9602
_Ref74B1D717E7389CC89BF7F2D0F8ED9602
_RefA3AF3B20F439F4501452FF975B1D604B
_RefA3AF3B20F439F4501452FF975B1D604B
_RefC89BCAAD8BD4D2199F088BE16D5AB5BB
_RefC89BCAAD8BD4D2199F088BE16D5AB5BB
_Ref4592F2B74AA00606C2EA75E8438FF53D
_Ref4592F2B74AA00606C2EA75E8438FF53D
_Ref6F03DDA5B32FD671E55BC0568F7F04D2
_Ref6F03DDA5B32FD671E55BC0568F7F04D2
_Ref4DF3A4EB81A25EA9ABF09677A2BD1F46
_Ref4DF3A4EB81A25EA9ABF09677A2BD1F46
_Ref1FD2E7C2568CC9B3F2B060319E2E4BD3
_Ref1FD2E7C2568CC9B3F2B060319E2E4BD3
_Ref068786AAD9B2A954A8F9375B5E6C9181
_Ref068786AAD9B2A954A8F9375B5E6C9181
_Ref8824C185C6E74A80BCE3A7DCC8D47E18
_Ref8824C185C6E74A80BCE3A7DCC8D47E18
_Ref87B01D6F50B68414C73FE2A238256D8F
_Ref87B01D6F50B68414C73FE2A238256D8F
_Ref19CCB775064F4C072363C1FF384F1318
_Ref19CCB775064F4C072363C1FF384F1318
_Ref8A2155021A082769359200C9624EB4A8
_Ref8A2155021A082769359200C9624EB4A8
_Ref9392E4FC859DA3F4C7318828B5F5EFFD
_Ref9392E4FC859DA3F4C7318828B5F5EFFD
_RefF2EAA4A989A3FD69BC97639E2FB3B9ED
_RefF2EAA4A989A3FD69BC97639E2FB3B9ED
_RefA2304ED28D4C1D1BCA74488301E81B78
_RefA2304ED28D4C1D1BCA74488301E81B78
_Ref2A2A8D416F4FEBDE6AD565C344108C83
_Ref2A2A8D416F4FEBDE6AD565C344108C83
_Ref5298AFB5362C19E8CFE354E4782C8AD1
_Ref5298AFB5362C19E8CFE354E4782C8AD1
_RefA9EDE3E30EF70C9C9BF366B7C5977F75
_RefA9EDE3E30EF70C9C9BF366B7C5977F75
_Ref69BEA0043F11773C9282928D616EBDCA
_Ref69BEA0043F11773C9282928D616EBDCA
_RefB561C8031F95588049611066E566E3BC
_RefB561C8031F95588049611066E566E3BC
_Ref7644D59D18EE6D042BCFFECEF3A3A36F
_Ref7644D59D18EE6D042BCFFECEF3A3A36F
_Ref36A76F1CB0817C513360F902E9C7791B
_Ref36A76F1CB0817C513360F902E9C7791B
_Ref53718168DB078CB2D1BC548BF9B6AAC9
_Ref53718168DB078CB2D1BC548BF9B6AAC9
_Ref30996458F27F113558357CC17B4F970C
_Ref30996458F27F113558357CC17B4F970C
_Ref22D753C0C271FB5E98A0F4B68D784D62
_Ref22D753C0C271FB5E98A0F4B68D784D62
_RefE5A511BBEB7EC649E10165D4066EBDFB
_RefE5A511BBEB7EC649E10165D4066EBDFB
_Ref804099580C82CCC4C6D3644626C82741
_Ref804099580C82CCC4C6D3644626C82741
_Ref5A628BE152EF3CF4CC7586498F368DE0
_Ref5A628BE152EF3CF4CC7586498F368DE0
_Ref7F5E234BB4E2DC1251F3646E4559E9E4
_Ref7F5E234BB4E2DC1251F3646E4559E9E4
_Ref19B9627575DA689BCEB07C477BB73062
_Ref19B9627575DA689BCEB07C477BB73062
_Ref681759BB46B98FD0CDDC12EA042A0E04
_Ref681759BB46B98FD0CDDC12EA042A0E04
_Ref5E9A7E1E6EA19861B71369DE02EA0780
_Ref5E9A7E1E6EA19861B71369DE02EA0780
_Ref16E5DC24219AACEF12A3B421152BB296
_Ref16E5DC24219AACEF12A3B421152BB296
_RefE71131246BBDFE8BF677742A2492855B
_RefE71131246BBDFE8BF677742A2492855B
_RefCE3143834FF0E98D5C3484D434278A50
_RefCE3143834FF0E98D5C3484D434278A50
_Ref13059CD9AF0EB5FAA1B90F7B616006CD
_Ref13059CD9AF0EB5FAA1B90F7B616006CD
_Ref46CC313EAD9BE51E9A51508DF2EF3623
_Ref46CC313EAD9BE51E9A51508DF2EF3623
_Ref3BF95AFD933DBA9918FFAE7156F9A2F7
_Ref3BF95AFD933DBA9918FFAE7156F9A2F7


 

 

Index 

312 | 313  A6V101068156 

 

Video Capture Card ...........................................  263 

Video Card 

Installation ....................................................... 263 

View Menu.........................................................  248 

Viewing Employee Details ..................................  198 

W 
Windows, password storage ..............................  175 

Work Groups .....................................................  117 

Z 
Zoom In .....................................................  248, 250 

Zoom Out ..................................................  248, 250 

_Ref41026E88CFE938F9EB672A89789BE381
_Ref41026E88CFE938F9EB672A89789BE381
_RefAA58F80DA26B95ADFDE8C4A773C5A446
_RefAA58F80DA26B95ADFDE8C4A773C5A446
_RefBE7E2D3A8C3D5CEDF2CD4FADD62E2858
_RefBE7E2D3A8C3D5CEDF2CD4FADD62E2858
_Ref6EF72278F934A9F489A63235E334F6F1
_Ref6EF72278F934A9F489A63235E334F6F1
_Ref6C2680B2A650D572E2094DE13510CC22
_Ref6C2680B2A650D572E2094DE13510CC22
_RefB3CE821D989FA589CF37D30D07CF9BF6
_RefB3CE821D989FA589CF37D30D07CF9BF6
_RefBF676CE51264C9DF62A3A206B11066A5
_RefBF676CE51264C9DF62A3A206B11066A5
_Ref8AFD3665126A9E2CC0FF700A42F13974
_Ref8AFD3665126A9E2CC0FF700A42F13974
_RefAEE1BC004ABF7AC1CD54FF5B56E32B65
_RefAEE1BC004ABF7AC1CD54FF5B56E32B65
_RefD0FE86836977C00AD9668788CD647529
_RefD0FE86836977C00AD9668788CD647529


 

A6V101068156   

 

Issued by 

Siemens Switzerland Ltd 

Smart Infrastructure 

Global Headquarters 

Theilerstrasse 1a 

CH-6300 Zug 

+41 58 724 2424 

www.siemens.com/buildingtechnologies 

 

© Siemens Switzerland Ltd, 2020 

Technical specifications and availability subject to change without notice. 

 


